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SourceForge  http://maexplorer.sour ceforge.net/

or
LECB/NCI http://www.lech.ncifcr f.gov/M AExplor er

++ Note: This hypertext manual is divided into chapters and appendices Web pages. These may be printed individually from your Web browser by (1)
clicking in the text window to be printed, and (2) using the "Print Frame" in Netscape or "Print" in Internet Explorer. Some of the chapters (eg. 2) have
many images. The entire manua may be downloaded at one time with low resolution figures and is suitable for printing in the Web browser. Y ou may

also download a an Adobe acrobate PDF file version of the entire manual with the lower resolution figures (~5Mb). The Unix script for creating the
full reference manual from the individual HTML pagesis CreateM aeFull RefM anual .do.

The MAExplorer is a Java-based bioinformatics exploratory data-analysis and data-mining program for analyzing sets of
guantitative spotted cDNA or oligonucleotide microarray data (Lemkin et al., 2000) - (see (Schulze, 2001) for areview of

microarray technology).
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MAExplorer - cDNA Microarray Exploratory Data Analysis

Prior to its release on SourceForge, MAEXxplorer was developed by Dr. Peter Lemkin (LECB/NCI-Frederick) with help from
Gregory Thornwall (SAIC) and Jai Evans (DECA/CIT, NIH). It wasiinitially created for analyzing 33P labeled membrane array
data from the mouse mammary tissue from Mammary Genome Anatomy Project (MGAP) http://mammary.nih.gov/ with the help
of many researchers in the Laboratory of Genetics and Physiology, NIDDK under Dr. Lothar Hennighausen. Since the early work
with MGAP it was extended to work with other types of cDNA and oligo arrays and various nucleotide labeling methods. These
include spotted Cy3/Cy5 glass slides, spotted membranes, non-geometric chip data, and other chip supports with different
geometries and numbers of duplicate spots/gene, clones as well as oligo chip data such as Affymetrix. A wizard tool called
Cvt2Mae was devel oped to make it easier for other researchers to convert their data to the format required by MAExplorer.
Cvt2Mae was devel oped by Peter Lemkin, Greg Thornwall and Bob Stephens (ABCC/SAIC). Y ou may extend the set of builtin
analysis methods by writing Java plugins called MAEPIugins.

This document describes the MAEXxplorer's functionality, provides tutorials and contains documentation for using it with various
types arrays.

With this program, you may: 1) analyze expression of individual genes; 2) analyze expression of gene families and clusters; 3)
compare expression patterns for multiple hybridized samples.

MAExplorer iswritten in Java and runs as a stand-al one application that you download to your computer. Although MAEXxplorer
began out as a Java applet for use with with Web browsers for the MGAP Web database (_http://www.lecb.ncifcrf.gov/mae ), we
have depricated its use as an appl et because of many problems with running large Java applets in some Web browsers. Instead, we
recommend downloading MAEXxplorer which includes the public MGAP array data as a demonstration data set. Then run
MAExplorer on this data after you have installed it on your computer.

Notation: MAExplorer uses the notation that the sample probe total MRNA is labeled and then hybridized against the known
cDNA targets tethered to the microarray. Because of this notation, we refer to a hybridized sample asaHP. An alternative
notation that reverses these terms is also commonly used (see "Chipping Forecast”, Nature Genetics supplement, Jan, 1999, pg
1). Also, because arrays may be constructed from either spotted clones or oligonucleotides, we refer to hybridized chip DNA
from any of these sources genericlly as "genes'.

Throughout this document we use the abbreviations HP for hybridized sample, GC for gene class. These and other terms are
explained in the Glossary and Index . There are anumber of figures and tablesillustrating various features of MAEXxplorer

throughout this manual. Figures are presented at |ow-resolution. By clicking on the lower-resolution figure, the high-resolution
versions can be viewed.

NOTES: because MAEXxplorer isunder development, there may be occasional problems with some of its functionality. There may also be some
problems (mostly bad HTML links) with migrating from LECB/NCI to the SourceForge Web site. Some operations that are under development are
labeled with "[Future]" in this manual. We welcome your suggestions for improvements as well as letting us know about problems that you
encounter. Occasionally the manual or the figuresin the manual may not be quite in phase with the software. Please notify us of problems or
suggestions by E-mail so we can try to fix or implement them. If you are a bioinformatics devel oper and would be interested on working with the

MAEXxplorer project, consider joining the MAEXxplorer development team on SourceFForge.net.

**lcon Legend

Data from a 38 sample subset of hybridized samples from the MGAP mouse microarray database. This screen illustrates a synthetic pseudoarray image
showing the ratios of duplicated grids of genes comparing day 13 pregnancy in C57B6 mouse (sample HP-X 'set’) with Lactation day 1 (sample HP-Y
'set"). The color scale of the spotsisindicated on the left asis the current data normalization mode (median). Genes with white circles are named genes
and were selected by the datafilter. A scatter plot of this datais shown on the right with genes passing the data filter indicated as red + and those not
passing thefilter (i.e. ESTs, calibration DNA, user's genes) shown as gray + symbols. A single gene was selected by clicking on it in the array image and
has ayellow circle (grid 1-D) and a corresponding green circle in the scatter plot. Information on that gene isindicated above the array and at the top of
the scatter plot. MAExplorer can also be used to view mean data from sets of samples e.g. Day 13 pregnancies from C57B6 (3 HP-X samples) vs. Day 1
Lactation (4 HP-Y samples) at low or high resolution.
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MAEXxplorer - Overview

MAEXxplorer is a bioinformatics microarray data mining Java application that may help in the discovery of genes regulated in
cancer and other diseases. MAExplorer is generaly run as as a stand-alone application on alocal computer. By running as alocal
application, it is able to access your local disk to save the state of your data mining session aswell as plots and reports. Using the
previously saved data mining state, you can continue a data-mining session at alater date after exiting the program.

. MAExplorer helps perform computer data-mining of multiple samples hybridized with microarrays. Data mining is the
process of attempting to find relevant patterns of information from large sets of data. MAEXxplorer enables the investigator
to:

1. organize the hybridized sample data by experimental condition, (including: disease state, dose response,
developmental stage, strain, time course, knock-in/-out, shock treatment, etc.) so an investigator can design data
mining experiments relevant to those conditions or a subset of conditions from a particular database.

2. compare gene expression patterns between sets of different hybridized samples (denoted HP-X and HP-Y 'sets) for
comparing mean changes between replicate sets of samples. An ordered expression profile list HP-E of samplesis
used for finding similar expression patterns across genes for a sequence of samples such as from the cell cycle,
developmental stage, or conditions.

3. use data mining techniques of graphical direct-manipulation (which requires the real-time response of local
computation), statistical, clustering and spreadsheet techniques, and connectivity to other Internet genomic databases
to get additional information on individual genes. The latter leverages the maintenance resources of other groupsto
allow transparent access to that data.

4. explore, compare, and record analyses between researchersin their own group and for sharing with other
investigators (i.e. groupware).

. Spotsin microarray images are quantified into tab-delimited data files using programs such as generated by Axon's
GenePix(TM), Scanalyze, Molecular Dynamic's ImageQuant-NT(TM), Research Genetics Pathways(TM), and other systems.
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This datais transformed using the Cvi2Mae wizard data conversion tool to quantification datafiles, a print-file (Gene In
Plate Order table or GIPO), alist of DB samplesfile, and aMAEXxplorer configuration file. These may be copied to your
local computer file system (in stand-alone operation) or a MAEXxpl orer-compatible Web database server where they are
loaded on demand by MAEXxplorer. The file formats schema used by MAEXxplorer is discussed in Appendix C). The data
conversion tool Cvt2Mae (Appendix C.6) helps convert user's data sets to MAExplorer format.

. Upon starting, MAEXplorer usesa".mae" startup file to specify the subset of samples to be used from the database, and
initial parameters to use. It then loads a configuration file which describes additional files including the gene-in-plate-order
table which maps spot position to clone ID and other genomic information, and a samples database file containing a list of
the names of the quantified spot data files for the hybridized samples being analyzed. Later, you may request additional
sample files or data from the local file system or Web database server when requested by the user. The .maefile format is
discussed in Appendix D. Users may save data mining sessions to create new .mae startup files. These may be used at a

later for continuing their sessions in the future.

. Theinvestigator interacts directly with the system by selecting entries from menus (Section 2), selecting data by clicking on
spots in the microarray image, selecting points in graphic plots or cells in spreadsheets, manipulating threshold sliders, or
typing in gene names, clone IDs, GenBank IDs, UniGene IDs, LocusLink IDs, etc. Data reports may be exported to Excel
spreadsheets or used dynamically to access other genomic Web databases. With the stand-alone version, you may save the
full resolution plotsin GIF files and report tables in tab-delimited text files.

Recommended Hardware

Because data mining is a computationally and graphically intensive activity, a reasonable level of computation resources are
required for adequate response. The same Java program runs on a variety of operating systems including Windows
95/98/Me/NT/2000, Macintosh OS8/9/X, Solaris, Linux, etc. so the choice of computer is not that critical. We recommend the
following hardware:

. A computer with at least 500Mhz CPU speed (Intel). For other CPUs such as the PowerPC (Macintosh), Sparc (Sun), etc., it
should have a corresponding capability (for more powerful CPU chips, alower CPU speed may be fine). For large data sets
(order of 100 or more) having alarge number of samples with many spots, a much faster system with much more memory is
desirable.

. At least 128Mbytes of memory. Although it will work with less memory, we don't recommend it asit is underpowered. For
large data sets, more memory (eg. 256Mb or more) is desirable.

. Adequate disk space for the data sets required. The MAExplorer distribution itself, including the MGAP demonstration
database and a Java Virtual Machine, is on the order of 24 Mbytes. This Reference Manual with both low and high
resolution figuresis on the order of 11 Mbytes.

. Itrequiresat least a 1024x768 pixel resolution 256-color monitor. However, we find that because of the multiple plots
created during asession, it is much easier to use with a screen resolution of 1280x1024 pixels. It is very difficult to use with
an 800x600 resol ution system and we don't recommend it.

. The R extensions are not available with MacOS 8/9. Using the R extensions requires more memory - at least 256M bytes

with afaster processor is recommended.

Addition of user defined analysis methods using Java Plugins

We have provided the ability for users to add their own Java Plugin Extensions to MAExplorer. These extend the capabilities of
the core MAEXxplorer program to other more sophisticated analysis methods created by users and allow interaction with specialized
genomic servers. Thisisdescribed in Appendix E, Section 2.6, and in the MAExplorer Plugins Web page.

1. Introduction

This hyperlinked manual provides a detailed description of the MAExplorer conventions (Section 1) and operation (Section 2). The
latter contains many figures of computer screens showing the operations described in the Section. Section 3 discusses typical
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scenarios in using MAEXxplorer for data-mining microarrays and contains a brief introduction to the process of data mining. Section
4 lists currently known bugs and the revision history. Appendix A isashort tutorial. Appendix B isamore advanced tutorial.
Appendix C describes the files required by MAEXxplorer and how they may be created for using MAExplorer with other array data.
It also describes the data conversion tool Cvt2Mae. The Appendix D covers downloading, installing and running MAEXxplorer asa
stand-alone Java application on alocal computer. Appendix E discusses design issues for the MAExplorer Java program and
supporting Web servers. Users may create new analytic methods and add them as MAExplorer Plugins as Java extensions. Thereis
aglossary of terms used in MAEXxplorer. Thereisalso aList of Figures, aList of Tables, and an Index to help find material of
interest.

MAEXxplorer is normally used as stand-alone program

Figure 1 gives an overview of the system. Note that MAEXxplorer does not perform spot quantification from raw scanned images -
it is used for the subsequent data mining analysis of quantified spot data. Figures 1.1.1 through 1.1.3 describe thisin more detail.

-
Data é
Auxillary databases
G.lLR.O. DB é
Quantified spot data < ;
Array sample DB
Configuration DB
IS ™

State databases
Uszer State DB N

ESipmars B8 NMAErplorer
MAExplorer applet >
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User's Web Proxy Web server
browser executing ¢ F
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ntert I.MA.G.E. DB
/ et UniGene DB
User stand-alone | g 5 dbEST DB
application on GenBank DB
local file system  |q— | gm| Locuslink DB
histology DB
models DB
GeneCard DB, etc.

Figure 1. Overview of MAExplorer exploratory data analysis system. Initial data preparation steps are performed prior to analysis by MAExplorer
and areindicated by at the top of the figure. The primary data consists of quantified microarray image data as well as corresponding
qualitative clone ID, gene-in-plate-order (GIPO or print-table, etc.), gene name, hypertext base references and related information. After the microarrays
are hybridized, they are scanned and spots quantified using image spot quantification programs. These lists are then saved for each array in atab-
delimited file. Microarray image quantification may be performed by various software such as Axon's GenePix(TM), Scanalyze, Molecular Dynamics
ImageQuant(T™), Research Genetics' Pathways(TM), etc. When used as a stand-al one application, data may be saved on the local computer for local off-
line use, and direct access to other Internet genomic databases may be made without using a proxy server.

[DEPRICATED: When used as an applet, this auxiliary databases and the MAExplorer Jar files are copied to the Web server or local file system (in the
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case of the stand-alone version) where they are then available to be downloaded by users. When a user invokes a Web page containing the Java applet, it
first downloads the applet that then downloads auxiliary databases including a configuration file that describes the array data. It then downloads the
subset of quantified microarray spot data files requested for the set of hybridized samples being investigated. Additional samples may be downloaded at
any time. When the user selects an operation that requires access to Web databases not residing on the MAExplorer Web server, implicit Java security
restrictions prevent the applet from going directly to these other Web servers. Instead, it requests the MAEXxplorer proxy server request the data from the
foreign Web server, and then returns it back to the user's Web browser. ]

?@

Quantified Array Data

Stand-alone Web Browser
Java Application based Applet

Figure 1.1.1 Overview of MAEXxplorer exploratory data analysis system. MAExplorer is used as a stand-alone application on local data. [Itsuse asa
Web browser applet has been DEPRICATED. In the case of the applet, it may only access quantified array data from the Web server that launched the

applet.]
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cDNA spotted clones or oligos on chip supports

Labeled DNA sample probes »| Hybridized microarrays

hd

Scanned images

Quantified spot data

Figure 1.1.2 Overview of data preparation for quantified spot data used by MAExplorer. MAExplorer handles quantified spot data as shown in this
figure. Arrays are hybridized against labeled samples are scanned and spots are quantified into spot data files. Quantified spot data is represented as tab-
delimited data with data for one spot/row. Each spot isidentified in this file by its grid coordinates (grid, grid row, grid column) with image (X,Y)
coordinates being optional. Quantified spot data includes the raw spot intensity for each channel (in the case of multiple channels such as Cy3, Cy5,

etc.). If the original data has background spot intensity values, then that may be included as well - otherwise no background datawill be available for
background correction. The spot data is discussed in more detail in Section 1.1 and Appendix C.1, and Appendix C.3.
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Saved Reports and Saved state and
Plots on user's startup files (.mae)
local disk on user's local disk

MAExplorer program
installed on users computer

-™»

MAExplorer running
as Java Application
on user's local
computer

Array data from local
computer or W eb
serverincludes:

* quantified spot data
*sample DB

*GIPO DB

* configuration DB
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invoked on specific
gene or genes
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v

Genomic Internet databases, e.g.G enBank,
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oraccess to a specialized Genomic server

Figure 1.1.3 Overview of running MAEXxplorer as a stand-alone application. The preferred way of running MAEXxplorer is as a stand-alone
application. There are distinct advantages in running MAExplorer as an application in that data and the exploration state may be saved on the users local
computer, direct access to genomic serversis easier (no proxy server required - see Figure 1.4). MAExplorer plugin extensions (MAEPIugins) may only
be used with the stand-alone version. Since MAExplorer is packaged for download for avariety of operating systems, using this method is not difficult

to set up and the MAEPIugins should run on a variety of operating systems.
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Figure 1.1.4 [DEPRICATED] Overview of running MAEXxplorer asa Web browser applet. An alternative way of running MAExplorer on existing
databasesis as a Web-browser applet. There advantage of this method is that no software installation is required on the user's computer. However, the
user may not save data and the exploration state on their local computer. Furthermore, direct access to genomic servers requires a proxy server.
MAEXxplorer plugin extensions (MAEPIugins) may not be used with the the appl et version. The Mammary Genome Anatomy Program (MGAP)
originally used the MAExplorer applet.

Example of a MAExplorer database - http://www.lech.ncifcrf.gov/mae - the public MGAP DB

The Mammary Genome Anatomy Program (MGAP) microarrays of cDNA clones from mouse mammary tissue (collaboration with
Research Genetics) were hybridized with 33P radio-labeled samples. These were then used to charge fluorescing plates. See the
MGAP site for more documentation on the database and preparation procedures. The hybridized arrays are scanned on a phospho-
imager scanner at high resolution. Spot data was quantified from these images using the Research Genetics "Pathways 2.01"
program which generated tab-delimited data files. This data also includes the microarray grid point locations (field, grid, grid row,
grid col) from the associated microarray description data files (grid-in-plate-order data). When you download MAExplorer, you
will aso download the public MGAP dataset.

1.1 Microarrays and notation used with MAExplorer

In general, microarrays are hybridized using cDNA samples derived from mRNA labeled with either radio-label, biotin,
fluorescent dyes, or other methods (see Schulze, 2001) for review of the technology). MAExplorer may be used to construct
databases using single-labeled sample intensity (e.g., Affymetrix, 33P radio-labeled, etc.) and double-labeled ratio fluorescent (i.e.
Cy3/Cyb5) data arrays with different GIPO geometries.

Definition of "Condition list of samples"

Samples are organized into Condition Lists of samples (generally replicate samples). These may be used in various statistical and
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clustering tests. There are three built-in lists of samples called the HP-X 'set’, the HP-Y 'set’ and the HP-E list. The X and Y setsare
used in various 2 condition tests such asthe t-Test between the X and Y sets (Section 2.4.3). The HP-E list is an ordered expression

list of samples used in clustering and in displaying expression profiles. Y ou may interactively define new or edit named condition
lists using a graphical wizard (Section 2.6), manipulate and assign them to the HP-X 'set’, HP-Y 'set' and HP-E list. Some examples
of condition lists might be (assuming you have the data available in your database):

Virgin =( V.1, V.2, V.3)

Pr egnacy = ( P13.1, P13.2, P13.3)
Lactation = ( L3.1, L3.2, L3.3)
Involution = ( 14.1, 14.2, 14.3)

Definition of "Ordered Condition list" of multiple condition lists

We further extend this paradigm by defining a meta-data structure called the " Ordered Condition List" or OCL. Thisisan list of
multiple conditions that you have previously defined. The OCL may be sorted if you want and the data lends itself to sorting. E.g.,
atime series of conditions lends itself to sorting - different types of diagnoses may not. The OCL may be used in various statistical
tests (e.g., the F-test applied to the current OCL - see Section 2.4.3)). Y ou may interactively define new or edit named Ordered

Condition Lists using a graphical wizard (Section 2.7).An example of an ordered condition list might be:

Partuition= ( Virgin, Pregnacy, Lactation, Involution )
Definition of "intensity" for single-labeled samples

MAExplorer uses the term "intensity" in slightly different ways dependent on whether you are using the single-1abeled or
fluorescent double-labeled data. For single-labeled data, "intensity” is the raw quantified data value as measured by the image
scanner. Raw data must be normalized between samplesin order to compare it between samples. Therefore, to compare N samples,
you must first normalize the data and then compare them.

Definition of "intensity" for fluorescent double-labeled samples

For fluorescent double-labeled data, the Cy3 and Cy5 dye-labeled (for example) measurements are the raw quantified data values
as measured by the image scanner. In this case, "intensity" is defined as the ratio of Cy3to Cy5 (i.e. Cy3/Cy5). If you wish to look
at the ratio as Cy5/Cy3, you may flip the two channels on a per-sample basis (see Section 2.2.2 for more details).

Issues of experimental design of microarray experiments

Some of the issuesinvolved in experimental design (setting up experiments) based on the types of arrays are discussed in Section

3.1.1 for (Cy3/Cy5)-labeled as well as 33P-labeled samples. Poorly designed experiments will not yield significant statistical
results, so attention should be paid to devel oping an adequate and robust design for your data given costs of doing experiments as
well as statistical constraints on analyzing the data.

Actual and "Pseudoarray" image geometry

The main MAExplorer windows contains a pseudoarray image for visualization purposes. It may or may not correspond the spot
positions on the actual array. This array geometry is defined by the number of replicate Fields (normally 1) each of which contains
anumber of grids (also called "blocks") containing a number of rows/grid and columns/grid of spots. If thereis no explicit array
geometry or spot (X,Y) coordinate data avail able but simply gene identifiers and intensity data, then an arbitrary pseudoarray
geometry is generated. If there is an explicit array geometry, then it waill draw the pseudoarray using this geometry. The database
configuration determines which method will be used and is discussed in Appendix C.5. If there is no explicit grid geometry, the
number of spot Locations (e.g., Incytel D, Affymetrix probe_set) may be used to synthesize a set of grids of asize that is reasonable
for viewing with MAExplorer. Thisis done in the Cvt2Mae array data conversion program when the array geometry (#grids,
#rows/grid, #columns/grid) is not known. This conversion is not donein MAEXxplorer itself. In Cvt2Mae we generate a visually
appealing pseudoarray image geometry if no array geometry is specified with the data (e.g. Affymetrix data, etc). It maps the
number of N spot data entries to a (#grids,#grid-rows,#grid-columns). The algorithmis given in Appendix C.6 aswell asa
suggestion for handling non-standard geometries using Cvt2Mae.
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Gene coordinate numbering on the microarray

A gene coordinate numbering is a mapping of gene identifiers to locations on the array for a particular array geometry. These are
described by grids (or blocks), each consisting of grid rows by grid columns of spots. The grids may be repeated on the array and
constitute duplicate fields. Some arrays group subsets of grids into meta-grids which are specified by meta-grid rows by meta-grid
columns of grids. MAEXxplorer can handle grids but not meta-grids. In the case where thereis no array grid geometry specified or
meta-grids are used, an arbitrary pseudoarray geometry can be constructed to serve as a basis to display the microarray
pseudoimage (see the Algorithm for constructing the pseudo array from alist of spotsin Appendix C.6).

In MAExplorer we refer to grids by letter names (A,B,C,...) and fields by F1 and F2. If you are using Cy3/Cy5 ratio data and the
Cy3 and Cy5 datais available as independent channels for each HP sample, then operations that use F1 and F2 will use the Cy3
and Cy5 data for various operations such as scatter plots (Cy3 vs Cy5), etc. If thereis only onefield in an array (i.e. no duplicate
grids), then when MAEXxplorer is run, operations and menus describing F1 and F2 operations will not be available.

Using duplicate (F1 and F2) spots allows us to get an estimate of the hybridization variance within an array and is used to compute
the (F1,F2) gene coefficient of variation (CV) used in the gene data Filter to remove noisy data before looking for additional
differences. Note that if Cy3/Cy5 datais used, then F1 and F2 duplicates are not alowed as MAExplorer uses the (F1,F2) datato
hold the(Cy3,Cy5) datafor a hybridized sample.

Example: special array spot coordinate numbering for the MGAP array

As an example of this coordinate system, the following describes the array geometry for the array used in the NIDDK MGAP database. The general
principa with different sizes and numbers of fields is the same for other arrays. The MGAP array was spotted by Research Genetics for MGAP.
Clonesin the array are laid down in grids consists of 8 rows and 24 columns per grid. There are 8 grids (named A through H or 1 to 8) to afield with a
space between grids. Finaly, there are two fields (left and right named 1 and 2 or F1 and F2) that are duplicates.

Note: we currently present the MGAP arrays with grids A through H oriented from top to bottom - whereas Research Genetics orients them rotated
+90 degrees with grid H to the left and grid A to the right. This occurred when the images were scanned with a-90 degree change in the orientation.
Therefore, we have swapped rows and columnsin our relative orientations so it meets with users normal expectations of row-column orientation. This
could be easily changed to the Research Genetics convention using a parameter in the configuration file. Since the actual plate coordinates are tracked
with each clone and reported when it is accessed in MAEXxplorer, the image coordinate system is not that critical - although the verisimilitude of actual
array layout and the data-mining layout can be useful.

Setting the "current gene" to a specific gene by "Master gene ID"

The MAEXxplorer uses the concept of the "current gene" to indicate a particular gene to be analyzed. Y ou may interrogate the
microarray database or Internet databases for data on the current gene or to use it in one of the operations. For example, you might
cluster genes by expression profiles to find other genes with profiles similar to the current gene.

Various gene identifiers may be present in the GI PO data file associated with the array. One of these is selected to as a unique
identifier to represent genesin the MAEXxplorer database. Normally, the Master gene ID is defined as the Clone ID. However if
the Clone ID is not present, but the GenBank ID is, it will use the latter as the identifier. If neither GenBank nor Clone ID is
present, it will use GenBank5' then GenBank3' if present. If that is not present, it will use the UniGene ID if is present. If that is not
present, it will use dbEST5S' then dbEST3' if present. If that is not present, it will use LocusLink LocusID if present. Finally, if none
of those identifiers are present, you can specify a'Generic ID' that is related to some other database gene identifier such asa
'Location' identifier.

The current gene may be specified by clicking on a spot in the microarray image or on a point in the popup scatter plot, or agene
ID cell in areport.

Setting the "current gene" by Gene Name Guesser

In addition, the user may type a specific gene name or clone ID into a popup Gene Name Guesser dialog text window. Thisis
invoked by clicking on the blue button "Enter gene name or clone ID" at the top right in the control panel. When the "guesser"
window pops up, start typing the gene name or clone ID in the blue text entry field. Y ou select either the Gene Names, Clone ID,
UniGene ID, GenBank, GenBank 3' or GenBank 5',dbEST 3', dbEST 5', or LocusID identifier. Then you may start typing letters
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and it will match all names or identifiers which are prefixed with the sub-string you have typed so far. Asyou type more
characters, it will limit the list of possible completions of what you are typing. After selecting the gene you want, you then press
the "Done" button to use this entry to set the current gene and remove the guesser popup window. Y ou may press the "Clear"
button to clear what you have typed and the "Cancel" button to cancel the current gene selection process.

Setting the "Edited Gene List" subset of genes using wildcard names

Y ou may also define a set of genes from the guesser window using wildcard names where the character **' matches zero or more
characters. First you specify a sub-string common to gene names. Then pressthe "Set E.G.L." (set 'Edited Gene List') button. For
example (see Figure 2.3.1), you could find all oncogenes and proto-oncogenes by typing "* ONCO*" in the guesser. It

automatically enables the View 'Edited Gene List' in the array that shows genesin the E.G.L. enclosed in magenta boxes.

The current gene cluster

Some operations involving clustering will automatically assign the gene cluster to the E.G.L. This includes clustering of genes
similar to a selected (i.e. current) gene and K-means clustering. In the case of K-means clustering, the cluster you select by picking
agene belonging to that cluster will cause it to be defined as the current cluster and also assigned to the E.G.L. Thiswill be
discussed in more detail in the section on clustering.

The current Condition List of samples

The current condition list of samplesisthe last condition edited with the interactive graphical wizard (Section 2.6) used to define
new or edit condition lists.

The current Ordered Condition List (OCL) of multiple conditions

The current ordered condition list (is apossibly ordered list of Multiple Condition Lists) isthe last condition edited with the
interactive graphical wizard (Section 2.7) used to define new or edit ordered condition lists.

Saving full resolution plots as GIF files in stand-alone mode

The various plots may be saved as full resolution GIF files when running MAEXxplorer in stand-alone mode. The various plots have
"SaveAs" buttons which appear in stand-alone mode. Saving your intermediate results may be useful for documenting your data
mining session or for subsequent publication. (Here is an example of afull resolution clustergram of 38 MGAP hybridized samples
for 1076 named and EST genes).

Saving Text windows as .txt files in stand-alone mode

The various text windows may be saved as .txt files when running MAEXxpplorer in stand-alone mode. The various text windows
have "SaveAs" buttons which appear in stand-alone mode. Saving your intermediate results may be useful for documenting your
datamining session or for subsequent publication.

1.2 Microarray image quantification

Quantification datafor all genesin ahybridized sample (x and y coordinates, intensity, background density) is obtained by reading
data from a quantification file for that hybridized sample. The quantification file for each hybridized sample resides on the local
file system (for stand-alone) or MAExplorer Web server (for applet use) and is derived from image quantification programs such
as Axon's GenePix(TM) program, Scanalyze, Molecular Dynamics' ImageQuant(T™) program, Research Genetics Pathways(TM)
program, etc. These programs are independent of MAEXxplorer and are not part of our downloadable software distribution.
Normalization between hybridized samples must be performed to allow comparison between different hybridized array samples.

File formats are discussed in Appendix C).

1.2.1 Ratio and Zscore comparison of data from different hybridized samples

Because of variation between hybridized samples, datais normalized. Methods that are pure scaling transformations (such as
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Median, Scaleto 65K, By Calibration DNA, By Use Gene Set, etc.) allow you to compare data using the ratio between two
normalized sets of data. We define the ratio for two samples as follows:

ratio(x,y,c) = lyc / Iy

wher e:
sanples X,y have values |, and I . for the sane
gene c in sanples HP-X and HP-Y

The Zscore method transforms the data such that it can not be used with the ratio comparison. Instead we use the Zdiff(x,y) method
for comparing Zscore developed by Mark Vawter (Vawter, 2000). Zscores typically cover the range of -3.0 to +3.0 (standard

deviations) with atransformed mean of 0.0. Therefore the Zdiff will typically cover the range of -6.0 to +6.0.

Let
Zscore(p,c) = (lpc - neany)/stdDev,
wher e:
lpc is the intensity of gene c¢c for sanple p. Sanple p has nean,
and stdDev,,
Then,
Zdi ff(x,y,c) = Zscore(x,c) - Zscore(y,c),
wher e:

sanpl es x,y have Zscore(x,c) and Zscore(y,c) normalized values for the
sanme gene ¢ in sanples HP-X and HP-Y, or HP-X 'sets' and HP-Y 'sets'.

Table 1.2.1 Displays affected by the normalization mode. When comparing two hybridized samples or sets of hybridized
samples, the metric used is either ratio or Zdiff depending on whether the Zscore normalization was selected in the Normalization
menu. Thiswill affect avariety of data displays and some of the data Filter methods listed here. In addition, all of the other
graphics (EP plots, intensity histogram plot, cluster plots including clustergrams and dendrograms) are also affected by the
normalizations.

Pseudocolor X/Y ratio, X-Y Z-diff, and other pseudoarray images

the 3-line gene data displayed in the main MAExplorer window

the gene data display at the top of the scatter plot when clicking on a point in the scatter plot

report tables of genes with the highest/lowest X/Y (Cy3/Cy5) (FL/F2) ratio or X-Y (F1-F2) Zdiff

Ratio histogram plot of X/Y (Cy3/Cy5) (FL/F2) ratios or X-Y (Cy3-Cy5) (F1-F2) Zdiff data

data Filter: Spot Intensity [SI1:SI2] range or Zdiff [Z21:Z2] range for HP data

data Filter: Intensity [11:12] range or Zdiff [21:22] range for (HP-X/HP-Y) or (HP-X - HP-Y) data

data Filter: Ratio [R1:R2] range or Zdiff [Z21:Z2] range for (HP-X/HP-Y) or (HP-X - HP-Y) data

data Filter: Ratio [CR1:CR2] range or Zdiff [CZ1:CZ2] range for (Cy3/Cy5) or (Cy3-Cy5) data of asingle sample
Range and scale of datain EP plots, cluster plots, clustergrams, dendrograms, etc.

Statistical testst-tests (X and Y sets), Kolmogorov-Smirnov test (X and Y sets), ANOVA F-test (OCL), etc.

RPOOoOoNo~WNE

e

1.3 Microarray image and plot display

The MAExplorer displays one microarray pseudoar ray image of the hybridized samples. Thisis either for asingle sample, the
ratio of two samples, the average of replicate samples or the ratio of two sets of replicate samples, the ratio Cy3/Cy5 or Cy5/Cy3,
or other mappings. Section 2.4.4.1 Show microarray pseudoarray images menu describes these options and shows some examples.

The Filter menu is used to select a set of datafilters that determines which genes are selected. These are highlighted in the array
image in different ways - with ared (white) circlein theintensity (ratio) pseudoarray image each spot meeting the range threshold
criteria. How these are highlighted depends on which Plot menu Show Micr oarray method and View menu modes were sel ected.
If the Show 'Edited GeneList' (EGL) option is set in the View menu, genesin the EGL will appear as magenta squares. The
"Filter mode" is always present and shows genes meeting various Filter criteria (to be discussed). The user may interactively define
alist of genes by clicking on them when the Click to add gene to edited genelist option is set in the Edit menu. Alternatively,
you can click on a gene with the Control key pressed to add a gene to the EGL or with the Shift key pressed to delete a gene from
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the EGL.
Types of pseudoarray image displays

There are several differnt types of pseudoarray images that may be displayed. The current typeis set in the Show Microarray
submenu in the Plot menu selections including Pseudogr ayscale intensity that approximates the intensity of a single sample or
average of samples. The Pseudocolor Red(X)-Y ellow-Green(Y) HP-X/HP-Y ratio or Zdiff and Pseudocolor Red(Cy5)-Y ellow-
Green(Cy3) Cy3/Cy5 (or F1/F2) ratio or Zdiff add the two samples or channels together as separate Red+Green channelsto give
acolor spectrum. The Pseudocolor HP-X/HP-Y ratio or Zdiff Pseudocolor Cy3/Cy5 (or F1/F2) ratio or Zdiff givesacolor
spectrum from alow ratio (zdiff) value (Green) to a high value (Red) with avalue of 1.0 (0.0) of Black. The Pseudocolor (HP-
X,HP-Y) 'sets' p-value shows the p-Value between two X and Y setsin acolor spectrum.. If the Original image is set and the
imagefileisin the database, it will pop up a separate Web browser window to display it. The Pseudograyscale display isa
grayscale image, with higher concentration genes appearing darker, on alight blue background. The pseudocolor HP-X/HP-Y ratio
of spotsimage is constructed using a color scale going from bright green (<1) to black (=0) to bright red (>1) on a black
background. For the pseudocolor Zdiff of (X-Y), the color scale goes from bright green (<0) to black (=0) to bright red (>0). If the
dichromasy switch is set in the View menu, that a different set of colorsis selected that may be easier for some people to
differentiate. If the Use dual HP-X & HP-Y 'sets else single samplestoggle in the Samples menu is set, it displays the mean HP-
X datain the left and HP-Y in the right for doing a side by side comparison.

In all of the pseudoarray images, the grids in the image are labeled field#-GridLetter (e.g. 1-C, 2-B, etc). This alows them to be
clearly identified as the user scrolls over the image that is larger than the visible computer window.

Popup windows

MAExplorer starts with the main pseudoarray image windows. This window contains the pull-down menus where you may issue
commands. As you perform various operations, new windows may popup for some of these commands. For most of these
windows, you may click on the "Close" button or click on the close window icon associated with your operating system (generally
one of the buttons at the top of the popup window). However, some windows were designed to not close when you do this. In
particular the " State sliders" are not able to be closed unless the associated data filtering or clustering operation is closed. When
you close the associated operation will automatically close the state slider window.

Thereis also apopup alert message window for bettering informing users of conditions that prevent them from doing the operation
they requrested. Y ou must press the Close button to pop-down the message, although you may do press the SaveAs butto to save
the message to afile. For complex problems, some of the messages may suggest what you need to do to correct the problem.

The current sample sample, HP-X, and HP-Y

In MAExplorer, ahybridized array sampleis abbreviated HP. The underlying data comparison model assumes, as a minimum, the
comparison of two different experimental conditions represented by samples HP-X and HP-Y. A good way to think about thisis
that these variables are the two axes of a scatter plot (one of the displays you may generate). The HP-X and HP-Y may be thought
of as containing data from either single hybridized samples or containing mean data from multiple replicate sets of sample. The HP-
X and HP-Y are assigned using the Set current HP-X and Set current HP-Y in the Samples menu (hybridized sample is
abbreviated HP in MAEXxplorer. The sets are most easily changed using Choose HP-X, HP-Y and HP-E to select the currently
active samples. The contents of the of multiple sample HP-X and HP-Y 'sets' may alternatively be changed using the Edit HP-X &
HP-Y 'sets' of samples by sour ce submenu, and the HP-E list of samples using the Edit HP-E list of samples by source.
Assigning single samples to either HP-X or HP-Y may be done from the Samples menu. However, it is easier to do it by clicking
on the pseudoarray image. First click on the magenta"[X]" or "[Y]" Current Sample box at the top of the list of switch between HP-
Y and HP-Y. Whichever isvisible ([X] or [Y]) isthe one that will be the HP sample assigned. Then simply click on the magenta
"** to the left of the sample name for the sample you wish to assign.

Hybridized samples are selected from alist of al of the sample samplesin the database. To make it easier to select aHP, they may
be selected from submenus by their developmental stage (if supported by your particular database) or from alist of all samplesin
the database located on the left side of the pseudoarray image. If a sample has never been loaded during a session, it will be loaded
when you request it.

The last sample selected is called the current sample or current HP. That is the sample that is displayed in the pseudoarray image
in the primary MAExplorer window when using display modes requiring a single sample.
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Using 'sets' of HP-X and sets of HP-Y

Multiple samples may be assigned to the to the HP-X or HP-Y sets. These are assigned using the Edit HP-X and HP-Y 'sets' of
microarrysin the Samples menu. The multiple sets are enabled by setting the Use HP-X and HP-Y 'sets else single samples
checkbox in the Samples menu. Then, when statistical calculations are performed on that data, it will use the means, std-
deviations, etc. from each of these sets rather than individual samples.

The HP-E sample list for computing expression profiles

Y ou may cluster sets of genes with similar expression profiles across a set of hybridized samples. The set of HP samples used in
doing these profilesis specified by Edit expression profile'list (HP-E) in the Samples menu. The Choose HP-X, HP-Y, and HP-
E command may also be used for defining the members and order of the samplesin the HP-E 'list'. Then, geneintensity expression
profiles may be created in a popup window for hybridized samples in the HP-E set by using the Expression profile plot commands
in the Plot menu. Severa of these plots may be created on the screen at the same time. Clicking on avertical datalinein the plot
will show the name of the HP, itsintensity and coefficient of variation (CV) of the (F1,F2) data for this gene. Note that you can
order the hybridized samples in the HP-E set by the order in which they are added.

Data 'Filters' - the intersection of one or more data tests

A set of genes may be computed by taking the intersection selected gene sets. These sets are determined by various logical, data
range and statistical tests. Genes passing each test are assigned to a gene subset which in turn are used in the gene intersection
computation. The final gene subset is used in array, plots, and reports, and subsequent data filtering. Changing any test parameters
causes the data filter to be re-computed.

[
Gene Set Data Filter is Intersection of Tests

Spot Intensity and

" Gene Subset Tests ! Ratio Tests
= Gene class * Ratio or Zdiff range _
[ + Edited Gene List [ eIntensity range i
= Good genes el = Ratio histogram bin |
= Spot quality p-value » Intensity histogram bin  /
« User named gene set— ~— = Highest/lowest ratios

*ﬁb&l?\{-‘r‘l difference -
: 2 _

~ Statistical Tests
= Coeff. of Variation \
» f-test of X vs Y sets
» KS-test X vs Y sets !
= ANONVA lists of conditions
» Clustering distances
= Cluster membership

Figure 1.3 Data Filter Venn diagram. Thisillustrates some of the logical, data range and statistical tests criteria available using the MAExplorer data
Filter paradigm. Note that multiple criteria may be selected from each of these categories. The extreme case, probably never used, could use all tests.

1.4 Exploratory data analysis - overview

MAExplorer may be used to perform various data explorations by looking for patterns correlated with different sets of hybridized
samples or with expression profiles of genes. Thisis discussed in more detail throughout this manual and later in Section 3 on

Exploratory Data Analysis. Detailed descriptions of all commands are given in Section 2 Menus.
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A first-approximation approach to data-mining might be to sequentially constrain the data of interest to find some changes and then
to report on those changes. We have arranged these commonly performed first-pass operations as submenu entriesin the Analysis
Menu. The submenus are;

1. GeneClass Menu
2. Normalization Menu
3. Filter Menu
4. Plot Menu
5. Cluster Menu
6. Report Menu
[28 Microdnay Explores - Vil 84,02 -Beta - CSTRE dap 13 pueg, va doy 1 lact, 38 probes
Fil= Samples Edit JELLVESE view Flugns  Help
GenaClss b
Eniber gend nams ai Solt= R PTG HF.: Pepgmaneoy 13 (8 hi) [C57 Bl g3 feladR HaTwgd
= Hormakralion}
[Filler L HPY: Lackation 1 (30 min) [C57 B-L1 . 30wmia]
y = - — Pt L P
[Geting Geneciass EeTs
Repert b
Thiera are 1076 panes pasneg e Flitar

HP-¥: Pregnancy 13 {1 hr) [CS5TBE-p13-totalRNASUg]
HP-Y: Lactation 1 (30 min) [CETBS-L1-30min]
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Figure 1.4 Screen view of MAExplorer main window with Analysis Menu. The menu structure of MAExplorer was designed to allow usersto
quickly perform commonly used data-mining operations. Other menus are used for modifying the data (File, Samples, Edit, and View menus) or
accessing on-line Help menu information in a separate Web browser popup window. MAExplorer menus are similar to most Windows PC applications
where pull-down menu selections are used to invoke operations. The current hybridized array sample is displayed as a pseudocolor ratio image of
median normalized spot intensities. Clicking on a spot assignsit as the current gene with data being reported in the top most message area. The names of
the current HP-X and HP-Y samples are listed above that area. In general, clicking on spots, points in plots or cells in spreadsheet reports will assign the
it as the current gene and access Web genomic databases if enabled.

In addition to displaying the hybridized sample pseudoarray images, derived data may be viewed in various types of plots. These
include scatter plots, histograms, ratio-histograms, expression profiles, gene clustering, etc. Data may be presented as table reports
presented as either active spreadsheets that can access genomic databases by clicking on cells or as tab-delimited Excel-compatible
tables that may be cut (if your windowing system supports this) and pasted into an Excel spreadsheet.

The selected HP-X and HP-Y samples are used when generating scatter plots, ratio histograms and other graphics. Scatter plots and
ratio histograms may also be performed on the left and right sides of the currently displayed HP array (fields F1 and F2
respectively if array data has duplicate spots for the same genes).

A MAExplorer database contains a table identifying genes, so data is accessible by gene name as well or by sub-strings identifying
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aset of genes (e.g. "onco" that could be used to find any oncogene or proto-onco gene in the database).

When the program starts, it displays the microarray image of the first hybridized samplein the HP-X set of samplesinitially
specified. If you specify anew HP-X or HP-Y sample, then it changes the pseudoarray image to correspond to that array. Y ou may
change the current HP-X or HP-Y sample from either the Samples pull-down menu or by clicking on a sample in the Active
Samplelist in the left of the pseudoarray image. If you click the mouse on or near a spot, it will latch onto that spot and define it as
the current gene.

Note: In Figure 1.4, genes that pass the MAEXxplorer data Filters are indicated by red (white) circles around spotsin the
pseudograyscale (pseudocolor) intensity (ratio) image. The pseudoarray image shows the gene data as replicate grids of spots if
there aretwo fields Field 1 (left set of grided spots) and Field 2 (right set of grided spots). If there is no duplicate spot data, then
only Field 1 is shown.

If background correction is enabled in the Normalization menu, then intensity is reported in the message displays as intensity'
otherwise as intensity. Normalization should aso be used between hybridized samples - whether the datais ratio data (i.e.

Cy3/Cy5) or single sample intensity arrays.
1.4.1 Saving the state of a data-mining session in stand-alone mode

If you are running MAEXxplorer in stand-alone mode, you may save the state of your session for later use using the "Save DB" or
"SaveAs DB" commands. Then, the checkpointed database could be accessed using the "Open file DB command". It currently
saves: the gene sets, condition (HP) lists, current HP-X, HP-Y and HP-E lists, data Filter options and slider value settings, display
options, clustering options, normalization options, etc. We recommend using the "SaveAs ... DB" so you can save the state under a
different name rather than overriding the original state. Thisway you could backup to the original state if you wanted to. The
"SaveAs DB" and "Open file DB" commands are described in the File menu.

1.4.2 Logging messages and command history

Often auser would like to review measurements of particular genes and to review the list of commands they issued (also called the
command history). Various data measurements as well as many other types of information in the three text lines in the status area
of the main window may optionally be recorded in a popup message log (Section 2.5.1) and the command history may also be
reviewed in a separate popup message log (Section 2.5.2). If you are running the stand-alone version, the logs may be saved.
Otherwise, you could cut and paste the log data into other word processing applications.

1.5 Quick start - demonstration of MAExplorer

MAExplorer is used as a stand-alone application. Y ou may download the stand-alone application (see Appendix D). This
download aso include a demo data set of 50 hybridized samples from the public MGAP database. In any case, you can explicitly
download the data at any time at http://www.lecb.ncifcrf.gov/mae/M GAP-Array-database.zip or

HREF="http://prdownl oads.sourceforge.net/maexpl orer/M GA P-Array-database.tar.gz?downl oad" >
http://prdownl oads.sourceforge.net/maexplorer/M GAP-Array-database.tar.gz?downl oad

Setting up MAEXxplorer to work with user-specific data is discussed later in this manual in Appendix C.
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Figure 1.5.1 The MicroArray Explorer home page at http://maexplorer.sourceforge.net/. The table of contentsin the left panel lists an introduction

and short tutorial, several demonstration databases. Below that are links to documentation including this reference manual, glossary and index. The
Export version discusses running MAExplorer with other arrays and as a stand-alone version. The Download application is a Web page for downloading

and installing the stand-alone Java application on your computer.

Y ou may start MAExplorer in your Web browser from the MGAP Startup DB. This offers several preset public databases
consisting of sets of hybridized samples as well as the empty database. After you have clicked on a particular startup database, it
will begin loading MAExplorer - indicated by ared box with a"Loading..." message in the top window of your browser. After
MAEXxplorer starts, this message changes to awhite box with "Reading DB" while it downloads the data files required. Finally,
when it isready for your interaction, it displays awhite box with agreen "Ready".

NOTE: for Web browser invocation, the MAExplorer applet works with Netscape 4.7, Internet Explorer 5.0, and HotJavaon a
Windows (95/98/NT/2000/X P) system or a Solaris Unix system. Macintosh and SGI systems seem to hang at times because of
Web browser problems. However, it works on al other systems as a stand-alone Java application that you may download and

install on your computer. Y ou might want to review these Web browser restrictions.

After the MAEXplorer is started and the menus become active, you may switch the preset hybridized samples to other samples
using the Samples pull-down menu. The last hybridized sample |oaded becomes the "current hybridized sample" and itsimage is
the one displayed.

Exiting MAExplorer

If you arein MAExplorer and want close the program and exit, you may use the Quit command in the File menu or click on the
"close application” button (found in the upper right hand corners of MAEXxplorer windows put there by your operating system).

1.6 Tutorials for using MAExplorer
There are a number of things you may do in this data mining facility.
1. Analyze expression of individual genes

file:/lIC|tmp/MaeRefMan/hmaeFullRefMan.html (20 of 234) [11/24/2003 10:49:35 AM]


file:///C|/tmp/MaeRefMan/GifsDocH/fig-HMAEhomePageLarge.gif
http://maexplorer.sourceforge.net/
file:///C|/tmp/MaeRefMan/Install/index.html
http://www.lecb.ncifcrf.gov/mae/maeListOfStartupDB.html
file:///C|/tmp/MaeRefMan/hmaeDocD.html#standAloneMAE
file:///C|/tmp/MaeRefMan/hmaeDocD.html#standAloneMAE
file:///C|/tmp/MaeRefMan/hmaeDoc4.html#browserBug

MAExplorer - cDNA Microarray Exploratory Data Analysis

2. Analyze expression of gene families and clusters
3. Compare expression patterns in multiple hybridizations

We wrote two tutorials to help you understand its capabilities. We recommend you first try the short tutorial before attempting the
advanced tutorial. The latter demonstrates some of the more advanced capabilities.

_— SN SIS e—— e —

2. MAEXxplorer menus

A MAExplorer analysisis performed using various interactive controls. These commands are selected from pull-down menus
located on the "menu bar" at the top of the main MAExplorer window. The primary menus are:

. 2.1 File- database, file access operations
. 2.2 Samples - select lists of hybridized sample conditions
. 2.3 Edit - edit gene and condition subsets, E.G.L. and preferences
. 24 Analysis- primary analysis menus
2.4.1 GeneClass - select gene subset for gene class data Filter
2.4.2 Normalization - select gene intensity normalization mode
2.4.3 Filter - select datafilters to compute gene subset of interest
2.4.4 Plot - pseudoarray image, scatter, histograms, expression profile popup plots
2.4.5 Cluster - perform cluster analysis on data filtered genes
2.4.6 Report - generate popup spreadsheet reports of genes and samples
. 2.5 View - setup genomic gene data views preferences
. 2.6 Plugins - add and execute new MAEPIugin methods
. 2.7 Help - popup documentation on MAEXxplorer and specific database

Menu notation

In the following menus, selections that are sub-menus are indicated by a'¥'. Selections prefaced with a ™" and indicate T " indicate
that the command is a checkbox that is enabled and disabled respectively. Checkbox menu items have a"[CB]" at the end of the
command. Selections prefaced with a'™*' and indicate ™" indicate that the command is a multiple choice "radio button" that is
enabled and disabled respectively, and that only one member of the group is allowed to be on at atime. Radio button menu items
have a"[RB]" at the end of the command. The default values set for an initial database are shown in the menus. Selections

prefaced with a'# indicate that the commands are available only when MAEXxplorer is run in the stand-alone mode. Selections
prefaced with a™*' commands requires access to the backend Web server [Future]. Selections that are not currently available will be
grayed out in the menus of the running program.

The following Sections 2.1 through 2.7 describe the pull-down menus in detail.

—— SN NS e S

2.1 File menu

The File menu operations includes options and submenus providing access to database data from disk and Web servers, state
saving, and groupware to share states between collaborators.

In stand-alone mode, the user may select the database subset to be loaded from either a Web server or alocal file system. When
used as an applet, thisis pre-determined by the Web page where MAEXxplorer is started. Opening adisk DB, '‘Open disk DB', also
restores any user defined gene sets and other parts of the exploratory state that were present when the 'Save ... disk DB was
invoked.

In the following menus, selections that are sub-menus are indicated by a'®'. Selections prefaced with a ™" and indicate T " indicate
that the command is a checkbox that is enabled and disabled respectively. Checkbox menu items have a"[CB]" at the end of the
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command. Selections prefaced with a'%* and indicate """ indicate that the command is a multiple choice "radio button” that is
enabled and disabled respectively, and that only one member of the group is allowed to be on at atime. Radio button menu items
have a"[RB]" at the end of the command. Selections prefaced with a'#' indicate that the commands are available only when
MAExplorer is run in the stand-alone mode. Selections prefaced with a*** commands requires access to the backend Web server
[Future]. Selections that are not currently available will be grayed out in the menus of the running program.

When used as an applet connected to a Web database server, databases may be divided into public and collaborator projects. Users
accessing protected collaborator projects will be required to log-in to the server and a popup login request will appear.

. Databased®] - open and save databases of hybridized samples
. Exploratory state B - save and restore the user's data-mini ng explorations

c GrougwareE - share some exploration states with collaborators [Future]

. Update MAExplorer from maexplorer.sourceforge.net - Thiswill (1) backup the current MAExplorer.jar file as
MAExplorer.jar.bkup; (2) copy the latest MAEXxplorer.jar file from the maexplorer.sourceforge.net Web site and replace
your MAEXxplorer.jar file in your installation directory. Then when you restart MAEXxplorer, it will use the new version of
the program. The much more time consuming alternative is to do an entire download and reinstallation from the Web site.

. Update Plugins from maexplorer.sour cefor ge.net - Thiswill determine the list of new MAExplorer Plugins available. It
will prompt you on whether you want to update each default plugin one by one. If you are running one of these plugins, you
must first Unload it and then Load it again (see Plugin menu).

. Update RLO methods from maexplor er.sour cefor ge.net - This updates RLO methods available from the server. RLO
methods consist of pairs of R scripts and RLO files. To use these methods, R must be installed on your computer (www.r-
project.org. When MAEXxplorer is restarted these downloaded RLO methods will be available in the (Plugins | RLO

methods) submenu.
. Quit - exit MAExplorer

2.1.1 Databases menu

The Databases submenu is currently available only in stand-alone mode and contains the following selections for opening and
saving databases.

[In the future], each user will be able to save the state of their exploration into a password protected directory of named states on a
Web server (e.g. doing a'Save ... Web DB' command. Later, they could restore that state from the Web server by doing an 'Open
Web DB' command). Users would be required to register with that server to set up a unique state-saving area. Once this facility
was setup, users may selectively allow other user's to view selected data implementing a groupware environment for improving
collaboration.

. #New project - assign new project . mae database file. This assigns a project to either alocal disk directory (or to a Web DB [Future]).

. #Set project directory - change the project directory and then do an "Open disk DB" command (or "Open Web DB"). Note: used with "New
project” [Future].

. #Open disk DB - open an existing disk . mae database file

. #Open Web DB - open MAExplorer database with Web server that supports MAExplorer. [Future]

. #Savedisk DB - save current database asa. mae startup disk file

. #Saveasdisk DB - save current database as anew . nmae startup disk file

. #SaveWeb DB - save current database as a. mae startup Web DB file [Future]

. #SaveasWeb DB - save current database as anew . mae startup Web DB file [Future]
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Figure 2.1.1 Example of the" Open file DB" command. The file browser is opened in the current project directory with the name of the currently
opened file. Y ou may select another .mae startup database file to load in the current project. Y ou may also "cruise” the file system and load an .maefile
from adifferent project directory. The "Set project” command makes this easier sinceit gives you alist of available projects that you may change
directly. The projects must have been setup on your computer previously. The "New project" command can be used for setting up new projects or

projects.
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Figure 2.1.2 Example of saving a user session in a new startup file using the " SaveAs DB" command. The file browser is opened in the current
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project directory with the name of the currently opened file. Y ou may enter another .mae file name to save your current session. Then when you restart
MAEXxplorer using this new file, it will restore the data mining state to where you left off (except that no popup windows are opened).

2.1.2 Exploratory state menu

The Exploratory 'state’ submenu contains the following selections for saving and later using the user's state of the exploration. If
MAExplorer isbeing run on alocal computer, no login is required.

- * Register - register your login name and request a password so you may login in the future [Future]

. * Login - log on to the MAExplorer web server. Thisis used for accessing protected projects and for saving accessing your "state" data
[currently only used for MGAP DB]

. * Open user'sstate - restore a user's previously saved exploratory state file [Future]

. * Saveuser'sstate - save the user's current exploratory state in afile on the server [Future]

. * Directory of user's states - list the user's named exploratory states [Future]

. * Delete user's state - delete a particular user state file [Future]

2.1.3 Groupware facility for sharing user states menu [Future]

The groupware facility allows users to share their state data with other users. However, If MAEXxplorer isbeing run on alocal
computer, then groupware may not be available since it depends on using specific Web servers with MAEXxpl orer-specific
groupware services available. [We first devel oped these concepts in the context of 2D protein gels. They include: WebGel (Lemkin

et al., 1999b) for Internet exploration of 2DE databases, Xconf (Lemkin et al., 1993) an early X-windows based image
conferencing similar to CU-See-Me or ALO Instant messenger for sharing images in a conference over the net, Flicker (Lemkin,
1997) an image comparison over the internet using a a Java applet, and GELLAB-II (Lipkin and Lemkin, 1981) a system for data
mining - see GELLAB-II Poster on the Web) that embody many of the concepts used in MAEXxplorer.] The Groupwar e submenu
contains the following selections:

. * Open another user's state - read another user's exploratory state file if they granted you access [Future]
. * Shareuser state - alow another user to access a particular exploratory state [Future]
. *'Unshare user state - disallow another user access a particular exploratory state [Future]

Saving the state and databases on the local file system

The current state of an exploratory data analysis session may be saved on the local file system. The state consists of: gene sets; HP-
X and HP-Y hybridized sample sets; HP-E hybridized sample lists; thresholds and switch setting preferences; etc. The user may
save their current state and restore a previous state at any time. Restoring the state will overide the current database.

Groupware sharing of intermediate exploratory results [FUTURE]

Each registered user will be able to save the current state of their exploration of the datain named User Sate files on the back-end
Web server using the Save user's state command. The user may keep multiple named states on the back-end secure server where
they be accessed to restore the state at a future time using the Open user's state command. The user can request alist of their
states with the Directory of user's states command. They may remove a particular state with Delete user's state.

A registered user may allow another registered user to access their state or states (using the Open another user's state command)
if the user owning the data had granted them permission. The Share user state and Unshare user state commands control these
permissions. There are two specia share-users defined: public to allow unlimited read-only access to the state they specify, and
private to disallow all accessto a user state.

2.2 Samples menu
Each experimental condition sample is represented by a hybridized sample (abbreviated HP in MAExplorer). The Samples menu
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operations include operations to select the current hybridized sample or samples. The simplest model of a MAExplorer analysis
assumes (at least) two microarray hybridized samples variables HP-X, HP-Y whose data may be plotted against one another or
compared. The default is asingle HP-X sample and asingle HP-Y sample.

The first menu command, "Choose HP-X, HP-Y and HP-E samples’, entries lets you change the current working HP-X 'set', HP-Y
‘set’, and HP-E 'list' hybridized samples.

The second menu command, " Choose named condition lists of samples', lets you define or edit new named lists of hybridized
samples. Thisisuseful for defining sets of replicate samples. These may be further manipulated using the (Edit menu | Sets of
Conditions (samples)) commands.

The third menu command, "Choose ordered lists of conditions’, lets you define or edit new named Ordered Condition Lists (OCL)
of named condition lists. Thisis useful for defining a sub-experiment consisting of N conditions each with replicate samples. The
last OCL manipulated is defined as the "current OCL". The current OCL isused in the OCL F-test Filter.

The fourth menu command, " Set Samples from lists', lets you change the current HP-X and HP-Y, HP-Y samples as well asthe
HP-X 'set', HP-Y 'set', and HP-E 'list' samples. Thisis similar to using the "Choose HP-X, HP-Y and HP-E samples' command, but
is more dificult to use. Y ou may change the current HP-X or HP-Y sample by clicking on the sample name directly in thelist of
sample names on the left side of the pseudoarray image (see Figure 2.2.3 legend).

The fifth menu entry, "Edit use (Cy5/Cy3) else (Cy3/Cy5) for each HP", lets you swap data channels for Cy3/Cy5 data for
individual samples.

Other menu commands list the status of the current HP-X 'set’, HP-Y 'set’, or HP-E 'list’, and define condition class names that are
associated with the HP-X 'set’ and HP-Y 'set’. The last menu entry, "Use HP-X & HP-Y 'sets else single samples’, lets you switch
between using HP-X and HP-Y as single samples of sets of multiple samples. For example, if you are using a scatter plot of X and
Y, it will switch the data being plotted from a comparison of single samplesto a comparison of means of sets of samples
depending on the status of the switch. Sets of samples are used extensively in data explorations.

. Choose HP-X, HP-Y and HP-E samples - change the currently active samples for the HP-X and HP-Y 'sets and HP-E
'list" of samples.

. Choose named condition lists of samples - define or edit new named lists of hybridized samples.

. Choose ordered condition lists of conditions - define or edit new named ordered condition lists (OCL)

. Set Samplesfrom lists® - define HP-X, HP-Y, HP-X 'set’, HP-Y 'set’, or HP-E 'list' from lists of samples.

. Edit use (Cy5/Cy3) else (Cy3/Cy5) for each HP for use with ratio data. This selectively swaps (Cy3,Cy5) data entries so
may use (carefully!) dye-swap data for replicates. Only available for ratio data.

. List HP-X & HP-Y sample'sets' - list the samplesin the HP-X and HP-Y 'sets.

. List HP-E sample'list' - list the samplesin the ordered HP-E 'list'.

. Define HP-X class name - for set of HP-X samples

. Define HP-Y class name - for set of HP-Y samples

. [T UseHP-X & HP-Y 'sets else single samples [CB] - toggle between using HP-X and HP-Y 'sets’ of multiple samples or
single HP-X and HP-Y samples.

Figure 2.2.1 shows setting the HP-X, HP-Y, HP-E lists of samples using the "Chooser" - the preferred method. Figure 2.2.2 shows
setting the HP-X sample from the menus. Figure 2.2.3 shows changing the current HP-X sample by clicking on a sample namein
the microarray image.
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Figure 2.2.1 Samples menu - selecting lists of samples by using the " chooser" . The hybridized samples assigned to the current HP-X, current HP-Y,,
set of HP-X, set of HP-Y and expression profile list HP-E may be changed from the Samples pull down menu using the Choose HP-X, HP-Y and HP-
E option lets you graphically change the currently active sample HP-X, HP-Y sets and E-list.

[ Mo e s - WLl (1 it - 0 TG i 17 s, we i 1 L, T pallesa

Crose HP-E 1T el Eaneies | ERHEB
— SR e — . rd

T EECE N TN e
W il HPE sl bl Bt HP-X AHPY mely’ of sanples by source b [ — “ Lachation | 7 b} KEER-rul-' Fr!
A L HPL epe e Bl by s el st AL LS IR S
r_ 1l Tiituie’ Al B Lhaar | (X0 P [Saaa - L]

e % 'nef £y Conrlen] e
""'N‘""""" 3 -tatal RHASLH] ] gy 13 (1% )| S5 - 1 - 18]
HF=¥: Lictatsen 1 (30 mas) [S5788:L1S0win] - Pregrancy 13 (18 e JCE8P rul-pl 31 Bir]
Eragrey 11 () b [RetEn - p 1]
Fregancy 15 (e S - e
Frearanay 13 C0 AR a5 - a1 et
Pragraray 10 €0 Pwu) FEORP-rad-ped -1 Diva]
wrgn (18hre) FKEEP-rulbvingn- 1 3hra|
Vg 11 be) Petaft e

W (1 6 Eiatin- 1]

::‘

Figure 2.2.2 Samples menu - selecting samples by sour ce characteristics. The hybridized samples assigned to the current HP-X, current HP-Y, set of
HP-X, set of HP-Y and expression profile list HP-E may be changed from the Samples pull down menu. The specific "By Source" menus shown here
are from the MGAP database. This figure shows the user changing the current X sample from the developmental stages submenu that is part of the "By
Source" submenu. Alternatively, samples containing a keyword or part of a keyword can be found using a"guesser" popup window that allows the use
of wild cards. Thisisinvoked using the "From list of all H.P.s" submenu. For example, you could specify "* pregnancy*" to find all samples of
containing that word.
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Figure 2.2.3 Changing the current sampleto either the HP-X or HP-Y sample by clicking on a sample name at the left edge in the microarray
pseudoarray image. The current sample isindicated in magenta. Click on the magenta"*" adjacent to the new name you want to select and it will
change the HP-X sample. To switch between setting HP-X and HP-Y, click on the [X] Current Sample box to change the sample to HP-Y. You can
click on [Y] Current Sample box to change it back to HP-X. Then clicking on a sample name will set it to the current HP-X or HP-Y that was selected.
This figure shows that the user had selected [Y] and C57B6-L 10-2%hrs for the new HP-Y sample.

2.2.1 Selecting hybridized samples with Chooser or pull-down menu sample lists

The Set Samples from lists submenu lets you define HP-X, HP-Y, HP-X 'set', HP-Y 'sat’, or HP-E 'list' from lists of samples. It
contains four submenus:

. Set current HP-X sample¥ - i.e. single HP-X sample from thelist of H.P.s
. Set current HP-Y sample® - i.e. single HP-Y sample from thelist of H.P.s
. Edit HP-X & HP-Y 'sets of samples by source¥ - edit setsof X and Y samples by source for advanced statistics

comparisons.
. Edit HP-E expr. profile'list' by source® - edit samples by source in the HP-E ordered list of samples for expression
profile statistics.

The Set current HP-X sample and Set current HP-Y sample commands offer another way to set the single current X and Y
sample (see Figure 2.2.3 above for the preferred way using the " Chooser").

The Edit HP-X & HP-Y 'sets' of samples by sour ce menu allows the user to define HP-X and HP-Y as sets having multiple
hybridized samples. Then, the mean values of the genes are used when comparing HP-X with HP-Y .

. Add sampleto -X ¥ - add the selected sample to HP-X set.
. Add sampleto-Y ¥ - add the selected sample to HP-Y set.
. Rmv sample from -X® - remove the selected sample from HP-X set.
. Rmv sample from -Y ¥ - remove the selected sample from HP-Y set.

The Edit HP-E expr. profile'list' by sour ce menu allows the user to define an ordered list of samplesfor use in expression
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profile statistics. Then, an expression vector of normalized quantification values (one for each sample in the HP-E list) is computed
for each gene. Note: to place the samplesin a particular order, start with an empty HP-E set and then add them in the order you
desire.

. Add sampleto HP-E¥ - add the selected H.P. to HP-E list.
. Rmv sample from HP-E® - remove the selected sample from HP-E list.

The Convention for pull-down menu sample selection lists
We use a common sample selection scheme when selecting a sample from a pull-down menu list. This sub-sample "By Source"
option is only available if your database was set up to allow sub-sample source names in the Samples database.

. By Source¥ - selects the sample from one of additional submenus. These database-specific menu entries might be
categories such as devel opmental stage, tumor models, time series, etc and are set up for a specific databasein its
configuration.

. From list of all samples - select asample from alist of all samplesin the database accessible to the user.

For example, the By Sour ce database-specific entries for the MGA P database includes the following submenus.

« Mammary Development &
. Developmental models®
« Tumor models®

« Knock-out mice®

. Transgenic micel

« Natural mutants¥

« Human specimens¥

The From list of all samples selection pops up a hybridized sample guesser dialog window. As with the gene name guesser, you
can start typing in the name of a sample and it will give you alist of HPs that match that initial string. Y ou then click on the sample
you want and then press the Done button.

2.2.2 Swapping selected samples' (Cy3,Cy5) channels in ratio data dye-swap
experiments

The Edit use (Cy5/Cy3) else (Cy3/Cy5) for each HP command may be used to selectively swap (Cy3,Cy5) data entries so the
user may use the samples (carefully, since gene labeling efficiency is not always symmetric!) dye-swap datafor replicates. Thisis
only available for ratio data. It swaps the data contained in MAExplorer (memory only) so that the Cy3 datais swapped for the
Cy5 data. For example, consider the case where there are two materials A and B hybridized in two experiments and labeled as
follows: E1 (A=Cy3,B=Cy5) and E2 (A=Cy5,B=Cy3). Then, assuming uniform symmetric labeling (which is generally not the
case - although it might be true for a subset of genes), then one might average data from E1 and E2 if the datafrom E1 (or E2)
were swapped. Thisis shown in the following figure.
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Figure 2.2.4 Samples menu - selectively swapping (Cy3,Cy5) data channelsfor particular samples. Thisisonly operative if your database contains
Cy3/Cy5 ratio labeling data. Thisis useful in databases containing subsets of dye-swap experiments mixed in with other samples that are not dye-
swapped.

2.2.3 Viewing sample HP-X, HP-Y, and HP-E partitions

Y ou setup sets of HP samples for the HP-X and HP-Y sample sets and HP-E expression list of samples using the Chooser (above).
The current contents of these lists may be viewed using the List HP-X & HP-Y sample 'sets to list the samplesin the HP-X and
HP-Y 'sets. The List HP-E sample 'list' may be used to list the samplesin the ordered HP-E 'list'.

2.2.4 Defining sample condition 'class' names

When using sets of conditions, the HP-X and HP-Y 'sets, you will probably want to assign meaningful names to these sets. The
commands Define HP-X class name and
. Define HP-Y class name assign afree text line name for the sets.

2.2.5 Toggling between single HP-X (-Y) samples and HP-X (-Y) sets

When MAEXxplorer first starts up, it assumes that you wish to treat the data as single samples so that HP-X and HP-Y are assigned
to single samples. However, if you want to work with sets of multiple samples then you must toggle the state using the Use HP-X
& HP-Y 'sets else single samples [CB] check box command. This toggles the state between treating the data as multiple samples
(HP-X and HP-Y 'sets) or as single HP-X and HP-Y sample samples.

2.2.6 Create and edit named condition lists of samples

The command Choose named condition lists of samples lets you define new or edit existing named lists of hybridized samples
called "Condition lists". Associated with each condition list is a set of annotation parameters to document the condition. The
condition lists may be used in the (Edit | Sets of conditions) operations. Among other operations, you may assign any condition list
to the working HP-X 'set', HP-Y 'set', or HP-E list of samples used through MAEXxplorer. The last condition list that was edited

file:///IC|/tmp/MaeRefMan/hmaeFullRefMan.html (29 of 234) [11/24/2003 10:49:35 AM]


file:///C|/tmp/MaeRefMan/GifsDocH/fig-SwapCy5Cy3-RatioDataLarge.gif

MAExplorer - cDNA Microarray Exploratory Data Analysis

with the (Sample menu | Choose named condition lists of samples) is called the "current condition” that could be used in various
operations. Figure 2.2.5 shows a screen illustrating a popup condition chooser session where the legend describes the options.
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Figure 2.2.5 shows a screen illustrating a popup condition chooser session. The set of all samplesin the database is in the scrollable "Remainder
Samples' window in the upper left. The samples you have selected for the condition list being edited is shown in the upper right " Selected Samplesin
current condition" window. Thelist of al conditionsin the database isin the lower left "List of Conditions' window. The current condition list that is
selected is highlighted and its contents displayed in the " Selected Samples' window. User defined annotation associated with the current condition are
displayed in the right "Current Conditioned Annotation" window. To add anew condition, click on the Add Cond button to define the new condition
name. The Remove Cond button is used to delete a named condition list. The List Cond button pops up areport listing the samples and annotation for
the current condition. The List All button pops up areport listing the the names of all of the conditions and the annotation names. Y ou may add or
remove new annotation names for all of the conditions. The Add Ann button will add the new annotation you enter into all conditions - you must enter
the data for each condition that requiresit. You may The Save the current status of al of the conditions into your working database. If you have pressed
Cancel before saving, then you will not have saved your edits. Pressing the Done button will save the changes and pop-down the window.

2.2.7 Create and edit named ordered condition lists (OCL) of conditions

The command Choose ordered condition lists of conditions lets you define new or edit existing named ordered lists of conditions
called "Ordered Condition Lists' (OCL). Associated with each ordered condition list is a set of annotation (name, value) pairsto
document the condition. The last condition list that was edited with the (Sample menu | Choose ordered lists of conditions) is
called the "current OCL". The current OCL is used by the (Filter menu | Filter by current Ordered Condition List (OCL) F-Test [p-
Value] dlider [RB]) test. Figure 2.2.6 shows a screen illustrating a popup ordered condition list chooser session.
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Figure 2.2.6 shows a screen illustrating a popup ordered condition list (OCL) chooser session. The set of all conditionsin the database isin the
scrollable "Remainder Conditions" window in the upper |eft. The conditions you have selected for the OCL being edited is shown in the upper right
"Selected Conditions in current OCL" window. The list of all conditionsin the database isin the lower left "List of Conditions" window. The current
OCL list that is selected is highlighted and its contents displayed in the " Selected Conditions" window. User defined annotation associated with the
current OCL are displayed in the right "Current OCL Annotation" window. To add a new OCL, click on the Add OCL button to define the new
condition name. The Remove OCL button is used to delete a named condition list. The List OCL button pops up areport listing the conditions and
annotation for the current OCL. The List All button pops up areport listing the the names of all of the OCLs and the annotation names. Y ou may add or
remove new annotation names for all of the OCLs. The Add Ann button will add the new annotation you enter into all conditions - you must enter the
datafor each condition that requiresit. You may The Save the current status of all of the OCLs into your working database. If you have pressed Cancel
before saving, then you will not have saved your edits. Pressing the Done button will save the changes and pop-down the window.

[ SRS S

2.3 Edit menu

The Edit menu operations include operations to modify the 'edited gene list' that is set from avariety of Filters aswell as manually
this menu. The user may perform set operations (union, intersection, and difference) on named sets of gene and sets of sample
experiments (conditions). User preferences are also set in this menu.

Sets of genes or HP condition lists are very useful for tracking complex data-mining sequences of analysis. For example, derived
named gene sets may be used in successive data filters and for reports. For example, one could do the following experiment given
four different types of HPsfor (e.g. virgin, pregnancy, lactation, and involution)

First compare two HPs using a statistical test such as a t-test. Then save the resulting set of genes under the name "virgin vs. pregnancy”. Then
compare the next two HPs and save the resulting genes under the name "lactation vs. involution”. Finally, compute the difference of genes found in
"virgin vs. pregnancy" that are not found in "lactation vs. involution". This resulting gene set could then be saved (e.g. with a hame "Genes found in
virgin vs. pregnancy, but not in lactation vs. involution"). Similarly, taking the inter section of these two named sets shows genes that are common
between the two sets. Taking the union shows genes found in either of the two named sets.

The Edit menu contains the following main selections. All of these entities and preferences are saved as part of the startup state
when you do a (File | Databases | SaveAs ... DB).

. User edited gene listl] - ediit the user defined 'Edited Gene List' or EGLL.
. Setsof gene@ - operations on named sets of genes.
. Setsof Conditiond®] - operations on lists of hybridized samples (i.e. experimental conditions).
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. Prefer ence@ - set various statistical limits and other parameters.

2.3.1 User edited gene list - the 'Edited Gene List' menu

Y ou may define and edit arbitrary sets of genes using the User edited genelist submenu to modify the 'Edited Gene List' (EGL).
This has sub-modes of operation for adding or removing genes from the image by clicking on spots. If the Show 'Edited Gene
List' mode is set, you may see exactly which genes you have defined by the magenta squares drawn around each gene in the EGL.
Many of the clustering operations will leave the current cluster in the EGL. The commands include:

. [ Show 'Edited GenelList' [CB] - toggle showing the EGL as magenta boxes in the pseudoarray image. |f enabled, genes set by manual
selection or as the result of some filtering operations

. B pon't edit [RB] - clicking on a spot does nothing (i.e. disable the ‘click to add (remove) genesto (from) the E.G.L.".
. [ Click toadd geneto E.G.L. (Ctrl/click) [RB] - clicking on a spot adds the corresponding gene to the 'Edited Gene List'.

. [ Click toremove genefrom E.G.L. (Shift/click) [RB] - clicking on a spot removes the corresponding gene from the 'Edited Gene List'.
. Set 'Edited GenelList' to Filtered genes capture the current Filtered genesinto the E.G.L.
« Clear 'Edited GenelList'

This gives you the functionality of adding and deleting genes from a user defined list of genesto be analyzed. The EGL may be
used with the gene-set operations discussed in Section 2.3.2. Y ou may aso define genesin the EGL using the "Gene Name
Guesser" shown in Figure 2.3.1.
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Figure 2.3.1 Edited Gene List defined from the Gene Name Guesser using wildcards. The Edited Gene List was defined as the set of genes
containing the sub-string "onco" in it. The sub-string was specified to the popup guesser window as "*onco*" using *' characters as wildcard symbols
indicating that it should match any or no characters. The button Gene Name may be toggled through a set of other identifiersincluding Clone ID,
UniGene ID, dbEST 3, dbEST 5', GenBank 3', and GenBank 5', Locusl D, etc. depending on what identifiers are available in your database. The user
then pressed the Set E.G.L . button on the guesser window that sets the E.G.L. to those genes. If you have enabled the View menu " Show 'edited gene
list', then the genesin the EGL . are viewed as magenta squares seen in the pseudoarray image. Y ou many to do additional editing to manually add or
remove genes that you want to change in the set. If a 2D scatter plot was being used, EGL labeled genes would appear there aswell. To select a
particular gene as the current gene, click on the gene you want in the list, then press the Done button.

2.3.2 Sets of genes menu
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These commands let you do comparisons of sets of genes generated under different criteria. In addition, you may compute derived
gene sets from existing gene sets using set operations (OR, AND, DIFFERENCE). Y ou may aso normalize the data by a gene
subset. The user may save the genes defined by: 1) by the Filter, or 2) the manually defined 'Edited GeneList'. The gene set
resulting from a binary gene set operation OR (union), AND (intersection), or DIFFERENCE are saved in a new named gene set.
The set difference (A-B) is defined asthe getsin set A that are not in set B. Genesin set B that are not in set A areignhored. The
'User Filter Gene Set' may be set to any gene set and may then be used as part of the gene Filter cascade. The 'User Normalization
Gene Set' may be set to any gene set and may then be used to normalize gene intensity values across hybridized samples. (See
normalization algorithm for more information on this method.)

If you are running MAEXxplorer in stand-alone mode, the current named gene sets are saved when you save the DB using the Save
disk DB or Save as disk DB selectionsin the Databases submenu of the File menu. The gene sets are saved in a State sub
directory as".cbs" files and are used to restore the gene sets when restarting MAEXxplorer on a.mae startup file. The .mae startup
file saves the names of the .cbs files that are shared among the various startup files for a given project. The implication then is that
if you change and save a gene set in one startup database, it will change in other startup databases when they load that gene set.
The advantage is that different startup databases may view a gene set produced by another database. The Sets of genes operations
in the Edit menu include:

. List saved gene sets - popup awindows with the catalog of named gene subsets showing how many genes are in each subset. If the contents of
any gene set is changed or a set is added or removed, the list is dynamically updated.

Save Filtered genes as gene set - assign the Filtered genes to a named gene subset

Save'Edited Gene List' asgene set - assign the 'Edited Gene List' to a named gene subset

Assign 'User Filter Gene Set' - for use as a Filter option

Assign 'User Normalization Gene Set' - for use as a Normalization option

OR (Union) of 2 gene sets - set the 'Edited Gene List' to the union of two named gene subsets (i.e. genes that are found in either set).

AND (Intersection) of 2 gene sets - set the 'Edited Gene List' to the intersection of two named gene subsets (i.e. genes that belong to both sets).
Difference of 2 gene sets - set the 'Edited Gene List' to the difference of two named gene subsets (i.e. the first set less genes in the second set
found in thefirst set).

« Rename gene set - rename a saved gene set

. Load gene set from disk file - load a specific gene set from a user specified disk file (stand-alone mode only)

» Remove gene set - remove a saved gene set

Thefollowing is an example of List saved gene sets state listing the catalog of named gene subsets in some of the MGAP data.
Note that sets#1 to #11 are fixed by the datain the GIPO file and may not be changed by the user. Sets #12 to #14 are assignable
from other sets or in the case of the E.G.L, by various MAEXxplorer operations. Sets #1 through #14 may not be removed whereas
#15 and higher may be removed.

User Gene Sets
Set# | #genes| title

#1 | 1727] ALL GENES

#2 | 394] ALL NAMED GENES

#3 | 246] ESTs simlar to genes

#4 | 456] ESTs

#5 | 1096] Al genes and ESTs

#6 | 1681| Good genes

#7 | 40| Repl i cate genes

#8 | O] Housekeepi ngGenes

#9 | 96| Cal i brati on DNA

#10 | 77| Your plates

#11 | 46| Enpty wells

--------- User Assignable ----------

#12 | 0| User Filter Gene Set

#13 | 60| Edited Gene List

#14 | 0| Normal i zati on Gene Set

--------- User definable------------

#15 | 60| The 60 genes closest to Carbonic Anhydrase-I1I1
#16 | 30] Naned genes in the 60 genes closest to CA-11I1
#17 | 4] Replicate genes in the 60 genes closes to CA-111

The following figureillustrates selecting sets by name for gene set operations.
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Figure 2.3.2 Selection of gene setsfor binary gene set operations. This example computes the Boolean AND of two sets"ALL NAMED GENES' and
"60 genes closest to CA-111 from Named and Ests", and then the AND of the "Replicates" with the previous result. Thefirst result is save in the set called
"The 60 genes closest to Carbonic Anhydrase-111". The second result is saved in the called set "Named genes in the 60 genes closest to CA-111". Finally,
the third result is saved in the set named "Replicate genesin the 60 genes closes to CA-I11".

2.3.3 Sets of sample conditions menu

In addition, MAEXplorer can operate on sets of hybridized samples. For example, a sample set might be replicate hybridized
samples from the same biological experiment sample, or it could be repeated experiments of different but the same types of
samples. (One must be careful in mixing data between the two cases because of the different expected sources of variance). This
means you can treat multiple replicate samples as a distribution and compare the mean values for each gene in one set of samples
with the mean values for another set of samples. We call these sets of hybridized samples conditions lists or HP lists. Y ou may
then put one or more HP samplesinto a condition set. These setsin turn can be used for computing statistics on clonal differences
between different condition sets. Note each condition set may have multiple (i.e. different) samples. These condition sets are saved
with the user state when doing a (File | Databases | SaveAs DB). As with sets of genes, there are a number of operationsto

mani pulate HP condition set in the Sets of Conditions menu that includes:

« Choose named condition lists of samples - define or edit new named lists of hybridized samples.

. List saved HP condition lists - list the saved HP condition lists.

« List contents of saved HP condition list - for a particular condition.

. Save HP-X ascondition list - save current HP-X 'set' to a named HP condition list.

. SaveHP-Y ascondition list - save current HP-Y 'set' to a named HP condition list.

. Save HP-E ascondition list - save current HP-E 'list' to a named HP condition list.

. Assign saved condition list to HP-X - set the current HP-X 'list' to the saved condition list.

. Assign saved condition list to HP-Y - set the current HP-Y 'list' to the saved condition list.

. Assign saved condition list to HP-E - set the current HP-E 'list to the saved condition list.

« OR (Union) of 2 condition lists - make a new condition that is the union of two named condition lists (i.e. conditions that are found in either
list).

« AND (Intersection) of 2 condition lists - make a new condition that is the intersection of two named condition lists (i.e. conditions that are
found in both lists).

. Difference of 2 condition lists - make a new condition that is the difference of two named condition lists (i.e. thefirst list less conditionsin the
second list).

« RenameHP list - rename a saved HP condition list

. Load HP condition list from disk file - [Future]
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. RemoveHP list - remove a saved HP condition list

Thefollowing is an example of List saved HP condition lists state listing the catalog of named HP condition lists.

Condition Lists

Condition[1] #HPs 2, [Initial HP-X: C57B6 pregnancy day 13]
Condition[2] #HPs 2, [Initial HP-Y: Stat5a (-,-) pregnancy day 13]
Condition[3] #HPs 4, [Initial HP-E expression list]

Thefollowing is an example of List contents of saved HP condition list state.

Condition List #1 [Initial HP-X: C57B6 pregnancy day 13]

HP[ 1] Pregnancy 13 (1 hr) [C57B6-pl3-total RNASug]
HP[ 2] Pregnancy 13 (1 hr) [C57B6-pl3. 2poly-A]

2.3.4 Setting user preferences menu
The Preferences submenu is used to set various data labels, statistical limits and other parameters. These include:

. [ #UseWeb DB [CB] - if Web DB was defined, get data from the Web

. #Define Web DB - (re)define Web DB URL name for access when restart database

. [¥ #Web DB data caching [CB] - if Web DB was defined, cache data on local computer if getting data from the Web

« DefineHP-X class name - for set of HP-X samples

. Define HP-Y class name - for set of HP-Y samples

. Define DB name - (re)define the local database name

. Define DB title - (re)define the local database title

. Define GEO Platform ID - (re)define the NCBI GEO Platforml D associated with an array GIPO that can be accessed by MAEPIugins for
gathering additional information about an array.

. Adjust all Filter threshold scrollers - popup the state scroller window with all of the thresholds. Thisis useful when you want to adjust
thresholds befor e you enable data Filtering or clustering. If you are logging messages, then closing the window will print the current values of
all of the threshold dlidersin the log.

. Set max # genesin highest/lowest report - sets the number of genes N to report or Filter.

« Font Family - set the font family (to improve readability)
. Font Size - set the font size (to improve readability)

. Resize MAExplorer memory limitsfor the next timeit isrun - After the command is run, you must exit and restart MAExplorer for the new
memory limits to take affect. It changes the memory limitsin the MAExplorer.lax startup file. This command may be useful if you are working
with very large arrays with large numbers of samples. The default memory limit is 256Mbytes.

The Font Family submenu is used to set the text font family. This may be useful if your computer is missing some fonts or some
fonts are easier to read than others. Note: some fonts may not work well on your computer. If thisis the case, try another font.
When you save the data mining session with the "SaveAsfile DB", it also saves the font you have set. For some plots or popup text-
windows, you may have to regenerate the popup window to see the font changes.

o Arie

. Courier

« Helvetica

« MonoSpaced

« SanSerif - the default font
« TimesRoman
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The Define HP-X (HP-Y) class name command may be used to change the names of the HP-X (HP-Y) experimental condition sets. These names are
used in various labels in the main window, popup plots and reports, etc. The commands to change various names of database components are in the
Preferences submenu in the Edit menu.

_— SN SIS e—— e —

2.4 Analysis menu

The Analysis menu (see Figure 1.4) contains an ordered list of six primary menus that may be used, in that order, to perform an

initial analysis. In more complex analyses, the sequence of operations will vary and include commands selected from other menus
or will use these menusin different order. The Analysis submenus are as follows:

2.4.1 GeneClass Menu
2.4.2 Normalization Menu
2.4.3 Filter Menu

2.4.4 Plot Menu

2.4.5 Cluster Menu

2.4.6 Report Menu
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Fil= Samples Edit CULVESE vView Flugns  Help
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Figure 2.4 MAExplorer main window with Analysis M enu. The menu structure of MAEXxplorer was designed to allow users to quickly perform
commonly used data-mining operations as a first approximation analysis.
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2.4.1 GeneClass menu
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A geneclass (e.g. all named genes, EST's, oncogenes, etc.) isa set of genes that belongs to the class of genesin the universe of
genesin the particular microarray database. MAExplorer may restrict the set of genes by "Gene Class' membership (currently
includes All Genes, All named Genes, ESTs similar to genes, Unknown ESTSs, All genes and ESTs, Good genes, Replicate genes
(i.e. with more than one copy of the gene in the array), Calibration DNA, genes from user's plates). The additional Gene Class list
of names depends on its availability in a specific database.
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Figure 2.4.1.1 Gene Class menu. The user may select a subset of genes that belong to one of the classes of genes. This shows the user selecting the set
of "All named genes' that are indicated with red (white) circle over the spotsin the array intensity (ratio) pseudoarray image.
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Figure 2.4.1.2 Example of all replicated genes occurring morethan oncein the array. Thiswas selected by using the GeneClass 'Replicate genes.
Y ou may use the data Filter "Filter by genes with replicates’ instead of the GeneClass. This has the advantage that you may use other GeneClasses (e.g.
ESTs, or All named genes, etc.). Alternatively, you can find all of the replicates for a particular gene by 1) use the Gene Guesser to find the particul ar
gene you want; 2) press"Set E.G.L." to save it as an Edited Gene List; 3) enable the Filter "Filter by E.G.L." at the same. Thiswill show all occurrences
of that gene.

The set of all genes constitutes a number of different gene classes. It is possible to restrict the subsequent analysis to a particular
subset of these genes called a gene class. The GeneClass menu operations include operations to select the current set of genesto
analyze from the set of all genes by their membership in a gene class.

. All genes[CB] - select the gene class of all genes

. All named genes[CB] - select the set of all named genes where the gene name is known

. ESTssimilar to genes[CB] - select genesthat are ESTs similar to named genes

. ESTs[CB] - select genes that are unknown ESTs

. All genesand ESTs[CB] - select genesthat are either named genes, ESTs or ESTs similar to named genes

. Good genes[CB] - select the predetermined set of good genes marked in the GIPO file. If none are indicated, then it
defaultsto All genes.

. Replicate genes[CB] - select the genes there are at least 2 copies of the gene replicated on the array. Note: duplicated
genes (i.e. F1, F2, etc) are not considered replicates for this purpose.

. Housekeeping genes [CB] - select the predetermined set of housekeeping genes (if present) [Future]

. Calibration DNA [CB] - select the predetermined set of Calibration DNA spots for microarray normalization (if present)

. Your plates[CB] - select genes from the investigator's plates (if present - see Table 2.4.1 below). The 'Y our plate’ menu
name is specified in the database configuration setup file (see Appendix C.5.1-C).

. Empty wells[CB] - select spots that are empty wells on the array (if present - see Table 2.4.1 below). The 'Empty well'
menu name is specified in the database configuration setup file (see Appendix C.5.1-C).

. Set Gene Class subset ¥ - select one of the gene class subsets [Future]

Some of the above gene classes are deduced from the gene name supplied with the Gene In Plate Order (GIPO) file for the array.
We use the following automatic classification rules shown in Table 2.4.1.

Table2.4.1 Rulesfor the automatic classification of gene namesinto the default Gene Class sets. The gene name is analyzed
a phabetic-case independently.

Gene class Rulefor class member ship
All genes al geneson the array

All named genes not starting with "EST"
ESTssimilar to genes |genes starting with "EST,"
ESTs genes with the name "EST"
Replicate genes genes with multiple copies

Calibration DNA genes using the configuration file name "calibDNAname" (optional - see Appendix Table C.4.1)

Your plates clones using the configuration file name "yourPlates' (optional - see Appendix Table C.5.1-C))

empty wells where no spot exists on the array indicated by keywords "empty"”, “empty well" or
"EmptyWell" (optional - see Appendix Table C.5.1-C))

spots on the array where the GIPO Qual Check data was used and was valid. If it was not used, then it
assumes all spots are good. (optional - see Appendix Table C.4.1)

Empty Wells

Good Genes

2.4.1.1 GeneClass ontology subsets [Future]
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If the Set Gene Class subset were activated, it might include categories such as the following. If the categories exist and the data
ismade available to MAEXxplorer, then it is possible to specify gene subsets by Gene Class name. It is the responsibility of the
database creator to define a mapping table supporting these named subsets of named genes.

« Apoptosis

« Bcl-2 family

« Cdkinhibibition
. Cdll adhesion

. Cdlcycle

. Cdl surface
Chemokines
Cyclins
Cytokines
Cytoskeleton
DNA binding
DNA recomb
DNA repair
DNA synthesis
G-proteins
Growth factors
Heat shock
Interferons
Interleukins

lon channel
Milk Genes
Motility
Oncogenes
Proteases
Protein turnover
Receptors
Receptors
Sgnal transduction
Sressresponse
Transcription
Transport

« Tumor suppressors

2.4.1.2 Simulating Gene Class ontologies using Gene Set operations

Y ou can effectively implement finding ontology subsets for Gene Class subsets using the following procedure. Thetrick isto
repeatedly define an E.G.L. gene subset using the gene name guesser to find the genes of interest and save it as a named gene
subset. Edit out genes you don't want. Then you would repeatedly do the OR of gene sets of interest, saving the result as a new
named set. Then doing the OR of another gene set with the set you just created, etc.

Procedure

1. Usethe Gene Name Guesser (see Figure 2.3.1) to collect genes belong to a particular ontology. Pressing "Set E.G.L" puts the genes from the
guesser into the EGL set. Y ou can then delete any genes that don't belong by clicking on the gene in the pseudoarray image with the SHIFT
key pressed.

Save the EGL as a name gene set with a meaningful name representing the ontology construct using the (Edit | Save 'Edited Gene List' as
named gene set) (see Section 2.3.2 for gene set editing commands).

Repeat steps [1] and [2] to gather additional sets.

Merge appropriate gene sets to get the complete ontology constructs using the (Edit | OR (Union) of 2 gene sets) as required.

Finaly, set the (Edit | Assign 'User Filter Gene Set') to select a particular gene class to use, and then

Enable the data Filter by setting (Filter | Filter by 'User Filter Gene Set' membership) (Section 2.4.3).

N

ok w
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2.4.2 Normalization menu

The Nor malization menu operations include operations to normalize gene intensity data between hybridized samples. Thisis
critical in being able to compare samples because of differencesin amount of sample, labeling efficiency and variations in scanner
operation including gain and baseline settings. There are several methods available including normalizing by Zscore, median, log
mean, Zscore of logs, calibration DNA, housekeeping genes, etc. The specific microarray image quantification is determined the

image analysis program being used to pre-process the arrays.

Note: although this set of normalization methods is limited, it is adequate for some analyses of the data. We are in the process of
adding more normalization methods through MAEPIugin methods.

. [ Zscore of intensity [RB] - normalize by the (intensity-mean)/stdDev of raw intensities for all spotsin each sample.
. & Median intensity [RB] - normalize by the median of the raw intensities for all spots in each sample (the default
normalization).
. I Log median intensity [RB] - normalize by the log of median scaled raw intensities for all spotsin each sample.
. I Zscorelog intensity, stdDev [RB] - normalize by the Zscore of the log intensity using (log(intensity)-
mean; og)/stdDev, g, standard deviation for all spotsin each sample.

. [ Zscorelog intensity, mnAbsDev [RB] - normalize by the Zscore of the log intensity using (log(intensity)-
mean; og)/meanAbsDev o, mean absolute deviation for all spotsin each sample.

. By Calibration DNA set of genes[RB] - normalize by the sum of the 'Calibration DNA' genes for each sample (if it
existsin your database).

. By 'User Normalization Gene Set' [RB] - normalize by the sum of the genesin auser defined gene set in each sample.
Y ou assign this gene set using the (Edit menu | Gene sets | Assign 'User Normalization Gene Set') operation.

. I By housekeeping gene set [RB] - normalize each HP data set by the sum of the intensity values for known housekeeping
genesin each sample (if it existsin your database).

. [ Scaleintensity data to 65K [RB] - scale the data for the microarray by 65535/maxIntensity for each sample.

. 7 Unnormalized [RB] - do not scale data between samples. |.e. use the raw data.

. [ Use background intensity correction [CB] - enable/disable background correction to gene intensity measurements.

. [ Useratio median intensity correction [CB] - enable/disable ratio median correction to clone intensity measurements by
multiplying the ratio (Cy3/Cy5) by medianCy5/medianCy3 intensies. |If background correction is enabled, correct by
(medianCy5-medianBkgdCy5)/(medianCy3-medianBkgdCy 3).

2.4.2.1 Intensity background correction

The background intensity data from the spot quantification programs may be used to correct spot intensity. Background may be
specified as either aglobal vaue or on a per-spot basis. If the array images have low background, then this may not be too much of
aproblem if no background values are available.

Some software quantification software (e.g. Research Genetics' Pathways 2.01) measures background globally as: BGLow (low
background), BGAvg (Average background), BGRms (root mean square background). For MGAP, MAEXxplorer uses the BGLow
value when you request background subtraction. These values are read from the MAEXxplorer Samples DB file (see Appendix
Table C.2.1.1 For other quantification programs, background may be available on a per-spot basis in the quantification files. It the
latter is available in your data, it will be used if background correction is enabled (see Appendix C.3).

The background corrected intensity | * ; ; is computed from the raw intensity | ; ; and background intensity bkgr dyp; for H.P. i
and spot j asfollows:

llij = IJ = bkgrdei
Ratio computation for Cy3 and Cy5 data

For most MAEXxplorer operations, the intensity of ageneis generally computed as the mean intensity of the spots (background
corrected or not) which duplicate that gene on the microarray. When working with dual hybridized samples using Cye-3 and Cye-5-
dUTP labeling that results in green and red fluorescence, this can be used in self-normalizing intensity for each hybridized clone
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array using the Cy3/Cy5 ratio. If local background is available, then the ratio can be computed for HP h and spot j as

(Cy3p; - BkgrdCy3p;) / (Cy5, - BkgrdCysy)

2.4.2.2 Normalization between microarrays to allow comparison

The normalization of quantitative datais crucial when comparing data between different microarray samples. There are a number
of different schemes possible. One is to normalize by the sum of known calibration, housekeeping genes or other "constant

expression” genesin the microarray. Another isto sum the background corrected integrated density for al spotsin an array and to
normalize individual gene measurements by that sum. These methods are now described in more detail. Asthe MAEPIugins

facility becomes available, we will be adding a number of more sophisticated gene-specific normalization methods that take many
of the problems specific to microarrays into account.

Normalizing by scaled Zscore of intensity
The "normalized Zscore of intensity" method normalizes each hybridized sample by the mean and standard deviation of the raw

intensities for all of the spotsin that sample. The mean intensity mnl; and the standard deviation sdl ; are computed for the raw
intensity of '‘Good genes. It is useful for standardizing the mean (to 0.0) and the range of data between hybridized samples to about

-4.0 to +4.0. When using the Zscore, you compute Zdiff(erences) not ratios. The Zscore intensity Zscor e;; for intensity | ;; for
HP i and spot j is computed as
Zscorejj = (lj; - ml;)/sdly,

and
Zdiffj(x,y) = Zscorey; - Zscorey;.

Normalizing by the median of intensity

The "Median intensity" method normalizes each hybridized sample by the median of the raw intensities of '‘Good genes for all of
the spotsin that sample. It is auseful normalization to use when you want to compute X/Y ratios between hybridized samples.

Im] = (I|J/ medi an'i)
Normalizing by the log of median of intensity

The "Log median intensity” method normalizes each hybridized sample by the log of median scaled raw intensities of ‘Good genes
for al of the spotsin that sample. The value 1.0 is added to the intensity value to avoid taking the log(0.0) when intensity has zero
value. Thisisauseful normalization to use when you want to compute X/Y ratios between hybridized samples and compress the
scale. Because we are computing alog, we report the difference between HP-X and HP-Y as (X-Y) instead of aratio (X/Y).

Imj =10g(1.0 + (I;;/ medianl;))
Normalizing by scaled Zscore of log intensity, standard deviation
The "Normalize by Zscore of log intensity, stdDev" method normalizes each hybridized sample by the mean and standard
deviation of the logs of the raw intensities for &l of the spotsin that sample. The mean log intensity LI ; and the standard

deviation log intensity sdL| ; are computed for thelog of raw intensity of ‘Good genes. Then the Zscore intensity ZI 0ogS; ; for
HPiand spot j is

Zl ogSij = (IOg(II]) - rmLI,)/deI,
Normalizing by scaled Zscore mean absolute deviation of log intensity

The "Normalize by Zscore of log intensity, mean absolute deviation" method normalizes each hybridized sample by the mean and

file:/lIC|tmp/MaeRefMan/hmaeFullRefMan.html (42 of 234) [11/24/2003 10:49:35 AM]


file:///C|/tmp/MaeRefMan/hmaeDoc2.4.2.html#NormMenu
file:///C|/tmp/MaeRefMan/hmaeDoc2.4.2.html#NormMenu
file:///C|/tmp/MAEPlugins/index.html
file:///C|/tmp/MAEPlugins/index.html

MAExplorer - cDNA Microarray Exploratory Data Analysis

mean absolute deviation of the logs of the raw intensities for all of the spotsin that sample. The mean log intensity mnLI; and the
mean absolute deviation log intensity madLl1 ; are computed for the log of raw intensity of ‘Good genes. Then the Zscore intensity
Zl ogA;j for HPi and spot j is

Zl ogAj; = (log(lj;) - mLl;)/ madLl;
By 'User Normalization Gene Set'
This method is useful a subset of genes have been determined to have relatively constant expression across the set of samples. It
normalizes by the sum of intensities for a subset of genes defined by the user in the 'User Normalization Gene Set’ (Section

2.3.2)using the gene set editing commands. Normalizing by the sum of genesusesthe| gs; ; that is computed for microarray HPi
withintensities| ;; for all genesj in the gene subset.

lgs; = Sum(I,J)
genes |
i in HPi

Then, the normalized intensity | * ; ; is computed as:

Ilij: ||J/|gS|

By 'Calibration DNA' set

If a predefined set of calibration DNA genes are available on the array, they may be used to normalize density values between the
samples. The calibration DNA genes are defined by special gene names that are declared in the Configuration file using the
‘calibDNAname' parameter (see Appendix C Table C.5.1(C)). If thereis no calibration DNA, this entry is not used. The algorithm

isthe same as "User Normalization Gene Set" (above), but the set is predefined as the genes flagged as calibration DNA. For
example, in the MGAP database, these spots are the "mouse genomic DNA" spots so the Configuration file entry would be

cal i bDNAnane="m g. DNA".

Scaling intensity data to 65K

Another method " Scale intensity datato 65K" scales the maximum intensity of each sample to 65K (the maximum intensity). Since
the raw scanned data is often 16-bits, it can have a maximum value of 65535 (216-1) and so this does minimum scaling. This

method may make it easier to view the datainitially using the pseudoarray image. However, it may not properly scale the data
between arrays and should probably not be used in quantitative comparisons.

No normalization

Y ou may also want to ook at the raw intensity (or Cy3 and Cy5 channel) data. Turning off normalization gives you the raw data
read into MAEXxplorer.

2.4.2.3 Using different normalizations to 'see' different data views

Changing the normalization method will sometimes make differences between data sets more apparent. The following figure
shows the same data in two different scatter plots but with two different normalizations.
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Figure 2.4.2.3 Scatter plot of HP-X and HP-Y 'sets data. HP-X is C57B6 pregnancy day 13 and HP-Y is Stat5a (-,-) pregnancy day 13 filtered by
"All named genes and ESTS". A) A scatter plot using the Median normalization. B) A scatter plot using the Zscore of the logs normalization. Notice how
the Casein apha outlier is more apparent in the case of the Zscore log normalization. The skewed plot is characteristic of much microarray data. Some
normalization methods (not currently included in MAExplorer) can compensate for these some of these artifacts (Dutoit, 2000) and are planned for

future MAEPlugins.

2.4.3 Filter menu

Thefinal set of genes presented for display, plotting, reports, etc. is determined by a cascade of gene "datafilters' that generate a
restricted gene set. The cascade is computed in real-time using the intersection of individual criteria and tests selected by the user.

Examples of Filter criteriainclude: membership in a particular gene set, ratio (HP-X/HP-Y) within arange, passing statistical tests
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Figure 2.4.3 Filter menu. The Filter menu is a cascade of datafiltersthat restrict the set of genes passing al filters that have been enabled and whatever
the criteria was that was set for those filters. This figure shows the GeneClass filter set to "All genes and ESTS", the spot CV filter and Ratio (X/Y) range
filters being set interactively by the scroll bars on the right. The genes that pass the filter are indicated with ared (white) circle in the array intensity
(ratio) pseudoarray image.

The Filter menu options are used to restrict the set of genes by pre-filtering the data with a series of cascaded filter criteriaand
tests. The resulting subset of genes passing the filter are then used in the plots, reports and other data analysis methods. Some of
the filters require additional parameters that are set by the Sate scrollers. The user will automatically be prompted for changes to
these scollers (athreshold scrollers window will pop up) when the filter is activated or change. These values may also be set from
the Adjust all Filter threshold scrollersentry in the Preferences submenu in the Edit menu. Thefilters are broken up into
subgroups in the following menu with the grouping haveing more to do with the criteria (i.e. gene set membership, datarange, or
statistical tests).

. [* Filter by GeneClass member ship [CB] - only include genes that are members of the current GeneClass.

. [ Filter by 'User Filter Gene Set' member ship [CB] - only include genes that are members of the current 'User Filter
Gene Set'.

. [ Filter by 'Edited Genes List' membership [CB] - only include genes that are members of the 'Edited Gene List'.

. [ Filter by global 'Good Genes List' membership [CB] - only include genes that are members of the list of good genes.
[These genes are indentified by a Qual Check entry in the GIPO database file]

. [ Filter by 'Geneswith replicates [CB] - only include genes that genes that have at least 2 copies of the gene replicated
on the array. Note: duplicated genes (i.e. F1, F2, etc) are not considered replicates for this purpose.

. [ Filter by ratio or Zdiff histogram bin [CB] - only include genes that are in the range of the ratio or Zdiff histogram bin
you have clicked on (should be set from histogram plot, but may be turned off here)

. [ Filter by intensity or (Cy3/Cy5) histogram bin [CB] - only include genesthat are in the range of the intensity
histogram bin you have clicked on (should be set from histogram plot, but may be turned off here)

. Filter by positive intensity data® - filter by positive intensity dataif the data may contain negative numbers. Otherwise it
will use both positive and negative data. If the database has 2 channels (F1, F2) or (Cy3,Cy5) each channel is checked. If
the background correction is enabled, the background corrected values are tested to see if any of them are negative.

. [ Filter by geneswith non-zero intensity [CB] - only include genes that have non-zero density. This protects against zero
data that may be present in the database when taking logs of the data.

. Filter by per-sample Good Spot data ¥ - filter out genes that do not have "Good Spot" values (defined by the optional
Qual Check spot data on a per-sample (i.e. HP) basis. See the list of codesin Appendix C.4). If thereis no such spot quality
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data, then all spots are considered "good".

. Filter by per-sample Spot Detection Value data ¥ - filter out genes that do not have "Detection Value" values (defined by

the optional DetValue or CorrCoef spot data on a per-sample (i.e. HP) basis. Typical Detection Vaues could be the

Affymetrix MAS5.0 "Detection p-value" or other continuous value of spot detection quality.

. Filter by spot intensity [SI1:S12] dlider sk - filter by individual spot intensity (Cy3 and Cy5 channels if ratio data) within
[SI1:S12] threshold ranges

. Filter by [11:12] dider sk - filter by gene expression (or Cy3/Cy5 if ratio data) within [11:12] threshold ranges

. Filter by ratio or Zdiff dliders¥ - filter by generatios or Zdiff values within [R1:R2] or [21:Z2] threshold ranges
(depending on the normalization method)

. Filter by Cy3/Cy5 HP-X ratio or Zdiff diders¥ - filter by gene ratios or Zdiff values within [CR1:CR2] or [CZ1:CZ2]
threshold ranges (depending on the normalization method). Thisis useful for filtering data from a single sample.

. Filter by spot CV ® - filter out genes that do not meet minimum Coefficient of Variation (CV) values of spot replicates (F1
and F2 for the same HP, replicatesin HP-X and HP-Y 'sets’ of samples etc.).

. [ Filter by HP-X,HP-Y t-Test [p-value] dider [RB] - only include genes that meet the HP-X,HP-Y t-Test criteriaif they
have (F1,F2) duplicate spot (thisis aweak form of the t-Test).

. [ Filter by HP-X,HP-Y 'sets t-Test [p-value] dider [RB] - only include genes that meet the HP-X,HP-Y 'sets t-Test
criteria (only worksif using HP-X and HP-Y 'sets mode where there are replicate samples).

. [ Filter by HP-X,HP-Y 'sets K olmogorov-Smirnov test [p-value] slider [RB] - only include genes that meet the HP-
X,HP-Y 'sets' KS-Test criteria (only works if using HP-X and HP-Y 'sets' mode where there are replicate samples).

. [ Filter by current Ordered Condition List (OCL) F-Test [p-Value] slider [RB] - only include genes that meet the F-

test criteria on the current OCL. This only works if there are at least 2 (replicate) samples/condition for each of the

condition setsin the OCL. Seeinfo on defining the OCL and using the OCL data.

. [ Filter by HP-E clustering [Cluster dist] slider [CB] - only include genes that meet the clustering criteria (alternatively,
see the Cluster menu commands).

. [ Filter by Diff(HP-X,HP-Y) [Abs.Diff.] slider [CB] - only include genes whose absol ute difference between mean HP-
X and HP-Y (single or 'sets) is < threshold.

. [ Filter N geneswith highest X/Y ratio or X-Y Zdiff [CB] - look at highest ratios or Zdiff values. The vaue of N is set
in the Edit menu preferences.

. [ Filter N geneswith lowest X/Y ratio or X-Y Zdiff [CB] - look at lowest ratios. The value of N is set in preferences. N
is set in the Edit menu preferences.

TheFilter by positive intensity data submenu filter contains options that specify which spot intensity values are to be considered
when excluding negative quantified spot data. Note: this filter only makes sense if your data might have negative values (e.g.
Affymetrix chip "Avg Diff" data) or a background corrected value that is less than 0.0. The filter is enabled by setting the "Filter
by spots with positive intensity" checkbox. Negative intensity values may occur with some types of arrays quantification programs.
In the " Check spots for positive values mode" submenu, you may set the samples where the test may be applied to spots from the
current HP, the single (HP-X,HP-Y) samples, (HP-X,HP-Y) 'sets' (replicated spots), or samplesin the HP-E list selected to be used
in thefilter. If there are (F1,F2) or (Cy3/Cy5) data, then each spot must meet the threshold criteria.

. B current HP [RB] - spotsin current sample spots

« THP-X & HP-Y [RB] - spotsin X and Y single samples

« CTHP-X or HP-Y 'sets [RB] - spotsin the HP-X set or HP-Y set

« CIHP-X & HP-Y 'sets [RB] - spotsin both the HP-X set and HP-Y set
. COHP-E [RB] - spotsin HPsin expression profile list

The Filter by Good Spot data submenu filter contains options that specify spots based on their quality. It filters out genes that
have that do not have "Good Spot" values defined by the optional Qual Check spot data. (See the list of codesin Appendix C.4). If
there is no such spot quality data, then all spots are considered "good". Thefilter is enabled by setting the "Filter by spots with
Good Spot values' checkbox. All spots for the specified samples must meet the criteria. In the " Check spots for Good Spot mode”
submenu, you may set the samples where the test may be applied to spots from the current HP, the single (HP-X,HP-Y') samples,
(HP-X,HP-Y) 'sets' (replicated spots), or samplesin the HP-E list selected to be used in the filter.

. E current HP [RB] - spotsin current sample spots
« FIHP-X and HP-Y [RB] - spotsin X and Y single samples
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« FIHP-X or HP-Y 'sets [RB] - spotsin HP-X set or HP-Y set
« FUHP-X and HP-Y 'sets [RB] - spotsin HP-X set and HP-Y set
. COHP-E [RB] - spotsin HPsin expression profile list

The Filter by Spot Detection Value data submenu filter contains options that specify spots based on their spot detection value
quality metric over the range of [0.0: 1.0]. Thefilter isavailable only if the data exists for your database and is ignored otherwise.
If active, it pops up a"Spot Detection Value" dider in the range of [0.0 : 1.0]. Only spots greater than the slider value pass the
filter. This data could be the Affymetrix MAS5.0 "Detection p-value" or some other metric correlated with spot detection quality.
Thefilter is enabled by setting the "Filter by per-sample Spot Detection Value" checkbox. All spots for the specified samples must
meet the criteria. In the "Check spots for Spot Detection Vaue mode" submenu, you may set the samples where the test may be
applied to spots from the current HP, the single (HP-X,HP-Y) samples, (HP-X,HP-Y) 'sets’ (replicated spots), or samplesin the HP-
E list selected to be used in the filter.

. B current HP [RB] - spots in current sample spots

« CTHP-X and HP-Y [RB] - spotsin X and Y single samples

« CTHP-X or HP-Y 'sets [RB] - spotsin HP-X set or HP-Y set

« ITHP-X and HP-Y 'sets [RB] - spotsin HP-X set and HP-Y set
. COHP-E [RB] - spotsin HPsin expression profile list

The Filter by spot intensity [SI 1: Sl 2] slider s submenu contains options that determines how individual spot intensity
thresholding isto be applied in the Filter.

« [ Usespot intensity [SI1:S12] sliders [CB] - use spot intensity thresholding
O Inside[RB] - test inside of [SI1:S12] range
. [ outside[RB] - test outside of [SI1:SI2] range

« Usedata mode ¥ - specify which samples are tested

. Compar e channels meeting range ¥ - specify which additional constraints are used. Thisis useful for finding genes with high or low
expression but that has some samples that have opposite expression.

The Use data mode submenu filter contains options that specify which spot intensity values are to be considered of the single
sample (F1 and F2 replicated spot intensity data, or Cy3/Cy5 for ratio data), or the (HP-X,HP-Y) 'sets' of replicated samplesisto
be used in thefilter. If there are single sample (F1,F2) or (Cy3/Cy5) data, then each spot must meet the threshold criteria.

. E current HP [RB] - spotsin current sample spots

« FIHP-X & HP-Y [RB] - spotsin X and Y single samples

« CUHP-X & HP-Y 'sets [RB] - spotsin HP-X set and HP-Y set
. COHP-E [RB] - spotsin HPsin expression profile list

The Compar e channels meeting range submenu specifies which additional constraints are to be used. If required by the (AT
MOST channels, AT LEAST channels, PRODUCT OF channels, SUM OF channels) commands, the Per cent SI OK
scroll bar will appear which covers the range of 0% to 100%.

. B ALL channels[RB] - ALL channels must meet the range specification

. T ANY channels[RB] - ANY channels may meet the range specification

. AT MOST channels[RB] - AT MOST Per cent Sl OK channels may meet the range specification
. COAT LEAST channels[RB] - AT LEAST Per cent SI OK channels may meet the range specification
. U PRODUCT of channels[RB] - the PRODUCT of all channels must meet the range specification

. [ suM of channels[RB] - the SUM of all channels must meet the range specification

The Filter by [I11:12] dliders submenu contains options that determines how spot expression (intensity or (Cy3/Cyb5) ratio value)
thresholding isto be applied in the Filter:

« [ Useintensity [11:12] sliders[CB] - use spot intensity thresholds 11 (lower) and 12 (upper)
. B Inside[RB] - test for intensity inside of [11:12]
. Outside [RB] - test for intensity outside of [11:12]

TheFilter by ratio or Zdiff sliders submenu contains options that determines how spot-ratio thresholding is to be applied in the
Filter. The spot ratio is mean HP-X / mean HP-Y for sets of samples. The spot Zdiff is used if one of the Zscore normalization
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methods is active and is computed as (mean HP-X - mean HP-Y) for sets of samples.

. [Useratio [R1:R2] or Zdiff [21:Z2] sliders [CB] - use spot ratio [R1:R2] or Zdiff [21:22] range thresholds
. Inside[RB] - test inside of [R1:R2] or [Z21:Z2] range
. Outside [RB] - test outside of [R1:R2] or [Z21:Z2] range

TheFilter by Cy3/Cy5 HP-X ratio or Zdiff slider s submenu contains options that determines how spot Cy3/Cy5 HP-X ratio
thresholding isto be applied in the Filter. The spot ratio is Cy3/Cy5 for normalized data unless one of the Zscore methods is used.
In that case, the Zdiff is used and is computed as (Cy3 - Cy5) for sets of samples. If HP-X 'sets' is used, then it computes the mean
Cy3 value and the mean Cy5 value and uses those values in the above computations.

« [ Useratio[R1:R2] or zdiff [21:Z2] sliders[CB] - use spot ratio [R1:R2] or Zdiff [21:22] range thresholds
. Inside[RB] - test inside of [R1:R2] or [Z1:Z2] range
. ¥ outside[RB] - test outside of [R1:R2] or [Z1:22] range

The Filter by spot CV submenu filter contains options that specify how the Coefficient Of Variation of the (F1,F2) or (HP-X,HP-
Y) 'sets (replicated spots) isto be used in the filter. The (F1,F2) CV isavailable only if there are duplicate spots on the HPs.

« [ Usespot [CV] slider [CB] - apply one of the spot CV filter modes as a Filter and popup a CV slider to set the threshold
« CV spot filter mode® - select samples to be used in computing the CV
« [ Usemean else max of CVs[CB] - compute the CV as the maximum or the mean of the CV's of the samples selected

Filtering using statistical test by your selecting a p-value

These tests will filter genes meeting the test criteriaif the resulting p-value of that test is <= the value specified by the p-Value
state slider. Only one test may be active at atime. If you switch to anew p-valuetest, it will disable the previous p-value test. If
any of these tests are selected, it will pop up the p-Value state slider window for you to set the p-Vaue. There are two t-tests: one
operating on duplicate (F1,F2) dataif available, and the HP-X,HP-Y 'sets' if they are defined. The Kolmogorov-Smirnov test
operates on HP-X,HP-Y 'sets' if they are defined. The F-test operates on the current Ordered Condition List (OCL) consisting of
any number of condition lists each containing at least 2 (replicate) samples/condition.

. [ Filter by current Ordered Condition List (OCL) F-Test [p-Valug] slider [RB] - only include genes that meet the F-test
criteriaon the current OCL. This only worksiif there are at least 2 (replicate) samples/condition for each of the condition setsin the
OCL. Seeinfo on defining the OCL and using the OCL data.

Filtering out genes with high replicate spot variation

The Spot CV filter mode submenu contains options to select how the spot CV filter is to be applied. It computes the maximum
value of CV for all of the sasmplesin the particular sasmple set specified. That maximum value is then used for the spot CV filter
test. Genes may be filtered out having a large difference between spot quantification values of corresponding duplicate spots. Y ou
may compute the coefficient of variation CV; for the two values (f1; and f2; for a particular genej.

oV = 2f1-f2|/(f1+f2))

If the database only has one field but replicate HPs, then you may usethe HP-X & HP-Y "sets' CV to filter the genes. Then CV;
values are tested against a CV threshold dlider value to eliminate genes with a high coefficient of variation.

. B current HP [RB] - CV of (F1,F2) for each genein current sample [if duplicate spots are available on each sample]

« CIHP-X or HP-Y [RB] - CV of (F1,F2) for HP-X and HP-Y single samples [if duplicate spots are available on each sample]
« FCUHP-X 'set' [RB] - CV of spotsin HP-X set

« CUHP-Y 'set’ [RB] - CV of spotsin HP-Y set

« FUHP-X or HP-Y 'sets [RB] - CV of spotsin the HP-X set or HP-Y set

« FTHP-X and HP-Y 'sets [RB] - CV of spotsin both the HP-X set and HP-Y set

. COHP-E [RB] - CV of HPsin expression profile list

2.4.3.1 Data filtering using multiple gene data filters
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Any or all of the data filters may be selected simultaneously. In particular, if you select filters that use parameter threshold
scrollers, they will be added to a state scroller window (see Figure 2.3.4.1 for details to allow adjustment of ALL dliders
simultaneously). Y ou may change various thresholds and see the effect in real time. Note: some of the scrollers are more sensitive
to low values. Therefore, we set them to respond non-linearly with a more precise vernier at the low end.
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Figure 2.4.3.1 Filtering using multiple scrollers. This exampleis of Cy3/Cy5 time series data. It filters normalized spot intensity of the Cy3 and Cy5
channels independently ([SI1:S12] inside range) where low intensity spots are eliminated. It then filters out genes outside of the [R1:R2] ratio range.
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Figure 2.4.3.2 Using the Positive I ntensity data Filter. This allows removing negative data if the data contains negative intensity values (e.g. Some
Affymetrix data has negative Average Difference values which could be read as Intensity for MAExplorer).
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2.4.4 Plot menu

The Plot menu lets you display a pseudoarray image, scatter plots, ratio and intensity histograms,and expression profile plots. The
pseudoarray image is displayed in the main MAExplorer window. All of the other plots are displayed in popup windows.
Depending on the particular plot, multiple instances may be allowed. The Plot submenus are:

. Show Micr oarrayE - display the pseudoarray image for the current HP sample

. Scatter glotsE - display various scatter plots of selected pairs of HP samples
. Histogram@ - display both ratio and intensity histograms of HP sample data
. Expression profile pIotsE - display expression profile plots of genes or gene subsets

Y ou may switch between different representations of the microarray spot pseudoarray image. It may be viewed as several different
types of pseudo images including an intensity gray value and a pseudo-color Red/Black/Green image for ratio (HP-X/HP-Y) and
Zscore (HP-X - HP-Y) data. The p-Value results of comparing a HP-X 'set’ with aHP-Y 'set' of samples, or the CV of the HP-EP
'list can be displayed as a color spectrum pseudoarray image.

Depending on the origin of the array data, it may have the same verisimilitude as the original arrays. Otherwise, it isdisplayed in a
generic pseudoarray image containing grids that will fit the window - these are not the same as the original array image (see.
However, the pseudoarrays are useful to getting arough idea of the global changes in the data between arrays and how may genes
pass the data filter.

When enabled using one of the commandsin the Section 2.4.5 Clustering menu, cluster data appears as blue circles or squares

drawn as overlays on the pseudoarray image. These options are discussed in the section on clustering. If you are doing clustering K-
means clustering, the current cluster is displayed in the scatter plot if the latter is active.

Scatter plots, ratio and intensity histograms of the mean (HP-X/HP-Y) or (HP-X/HP-Y) 'set' data, or the F1/F2 or Cy3/Cy5 data.

FL/F2 or Cy3/Cy5 plots are available if the data exists in your particular database. That might be the case with replicate spots or
with Cy3/Cy5 data. If the normalization is set to a Zscore or log mean mode, it will compute Zscore scatter plots and histograms.

Clicking on spotsin an array image or points in scatter plots sets the current gene and will bring up data on the gene or (optionally)
access corresponding data from GenBank, UniGene, mAdb Clone, etc. databases in a popup Web browser. Clicking on abinin a
ratio or intensity histogram plot filters out al genes except for those in the range of that bin.

Expression profiles plots of selected genes or subsets of genes for all samplesin the HP-E list. These are active plots with data
reported when the user clicksin the plot.

Clicking on aspot (i.e. gene) in the microarray pseudo image or on apoint (i.e. gene) in the scatter plot, it will define that gene as
the "current gene" that is used in other operations. The current gene is indicated in both plots with a green circle around it.
Similarly, you may modify the 'Edited Gene List' from either the pseudoarray image or the scatter plot. When viewing is enabled, it

overlays those genes with magenta squares.
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Figure 2.4.4 Plot menu - selecting Ratio Pseudoarray image. This displays a pseudocolor show in the scale on the |eft that indicates the ratio of the
value of the HP-X sample/ HP-Y sample (or 'sets' if the option to use HP-X and HP-Y 'sets' is enabled.) If The datais Cy3/Cy5 data, then this displays
theratio of the ratios using the current normalization. V arious other pseudoarray image representations could be used.

2.4.4.1 Show microarray pseudoarray images menu

Y ou may show the pseudoarray image of the current hybridized samples using several modalities. The grayscale pseudoarray
image is generated from the quantified spot data. If the data contains the actua spot positions of the genes (as generated by the
various array image quantification program), the spots may be drawn using a scaled version of those coordinates. Otherwise, a
generic set of grids (and fields in there are multiple fields) is synthesized to represent the spot positions. Pseudoarray images may
also be useful as an aternative modality for displaying X/Y ratio or X-Y Zdiff data. If the normalized intensities are the same, then
the spot will appear as black with the overall spot intensity depending on the spot concentrations. High ratios and Zdiffs will be red
and low values green as shown in Table 2.4.4.1. The p-Value results of comparing aHP-X 'set' with a HP-Y 'set' of samples can be

displayed as a color spectrum pseudoarray image.

If the database that was loaded contains only one sample, the pseudoarray image display defaults to the pseudograyscale spot
intensity mode. If thereis at least one HP-X and one HP-Y sample, then the Pseudocolor HP-X/Y ratio or Zdiff modeisthe
initial default display. If there are duplicate spots for each gene, you may generate a Pseudocolor F1F2 ratio or Zdiff mode
image. If you are using Cy3/Cy5 ratio data and the datais available as independent channels for each HP, then you may plot Cy3
vs Cy5 for individual samples.

When available on the database server, the original image may be displayed in a separate popup Web browser.

. Pseudograyscale intensity [RB] - display a pseudograyscale microarray pseudoarray image for the current H.P. where higher intensity spots
are mapped to black.

. [ pseudocolor Red(X)-Yellow-Green(Y) HP-XY ratio or Zdiff [RB] - display the HP-X and HP-Y microarrays as a pseudocolor image as
either aratio (HP-X/HP-Y) or Zdiff (HP-X - HP-Y) if Zscore normalization isin effect. The HP-X (red) and HP-Y (green) components are
added together so that high total intensity values are yellow and low values are black. High HP-X/HP-Y ratio values are more red and low
values are more green.

. [ Pseudocolor Red(Cy5)-Y ellow-Green(Cy3) Cy3/Cy5 data [RB] - display the Cy3 and Cy5 microarray channels as a pseudocolor array
image. The the Cy5 (red) and Cy3 (green) components are added together so that high total intensity values are yellow and low values are black.
High Cy3/Cy5 ratio values are more green and low values are more red. Note: thisis only available with Cy3, Cy5 ratio data. Note: if the"Use
ratio median corrections’ is enabled, the Cy3 channel is scaled using the to the domain of the Cy5 channel by (median Cy5/median Cy3).

. ¥ pseudocolor HP-X/Y ratio or Zdiff [RB] - display the HP-X and HP-Y data as a pseudocolor array image as either aratio (HP-X/HP-Y) or
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Zdiff (HP-X - HP-Y) if Zscore normalization isin effect. The high ratios or Zscores are red and low values are green. Vauesin the middle are
black.

" pseudocolor (HP-X,HP-Y) 'sets' p-value [RB] - displays each spot as a pseudocolor proportiona to the p-Vauein at-Test of the HP-X 'set'
VS HP-Y 'set'. This can only be used when the "Use HP 'sets ..." option is enabled and there are at least 2 samplesin both the HP-X 'set' and the
HP-Y 'set'. Note that unless proper normalization and filtering is used to remove poor quality data, some of the p-Values will not be significant
and there will be a high false-positive rate. Use this display with that in mind.

™ pseudocolor HP-EP 'list' CV (Coefficient of Variation) [RB] - displays each spot as a pseudocolor proportional to the CV of the spots
within the subset of samplesin the current HP-EP 'list'. It is useful to look at the variation in a set of replicate samples. Use the (Samples |
Choose HP-X, HP-Y and HP-E samples) command to define the HP-EP list of samples you want to investigate.

" pseudocolor Cy3/Cy5 (or FU/F2) ratio or Zdiff [RB] - display the Cy3 and Cy5 (or F1 and F2 for duplicate spotted grids) corresponding
spots for the same genes as a pseudocolor array image as either aratio (Cy3/Cy5) or Zdiff (Cy3-Cyb5) if Zscore normalization isin effect. The
high ratios or Zscores are red and low values are green. Valuesin the middle are black.

" Flicker HP-X & HP-Y Pseudoimages [RB] - toggle flickering the HP-X and HP-Y pseudograyscale intensity array images.

Original image - display the original microarray 8-bit image (if available) for the current HP sample in a separate Web browser window.

[¥! Usedual HP-X & HP-Y Pseudoimage [CB] - If have replicate spots (F1,F2), toggle the display between F1 datain left grids and F2 datain
the right grids to mean HP-X datain the left grids and HP-Y in the right grids for side by side comparisons.

[¥ " Scale pseudoarray image by 1/100 to zoom low-range values [CB] - rescales intensity and (Cy3+Cy5) and (HP-X + HY-Y) (Red-Y ellow-
Green) plots to so mid values are easier to visualize.

SaveAs Gl F - save the current microarray pseudo image as afull resolution GIF file specified by the user in a popup file browser window (stand-
alone mode only).

Table 2.4.4.1. Pseudocolor s assigned to spotsto represent datain the X/Y ratios or X-Y Zdiffs pseudocolor array images.
Each color represents the normalized X/Y ratio or X-Y Zdiff depending on Normalization mode. The 9 colors of the boxes
represent the normalized expression ranges.

NN NEEEEE -

mode - RBG

bright green dark green |Black |dark red bright red

IEREE
mode - dichromasy

bright blue dark blue |Black |dark orange bright orange

<0.250X 0.307X |0.400X |0.571X 1.000X |1.75X 2.50X |3.25X |>4.00X Ratio data

<-3.0 -2.25 |-150 |-0.75 0.00 [0.75 150 (275 [>3.0 Zscore data

<-0.99 -0.742 |-0.495 |-0.247 0.000 |0.247 0.495 |0.742 |>0.99 Zscore Log data

Clicking on aparticular gene will report its specific quantification and identification values (See Section 3.3 on gene
quantification). If the Enable display current genein popup genomic DB Web Browser optionis set in the View menu, then it
will aso pop up a Web browser with the corresponding to the particular genomic DB data for that database if it exists.

The same datais shown in avariety of normalization and display formats.

2.4.4.1.1 Examples of microarray intensity data pseudoarray image

The relative intensity may be displayed for the current sample (last HP-X or HP-Y selected) or two samples (HP-X or HP-Y
samples or HP-X or HP-Y 'sets of samples). To show two samples side by side, enable the Use dual HP-X & HP-Y Pseudoimage
in the Show Microarray submenu. To show averaged set datain the dual mode, enable the "Use HP-X & HP-Y 'sets optionin the
Samples menu. The grayscale value reflects the current normalization mode.
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Figure 2.4.4.1.1.1 Pseudoarray intensity image of median normalized intensities of the current HP sample (C57B6 virgin 10 weeksfrom MGAP
database). The graylevel scale on the left edge of the pseudoarray image indicates the spot intensity. All pseudoarray images have scales that vary
depending on the type of pseudoarray being displayed.
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Figure 2.4.4.1.1.2 Pseudoarray intensity image of Zscore normalized intensities of the current HP (C57B6 virgin 10 weeksfrom MGAP
database).

file:///C|/tmp/MaeRefMan/hmaeFullRefMan.html (53 of 234) [11/24/2003 10:49:36 AM]


file:///C|/tmp/MaeRefMan/GifsDocH/fig-pseudoImageMedianIntensityLarge.gif
file:///C|/tmp/MaeRefMan/GifsDocH/fig-pseudoImageZscoreIntensityLarge.gif

MAExplorer - cDNA Microarray Exploratory Data Analysis

f\j Microdaray Explocer - VO 3402 Hela - CSPHE day 11 pieg. w2 day 1 kel 38 peobes
Fila Somples Bt Anahysis View Fugns  Help

Erlas g name o sbars 10 Ir MougE-twilr iffS  MP-X: Pragranoy 13 {1 R [CSTBS-p 1 D-4skaiR HAS ug]

P Lactation 1 (30 min) [C5708-L1-30mia]

Mo, scong, shaliay, log imdensity
Clonelle 1 48383, dBESTS: 1511330, GenBank 5° AATEAGAS, LiniCanse: Mm 18123, plate]d Ad]
GEnabame Mus musoulus GOP G50 ciamon infibinor bela mRMNA, complels ods
Virgin 10 weeks old [3 hrs} [C5TBE-virgin-2hrs-2] Ll

e Z-seoe, sldChey, log inbersiy
Ifendity

" " ® @
*“ﬂ““ﬂ
M -ozez 1Assesage s ere
| EXIE
W oois
| X
[ EET
B
Lo L B LT TR Shet L T
B o510 CE-BeeE soas s BEE L0 B
Bl Teebl w b e L .
- e o - o el
& Rt
[¥] Cusred Saenple FEBSNEEESs ,.“‘:.:t.. LAl b bl L
*CATEE-p13-fols
*CETEA-p3 A " F e R & & & 5 8 % 8 8 8 @ 8 @
S ——— 1I¢2-ain=‘nﬂ2snia--i- .E_‘:o triiﬂ_- raa.qqtﬂo ...
* CATBO-L1-30min . Fitosal oot elagl -u,_-ﬁ' sae l
"CI7RG-LA A o 02:008ts s e0s 9000 00
" CETBO-L -Gk 'n-' eee Seleve -mnu:g; s2sigiBens
T $8:80ecc et eecRe0s e - radat FHEEFER--
" CETREwigined
SRR wigind LK ] - & 5 B B % & @ &

;fﬂ'ﬂuh“ o ¥ .‘!Wi‘l u¢-m-f e A it ik bt Qtnm Sl =

Figure 2.4.4.1.1.3 Pseudoarray intensity image of Zscor el og normalized intensities of the current HP (C57B6 virgin 10 weeksfrom MGAP
database).
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Figure 2.4.4.1.1.4 Pseudoarray intensity image of Zscor el og normalized intensities of the dual HP-X and HY-Y individual samples. The Plot
menu Show Microarray submenu toggle "Use dual HP-X & HP-Y samples' option is set. HP-X isa C57B6 pregnancy day 13 and HP-Y isa Stat5a (-,-)
pregnancy day 13.

file:///IC|/tmp/MaeRefMan/hmaeFullRefMan.html (54 of 234) [11/24/2003 10:49:36 AM]


file:///C|/tmp/MaeRefMan/GifsDocH/fig-pseudoImageZscoreLogIntensityLarge.gif
file:///C|/tmp/MaeRefMan/GifsDocH/fig-pseudoImageZscoreLogXYintensityLarge.gif

MAExplorer - cDNA Microarray Exploratory Data Analysis

[ Micratunap Eaploser - Vi 94,02 Hela - CSTHE dap 19 parg. v dap 1 Lacl, 38 paobes
Fila Somplas B@t Analyss  View Plugns  Heip

Erlas pares name o glars 10 I r MOUSE-0wif A3 HP-X: CITBE pregnancy day 13

HP-Y; DET 08 Lactsficn day 1

III A, 1B HP-EY sebs” mnR =00 222 00 E2T) mn mn == 00052 SDEC=00023,)0 083 CWiE Y)={0. 102 014 8) nd =]

I-' onelle 17483083, dBESTS™ 1511300, Genbank 5° SATEOE4S, UniGame: Mm 13123, plate]d A4]

I'Z-l.'lu.'-‘ulr-u Mus musoulus GDP GSsocision infibior bila mRMNA, complite cds
HP-X: C5TBE pragnancy day 12
HF' ¥: CETEE lactation day 1
l- sidChe, 100G interay
# & &% % & & # * & & @

bt e ﬂ'_‘ﬂ*lll.+i Rl e it & L
K-Aentis e bpegeiafles asfaf-Ases sl@ o #0000 o
CReBge s SRRl saas talnend i R L R L L]
BB oo BB D Bl B850 & S R B
e ahe s g o tabea® - it ane®s O
S o bR o B SR e B0 s S0eg O SOCTTee

L LR

& % & & 8 * & % & ® 8
bl L TR Sl LIt SRR aaes & OF L e
K-Beosds sign pha@a R Ol ‘B'l'l.'. - el BEE 08 W
B TE 2 r!t’:.utn}!ﬂﬂ So@Ee  CeeBE oM e & 80
. L] LWl

07808 ) BEBE s BT n-:-ncw_. o
(L IRE LTI O.- R T L et ] La e e ] FURE s o e
ragira] Baenole LR S P DRt B L AT & B8 ARCAC0Rs Cw RHE 8
Cman] Sarnple - e
C2708-p 13- 5xls
CATEE-p13.4 'lIt:,.fl-l.::{t'-. -’ - ~
L T 1 ] - O
CTRSPI I L e e a8 s0Es SESIRPITEORS .08 50 B LB SCIG OIS
CA7B0-L1-20min TRBERe T ST S s e el seemch O @ .
CE7TBE-L138m o SRR e e e '.I-. - -...m i e W Q -:';1
CETRG-L1-m '“""‘ Senasetesrle :
. 18208400000 00 B000 sen. u c-l-o Gesew 8390 1o

CETBS-wigined

EE RN EEE R
Ll o ' e bt =l‘;rl.‘ !‘ PG 8l GF R Gl ﬂl
1 L]

|1I
(L]
.

Figure2.4.4.1.1.5 Pseudoarray intensity image of Zscorel og normalized intensities of the dual HP-X and HY-Y sample'sets. The Plot menu
Show Microarray submenu toggle "Use dual HP-X & HP-Y samples' option is set. The "Use HP-X & HP-Y 'sets option in the Samples menu. HP-X is
the mean of three 'C57B6 pregnancy day 13' and HP-Y isthe mean of three 'Stat5a (-,-) pregnancy day 13'.

2.4.4.1.2 Example of microarray ratio or Zdiff data pseudocolor image

Theratio (HP-X/HP-Y) or zZdiff HP-X - HP-Y) normalized intensity data may be displayed as a pseudoarray image for HP-X and
HP-Y, or HP-X and HP-Y 'sets' of samples. To show averaged set datain the dual mode, enable the "Use HP-X & HP-Y 'sets
option in the Samples menu. The colors of the 9 scale boxes represent the normalized expression ranges and is assigned according
to the current normalization mode listed in the table.

Mn:mﬂlllrl:.ulvurm < VO D2 Hela - CHTHE day 13 pieg w2 dap |
Fin Somples Gl Anshyss  View FPugng  Help

Eorter gang ndme o o 1 I r MOUSE-OWEF D WP Wisgin 10w ey old (3 b (057 BE-wirgin-Jhe 3]

MP-Y; Lactstien 1 (30 min) [C5708-L1-30mia]

III A5, TE HP-EY, X, Vi=(45 504 4T 800 (O0F 1.F 2 mean)={0. 7 X231 28,0 9640, (Morm. medidn inlénsityd

I-' onallx 1748383, dBESTS” 1511330, GenBank 5 BATEOEAS, UiniGans Mm 13123, plale|d A4]

I'Z-l.'llufulr B Mus musculus GOP dEsociaton infibitor beta mRRNA, complets cds

HF-X: ¥irgin 10 weaks old {3 hrs) [C5TBS-virgin-3hrs-2]
HP-¥: Lactation 1 (30 min) [CETES-L1-20min]

LA A Ll L Ll T

file:/lIC|tmp/MaeRefMan/hmaeFullRefMan.html (55 of 234) [11/24/2003 10:49:36 AM]


file:///C|/tmp/MaeRefMan/GifsDocH/fig-pseudoImageZscoreLogXYsetsIntensityLarge.gif
file:///C|/tmp/MaeRefMan/GifsDocH/fig-pseudoColorXYratioLarge.gif

MAExplorer - cDNA Microarray Exploratory Data Analysis

Figure 2.4.4.1.2.1 Pseudocolor array image of median normalized X/Y ratios. HP-X is C57B6 pregnancy day 13 and HP-Y is Stat5a (-,-) preghancy
day 13. Each spot's color represents the normalized X/Y ratio depending on Normalization mode. The color of the box is one of 9 colors representing the
normalized expression ranges and assigned according to the table "Ratio mode".
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Figure 2.4.4.1.2.2 Pseudoarray color image of normalized X/Y 'set' mean valueratios. Mean of three HP-X C57B5 pregnancy day 13 samples and
mean of three HP-Y Stat5a (-,-) pregnancy day 13 samples. Each spot's color represents the normalized X/Y 'set’ ratios depending on Normalization
mode. The color of the box is one of 9 colors representing the normalized expression ranges and assigned according to the table "Ratio mode".
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Figure 2.4.4.1.2.3 Pseudoarray color image of X-Y Zdiffs. HP-X is C57B6 pregnancy day 13 and HP-Y is Stat5a (-,-) pregnancy day 13. Each spot's
color represents the normalized X-Y Zdiff depending using the Zdiff normalization mode. The color of the box is one of 9 colors representing the
normalized expression ranges and assigned according to the table "Zdiff mode".
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Figure 2.4.4.1.2.4 Pseudoarray color image of X-Y Zdiff of log data. HP-X C57B5 pregnancy day 13 sample and HP-Y Stat5a (-,-) pregnancy day 13
sample. Each spot's color represents the normalized X/Y ratio depending on ZdiffLog with StdDev normalization mode. The color of the box is one of 9
colors representing the normalized expression ranges and assigned according to the table "ZdiffL og mode".
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Figure 2.4.4.1.2.5 Pseudoarray image showing color-coded p-values for t-test comparison of HP-X and HP-Y 'set' samples. The HP-X and HP-Y
sets both have 2 samples each (more is obviously much better). The data was normalized using the Median and a spot intensity [S11:S12] data filter was
applied to eliminate some of the noisy data. Each spot's color represents a p-value in the range indicated in the scale in the |eft edge of the image. Note
that although all spots are assigned a p-Vaue, many may not be very significant because adequate preprocessing of the data (such as normalization, and
low intensity spot removal, etc.). So use this display with care.
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2.4.4.2 Scatter plots menu

Scatter plotsinclude HP-X vs HP-Y intensity for comparing data between HP-X and HP-Y samples (or setsif the HP-X and -Y
sample 'sets mode is enabled in the Samples menu - asis shown in Figure 2.2.1). Y ou may zoom into any area of the scatter plot
asisshown in Figure 2.4.4.4.2(C). If there are duplicate spots for each gene, you may plot F1 vs F2 intensity (or Cy3 vs Cy5 if
using ratio data) for comparing replicate data (or Cy3 and Cy5 ratio data channels) within the same sample It will also compute the
correlation coefficient for the data and display it in the plot and in the message panel. The datais the intensity values using the
current normalization method. If you are analyzing ratio Cy3/Cy5 data, you may compare Cy3 or Cy5 of the HP-X sample against
Cy3 or Cy5 of the HP-Y sample. If you are in stand-alone mode, a SaveAs Gl F button will also be available. This savesthe
current plot as afull resolution GIF file specified by the user in a popup file browser window.

r Sq=0. 974, n=1728, X(mm+-sd)=(4.477+-7.845), Y(m+-sd)=(12.379+-24.810)
The Scatter plots submenu includes:

« HP-X vsHP-Y intensity - display a scatter plot of HP-X vs HP-Y intensity data of H.P. selected (average of F1+F2 fields). If HP-X/-Y 'sets are
enabled, then the plot is of the mean set values.
. HPFlvsF2intensity - display ascatter plot of F1 vs F2 (or Cy3 vs Cy5) intensity data of the current selected sample

« HP-X Cy3vsHP-Y Cy3intensity - display a scatter plot of HP-X(Cy3) vs HP-Y (Cy3) intensity data of the currently selected HP-X and HP-Y
samples (retio data only).

« HP-X Cy5vsHP-Y Cy5 intensity - display a scatter plot of HP-X(Cy5) vs HP-Y (Cy5) intensity data of the currently selected HP-X and HP-Y
samples (rétio data only).

. HP-X Cy3vsHP-Y Cy5 intensity - display a scatter plot of HP-X(Cy3) vs HP-Y (Cy5) intensity data of the currently selected HP-X and HP-Y
samples (ratio data only).

« HP-X Cy5vsHP-Y Cy3intensity - display a scatter plot of HP-X(Cy5) vs HP-Y (Cy3) intensity data of the currently selected HP-X and HP-Y
samples (ratio data only).

If Cy3/Cy5 ratio datais being analyzed, then the "HP F1 vs F2 intensity” menu entry becomes
. HP Cy3vsCy5intensity - display ascatter plot of Cy3 vs Cy5 intensity data of the current sample selected (i.e. being displayed).

The following figure illustrates some of the scatter plots and zoomed regions using the scroll bars on the horizontal and vertical
axes.
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Figure 2.4.4.2 Scatter plot of HP-X and HP-Y single sample data. HP-X is C57B6 pregnancy day 13 and HP-Y is pactation day 1. A) An active
scatter plot may be generated for the current HP-X and HP-Y samples filtered by "All named genes'. B) similar plot for HP-X and HP-Y 'sets’ of
replicate samples (3 pregnancy and 4 lactation samples in the sets respectively). Clicking on a point in the plot sets the current gene. C) Zoomed up
region (of B) at the bottom of the plot showing more detail and filtered by just "All named genes'. Zooming is performed by adjusting the X or Y axes
limits scroll bars. Note the points enclosed in magenta boxes indicate genesin the E.G.L. genelist.

Scatter plots of data from multiple channels on the same sample

It is also possible to plot the separate channel s within a single sample against each other. For example F1 vs F2 in samples with
replicate data and Cy3 vs Cy5 in samples with separate ratio data channels.
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Figure 2.4.4.2.1 Scatter plot of multiple channel data from a single sample. A) F1 Vs F2 datafor a C57B6 pregnancy day 13 sample. B) Cy3 vs Cy5
datafor aNCl mAdb mouse array sample. C) Scatter plot of individual Cy3 channels from two different ratio Cy3/Cy5 data hybridized samples. C)
Scatter plot of individual Cy3 channel of HP-X compared with Cy3 channel of HP-Y for ratio Cy3/Cy5 data hybridized samples. D) Scatter plot of
individual Cy3 channel of HP-X compared with Cy5 channel of HP-Y for ratio Cy3/Cy5 data hybridized samples.
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2.4.4.3 Histogram plots menu

Y ou may compare ratios or Zdiffs of data using the HP-XY ratios or Zdiff command to display aratio histogram of Filtered
intensity data from two samples selected from the Samples menu. The HP-XY 'set’ ratio or Zdiff isused if there are multiple
samplesin the HP-X or HP-Y sets, then the mean values in each of the setsis used in the calculations. If there are duplicate spots
for each gene, you may plot the F1F2 ratio or Zdiff histogram of the F1/F2 ratios or F1-F2 Zdiff values for normalized data for
each spot in the currently displayed sample. If you are in stand-alone mode, a SaveAs GI F button will also be available to save the
current plot as afull resolution GIF file specified by the user in a popup file browser window.

The Intensity selection plots a histogram of the gene intensity data values for each Filtered spot (gene) in the current hybridized
sample.

The Histograms submenu includes:

HP-XY ratio or Zdiff - display ratio or Zdiff histogram of data from selected HP-X and HP-Y samples (mean F1+F2 data if duplicate spots).
HP-XY 'sets ratio or Zdiff - display ratio or Zdiff histogram of mean data from HP-X and HP-Y 'set's of samples (mean data).

F1F2ratio or Zdiff - display ratio or Zdiff of histogram of F1 F2 duplicate spot data from the current sample.

HP Intensity - (or HP (Cy3/Cy5) if ratio data) display a histogram of spot intensity (or Cy3/Cy3 ratio) data for the current sample.

If Cy3/Cy5 ratio datais being analyzed, then the F1F2 histogram menu entry becomes
« Cy3Cy5ratioor Zdiff - display ratio or Zdiff of histogram of Cy3 Cy5data from the current sample.

The following figuresillustrates the histograms. Y ou may use the histogram to specify ranges of [11:12] or { R1:R2] for data
filtering in the histogram by specifying the corresponding histogram bins. Thisis described in the figure legend.
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Figure 2.4.4.3 Histogram plots. A) Ratio histogram of HP-X/HP-Y datawith particular histogram bin selected with the constraint set to filter al genes
> that bin. HP-X is 13 day pregnancy C57B6 and HP-Y isday 1 lactatation. The selected bin thresholds are then used in the Filter with the resulting

Filtered genes shown in the array image. B) Zdiff histogram of HP-X

- HP-Y 'sets for same data as (A) but with the >< threshold constraint set to find

genes outside of the symmetric histogram range. C) Intensity histogram of HP-X data filtered by [11:12] intensity range. Aswith ratio histograms, you

can do additional filtering by selecting a particular histogram bin that

isthen used in the Filter. Filtering was disabled for the intensity histogram. To

apply the filter, the "Don't re-Filter" button would be toggled to the "Re-Filter" state. The threshold constraintsinclude: =, >, <, >, <>, and ><. Note that
each time you click on the"Thr:" button, it cyclesto the next option in the threshold constraints list.

2.4.4.4 Expression profile plots menu

Y ou may generate an individual expression profile plot (EP

plot) or ascrollablelist of EP plots. The order list of hybridized

samples to plot are specified by the HP-E set. In the latter case, the genes are specified by the data Filter.
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Y ou many generate as many individual expression profile plots as you want using the Display a gene's expr. profile for HP-E
command. However, only the last one will be active and will be updated with different genes as you click on them in the
microarray image scatter plot. This could be used to compare the EP plots for several different genes. First view the EP plot for one
gene, then create a new EP plot for the second gene, etc.

If you use the Display Filtered genes expr. profilesfor HP-E command, it will generate a scrollable list of expression profile
plotsfor all of the genes passing the Filter. If the number of genesisvery large, it may take awhile.

Y ou may interrogate a line corresponding to a particular HP sample in a EP plot by moving the mouse over the line and then
selecting the line. Thiswill cause the name of the HP, itsintensity and CV to appear in the plot. If the Err check box is set, then
the mean of the intensity isindicated by a short horizontal bar and the +- CV by red vertical error bars above and below the mean.
If the plot style Line button is pressed, then the plot styleis cycled between Line (vertical lines for each point), Circle (small
circles at each point), and Curve (circles are connected). Pressing the button repeatedly cycles through: Line (i.e. vertical vars),
Circle, or Curve (i.e. continuous curve of al samples). In the case of mean expression profiles used in K-means clustering, the
standard deviation is used in place of the CV value. The various clustering methods have EP plots buttons. When they are
invoked, the scrollable list of EP plotsis sorted by the clustering method ordered list of genes. This enables you to view the datain
the same order as that produced by the cluster analysis. If the zoom nnX button is pressed, then al of the plots are magnified by nn-
fold to make low intensity plots more visible. Pressing the button repeatedly cycles through: 1X, 2X, 5X, 10X and 20X. It does not
change the data itself. The Show HP names button pops up a numbered list of all HP entries used in the expression profile. If you
are in stand-alone mode, a SaveAs GI F button will also be available for the EP overlay mode (Figure 2.4.4.4.1) or individual EP
plot. This saves the current plot as afull resolution GIF file specified by the user in a popup file browser window.

The Expression profile plots submenu contains:

. Display a gene'sexpr. profilefor HP-E - popup awindow and display the expression profile of agene when click on aspot in the Image or a

point in the scatter plot.
. Display Filtered genes expr. profilesfor HP-E - popup a scrollable montage of expression profiles of thelist of Filtered genes.
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Figure 2.4.4.4 Expression profile plots. A) Individual expression profile plots may be created by clicking on any gene. Multiple instances may also be
created. Here we show some of the presentation options for the 38 sample MGAP database. Error bars are computed for the standard error for that
sample. There are three different plotting options: line, circle and curve. #1 is the default line plot with error bars. #2 is the line plot without the error
bars but clicking on line 7 to find out which sampleit is and what the intensity valueis. #3 is the circle plot with error bars, and #4 is the curve plot
without error bars. Window #5 shows the list of samples corresponding to the 38 pointsin the EP plots. B) List of EPplots of the oncogenes and proto-
oncogenes in the database (set by the guesser with "onco" and "Set E.G.L." and the Edited Gene List Filter). The list would become scrollable if there
were more than 10 profiles. Setting the current gene would scroll the list to the EPplot for the current gene.

E Expiazsaon Prolles of Fillerad genes lor HP-E
Coumrent gene [45] CID 382656, Carbonic ankydrage 3

1 5 10 15 20 25 30 35
|40] CIDC1 382558
Wus muscules ghoosyl-phosphatidyl-inosiolke

o

1 5% 10 15 20 25 30 35
[41) CID1 382463
Heal shock protein, DAS-like 2

1 5 10 15 20 25 30 35
(42 CID:1 382367
GALECTIN-2

& 0
|44) CIDC1 382511
Inedeukin 10 recepior, bata

28 20

fﬂ _

i 5 10 15 20 25 20 =5
3 CID 3823149
C:alrmo-dulin

Ul

1015 M 28 30 28

W

1 5 10 15 30 25 3 35
|46) CID-1 382296
Phosphatidylinositod ghycan, class R

1| I

1015 20 25 30 35
[48) CID-1247833

1§ 10 15 30 25 20 35
(47 CID:1 382561
Mug musculus GTP-specic succimdCok synt

.

T 5 1% 20 35 30 35
MO CIDA 247737

Mus musculus radio-resistancefchemo-resist:  Eukaryolic franslation initiation facior 4E bindin ,J

Mien | s¢| cune| HPnames| Close|

A)

file:///C|/tmp/MaeRefMan/hmaeFullRefMan.html (65 of 234) [11/24/2003 10:49:36 AM]


file:///C|/tmp/MaeRefMan/GifsDocH/fig-EPplotListLarge.gif
file:///C|/tmp/MaeRefMan/GifsDocH/fig-scrEPplotListLarge.gif

MAExplorer - cDNA Microarray Exploratory Data Analysis

E_':?,E:mf:ﬂian Profiles of Filered genes for HP-E

[1-F2,16) ¥ 0 [C5TBE-L1-tolal] imans=167 BOBT, (Morm.: median intensityd
ClonelD: 1247846, dbEST3" 1696023, GeneBankAccd’ ARIS9EAT, UniGane: Mm, 259¢
GeneMame: House mouse; Musculus domesticus kidney mRMNA for Phiosphatidic acid

167.808
3
el
B 4:;51 "
r e
i Yy : 138 .
i gt T
o . i PR
+ L *+1
£ l it Lildy 8
i ¢ :
1 :
4 *
'
']
0.0

23456789181 Iﬂ!ﬂﬂﬂ!mmlaﬂlﬂ!&

[ Mouseinfo | ShowEGL | [ Showriterea | 'Saveas| |HP names

B)

F_;:;E::meﬂian Profiles of Filered genesz for HP-E

Expragsion Profile Cvarlays
64118

Expr

13

00 it Bttt s s
12345678910 Iﬂ!ﬂﬂﬂ!ﬁ?ﬂli%lﬂlﬂﬁ
samples

™ Mouseinfo  DontshowEGL| Show Fillered | sm| HP names

C)

Figure2.4.4.4.1 Expression profile plots. A) Scrollable list of EP plots of Filtered named genes centered at Carbonic anhydrase I11. B) Overlay plot of
all named Filtered genes. C) Overlay plot of all ONCO or PROTO-ONCO genes with the draw EGL option active so the graphs are drawn for these
genes.

2.4.5 Cluster menu
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The Clustering menu lets perform various types of gene and condition clustering operations. When you invoke a clustering
operation it will popup one or more windows and may modify the pseudoarray image. Some of the popup windows include
clustergram and dendrogram analysis plots used with the hierarchical clustering.

When enabled, cluster data appears as blue circles or squares drawn as overlays on the pseudoarray image. These options are
discussed in the section on clustering.

Cluster analysis plotsinclude finding a subset of genes or subsets of samples based on cluster analysis of expression profile
similarity measures. These show genes belonging to particular clusters, or genes that cluster well with specified genes. Cluster
methods include: finding genes similar to the current selected gene within a"distance” threshold; K-means-like clustering where
you specify a seed gene and the number of clusters; and hierarchical clustering with clustergram and dendrogram graphics.
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Figure 2.4.5 Cluster Menu options. The hierarchical clustering option is being selected.

Use of clustering to find patterns of similar gene expression

Clustering isaway of possibly finding co-expressed genes that exhibit similar expression changesin a set of samples. Genes may
show similar co-expression, but that does not prove they are co-regulated at the same point in a pathway - merely that
measurements of those genesin a particular set of experiments show similar expression. However, identifying genes with similar
expression for which some information is already known about some of the genes may be useful as a starting point to help figure
out gene function and possibly aspects of its pathwaysin cell function using additional experiments and analysis.

There are many methods for doing clustering - each with advantages and disadvantages. We present three methods in MAExplorer
and plan on adding a variety of more powerful methods through the MAEPIugin facility under development.

These methods may find genes belonging to particular clusters or genes that cluster well with particular genes. Gene clusters are
sets of genes whose expression profiles are found to be similar according to a particular metric. We now define what we mean by
"similar". The order list of hybridized samples used in computing the expression profiles are those in the HP-E list. MAEXxplorer
has two different dissimilarity measures for C;;: Euclidean distance LSQuist; and Pearson correlation coefficient r;. These are

computed as follows and are tested against the cluster distance threshold (set by the slider in the preferences dliders). Let n= [HP-
E|, the number of samplesin the expression profile. We define similarity as (1.0 - normalized dissimilarity).
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Hint: when working with very large data sets with many samples, it may be useful to pre-adjust the distance and/or number of clusters threshold
slidersto an approximate range using the (Edit Menu | Preferences | Adjust all Filter threshold scrollers). Thisis because once the clustering starts, it
does not (currently) let you abort the clustering to change the threshold value.

LS@lStll = Sqrt( Sum( Dhj = Dhi) **2) / n

Let,

hin HP-E

i,j in Filtered genes, i not j

sumj = Sun( Dy * Dy ),
m; = (1/n)Sum Dy ),

m; = (Un)Sun( Dy ),
sunBg; = Sun( Dy * Dy ),
sunBg; = Sun( Dy * Dy ),

t hen,

[Sqrt(sunBg; - n*n*m;*mm;) * Sqrt(sunBSg; - n*n*m;*m;)]
hin HP-E

i,j in Filtered genes, i not j

The Cluster plots submenu contains a number of clustering methods. Pressing the Escape key during along cluster operation will
abort the operation. If you are in stand-alone mode using the ClusterGram, a SaveAs Gl F button will also be available for saving
the current plot as afull resolution GIF file specified by the user in a popup file browser window.:

I Cluster genes with expression profilessimilar to current gene [RB] - click on gene in image to find other genes with similar HP-E
expression profiles whose cluster distance is less than the cluster distance threshold. The larger the blue box, the higher the similarity.

™ Cluster counts of similar Filtered genes by expression profiles [RB] - draw blue circles around filtered genes indicating the number of
other genes whose cluster similarity isless than the cluster distance threshold. The larger the circle, the more similar genes were found. Clicking
on a gene switches to the above mode.

I K-means clustering of gene expression profiles [RB] - draw magenta circles around the N primary-node gene clusters representing the gene
closest to representing the center of the cluster. Each of the nodes is a maximum distance from al other nodes in the recursive definition of
nodes. N is determined by the State Scroller "# of Clusters'. Changing N will recompute the clusters. It then pops up a scrollable text window
with the clusters and indicates which genes belong to it. If you select the EP plot button, it will draw the expression profiles for the clustered
genes. The Mn-Cluster-Report button will generate report for all genes sorted by K-means cluster. Summaries can be generated using the
Mean EP plot and Mn-Cluster-Report buttons. The SaveAs GeneSets button saves all of the clusters as named Gene Sets (" Cluster #1",
"Cluster #2", etc). If you change the filter or current gene, you should explicitly use the Recompute Cluster s button to regenerate the new set of
clustered genes. When you recompute the K-means clusters, it uses the current gene as the initial node.

Hierarchical clustering of expression profiles I - this computes the hierarchical clustering of the expression profiles (normalized by HP-X
sample data for each gene) of Filtered genes. The hierarchical clusters are displayed in an ordered gene clustergram and optional dendrogram.
Sub-regions of the clustergram may be explored in more detail using the EP-subset plot button, or areport of the ordered genes can be created
using the ClustGram Report Note: you may add (remove) genes you select from the Clustergram to the E.G.L. by holding the Control (Shift)
key while clicking on the gene name.

" S.0.M. gene clusters by expr profiles[RB] - [Future MAEPIugin]

" Multi-Dimensional Scaling of genes by expr profiles[RB] - [Future MAEPlugin]

I Multi-Dimensional Scaling of genes by exprprofiles [RB] - [Future MAEPIugin]

I Clusters of (HP-E) samples asfct of Filtered genes[RB] - [Future]

[ Use correlation-coefficient else Euclidian-distance [CB] - use the (1.0 - correlation coefficient) as the distance metric instead of the defauit
Euclidean distance.

[ Scale EP vector by max magnitude prior to clustering [CB] - scale each sample in the EP by the max magnitude for all sample valuesin
the EP.

[¥! Normalize by HP-X sample else HP max intensities [CB] - normalize data by the corresponding HP-X sample data for each gene or the
maximum raw intensity for each HP in the expression profile.

[ Use median instead of mean for K-means clustering [CB] - use the clustering (see (Bickel, 2001)).

The Hierarchical Cluster plots submenu contains:

file:/lIC|tmp/MaeRefMan/hmaeFullRefMan.html (68 of 234) [11/24/2003 10:49:36 AM]


file:///C|/tmp/MaeRefMan/hmaeDocRef.html#Bickel01

MAExplorer - cDNA Microarray Exploratory Data Analysis

. [ Display Cluster Gram of gene expr profiles [CB] - compute the hierarchical clustering of the expression profiles (normalized by HP-X
sample data for each gene) of Filtered genes. Then display the hierarchical clustersin an ordered gene clustergram and optional dendrogram
when the dendrogram checkbox is selected. Expression profile plots of the clustergram may be explored in more detail using the EP plot
button that generates a scrollable list of all EP plots ordered by the same order as the clustergram. A full report of the ordered genes expression
profiles may be created using the ClustGram Report button.

. Cluse avg-arithmetic-linkage [RB] - set the hierarchical clustering linkage method to the average arithmetic linkage of sub-clusters.[ Future]

. Fuse avg-centroid-linkage [RB] - set the hierarchical clustering linkage method to average centroid linkage of sub-clusters (default).

. Duse next-min-linkage [RB] - set the hierarchical clustering linkage method to the next minimum distance sub-cluster linkage in random
order.

« ¥ Usecluster-distance matrix cache [CB] - if you do not have enough memory for clustering large gene sets, disable the cache. It will take
MUCH longer without the cache. When clustering, if there is not enough memory available for the cache, it will warn you and suggest you
either reduce the number of genes being clustered or use a computer with more memory.)

« [ Useshort elsefloat cluster-distance matrix cache [CB] - if thereis not enough memory for the set of genes you wish to cluster and you
till want to use the cache, you can use 16-hit (i.e. short) datainstead of the 32-hit (i.e. float) data. The results will be less precise.

. [ Useun-weighted else weighted average [CB] - set the hierarchical clustering vector averaging to un-weighted (the default weights it by the
number of genesin that sub-cluster). Otherwise using weighted gives equal (0.50) weighting to each sub-cluster.

Handling of hierarchical clustering of large numbers of genes - problem with slow response

The hierarchical clustering algorithm uses a gene-gene floating point (i.e. 32-bit) distance matrix of order N2 (for N data filtered
genes). Thismeans that if you are experiencing a slow response, this may be due to several factors some of which you may not be
ableto control. Y ou might:

1. If you determine that your computer is"paging”, use a computer with more memory. The currently distributed stand-alone
version will use up to 256 Mbytes of chip memory.

2. If that is not possible, reduce the number of genes being clustered. Even if you have enough memory, the computation is
gtill highif N islarge.

3. Setthe Use short elsefloat cluster-distance matrix cache option in the cluster plot menu. This reduces the memory
requirements for the distance matrix by 1/2.

2.4.5.1 Cluster genes with expression profiles similar to current gene

The Cluster geneswith expression profiles similar to current geneis used to find genes with similar HP-E expression profiles
as measured by the least square error that are less than the cluster distance threshold. It pops up the "Cluster Distance" threshold
scroller. Then click on agene in the microarray image. It then pops up up awindow with alist of the similar genes and their
expression profile distances to the current gene. Each gene that passes the cluster distance threshold test isindicated in the image
with a blue square where the size of the square is proportional to its similarity. It also displays a sorted list of the genes with the
cluster distance in the cluster panel that was popped up. On each linesis a series of *****' - the more stars the higher the similarity
to the seed gene. Thisis a silhouette plot that is used to display a sorted list of similar objects and is described to that described in
(Kaufman and Rousseeuw, 1990). Larger squares indicate that more genes are similar. Y ou may change the cluster distance
threshold and it will update the display and the list. In addition, the 'edited gene list' is set to the subset of genes that belong to the
current cluster.
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Figure 2.4.5.1 Similar genes clustered to the current gene. This method finds all genes that are similar to the current gene as those defined by their
distance between expression profiles being less than the threshold set by the user. Each gene that passes the cluster distance threshold test isindicated in
the image with a blue square where the size of the square is proportional to its similarity. This datais from the 38 samples in the MGAP database
containing duplicated spots. A) Main windows with popup cluster similarity report and cluster distance threshold slider. B) Scrollable list of EPplots of
similar genes with the red error bars indicating the variation for duplicated spots for each HP sample. The Err checkbox may turn the error bar overlays
on and off.

2.4.5.2 Cluster counts of similar filtered genes by expression profiles
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The Cluster counts of similar Filtered genes by expression profiles command analyzes the set of all Filtered genes for the
expression profile defined by the HP-E samples. It counts the number of similar genes for each Filtered gene and draws a blue
circle whose size is proportional to the number of genes similar to that gene. After it analyses these genesit lists the genes and their
countsin the cluster panel. Y ou may change the cluster distance threshold and/or Filter parameters and it will update the display
and thelist. If you click on a gene with a green circle, it will switch to single gene cluster mode (with the blue squares).

For both of these commands, if you want to view the expression profile plots, click on the EP plot button in the cluster window
and it pops up the scrollable expression profiles window. If you click on agenein the image, it will select it as the new current
gene and seed gene and recompute the cluster of genes most similar to the new see gene.

For both of these commands, if you want a permanent report, click on the "Cluster Report" button in the cluster window and it will
generate areport in the current modality (i.e. scrollable spreadsheet or tab-delimited). Y ou may switch between these two modes
by pressing the "Go '..."" button in the report.
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Figure 2.4.5.2 Display of cluster countsfor all geneslessthan the cluster threshold from MGAP 38 sample database. The algorithm counts the
number of similar genes for each Filtered gene and draws a blue circle whose size is proportional to the number of genes similar to that gene. That is
why there are alarger number of the larger circles.

2.4.5.3 K-means clustering' gene expression profiles for filtered genes

The K-means cluster gene expression profilesfor Filtered genes command searches the data Filtered gene list for the genes (i.e.
primary genes) with the N most orthogonal expression profiles. It will start this recursive computation from the gene with
minimum distance to all other genes unless you have selected a"current gene” with the mouse. All Filtered genes are assigned to
the nearest K-means primary node. The mean cluster vector is computed and used as the new definition of the cluster center. If you
set the "Use median instead of mean for K-means clustering” option in the Clustering submenu, it will compute the center as a
median instead of a mean (Bickel, 2001). K-means clustering is described in (Sneath and Sokol, 1973). A new K-means primary
gene (i.e. gene for the cluster center) isfound that is closest to this new center. Then al of the data Filtered genes are reassigned to
the new cluster centers. The mean+-stdDev of the within-cluster distance to its center is computed. It then pops up a text window
with an ordered report of the Filtered genesillustrated by part of areport shown below. [Thisis part of areport from a 38 sample
MGAP database subset of 141 genes from the set of named genes restricted by the CV datafilter.] Note that clusters where the
"Similarity" datais plotted as a silhouette plot use variable length strings of ***** is about the same for the entire cluster (e.g.
cluster #4) contain genes that probably belong together in the same cluster. Clusters that do not (e.g. Cluster 6) probably contain
two smaller more robust clusters.
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Figure 2.4.5.3 Genes clustered using the K-means cluster method. A) Using the current gene as theinitia cluster, MAExplorer finds N orthogonal
clusters assigning the set of filtered genes to these clusters using the HP-E expression profiles. All genes areiteratively assigned to these clusters. Genes
belonging to the current cluster are labeled with a green cluster number both in the array and in the scatter plot. The slider determines the number of
clusters (set to 6 here). A 2D scatter plot shows the genes belonging to cluster 6. The K-means cluster report on the right contains a sorted list of the
genesin each cluster and has buttons to generate EP plots and reports as well as summary mean EP plots (shown) and mean cluster reports. The detailed
list is shown below. B) Part of the scrollable EP plots for this data showing genes belonging to both clusters #5 and #6. C) The mean EP plots for the 6
clusters.

Cluster report for 6 K-neans clusters with 141 genes being cl ustered.
The seed gene is [1248564] Jun-B oncogene.

Clone ID Simlarity Cluster-# Distance-to-cluster Gene-Nane

1248411 R E KKK XK XXX XK ] Cluster [26 genes] in cluster [distNext: 1.035] wi Cdist:m+-sd=1.223+-0.453
Cv=0.371 Calpactin | light chain

1381592  xxxkkkkxxk 1 0.448 Surfeit gene 4

1247956 *okokok ok ok ok ok k 1 0.706 Protein kinase, cAWP dependent, catalytic, beta

1381836  rxxkkkxx 1 0.761 Prohibitin

1382325 *ok ok ok ok k k% 1 0.771 M nusculus nRNA for C1D protein

1248270 il 1 0.775 Seven in absentia 1A

1247716 IO 1 0.794 Lipoprotein |ipase

1248184 *okokokok ok ok x 1 0.847 Mus nuscul us bronpbdomai n- cont ai ni ng protein BP75 nRNA, conpl ete cds
1248564 oo 1 0.864 Jun-B oncogene

1382667  xxxxkxx 1 0.888 SERI NE/ THREONI NE PROTEI N PHOSPHATASE PP2A- BETA, CATALYTI C SUBUNI T
1382561 i 1 0.931 Mus nuscul us GTP-specific succinyl -CoA synthetase beta subunit (Scs) nRNA,
partial cds

1248089 i 1 1.013 M nuscul us RPS3a gene

1247780 il 1 1.088 Proprotein convertase subtilisin/kexin type 7

1247557 i 1 1.104 M nusculus L28 nRNA for ribosomal protein L28

1248321 i 1 1.278 Decay accelerating factor 1

1382751  xx** 1 1.311 Custerin

1382007 *ok ok x 1 1.357 Murine nRNA with honol ogy to yeast L29 ribosonal protein gene
1382074 *okokok 1 1.390 Oosonucoid 1

1381963  **** 1 1.417 Mnusculus nRNA for ribosonal protein L36

1248278 *x 1 1.658 HI STONE H3. 3

1247630 *x 1 1.675 Procollagen, type I, alpha 2

1247865 * 1 1.837 Mouse beta-D gal act osi dase fusion protein nRNA, conpl ete cds

1382236 * 1 1.85 Caspase 7

1247833 1 1.882 Mus nuscul us radio-resistance/ chenp-resistance/cell cycle checkpoint control
protein (Rad9) nRNA, conplete cds

1248535 1 1.953 M nusculus nRNA for sel enoprotein P

1247702 1 2.157 Cytochrone C oxidase, subunit Va

1382282 FrRr KKK XK XX XXX D Cluster [13 genes] in cluster [distNext: 24.199] wi Cdist:m+-sd=16. 184+-6. 667
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TRANSPLANTATI ON ANTI GEN P35B

Prol yl 4-hydroxyl ase, beta pol ypeptide

Mouse nRNA for osteoblast specific factor 2 (OSF-2)

Mis muscul us vacuol ar adenosi ne triphosphatase subunit A gene, conplete cds
T-conplex protein 1, related sequence 1

Mis muscul us cytochronme c oxidase subunit Vlila-L precursor (Cox7al) nRNA,
conpl ete cds

Cat hepsin D

Mus muscul us endot hel i al nopnocyte-activating polypeptide | nmRNA, conplete

Stromal cell derived factor 5

Mis muscul us FK-506 bi nding protein honol og (SAML1) nRNA, conplete cds
d ut at hi one- S-transferase, al pha 3

House npuse; Muscul us donesticus kidney nRNA for Phosphatidic acid

[22 genes] in cluster [distNext: 11.979] w Cdi st: m+-sd=7.559+-3. 347

Mis nuscul us Btk | ocus, al pha-D- gal actosidase A (Ags), ribosomal protein
enes, conplete cds

Cell division cycle 42

EST

Mirine nRNA for integrin beta subunit

EST

Mis nuscul us nmRNA for peroxi somal integral nenbrane protein PMP34

Mius nuscul us UDP- Gal NAc: pol ypepti de N-acetyl gal act osam nyl transferase-T3

Mus muscul us thioredoxin nRNA, nucl ear gene encoding mtochondrial protein,

N-term nal Asn anmi dase

36 Mus nusculus N-nyristoyltransferase 1 nRNA, conplete cds

Mus nuscul us WDR protein nRNA, conpl ete cds
Erythrocyte protein band 7.2

67 M nuscul us BAP31 nRNA

Apol i poprotein D
Sterol O acyltransferase 1

42 Sterol O acyltransferase 1

Mius donesticus nucl ear binding factor NF2d9 nRNA, conpl ete cds
Thyroid autoantigen 70 kDa

Vol t age- dependent ani on channel 2

M nuscul us mRNA for MAP ki nase-activated protein kinase 2

Casei n al pha

[44 genes] in cluster [distNext: 1.035] wi Cdist:m+-sd=0.439+-0.266

RAS-rel ated C3 botulinumsubstrate 1
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alternatively spliced p67 nRNA, and alternatively spliced p93 nRNA, conpl ete cds
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Abl -interactor 1
Mus muscul us mRNA for ZI P-kinase, conplete cds

.26 Mius nuscul us proteasone al pha7/C8 subunit nRNA, conpl ete cds

Muse MA-3 (apoptosis-related gene) nRNA, conpl ete cds

Transcription elongation factor B (SII1), polypeptide 1 (15 kDa), -1ike
Mis nuscul us nRNA for ryudocan core protein, conplete cds

Mus nuscul us thioredoxin-related protein nRNA, conpl ete cds

I nhibitor of DNA binding 2

Li pocortin 1

Interferon beta, fibroblast

Mis nuscul us beta prine coatoner protein nRNA, partial cds

34 House nouse; Miscul us donesticus male brain nRNA for ARF1l, conplete cds

Thymoma viral proto-oncogene
Monoki ne i nduced by gamma interferon
Mis nuscul us mtogen-activated protein kinase-activated protein kinase nmRNA,

Protei n tyrosi ne phosphatase, receptor type, D

Prot ease (prosome, macropain) 28 subunit, beta

Mus mnuscul us al pha- net hyl acyl - CoA racemase nRNA, conpl ete cds
Lysosomal nenbrane gl ycoprotein 1

Tight junction protein 1

Reti nobl astoma 1

PROBABLE CALCI UM BI NDI NG PROTEI N PMP41

Mus nmusculus MRJ (Mj) nRNA, conplete cds

Max protein

SRY-box contai ning gene 17

Mis nuscul us heat shock transcription factor 1 (Hsf1) gene, partial cds
Mis nuscul us Supl 15h gene

Fi brobl ast growh factor inducible 14

St ear oyl - coenzyme A desaturase 1

Muse nRNA for PAP-1, conplete cds

CLUTATHI ONE S- TRANSFERASE GT8. 7

Cartilage derived retinoic acid sensitive protein

file:/lIC|tmp/MaeRefMan/hmaeFullRefMan.html (74 of 234) [11/24/2003 10:49:36 AM]



MAExplorer - cDNA Microarray Exploratory Data Analysis

1381636  ****xxxx 4 0.567 Lynphotoxin B

1381920 *ok ok ok ok k k% 4 0.569 Mus nuscul us nRNA for NEFA protein, conplete cds

1247757 KKKk Kk K 4 0.596 Granzyne B

1382094 *okokokok ok ok x 4 0.609 High nobility group protein 1

1247545 *okok ok ok ok ok x 4 0.638 Carbon catabolite repression 4 honolog (S. cerevisiae)

1247607 *ok ok 4 1.188 POLYADENYLATE- Bl NDI NG PROTEI N

1247727 4 1. 667 Mal ate dehydrogenase, mtochondri al

1248244 FrRxxxkxx XXX G Cluster [19 genes] in cluster [distNext: 3.473] wi Cdist: m+-sd=4.273+-2. 059
Cv=0.482 CD80 antigen

1248534 kokokokokok ok ok k% 5 1. 648 Carbonyl reductase

1247764 ok kK ok ok k% 5 1.776 H 2 CLASS Il H STOCOWPATI BI LI TY ANTI GEN, GAMVA CHAI N

1381933 *ok ok ok ok ok ok ok k 5) 2.345 Mouse rpS17 nRNA for ribosomal protein S17, conplete cds

1381616 ok ok ok ok ok k ok 5 2.42 Mus nuscul us oral tunor suppressor honolog (Doc-1) nRNA, partial cds
1248232 *ok ok ok ok k ok ok ok 5 2.486 Mus nuscul us putative glycogen storage disease type 1lb protein nRNA,
conpl ete cds

1382644  *rEExxxx 5] 2.717 Cyclin G

1248125 *okokok ok ok k% 5) 2.791 Histoconpatibility 2, class Il, |ocus M2

1247799 *ok ok ok ok ok k% 5) 2.869 Mus nuscul us signal recognition particle receptor beta subunit nRNA
conpl ete cds

1247708  xx**kkxx 3 3.024 Ephrin Al

1247932 USRI 5 4.235 Mus nuscul us (clone: pMAT1) nRNA, conpl ete cds

1382515 il 5 4.668 ATPase, Na+/ K+ beta 3 pol ypeptide

1248586 i 5) 4.838 Mus nusculus viral envelope like protein (Gre) gene, conplete cds
1248198 i 5) 5.874 Mus nusculus D9 splice variant 2 nRNA, conplete cds

1381623 *x 5 6.224 Stearoyl-coenzyne A desaturase 1

1382086 * 5 6.885 Mus nusculus (strain C57Bl/6) nmRNA sequence

1247887 & 5 7.014 Mouse chronpsone 6 BAC 284H12 (Research Genetics nouse BAC library) conplete
sequence

1247886 5 7.810 Cut (Drosophila)-like 1

1248303 5] 8.094 Lipopol ysaccharide response

1247621 FrRrxx KX XXX XXXK G Cluster [17 genes] in cluster [distNext: 19.157] wi Cdist:m+-sd=12. 410+- 3. 024
CVv=0.244 Mus nuscul us Lsc (Isc) oncogene nRNA, conplete cds

1248050 *okok ok ok ok ok 6 7.407 Mus nuscul us C57BL/6J ribosonmal protein S28 nRNA, conplete cds
1247698 ol 6 7.571 Adipocyte protein aP2

1248240 i 6 9.198 Mus nuscul us nRNA, conplete cds

1247862 DUDD 6 9.844 Mus nusculus Nmi nRNA, conpl ete cds

1382162 *ok ok ok 6 10. 330 CAMP responsive el enent nodul at or

1248398 IS 6 11. 007 Mouse nRNA for ribosomal protein S12

1248281 i 6 11.143 M nuscul us mRNA for histone H3.3A

1247852 i 6 11.576 Twi st gene honol og, (Drosophil a)

1381991 ** 6 12.809 Prolyl 4-hydroxylase, beta pol ypeptide

1382753 ** 6 13.019 Mus nuscul us cl eavage and pol yadenyl ati on specificity factor (MCPSF) nRNA,
conpl ete cds

1248368 & 6 13.639 Mus nuscul us ribosomal protein S26 (RPS26) nRNA, conpl ete cds
1247639 * 6 13.692 SRY-box containing gene 4

1248435 6 14.262 Thynus cell antigen 1, theta

1247961 6 14.75 ATP SYNTHASE ALPHA CHAI N, M TOCHONDRI AL PRECURSOR

1248344 6 15.217 «@ut enriched Kruppel-like factor

1382234 6 16.351 CD8 antigen, beta chain

We call the genes closest to the "center" of the K clusters primary genes and they are reported with additional information. The
"Cluster [# genes]" entries in the distance-to-cluster fields indicates that these genes are the center of the clusters (i.e. primary
genes). The distNext is the distance from this cluster center to the next nearest K-means cluster center. The number of clusters N (6
in this example) is set in the popup state scroller. If you change the value of N, it will recompute the clusters and the primary
genes.

It draws magenta circles around the primary genesin the microarray and the cluster number to the right of the circle. The size of a
circle corresponds to the number of genes clustered with that circle. If you click on a gene belonging to any cluster, it defines that
cluster asthe "current cluster”. It will change the labels of the subset of genes that belong to the current gene from red (white)
circleto agreen (yellow) cluster number of the current cluster in the intensity (ratio) pseudoarray image. In addition, the 'edited
genelist' is set to the subset of genes that belong to the current cluster. If you are aso displaying a scatter plot, genesin the current
cluster have their red '+' characters changed to the cluster number.

You can click on that genein the array image to determine its identity. Y ou may also popup an ordered (same as the above report)
plot of the clusters expression profiles by clicking on the EP plot button. Y ou may plot the mean expression profiles of the N
clusters using the M ean EP plot button. Y ou may generate areport of all of the clustered genes or of the mean clusters using the
Cluster-Report or Mn-Cluster-Report buttons respectively. If you change the Filter conditions, you may recompute the clusters
using the Recompute Cluster s button. Closing the text window will remove the magenta circles. If you selected the current
cluster, the genesthat belong to it will still be available in the 'edited gene list' for making reports, saving as a gene subset or for
additional gene filtering. If you press the SaveAs GeneSets button, then K gene sets are created with the names "Cluster#1",
"Cluster#2", ..., "Cluster#K". Y ou can then save or rename the clusters you want and delete the rest. If you press the Cluster Gram
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button, it displays the gene sets in a cluster gram order the same way as the cluster report.

2.4.5.4 Hierarchical clustering of expression profiles

The Hierarchical clustering of expression profiles computes the hierarchical clustering of the expression profiles of data Filtered
genes and displays a clustergram and optional dendrogram. Hierarchical clustering is described in (_Sneath and Sokol, 1973). The
gene datais normalized either by the corresponding HP-X sample data for each gene or the maximum raw intensities for each HP
samplein the expression profile set by the Normalize by HP-X else HP's max intensities menu toggle. There are three types of
clustering linkages: average-arithmetic-linkage, aver age-centr oid-linkage, and next minimum linkage. These may be modified
using the weighted aver age that gives equi-weighting to the child clustersin computing the mean of a new cluster, and un-
weighted-aver age that weights them by the number of non-terminal clusters. The average-linkage clustering is very compute
intensive and takes a while. The next-minimum-linkage is much faster and may result in adequate clustering for some situations.

Clustering is represented by a binary tree and is visualized as an ordered gene clustergram and optional dendrogram sub-plot. This
issimilar to the methods of (DeRisi, 1996), (Eisen, 1998), and (White, 1999). Currently, MAExplorer does 1-way clustering - not
the 2-way clustering of (Weinstein, 1998) and (Eisen, 1998). Each row of the clustergram represents a gene and each column
represents a HP in the HP-E list of samples. Each box in arow represents the normalized expression of that gene for the HP
represented in that column. The color of the box is one of 9 colors representing the normalized expression ranges and assigned
according to the following table:

Table 2.4.5.4. Cluster Gram pseudocolor assignments. The colors are assigned to "box" entriesin the clustergram corresponding
to genes. The color represents data as either the X/Y ratio or X-Y Zdiff relative to the normalizing HP.

bright green dark green Black dark red bright red
<1/8X 1/6X 1/4X 1/2X IX 2X 4X 6X >8X

The current gene may be set by clicking on arow that is then highlighted in green. If you click on a colored box, it will aso report
the HP name for that column and its normalized expression value (highlighting that box with awhite circle). If the Web genomic
databases are enabled (through the View menu, then it will also popup a Web page for that gene). If you set the current gene in any
of the array, scatter plot, gene guesser, etc. displays, it will set it for and position the clustergram at that gene. If the Dendr ogram
checkbox is enabled, then a dendrogram is drawn to the left of the clustergram boxes. Clicking on aregion in the dendrogram sets
adistance threshold (displayed at the top) and displays al parts of the dendrogram tree in red that have a cluster distance less than
what you defined. If the zoom nnX button is pressed, then the of dendrogram drawing is magnified by nnnn-fold to make highly
similar clusters more visible. Pressing the button repeatedly cycles through: 1X, 2X, 5X, 10X, 20X. Sub-regions of the clustergram
may be explored in more detail using the EP plot button that pops up a scrollable window of the ordered gene list. Y ou may
generate multiple EP-subset plots so as to compare different parts of the clustergram. A report of al of the ordered genes may be
created using the ClustGram Report button. The Show HP names button pops up a numbered list of all samples used in the
expression profiles and clustergram. This report has al of the normalized expression profiles on the right side of the report.
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Figure 2.4.5.4 Hierarchical clustering clustergram of genesfiltered by ratio histogram binsfor 19 samples from the MGAP data set. The hybridized
samples are drawn as colored boxes in the 19 columns. Rows of boxes correspond to gene expression profiles. In A), the set of all genes and ESTswas
filtered by the CV filter set to 0.387 and the normalization was the Zscore. The gene "Mus musculus D9 spice variant 2 mRNA, complete cds' was
selected as the current gene in the clustergram. Data for this gene and the selected HP column isindicated at the top of the clustergram. Thelist of the 19
samplesis shown on the left. B) Details of clustergram and dendrogram are shown where the user had selected a cluster distance threshold at "Mouse
mRNA for mitochondria cytochrome c oxidase subunit Vb" in the dendrogram part of the plot (zoomed by 2X). This selection draws all parts of the
dendrogram tree that are less than this distance are drawn in red. C) shows the manual selection of genes from the ClusterGram or Dendrogram by
clicking on the genes names you wish to capture in the Edited Gene List (EGL) while the Control key is pressed. The zoomed subregion shows three
genes in the same cluster that were selected (magenta stars in the right edge of the ClusterGram).

[ SRS S

2.4.6 Report menu
Various reports summarizing gene or sample data may be generated and appear in popup tables. These include:

. Dataon al of the hybridized samples in the database including links to related Web databases

. Dataon additional quantification and descriptive information on the hybridized array samplesin the database

. Hybridized sample calibration, Samples vs. Samples correlation coefficient of Filtered genes, and mean & variance tables

. Tablesof al named genes, the calibration DNA genes, etc.

. A table of genesin the 'Edited Gene List'

. A table of genesin the current Gene Class

. A table of genes passing the "Filter"

. The N genes with the highest or lowest ratios (HP-X/HP-Y or F1/F2) of the Filtered genes (N defaults to 100, but may be
changed as a Preference)

. Tablesof additional datafor the Filtered genesincluding expression profile ratios, HP-X vs. HP-Y 'set’ statisticsif the data
is enabled for using HP-X and HP-Y 'set' data. If you are doing at-test of Kolmogorov-Smirnov test, then it reports the p-
value and test statistics.

. Tableof statistics on F-test on the current Ordered Condition List of samples/condition, including p-value and F-test
statistics.

. Tablesof correlation coefficient statistics of data Filtered genes comparing al samplesin the HP-E list against each other.

. Tablesare presented as either: a) an active "clickable" spreadsheet that may contain links to Web sites and pops up a Web
browser window to that site (e.g. histology links or model system in the array report), or display additional gene features
and numeric comparisons. b) tab-delimited text that may be "cut" and then "pasted” into an Excel type spreadsheet for
further analysis.

. Additional expression profile data (from the HP-E samples) and/or statistical data from the HP-X vs. HP-Y 'sets' may be
included in gene report tables.

. Clicking on a column name in the dynamic report will sort the report by datain the report in ascending and descending
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Figure 2.4.6 Reports menu. Y ou may create either dynamic or tab-delimited text reports of either Samples or of subsets of genes.

These may be presented as interactive dynamic tables as well as scrollable text windows capable of being exported to Excel. If
Web DB access is enabled, clicking on an entry will bring up a Web browser with access to GenBank data. If the report contains
Clone ID as one of the fields, you can click on it to have it define that gene as the current gene and highlight it in the microarray
image or scatter plot (if it is being used). The reports are divided into two types - those dealing with lists of arrays (i.e. the sample
experimental condition) and those dealing with lists of genes.

The Report menu includes:

. Array rggortsE - show tables of sample array information.
. Gene rgportsE - show tables of sets of genes information.

. Tableformatl® - generates the table as 'Spreadsheet’, 'Tab delimited', or ‘Name=Vaue list'.
. Tablefont sizd® - changes the report font size from default 10 point.

2.4.6.1 Array report menu - hybridized samples global data

Y ou may generate reports of sample array information. The first two menu selections contain descriptive information about
specific hybridized microarrays samples. The "Extra Samplesinfo" contains quantitative and extra descriptive information (if
available for your database).

The "Samples vs Samples correlation coefficients' computes the correlation coefficients in an upper diagonal matrix for the current
set of Filtered genes showing HP samples similarity. Then entries are of the following form where HP:1 and HP:2 correspond to
samples listed in the field names of the table and the data is the intensity values using the current normalization method.

r Sq=0. 748, n=1656, HP: 1(mm+-sd)=(28991+-19564), HP: 2(m+-sd)=(5044+-9766)

The "Calibration DNA summary" table contains the computed means, std-dev, and computed normalization scale factor for al
active hybridized samples. The scale factors are used if the 'Calibration DNA' normalization is used.
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Y ou must set the Web access checkbox if you want to click on a blue hyperlink in the resulting report to access an associated Web
database.

Samplesinfo - show table of all samples accessible in the database.
Samples Web links - show table of Web links for all sample samples accessible in the database.
MAE Projects DB - show table of project databases if the project startup database exists (stand-alone mode).
Extrainfo on Samples - show table of additional information on all of the samplesin the database.

Sample vs Sample correlation coefficients - show table of correlation coefficients for all HP-E selected samples for genes meeting the data

Filter criteria.

'Calibration DNA' summary - show atable of means, std-dev, scale factor for all HP-E selected samples.

HP mean & variance summary - show table of means, std-dev, min, max, etc. of raw intensity data for all HP-E selected samples.
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Figure 2.4.6.1 Hybridized samples dynamic Report windows. A) Samples Info report. B) Sample Web links. Clicking on a blue hypertext link brings
up the corresponding genomic Web database entry in a separate Web browser window if the Web accessis enabled. The tab-delimited version of the
same reports (not shown) may be cut and then pasted into other programs such as an Excel spreadsheet. C) HP vs HP correlation table on genes passing
the data Filter for all samplesin the HP-=E list.

2.4.6.2 Gene reports menu

Y ou may generate gene reports with various additional options. Y ou must set the Web access checkbox if you want to click on a
blue hyperlink in the resulting report to access an associated Web database. In addition, specialized gene reports may be generated
from some of the cluster plot command windows. These include lists of genes sorted by cluster (K-means cluster #), by
hierarchical cluster order, by similarity to agene, etc. The mean cluster expression values may be reported for K-means clustering.

« All named genes - show table of all genes where the geneis named.

. Genesin 'Edited GeneList' - show table of genesin the 'Edited Gene List'.

. Genesin 'Normalization GeneList' - show table of genesin the ‘'Normalization Gene List'.
« Genesin GeneClass - show table of genesin the current gene class.

. Filtered genereports® - show genes that meet the data Filter criteria.

2.4.6.2.1 Filtered gene reports menu

Y ou may generate gene reports of Filtered genes with various additional presentation options. In the highest/lowest N genes, N
defaults to 100 and is set by (Report | Table format | Set max # genes in highest/lowest report) command.

. Genespassing the Filter - al genes passing the Filter

. Highest HP-XY ratios or Zdiff - top N Filtered genes

« Lowest HP-XY ratiosor Zdiff - lowest N Filtered genes

« Highest FU/F2ratiosor Zdiffs- top N Filtered genes (if duplicates). If ratio data, then highest Cy3/Cy5

. Lowest F1/F2ratiosor Zdiffs- lowest N Filtered genes (if duplicates). If ratio data, then lowest Cy3/Cy5.

« Expression profilesFiltered genes - show numeric expression ratios for HP-E data scaled to the first HP in HP-E.

« HP-XY 'set' statistics of Filtered genes - show (mean,stdDev,CV,n) datafor both the HP-X and HP-Y sets. If thet-Test is active, aso show (p-
value, df, t-statistic, pF-sameValue). If the Kolmogorov-Smirnov test is active, then it reports the (p-value, df, D-statistic).

. Ordered Condition list statistics of Filtered genes- for the current OCL if the F-test is active, show the (f-statistic, dfWithin, df Between,
mnSgWithin, mnSgBetween) (mean,stdDev,CV,n) data for each condition.

If Cy3/Cy5 ratio datais being analyzed, then the Highest (Lowest) F1/F2 entries become

. Highest Cy3Cy5ratiosor Zdiffs- top N Filtered genes (if duplicates)
. Lowest Cy3Cy5ratiosor Zdiffs- lowest N Filtered genes (if duplicates)
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Figure 2.4.6.2 Gene Report windows of 50 named genes with highest HP-X/HP-Y 'set’ ratios. A) Dynamic gene report of 50 genes with highest HP-
X/HP-Y 'set' ratios. A similar report may be generated for the lowest ratios or for single HP-X/HP-Y samples. This type of report may be generated for
the highest or lowest Zdiff values when the Zscore normalizations are used. Clicking on a blue hypertext link brings up the corresponding genomic Web
database entry in a separate Web browser window if the Web accessis enabled. It also sets the current gene to the gene for that row. B) The tab-

delimited version of the same report may be cut and then pasted into other programs such as an Excel spreadsheet.

2.4.6.3 Table format men

Thereport is presented as a table. However, it may be visualized several different ways. The scrollable spreadsheet includes the
ability to click on blue hypertext items and have a Web browser pop up for that item on a Web database (e.g. GenBank, dbEST,
UniGene, LocusLink, mAdb Genes, GeneCard, etc). The tab-delimited option enables you to cut the table and pasteit into a
separate spreadsheet program such as Excel. Y ou may aso extend the datain the table to by 'Adding’ expression profile ratios and

u

statistics from the HP-X and HP-Y 'set' comparisons.

. ¥ Spreadsheet [RB] - some cells (indicated by blue) are connected Web databases that are accessed by clicking on them (defauilt).

. [ Tab delimited - suitable for export [RB] - asin Excel, etc.

« [ Set max # genesin highest/lowest report or filter [CB] - sets the number of genes N to report or use in data Filter.

. [ Add EP datato Gene-Reports [CB] - for each of the samplesin HP-E.

« [ UseEP datain Gene-Reports[CB] - use raw EP data (under the current normalization) else use data normalized to 0.0 to 1.0 by maximum

value for all genes being displayed.
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« [/ Add HP-X/-Y 'set' statistics data to Gene-Reports [CB] - that includes (mean,stdDev,CV,n) for both the HP-X and HP-Y sets.

2.4.6.4 Table font size menu

For wider tables, you can see more information if you use a smaller font to display the table. The font sizes available are:

. [ 12pt [RB]
. % 10pt [RB] - (the defauit size)
. [l8pt[RB]
_——— ——— e ————m

2.5 View menu

The View menu options are used to modify the view of genes visible in the pseudoarray image. Genes may be displayed with
additional properties or capabilities including access to Web-based genomic database entries for specific genes. Note that
depending on your particular database, if some genomic identifiers are not available then the corresponding "Enable display
current gene in genomic DB Web browser" will not appear in the menu.
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Figure 2.5 View Menu options. These are divided into various options for modifying the presentation as well as recording activity such as the messages

or history popup scrollable log windows.

. [ Show 'Edited Gene List' [CB] - toggle showing the EGL as magenta boxes in the pseudoarray image. If enabled, genes

set by manual selection or as the result of some filtering operations (see Edit menu, the Filter and Clustering)

. I Enabledisplay current genein GenBank Web Browser [RB] - when click on agene in microarray image or scatter

plot to access NCBI data. It will use RefSeqID dataif available.
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. I Enabledisplay current genein dbEST Web Browser [RB] - when click on agene in microarray image or scatter plot
to access NCBI data.

. I Enabledisplay current genein Unigene Web Browser [RB] - when click on agene in microarray image or scatter plot
to access NCBI data.

. " Enabledisplay current genein mAdb Web Browser [RB] - when click on agene in microarray image or scatter plot
to access NCI/CIT data.

. 7 Enabledisplay current genein LocusLink Web Browser [RB] - when click on a gene in microarray image or scatter
plot to access NCBI LocusLink data (by Locus ID if available, and GenBank ID if it] is not).

. 7 Enabledisplay current genein OMIM Web Browser [RB] - when click on a gene in microarray image or scatter plot
to access NCBI OMIM databy OMIM ID if available.

. [¥ Show Filtered spotsin array [CB] - if on, show Filtered genesin the microarray image using circle overlays just
outside of each spot. Genes not passing the Filter have no circle.

. [¥ Gang F1-F2 scrolling [CB] - toggle gang scrolling. If on, gang measure F1 and F2 when click on one of them. If off,
only measure only the spot that you click on.

. ¥ Show mouse-over info [CB] - toggle mouse over. If enabled, report HP or gene details when the mouse is moved over
the sample names or spotsin the array image or genesin scatterplot or expression profile overlay plot.

. [ Presentation view mode [CB] - toggle presentation mode. If enabled, increase the fonts to 12pt and draw darker circles,
sguares, and "+" so the display details are easier to see when projecting the display or making dlides.

. [ Color scheme (red-green) or dichromasy [CB] - toggle between two color schemes red-green and orange-blue for
dichromasy which may be easier for some people.

. [ Show log of messages [CB] - toggle message logging mode. If on, it pops up a scrollable log of all messages to the three
line status area. Thisis useful for recording measurements and other activity. The messages may be saved in log file.

. [ Show log of command history [CB] - toggle command history logging mode. If enabled, it pops up a scrollable history
of all commands issued to MAExplorer. The commands are automatically numbered. Thisis useful for recording what steps
you took during an analysis. The history may be saved in log file.
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Figure 2.5. Popup genomic browser database page. A) The UniGene Web page pops up in anew Web browser window when the user clickson a
genein the array image, 2D scatter plot or Report and the view is set to "Display current genein Unigene Web Browser" toggle was enabled in the View
menu. The current gene was "Jun-B oncogene'. Alternatively, the B) mAdb Gene DB may be selected - as well as GenBank or dbEST genomic
databases. C) Alternatively, data from the NCBI LocusLink database may be accessed if either the GenBank ID or LocusID is available.
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2.5.1 Logging MAExplorer messages

MAExplorer shows various data measurements as well as many other types of information in the three text lines in the status area
of the main window. The Show log of messages pops up a scrollable log of all messages to the three line status area. Thisis useful
for recording measurements and other activity. The messages may be saved in log file (typically maeMessages.log). Figure 2.5.2
shows an exampl e of the messages popup log window. Clicking on genes in the pseudoarray image or in plots will log the gene
data (see Section 3.3) given the current normalization, Samples use (single or multiple), and pseudoarray display mode. The
current values of all of the State Threshold scrollers are saved in the message |og when the (Edit menu | Preferences | Adjust all
Filter threshold scrollers) State Thresholds popup window is closed. Thisis useful for capturing the current settings at any time.

2.5.2 Logging command history

During a datamining session, the user will typically execute many commands from the menu as well as clicking on genesin the
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pseudoarray image or in plots. It is useful to recording the steps you took during this analysis. The Show log of command history
pops up ascrollable history of al commands issued to MAEXxplorer. The commands are automatically numbered. The history may
be saved in log file (typically maeHistory.log). Figure 2.5.2 shows an example of the command history popup log window.
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Figure 2.5.2 Examples of messages and command history popup log windows. Measurements and other activity are shown in more detail in the
messages window whereas the command history indicates commands (numbered in the order they are executed) in the command history window. Data
from either of these windows may be saved in text log files.

2.6 Plugins menu

MAExplorer may be extended by users to use new analysis methods using Java plugins. We call these new methods MAEPIugins
which are small Java programs written by users that may be dynamically loaded into MAExplorer and then applied to their data.
These plugins will include plugins written by LECB, those written by academic or commercia groups. See the MAEplugins for
details. If you have a Java compiled plugin in the form of either a Java.class or .jar file, you may load it at run time using the
"Load plugin" command in the Plugins menu. If specified in the MAEPIugin, it will be added to the appropriate menu in the
MAExplorer menu tree at the end of the specified submenu (see Appendix C. Table C.5.7). If this submenu "stub" is not specified,

it will placeinthe list of pluginsin the Plugins menu (e.g. plugin #1, ..., plugin #n).
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MAEPugin Design
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Get and Put
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Figure 2.6 MAEPIugins paradigm. If you have aMAEPIugin .jar file, then it may be specified using the "Load plugin” command. When you invoke
the command from the menus (or other methods), it accesses data from the current MAEXxplorer database it may need from the Open Java API.

The Plugins menu includes:

. Load plugin - popup abrowser to load a MAEPIugin jar file
. Unload plugin(s) - popup a selector to pick MAEPIugins to unload

. RLO methodsE - list of executable R methods (R LayOuts). These may be added by the user using the RtestPlugin. An.
RLO analysis alows you to export data from MAEXxplorer, execute it with the R program, and import the R results back
into MAExplorer. [Thisisunder development and is alpha-level.]

. SaveRLO reportsin time-stamped Report/ folder [CB] - puts files generated by R from successive executions of the
same RL O into separate sub-foldersin the Report/ folder with names "RLOname-YYMMDD-HHMMSS/" to peep the data
separate.

. plugin #1 - 1st MAEPIugin added
. plugin #2 - 2nd MAEPIugin added

. plugin #n - n'th MAEPIugin added
RLO methods menu

This contains alist of executable R analyses methods (called R LayOuts or RLOs created with the RtestPlugin) for evaluating
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MAExplorer datawith R analysis scripts. It isonly availableif you have installed the R language program (www.r-project.org) on
your computer. An RLO analysis allows you to automatically export data from MAEXxplorer, execute it with the associated R
program, and import the R results back into MAExplorer. [Thisisunder development and is alpha-level.] A recent poster on
Extending MAExplorer with R is available as a PDF file.

The Save RLO reportsin time-stamped Report/ folder [CB] options puts files generated by R from successive executions of the
same RL O into separate sub-foldersin the Report/ folder with names "RLOname-YY MMDD-HHMMSS/" to peep the data
separate. Thisis useful when you want to compare results from the same RL O method but with different MAExplorer
preprocessing.

Y ou may download the latest versions of all plugins using the (File | Update Plugins from maexpl orer.sourceforge.net) menu
command. Similarly, you can update your versions of the RLO methods using (File | Update RL O methods from
maexplorer.sourceforge.net

2.6.1 Example of using a Plugin

This shows a short demonstration of what isinvolved in using a MAEPIugin. The user first load the plugin from the disk.
Generally the plugins .jar or .classfiles are stored in the Pluging directory where you have installed MAExplorer. Then they load a
particular plugin which installs it in the Plugins pull-down menu. Then they revisit that menu to invoke the particular plugin. You
may load any number of plugins (until you run out of computer memory if that should occur).
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Figure 2.6.1 L oading a MAEPIugin from your file system using the L oad Plugins command in the Plugins pull down menu. If you have a plugin
Jar or .classfile, it may be specified using the "Load plugin" command. This pops up afile browser to let you specify the plugin file.
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Figure 2.6.2 Executing the new command previously loaded in the Plugin menu. Selecting the new "Show List Active Filters' command that now
appears in the Plugins menu invokes the plugin. This pops up areport shown in the next figure.
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Figure 2.6.3 Popup window from executing the M AEPIugin. This plugin gives afull report on the data Filter status in a new pop up window.
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Figure 2.6.2 Plugins menu - executing a previously loaded plugin. Plugins that do not go into particular MAExplorer submenus go into the Plugins
menu. Selecting the command will invoke that MAEP ugin.

2.7 Help menu

Various on-line help and documents are available if you are connected to the Internet. These will appear in a separate pop-up Web
browser window so you may view them while working with MAExplorer. This includes on-line documentation (including this
reference manual), tutorials, and other information. This may be links to other Web pages describing key areas of specific
databases. For example, for the MGAP database, the point back to key areas of MGAP including the MGAP Anima Models,
Histology atlas, etc. Y ou can then use the browser's " Save as* and "Print" options to save the datato afile or print it.

The Help menu includes:

. Home page - MAEXxplorer home page on SourceForge.net

. Introduction - to MAEXxplorer

. Overview - overview of MAExplorer capabilities

. Short tutorial - simple tutorial of thingsto try in MAExplorer (Appendix A)

. Advanced tutorial - advanced tutoria of thingsto try in MAExplorer (Appendix B)
. Menu summary - short summary of the MAEXxplorer menus.

. Reference manual - this Reference Manual document

. MAEPIugins - plugin home page for MAExplorer

. Introtodata mining - for MAExplorer, (Chapter 3)

. Glossary - glossary of terms used in MAExplorer Reference Manual
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. Index - Index of terms used in MAEXxplorer Reference Manual

Database-specific help menu entries -
entries defined for a particular database (see below)

. About - show MAExplorer authors, version and revision date

2.7.1 Adding custom help links to your database to the Help menu

These Database-specific help menu entrieslist of entries are keyed to the database you are using and may be customized by the
database maintainer in the configuration file (Section C.5.6) to links relating to the particular database. For example, database
specific help for the MGAP databaseis:

. List of hybridized samples - available from MGAP.
. MGAP animal models - animal models used in MGAP.
. MGAP home page - Mammary Genome Anatomy Program

= - SRS SNS— S

3. Exploratory Data Analysis - Introduction to Data Mining

Data mining is the uncovering of relevant patterns of interest in data from a particular problem domain (Tukey, 1977). Typically
thisinvolves using various statistical techniques to identify the patterns including cluster analysis. See StatSoft Inc's, 2002 on-line
statistics textbook for definitions of clustering and other statistical terms. Researchers across a wide range of fields such as (Tufte,
1997) and (Cleveland, 1985) have suggested that a major aspect of this problem is finding the correct means of graphical
presentation to allow humans to be a part of the pattern recognition process. Tufte argues that the proper display of quantitative
datain the context of the problem domain can aid in the understanding of complex sets of data. This carries over to the analysis of
microarrays with data mining involves having statistical, genomic knowledge database, and graphical components for success.
(Jagota, 2001) discusses a number of methods and applications for microarray data analysis and visualization. Other useful
resources are the sets of papersin (" Chipping Forecast", Nature Genetics supplement, Jan, 1999), and (_"Chipping Forecast 11,
Nature Genetics supplement, Dec, 2002).

This section briefly addresses some of the issues you need to consider. However, afull discussion of the issuesinvolved is beyond
the scope of this manual. These issues are covered in other more focused statistical methods literature and you might also address
them in consultation with biostatisticians. The Internet has vast resources for microarrays. A few to get you started might include: a
microarray citation electronic library http://arrayit.com/e-library/, the National Library of Medicine PubMed journal search engine,
ageneral microarray Listserv GENE-ARRAY S@ITSSRV 1.UCSF.EDU. The MGED group (Brazma, 2001) has published the
MIAME standard which specifies (Minimum Information About a Microarray Experiment). Thisinformation is useful in doing an
analysis. Also try searching using general Internet search engines. There are a number of public microarray data repositories. One
that we find useful is NCBI's GEO (Gene Expression Omnibus), that contains array data and MIAME compliant information about

the arrays.

. Datamining is a pattern discovery activity - use all the tools you have.

. Itisopen-ended because of the variety of ways data may be partitioned, normalized, pre-filtered, clustered, and viewed.
Patterns that are apparent in one view may not be apparent in another.

. When data-mining microarray data, look at correlated genes from the point of view of what relationships might be
interesting from abiological view by characterizing genes that cluster together using additional information. I.e. check out
the results with various NCBI and PubM ed database searches on the resulting genes, by designing other lab experiments to
better uncover the cause and effect, etc. Remember correlation does not imply cause and effect.
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Organization of Sections in this Chapter

. 3.1 discusses Objectives in data mining, discovery and anaysis,

. 3.2 describesthe stepsin an analysis,

. 3.3 describes how the database may be interrogated for gene spot intensity & identification.
. 3.4 describes selecting subsets of genes using the datafilter.

. 3.5 describes selecting subsets of hybridized sample conditions.

. 3.6 describes setting thresholds using state-slider controls.

. 3.7 describes how to export (i.e. save) report and plot datato your local computer.

3.1 Objectives in data mining, discovery and analysis

There are anumber of objectives an investigator has when analyzing a set of data. The types of analyses and how useful they are
depends on what they wish to get out of the analyses as well as the type of data.

A good and appropriate experimental design (i.e. the design and setting up of experiments to subsequently be analyzed) is critical
for resolving significant differences in gene expression between experimental conditions. We touch on some of the issues here.
(Simon, 2001), (Dudoit,2000), and Kerr and Churchill (2001a, 2001b) discuss some of the issues of experimental design for
microarrays. We do not currently implement the Kerr-Churchill method. However, some of the issues involved in experimental

design based on the types of arrays are discussed in Section 3.1.1 for (Cy3/Cy5)-labeled as well as 33P-labeled samples.

If users are comparing two different types of samples, the analysis would be different than if they were comparing an ordered
sequence of samples (e.g. time series, cell cycle, dose-response, tumor-stage, etc.). MAEXxplorer gives usersthe ability to:

1. Organize their experiments by sample characteristics allowing them to perform avariety of mining analyses comparing
gene expression patterns between sets of different samples or comparing a single sample within an array's set of genes.

2. Explore, compare, and record these analyses and share the results or intermediate data with other investigators.

3. Usegraphical direct-manipulation combined with statistical methods, clustering and spreadsheet techniques to gain
different insights into the structure of the data.

4. Access public Internet genomic databases for particular genes that are found to be interesting.

Briefly, data mining is the discovery of potentialy interesting patterns in the data that were previously unknown. One approaches
the analysis of a set of data with minimal expectations. However, some idea of what you are interested in hel ps focus the search.
But beware of the trap of mining the data until you get the results you hope for. The following figure helps illustrate this process.
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Start analysis

If possible, postulate initial relationships, patterns, ideas, models to be investigated

— Organize samples into sets of conditions

Set data pre-filters (gene class, normalization, statistical filters, etc)
Examine plots (pseudoarray, scatter, histogram, expression profile, efc)
Cluster working gene subsets and view cluster plois

Refine views

+———[Evaluate resulis for interesting data relationships

——————Save interesting gene sets

Found interesting results, make reports, export results
Visit genomic Web databases for more information on these genes

Finished initial analysis

Figure 3.1 Flow chart of a typical data mining session. The user makes someinitial decisions on the experimental design such as which hybridized
samples to compare, the type and numbers of replicates. They then make initial guesses as to the normalization method to use, and the gene subset (the
gene class) to concentrate on when setting the datafilter. The datais viewed in various modalities to get afeeling for its inherent dynamic range and
where interesting outliers might appear. Clustering and plots hel ps bring these differencesinto view. The results are then evaluated and either the process
isfinished or the views are refined by adjusting data normalization and filter parameters, data subsets to be investigated, clustering methods, plots etc.
and the process repeated until the user is able to see the differences between gene subsets more clearly or no significant differences appear to be found.

Obvioudly, this approach is afirst approximation to what is eventually required. But it does capture the flavor of the data-mining
process. Typically the user would refine the search using variations of the datafilters and might contrast (using gene sets and
hybridized sample condition lists operations) results found under one set of conditions with those found under another set of
conditions.

Recording the analysis steps during your data mining session - command history

Because of the iterative nature of this process, you might want to keep arecord of the commands you have used or the messages
and measurements you have made. To do this you need to enable message and command history logging. Go to the View pull-
down menu and then select the type of logging you want using the Show log of messages or the Show log of command history

commands.

3.1.1 Some experimental design issues of microarray experiments
*** THIS SUBSECTION IS IN THE PROCESS OF BEING UPDATED ***
Proper experimental design of microarray experimentsis critical to successful use of microarray data. Several recent reports

discuss some of the key issuesinvolved in various aspects of statistical analysis of microarrays. (Radmacher, 2001), (McShane,
2001), (Korn, 2001), (Simon, 2001), (Dudoit,2000).

Comparing HP-X/HP-Y for Cy3/Cy5 data as 'ratio of ratios'

If we have two samples HP-X and HP-Y with a common reference sample P (e.g. Cy5p), then we would be comparing the HP-X
"intensity” Cy3y/ Cy5y against the HP-Y "intensity” Cy 3/ Cy5y. Alternatively, you can label Cy3 asthe common reference
sample P in which case just swap Cy3 and Cy5 in these equations. If you are using a common reference standard (i.e. Cy5y4) is
the same sample as Cy 5y eg. apooled sample Cy5p, then
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a)  (Qy3y Qy5x1) | (Oy3y/ Oy5yy)
becones

b)  (CQy3x Oy3y)
However, this new comparison is accompanied by additional noise because of use of the two Cy5p intermediaries.

An alternative method would be to compute ( Cy3y/ Cy5y) directly. However, this too hasits own sources of error and other

problems, namely that not all genes are labeled symmetrically with the two dyes since different dyes may have different sequence
specific affinities due to a variety of causes. For that reason, dye-swap experiments are often done. |.e. the two samples would be
runas ( Cy3y/ Cy5y) aswell as( Cy3y/ Cy5y) . If onewereto plot ( Cy3y/ Cy5y) against 1. 0/ (Cy3y/ Cy5y) and thedata

were perfectly symmetric (which they are not) then one would expect a straight line. That is generally not what you get in practice.

Another issue is that when you have a number of samples A, B, C, D, ..., N and wish to compare them, there are a number of
aternate experimental designs you can use with different resulting sets of advantages and problems. If acommon pooled Cy5p

sample P were used, then the following experiments would be done:
(Cy34 Oy5p), (CQy3p/ &y5p), ..., (Cy3y Cy5p)

This assumes that there is enough of the pooled sample P to be used for all of the experiments - otherwise additional sources of
error would be introduced. MAExplorer isideally used with this common reference sample P. It a common pooled sampleis not
used, then the experimental design becomes more complicated - especidly if dye-swap experiments are performed for all samples.
For N samples taken 2 at atime (i.e. Cy3 and Cy5), then the number of experiments may be impossibly large to perform for other
than avery small N. Eg. for N of 3, the number of experimentsis 3 and 6 if dye swap experiments are also performed. For N of 4,
the number of experimentsis 6 and 12. And this is without doing any replicate experiments. If a reasonable number of replicatesis
added, then this set of experiments becomes even difficult to perform.

MAExplorer is currently not oriented to handling these large combinatoric types of non-pooled sets of experiments. However, you
do have the ability to swap (Cy3,Cy5) dataon an individual basis so you could compute an average of data from dye-swap
experiments - but with the caveats or non-uniform labeling mentioned above.

[(Cy3x/ Oy5y) + 1.0/ (Cy3y/ Cy5,)]/2
In general, thisis probably not avery good estimate.
3.1.2 Design philosophy of MAExplorer methodology

There are several waysto implement a data mining system on moderate size databases. Thefirst isthat all computations are
performed on a Web server and the user's Web browser displays the results. The second is download an applet from the Web
server, get the data from the Web server and do computations in the Web browser. A third way is do download data from aWeb
server and run alocal stand-alone program on the data. MAEXxplorer can be run using both the second and third ways. However,
we encourage the use of the stand-alone paradigm as having the best bandwidth and being the most robust. The browser-based
computation paradigm (as opposed to server-based) is somewhat unusual. It keeps both the program and data on the server, making
user maintenance of the latest versions easier than if they had to constantly upgrade the program or data. This also has the distinct
advantage of giving the user instantaneous feedback through rapid visual and tabular views and the ability to more effectively
navigate the data since the analysisis done on their desktop computer. Because it is easy to access reference data from other
genomic sources (e.g. UniGene, GenBank, NCI/CIT's mAdb clone DB, dbEST, GeneCard, €etc.), it can be accessed from their
respective Web servers as needed. Complex browser-based computations are used in other data mining or intensive computation
domains. With the increased bandwidth of the Internet and compute power and memory of PCs approaching the Cray
supercomputers of the previous decade, this paradigm becomes even more feasible. However there are limits to how well it scales
because of Web browser limitations. Appendix E.2 discusses these issues in more detail

The major focus of the MAEXplorer isinteractive data mining with an emphasis on direct graphical and tabular manipulation of the
data. The investigator is able to interact with the system by clicking on spots in the array image, pointsin graphic plots, cellsin
spreadsheets, by manipulating threshold sliders or typing in gene names/clone Ids. This level of interaction allows investigators to
search for and identify patterns of differences with greater ease than with a more static graphic system sinceit is easier to test ideas
by "grabbing onto the data". For example, "what" isthe identity of "this" outlier | am pointing to in a scatter plot; "which" genes

file:///IC|/tmp/MaeRefMan/hmaeFullRefMan.html (94 of 234) [11/24/2003 10:49:36 AM]


file:///C|/tmp/MaeRefMan/hmaeDocE.html#dataMiningComputingModels

MAExplorer - cDNA Microarray Exploratory Data Analysis

are best clustered with "this* genein this clustergram and are perhaps co-regul ated; "which" genes have expression ratios within
the range of the histogram binsto that | am pointing?

Direct user manipulation of data, as incorporated in MAExplorer, was defined by (Schneiderman, 1997) who defends the position
that the direct manipulation of datain data mining is an extremely effective means to amplify human creativity in understanding
patterns. Schneiderman's dogma states "overview first, zoom, and then filter details on demand" and favors the use of "shallow
search trees, dlide controllers, and information-right screens with tightly coordinated panel view of data", (Beardsly, 1999).
MAEXxplorer also uses many of these direct manipulation principles. It was designed to run on the desktop computers with data
residing on the same computer and loaded into its memory for rapid direct manipulation - for both the Web browser and stand-
alone versions.

3.1.3 Evolution of MAExplorer from earlier proteomic data mining systems

MAExplorer was designed to do flexible exploratory quantitative data analysis of gene data from microarray hybridized sample
experiments. Many of the data-mining concepts are derived from a system called GELLAB-I1
(http://www.lech.ncifcrf.gov/lemkin/gellab.html) that is a UNIX-based stand-alone exploratory data analysis system for 2D protein
gels over multiple experiments (Lipkin and Lemkin, 1981), areview (Lemkin and L ester, 1989) and examples of graphical
representations of this type of data (Lemkin, 1995). An on-line GELLAB-II Web-Poster

(http://www.lecb.ncifcrf.gov/lemkin/gel lab-ep93wd.html) is available showing various screen shots of GELLAB-I1 in action.
Whereas GELLAB works with sets of corresponding spots (i.e. proteins) across sets of 2D gel samples, MAExplorer works with
sets of genes (spots in the microarray) across sets of hybridized sample microarrays. With protein gels, one typically has spot
alignment problems since gels are generally not superimposable. Thisis often called the rubber-sheet distortion problem and
requires localized alignment of spots based of neighboring spot constellation morphology. We have used Web-based visua
methods to visually compare gels including the Flicker (http://www.lecb.ncifcrf.gov/flicker/) image comparison system a Java
applet, (Lemkin, 1997), and the 2DWG (http://www.lecb.ncifcrf.gov/2dwgDB/) meta-database of 2D gel images, (Lemkin, 1999a).
Since the genes are precisely spotted on the arrays, aligning spots between arraysis not required and greatly simplifies that the data
analysis problem.

Part of the Flicker system allows comparison of user 2D gel images with standard images from SWISS-2DPROT for putative
identification of unknown spotsin the user gels. The user would select a standard 2D gel image from over 20 tissue types, enter
their own 2D gel image and aign them at spots of interest. They could then switch to a database access mode, click on those spots
and generate popup SWISS-2DPROT Web pages for those proteins - similar to Clone reportsin MAEXxplorer. That is accessed at
http://www.lecb.ncifcrf.gov/flicker/swissProtl dFlkPair.html.

MAExplorer will have a groupware facility similar to what we have done with our WebGel (http://www.lecb.ncifcrf.gov/webgel/)
system described in (Lemkin et al., 1999b). It is atwo-dimensional electrophoresis system for sharing data analyses. In WebGdl,
users may perform a data-mining analysis and leave the state of the their analysis and accompanying notes to share with their
collaborators on alogin-protected basis.

3.1.4 Concepts used in data mining with MAExplorer

This section introduces some of the concepts used in data mining microarrays with an emphasis on how they are used with
MAExplorer.

Gene data filters - a Boolean AND of gene set tests

A primary MAExplorer concept is that of gene datafilter that selects aworking set of genes by the conjunction (Boolean AND) of
user selectable tests. Each test further restricts the working set of genes to those meeting the test. These criteriainclude gene
membership in particular gene classes, membership in particular user defined or computed gene subsets, and meeting a variety of
statistical constraints. Statistics include intra- and inter-array CV, X-Y setst-tests. Range test criteriainclude X/Y ratio ranges and
histogram bins, intensity ranges and histogram bins. Membership criteriainclude test if genes are in the current-cluster (derived
from cluster-analysis), gene set membership, etc. By selectively including one or more of these filter restrictions, the user can
home in on the data that appears to be interest. Of course asin real mining, what appears interesting may not be interesting based
on further investigation.

Set operations on gene subsets
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Because of the complexity of comparing many different replicated samples, it may be difficult to manually organize the resulting
comparisons. MAExplorer offers set-theoretic operations on sets of genes and sets of hybridized samples (i.e. intersection, union,
difference) to help with this organization (step 9 in Table 3.2). The results of set operations may be saved and used in subsequent
set operations, normalization, as well as with the data filter. Thisis useful when comparing and documenting procedures, methods,
and analyses from several subsets of experiments.

User exploration states

Users needs to be able to save and restore the current state of their explorations of the data and option settings to document and
continue at later times. When running in stand-alone mode, the user may save their data mining session on the local disk asin
named (.mae file extension) startup files. Clicking on one of a startup file will restart MAExplorer and restore the state to that of
the time it was saved. In addition to filter and parameter status, the HP-X, HP-Y, HP-X and HP-Y 'sets, HP-E 'list', the named gene
sets and HP condition sets are saved as part of the state

User groupware sharing of exploration states with collaborators

[In the future], these could be saved on a public Web server using multiple named state files. These are protected for the user using
alogin procedure. A groupware sharing of these intermediate exploratory resultsis available when they allow another user to
access selected states. User states and groupware sharing complete step 11 in the analysis described in Table 3.2.

We now discuss using these tools for analyzing ones data.

3.2 Steps in data mining, discover, and analysis

An analysis scenario may use many methods for viewing the data. A typical sequence of analysis stepsislisted below in Table 3.2
in the order they might be performed. Note that thisis arough guide for a possible analysis and the iteration and backing up for of
some of these steps is required for data mining complex sets of conditions, especially in the setting of constraints for the "data
filter" (step 4) when the user focuses on subtle patterns of interest (c.f. Figure 3.1).

Table 3.2 Stepsin a data-mining analysis.

1. Select aset of hybridized samplesto be analyzed. Additional samples may be added or removed from the HP-X, HP-Y
and HP-E sample lists prior to or during an analysis.

2. Organize samples by selecting query type: 2-class (X vs. Y) sample sets or N-sample ordered expression lists.

3. Select normalization (transformation scaling) method appropriate to the type of data and what types of changes you are
looking for (patterns or outliers).

4. Restrict search using the "datafilter" to subset genes (pre-filter data) by gene-class, gene-subset, ratio range, intensity
range, coefficient of variation, t-test, expression profile, cluster membership, etc.

5. Review scatter and expression plots, ratio and intensity histogramsto gain insightsin overall characteristics of the data

range and intensity distributions. Export results using either SaveAs or cut and paste operations.

Cluster genes by similar expression profiles and other clustering methods. Review similarity, clustergram and dendrogram

plots and reports. Export using either SaveAs or cut and paste operations.

Select subset(s) of genes of interest in plots or reports.

Access other Web genomic databases for genes of interest from spreadsheets or plots.

Save genes of interest in named gene sets and perform set operations if required.

10. Create gene reports for export to Excel using tab-delimited Reports and either SaveAs or cut and paste operations.

11. Inthe stand-alone version of MAExplorer, save the state of exploratory data analysisfor later use or sharing.

o

© © N

In designing a data mining experiment, the first decision to be made is selecting the set of hybridized samples to be compared
(steps 1 and 2). Thisis accomplished by setting the current hybridized sample-X (HP-X) and hybridized sample-Y (HP-Y). In
Figure 2.4.4.2 for the scatter plot we selected a single C57B6 pregnancy day 13 and a single Stat5a (-,-) pregnancy day 13 as
current HP-X and current HP-Y samples. Changing the normalization changes the view in the scatter plot so that hidden
differences may be more apparent (see Figure 2.4.2.3)
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The names of the current HP-X and HP-Y samples are displayed at the top of the main window. The current HP-X and HP-Y
samples may be changed at any time by clicking on a new sample from alist of samples shown on the |eft side of the main window
or from lists of samples organized by sample population in the Samples menu.

The next decision to be made is selection of the genesto be studied by choosing a subset from the gene class menu list (step 4).
Further selection occurs throughout the analysis by clicking on spots in microarray images, points in graphic plots or cellsin
spreadsheets, by adjusting threshold dliders, or using the text-entry "guesser” to type in gene names, clone IDs, genomic IDs,
samples, etc.

The next decision the user must make isto set the intensity data normalization mode (step 3). Normalization of quantitative datais
crucial when comparing data between different hybridized microarrays because of spotting, hybridization efficiency, uniformity,
and other systematic errors.

Genes of interest may be separated for all of the genesin the database using a cascade of datafilters (step 4). Additional filtering
options are easily accessible in the (data) Filter menu. Some of the filters require additional parameters. These parameters are set
by state scroll bars that pop-up on the screen when data filters requiring them are added to the filter cascade. Changing scroller
values causes the data filter to be automatically be reapplied and a new set of genesto be computed.

It is desirable to reduce fal se-positives found by the datafilter by eliminating genes with high quantification variability between
duplicate spots on the same sample or spot duplicated in replicate samples. If duplicate genes are available on the array (denoted by
Field 1 and Field 2 or F1 and F2 spots), this allows the computation of a coefficient of variation (CV) for the duplicates. This CV
may be used in adatafilter to reduce potential false-positives. CV iscomputed as 2| F1- F2| / ( F1+F2) using those spot values
for each gene, as St dDev o/ Meanp for aset of replicate hybridized samples.

Graphical views of the data give the user additional insightsinto the data. These include spot intensity and ratio or Zdiff
pseudoarray images, scatter plots, histogram plots, expression profile plots, cluster plots showing genes similar to a specified gene,
the number of clustered genes for each clone, divisive clusters for K-means clustering, and clustergrams and dendrogams for
hierarchical clustering.

Scatter plots are useful for visualizing data from two conditions

The scatter plot method (step 5) allows the user to plot the intensity data between two samples, the X-sample and the Y -sample.
Gene data may be spot data for two different samples (HP-X and HP-Y), means of two different sets of hybridized samples of
replicate samples (sets of HP-X and sets of HP-Y), or the left and right normalized replicate data (F1 vs. F2) for the current
hybridized sample. If Cy3/Cy5 datais used, then each sampleisthe ratio of datafrom two different hybridized samples. So if we
have sample Cy3a and Cy3b then HP-X could be Cy3a/Cy5 and HP-Y could be Cy3b/Cy5 such that we are scaling the Cy3a and
Cy3b samples using acommon Cy5 normalization sample. Scatter plots are useful for obtaining a better understanding of the
outliers when comparing different hybridized samples and determining the reproducibility of spotting when comparing F1 vs. F2
data or replicate sample data.

Filtering genes by histogram plots of ratios, Zdiffs or intensities

Histogram plots may be generated from either X/Y ratios or (X-Y) Zdiffs of two different hybridized samples (single samples or X
and Y replicates) or from the FL/F2 intensities of a single hybridized sample. Selecting abin in a histogram restricts filtered genes
to those that are contained in that histogram bin. As an aternate method, data filtering by ratio (Zdiff) or intensity range may be
used with adjustable range scrollers independent of the histograms. However, histograms and scrollers may be used together. For
example, one could filter by the ratio histogram after filtering out genes with low-intensity values that may be considered noise
using the intensity dliders. That might help eliminate falsely high ratios resulting from dividing high X values by a very small noisy
Y values. Histograms are useful for getting a better understanding of the range and distribution of the gene intensities or ratios.

Expression profile plots (EP-plot) of N conditions for viewing time series, etc.
List HP-E isan ordered list of samples - as different from HP-X and HP-Y that are unordered sets of samples. The expression
profile (step 5) of ageneisthe plot of its normalized intensity as afunction of the samplesin the ordered HP-E list. It may be

plotted for the current gene in a pop-up window. Selecting a different current gene causes the EP-plot to be displayed for that gene.
Multiple EP-plots may be created to view the differences between afew genes you are investigating further. The HP name button
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pops up awindow with the ordered list of samples so you can see the details of the sample names being plotted. Selecting alinein
aplot displays the intensity data and sample name for that hybridized sample. The data may be plotted as a bar, point or continuous
curve and error bars may be turned off to better compare multiple plots.

When there are too many EP-plotsto be viewed simultaneously, you might use a scrollable list of expression profile plots that lets
you scroll through an arbitrarily large list of genes. However, it is difficult to compare genes that are not sorted in some way (i.e.
clustered). Therefore, these are most useful when used after clustering the data and displaying the scrollable EP-plots of the cluster-
order data.

Clustering is one way of possibly finding co-expressed genes that exhibit similar expression changesin a set of samples. Genes
may show similar co-expression, but that does not prove they are co-regulated at the same point in a pathway - merely that
measurements of those genesin a particular set of experiments show similar expression. However, identifying genes with similar
expression for which some information is already known about some of the genes may be useful as a starting point to help figure
out gene function and pathway using additional experiments and analysis.

There are many methods for doing clustering - each with advantages and disadvantages. We present three methods in MAEXxplorer
and plan on adding a variety of more powerful methods through the MAEPIugin facility under development.

Finding clusters of genes with similar expression profiles: similar, cluster counts, K-means, and hierarchical
methods

We may define a cluster of genes as a set of genes whose expression profiles are found to be similar (step 6). The samplesused in
computing the expression profiles are specified by the HP-E ordered list. Y ou can scale the list of normalized intensity datafor
each geneto 1.0 (resulting in finding genes with similar shaped EP-plots). Alternatively, if you don't scale this data it will cluster
more on magnitude changes. Y ou can select either the Euclidean distance or the correlation coefficient of the EP lists between two
genes as the measure of gene-gene distance. Similarity is 1.0 - normalized distance.

The first cluster method finds a cluster of genes whose expression profiles are similar to that of the currently selected gene. This
list of genesisrestricted by the constraint that the cluster distance between each of these genesto the selected gene isless than the
"Cluster threshold" distance set by the user with a scroll bar. It displays genes that are found both with blue boxes (the larger the
box, the higher the similarity) and in atext report window showing the genes and their distances to the current gene. By varying
the threshold and observing the results, the user can find a set of highly correlated genes. If the threshold is set to 0.0, no genes are
found. If it is set too high, all datafiltered genes arefound. So it is critical to adjust the threshold to areasonable level
commensurate with the type of data being analyzed and the approximate number of genes expected.

A second cluster method draws blue circlesin the array image around all filtered genes meeting the threshold criteria, where the
larger the circle the larger the number of similar genes (i.e. passing the threshold) are found to be clustered with that gene. Clicking
on a gene toggles between the first and second methods. For both of these methods, it will pop-up a"Cluster Distance” threshold
scroller and recomputes the clusters if you change the scroller value or the current gene. It also shows atext report that displays the
number of genes similar to each data filtered gene.

A third method called "K-means" clustering K genes (we call primary nodes) whose expression profiles are most orthogonal to
each other. It uses the current gene as thefirst or "seed" node. It then finds the gene furthest from this and assigns it as node 2.
Then the gene furthest from both nodes 1 and 2 is assigned to node 3, etc. This processis repeated until all K nodes are assigned.
Then the remaining genes are assigned to the closest node. Having defined the initial cluster centers, it recomputes the centroid of
each of the clusters. The centroid can aternatively be computed using a median instead of a mean in which case we would be
doing K-median clustering (Bickel, 2001). K genes are then reassigned to the nearest new centroids as the new K-means node
instances. Finaly, the remaining genes are assigned to the nearest centroid. A scrollable K-means cluster text window report pops
up with genes sorted by cluster. Clicking on agenein either the array image or scatter plot assigns all genesin the cluster to which
that gene belongs to the "current cluster”. Genes in the current cluster are labeled in the array and scatter plot with a small number
of the cluster. In addition, genesin the current cluster are copied to the E.G.L. where they can be used in areport, saved in a named
gene set, or used for additional filtering. It also pops up a"N-clusters" scroll bar window to let you dynamically adjust the number
of clusters. Changing N will recompute the clusters. When the K-means is recomputed, it uses the current gene asthe initial seed
gene.

The fourth method is a hierarchical clustering method that generates a clustergram and dendrogram similar to that of Eisen's red-
black-green clustergram (Eisen, 1998). This was derived from the clustered correlation map (ClusCor) of Weinstein et al.
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(Weinstein, 1997). The MAExplorer clustergram and dendrogram are dynamic and may be interrogated and used to set the current
gene. This meansthat it may also position a corresponding ordered list of expression profile plots to the same gene so you may
view the data as a plot as well. The dendrogram may be zoomed in to explore a part of the dendrogram in more detail. As with the
K-means clustering, areport can be made of the ordered genes.

Gene reports: dynamic spreadsheets for Web access or tab-delimited for exporting data to Excel

Pop-up report windows (step 7) may be generated for either individual genes or aglobal array sample data. Instances of the latter
include experimental information and Web links, global statistics, correlation coefficients between array samples, etc. Gene reports
may present this datain a number of ways. These include: highest/lowest gene ratios, profiles, parametric and cluster statistics, etc.
Reports may be presented as either dynamic Web-interactive spreadsheet tables or as static tab-delimited tables. The latter is useful
for exporting data using cut and paste into Excel (step 10). If the user clicks on a blue hyperlinked cell in a dynamic spreadsheet
table, it pops up another Web browser window and loads it with data (step 8) from the respective Internet genomic database such
asmAdb Clone DB, UniGene, GenBank, dbEST, GeneCard, and MGAP model and histology Web pages.

Collaborative groupware environment

Having immediate access to collaborator's data is a powerful research tool. A collaborative environment is being implemented for
MAExplorer that allows groups of users to share data and intermediate results. These capabilities include: 1) the ability to save and
restore exploratory data mining sessions (states) through the Web server including named sets of genes, and 2) to selectively share
these states with collaborators. The latter process is sometimes called a groupware environment because if offers a collaborative
group the ability to share and interact. These capabilities are modeled after our WebGel system (Lemkin et al., 1999b). In addition,
users can create a custom database Web page as a subset of samples from the entire database. This may be saved on their own
computer through their Web browser's "File/Save as' command. This hypertext file could then be used at alater time to access the
database or be E-mailed to a collaborator to do the same.

3.2.1 Definition of expression profile
It is helpful to define an expression profile. There may be aternate definitions, but the following is useful for getting an

understanding of how it might be computed. An expression profile e; of an ordered list of N samples (k=1 to N) for a particular
genej isavector of scaled expression values v .

Then, the expression profile is expressed as alist of values:
ej = (le, Vj2’ Vj3’ ey VJN)

A difference between two genes p and g may be estimated as a N-dimensional metric "distance” between e, and e. The
Euclidean distance is then defined as

dpg = (/N SUM-1.n (Vjp - Vjp)? )12
Other distance measures may include correlation coefficient, city-block (or manhatten distance) etc.

For scaled data such that dy,, has a maximum value of 1.0 ovger all samples. A similarity measure could be computed as 1.0 -
distance or

S =1-4d

pq pq

3.2.2 Clustering Methods

Clusters represent one way to identify similar gene expression across a set of experiment samples. There are many ways to cluster
the data, some of which are available in MAEXxplorer. These include:

1. Finding genes with similar expression
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2. K-means clusters where the number of clusters K isfixed prior to clustering and a particular gene is used to start off the cl.
3. Hierarchical clustering where a binary tree hierarchy is created

Other methods include Self Organizing Memory (SOM), fuzzy clustering, Support Vector Machines (SVM), etc.
3.2.2.1 Clustering similar genes

If we have aparticular gene s (the "seed” gene), we may want to find aset of al genes{ g; } similar to gs. We can find this set of
genes by testing We define a particular gene g; as similar to seed gene if the distance between geness andj  meets the following
criteria.

djs<T

Thethreshold T is set by the investigator and in MAExplorer is changed using aslider. Typically, the set of all genes{ g; } found
is sorted by similarity before being viewed.

3.2.2.2 K-means clustering

K-means clustering finds K clusters of genes with similar expression profiles to a given gene (see Sneath and Sokol, 1973). Given
the number of clusters K, we could use high variance of clustersto determine if they should split into sub-clusters. K-means
clustering does not need a distance matrix (see Hierarchical clustering which follows), so it is faster and may cluster large numbers
of N genes. However, it is highly dependent on seed selection. It may be useful for getting an initial estimate - especialy if other
techniques (such as silhouette plots) are also used. The following is asimplified definition of one way to compute a set of K-means
clusters of gene expression profile data.

Algorithm:

Pick seed genes and putitinto cluster 1 (letk = 1)
For al clustersj = 1 to k, find geneq such that d; 4 isamaximum

Setk = k+1. Put geneq into new cluster k
Forj = k to K repeat steps2 and 3 until there are K clusters
Then, assign ( N- K) remaining genes g into one of the K clustersj with minimum d;

Compute new virtual gene cluster centroids as means or medians{ e} for each of K clusters
Reassign all N genes g into K new clusters with minimum d,4 using virtual genes{ ep}
Variants: use multiple seed genes, range of K values, minimize CV

© N W DNRE

3.2.2.3 Hierarchical clustering

Hierarchical clustering of a set of geneswill generate abinary tree of clusters with the genes at the terminal ends of the tree and a
single cluster of the entire tree at the top (also called the root) of the tree. See (Sneath and Sokol, 1973) for a discussion on
hierarchical clustering. There are many other variants of hierarchical clustering. Hierarchical clustering requires a distance matrix
or the equivalent of one [there are more efficient waysto computeit]. ForN genes (terminal clusters), it generates 2N- 1 clusters.
Distance matrix is upper diagonal matrix D of d,, of size N(N-1)/ 2.

D can get quite large for clustering alarge number of genes N [for N=5000, thisis > 50 Mbytes!]

Thefollowing is asimplified definition of one way to compute a hierarchical clustering of gene expression profile data.
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Algorithm:
1. Assignall Ngenesto clusters1to N, set n to N
2. Find two clusters p and g such that d, is aminimum doing the following:
2.1 Compute avirtual cluster vector e, = aver age (ep, eq)
22Setn = n+l
2.3 Assign virtual cluster to new cluster
3. Repeat step 2 untiln = 2N- 1.

3.3 Display of gene spot intensity and identification data measurements

Y ou may select the current gene by clicking in the pseudoarray image or in the X-Y scatter plot and MAEXxplorer reports. The
microarray grid coordinates, normalized quantified spot intensity data, plate coordinates, gene name (if known) and associated data
for that gene. If you are displaying a pseudocolor ratio (X/Y) or Zdiff (X-Y) image, it will report HP-X/HP-Y or (HP-X - HP-Y)
data respectively. It aso sets the gene as the current gene. The pseudoarray image coordinates are reported as.

[ <field><grid name><row#>, <col #>] .

e.g.
[1- A4, 3]

If thereisonly onefield in the array, it will appear asfield 1. In the above example, [1-A4,3] isfield 1 grid A row 4 and column 3.
Note that the pseudoarray coordinates are for visualization purposes in MAEXxplorer and may or may not be the same as the
coordinates on the actual array. That depends on how the MAEXxplorer database was defined in the configuration file described in
Appendix C.

When the current geneis defined, it will draw ayellow (green) circle around the spot in the ratio (intensity) pseudoarray image and
display other features of the gene in the three-line status area near the top of the main window. If background correction is enabled
(the "Use background intensity correction” in the Normalization menu), then spot intensity values will appear asi nt ensi ty'
(with background intensity subtraction) and i nt ensi t y (without background subtraction).

There are a number of different reporting formats available depending on the array display mode and particular normalization
method selected. These include: the pseudoarray image of the intensity of a single sample, the pseudocolor ratio X/Y or Zdiff (X-
Y) image (using either HP 'sets' or single samples), or the ratio of Cy3/Cy5 for dual-1abeled dyes or F1/F2 for replicate spots for a
single sample. In addition, the normalization mode is also displayed in the reporting line. We will present examples of each of
these different reporting formats.

Y ou may show theintensity datafor a particular spot in the currently displayed pseudoarray image. First select the
"Pseudograyscale image” option in the "Show Microarray" submenu in the "Plot menu". If your data has duplicate grids (i.e. fields
F1 and F2) then you may look at F1, F2 and mean (F1+F2)/2 datain the reports when you click on a spot. If the "Gang F1-F2
scrolling” switch is disabled in the "View menu”, then thei nt ensi t y valueisthe intensity data value for the gene at that
location. If the "Gang F1-F2 scrolling” switch is enabled, then it reports intensity[F1], intensity[F2], and the F1/F2 ratio. These two
formats are shown in the following two examples for a C57B6 pregnancy day 13 samplesin the MGAP database:

a) Field F1 spot for asingle spot in a single sample with the median intensity selected.

[1-A4,5] intensity=4.5267, (Norm: nedian intensity)
Clonel D: 1248228, dbEST3': 2279072, GenBankAcc3': Al 463183, Uni Gene: Mm 13859, plate[5, A 5]
CGeneNane: Mus nuscul us ribosomal protein L41 nmRNA, conpl ete cds

b) Field F1 and F2 replicate spots for a single sample. The top line is shown for each of the different normalization methods.

[1-A4,5] intensity[F1]=-0.3067, intensity[F2]=-0.2312, F1-F2=-0.0755, (Norm: Zscore intensity)
[1-A4,5] intensity[F1]=4.5267, intensity[F2]=6.2408, F1/F2=0.7253, (Norm: nedian intensity)
[1-A4,5] intensity[F1]=0.8755, intensity[F2]=1.1457, F1-F2=-0.2701, (Norm: |og nedian intensity)
[1-A4,5] intensity[F1]=-0.1442, intensity[F2]=-0.0945, F1-F2=-0.0497, (Norm: Z-score, stdDev, |og
i ntensity)
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[1-A4,5] intensity[F1]=-0.1533, intensity[F2]=-0.1004, F1-F2=-0.0528, (Norm: Z-score, mean

abs. deviation, log intensity)

[1-A4,5] intensity[F1]=630.9911, intensity[F2]=869.9273, F1/F2=0.7253, (Norm: calibration DNA

i ntensity)

[1-A4,5] intensity[F1]=1919.9376, intensity[F2]=2646.957, F1/F2=0.7253, (Norm: scale to nax. (65K)
i ntensity)

Clonel D. 1248228, dbEST3': 2279072, GenBankAcc3': Al 463183, Uni Gene: Mm 13859, plate[5, A 5]
GeneNane: Mis nuscul us ri bosonal protein L41 nRNA, conpl ete cds

If the "Pseudocolor HP-X/HP-Y ratio or Zdiff" option is selected in the "Show Microarray” submenu, datais reported as either
Ratio or Zdiff data depending on the normalization method selected. The data used in the following examplesisfor C57B6
pregnancy day 13 (HP-X) compared with Stat5a (-,-) pregnancy day 13 (HP-Y).

) Ratio datafor two samples X and Y in separate hybridized arrays. Ratio data for the field F1 and F2 spot data as well as the
mnX/mnY ratio is reported. The median normalization was used in this example.

[1-A4,5] HP-XY: mm( X Y)=(5.383,6.834) (X Y)(F1, F2, mean)=(0.651,0.928,0.787), (Norm: median
i ntensity)

Clonel D: 1248228, dbEST3': 2279072, GenBankAcc3': Al 463183, Uni Gene: Mm 13859, plate[5, A 5]
GeneName: Mus nuscul us ri bosonmal protein L41 nRNA, conplete cds

d) Zdiff datafor two separate samples X and Y. Ratio datafor the field F1 and F2 spot data as well as the mnX-mnY Zscore
differenceis reported. The three Zscore, Zscorelog, and logMean normalizations were used in this example (first lines are shown).

[1-A4,5] HP-XY: mm(X Y)=(-0.269,0.151) (X-Y)(F1, F2, mean)=(-0.470,-0.370,-0.420), (Norm: Zscore
intensity)

[1-A4,5] HP-XY: mm(X Y)=(-0.119, 0.051) (X-Y)(F1, F2, nean)=(-0.199,-0.142,-0.170), (Norm: Z-score,
stdDev, |log intensity)

[1- A4, 5] HP-XY: mm( X, Y)=(1.010,1.224) (X-Y)(F1, F2, nean)=(-0.362,-0.064,-0.213), (Norm: |og nedian
i ntensity)

Clonel D. 1248228, dbEST3': 2279072, GenBankAcc3': Al 463183, Uni Gene: Mm 13859, plate[5, A 5]
GeneNane: Mus nuscul us ri bosonal protein L41 nRNA, conplete cds

€) Example of when the "Use dual HP-X & HP-Y Pseudoimage’ mode is enabled in the "Show Microarray” submenu of the "Plot"
menu. This displays mean data for the HP-X and HP-Y data side-by-side. The median normalization was sel ected.

[1-A4,5] intensity[X]=5.3837, intensity[Y]=6.8342, X/ Y=0.7877, (Norm: nedian intensity)
Cl onel D: 1248228, dbEST3': 2279072, GenBankAcc3': Al 463183, Uni Gene: Mm 13859, plate[5, A 5]
GeneNane: Mus nuscul us ri bosonal protein L41 nRNA, conpl ete cds

Reporting for multiple hybridized samples when using HP-X/-Y 'sets’

If you have enabled MAEXxplorer to "use HP-X and HP-Y 'sets' of multiple samples® rather than single samples® in the Samples
menu, it will report a spot differently using the means (mn), standard deviations (S.D.), coefficient of variations (CV) for the
samplesin the HP-X and HP-Y 'sets. For duplicate fields, these are computed using the normalized average of F1 and F2 spots for
each gene in each samples. The data used in the following examplesis for three C57B6 pregnancy day 13 (HP-X) samples, and
five Stat5a (-,-) pregnancy day 13 (HP-Y) samples.

f) Multiple HP-XY 'sets' using median normalization for the pseudoarray image display for the HP-X 'set' of three C57B6 samples.

[1-A4,5] HP-X '"set' mean intensity=3.295 stdDev=1.482 CV=0.449 n=3, (Norm: median intensity)
Clonel D. 1248228, dbEST3': 2279072, GenBankAcc3': Al 463183, Uni Gene: Mm 13859, plate[5, A 5]
GeneNane: Mus nuscul us ri bosonal protein L41 nRNA, conpl ete cds

g) Multiple HP-XY 'sets' using median normalization for the pseudoarray image display for the HP-Y 'set' of five Stat5a (-,-)
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samples.

[1-A4,5] HP-Y 'set' mean intensity=8.180 stdDev=0.986 Cv=0.120 n=5, (Norm: median intensity)
Clonel D: 1248228, dbEST3': 2279072, GenBankAcc3': Al 463183, Uni Gene: Mm 13859, plate[5, A 5]
GeneNane: Mus nuscul us ri bosonal protein L41 nRNA, conplete cds

h) Multiple HP-XY 'sets' using median normalization for the pseudoarray image display for the HP-X and HP-Y 'sets when the
"Use dual HP-X & HP-Y Pseudoimage" mode is enabled in the " Show Microarray" submenu of the "Plot" menu.

[1-A4,5] HP-XY 'sets': m(X, Y)=(3.295,8.180) mX/ mY=0.402 SD(X, Y)=(1.482,0.986)
CV( X, Y)=(0. 449, 0.120)\
n(X, Y)=(3,5), (Norm: nedian intensity)
Clonel D: 1248228, dbEST3': 2279072, GenBankAcc3': Al 463183, Uni Gene: Mm 13859, plate[5, A 5]
GeneName: Mus nuscul us ri bosonmal protein L41 nRNA, conpl ete cds

i) Multiple HP-XY 'sets using median normalization for ratio (HP-X/HP-Y) data for the "Pseudocolor HP-X/HP-Y Ratio or Zdiff"
display.

[1-A4,5] HP-XY 'sets': m( X, Y)=(3.295,8.180) mX/ mY=0.402 SD( X, Y)=(1.482,0.986)
CV( X, Y)=(0. 449, 0.120) \
n(X Y)=(3,5), (Norm: median intensity)
Clonel D: 1248228, dbEST3': 2279072, GenBankAcc3': Al 463183, Uni Gene: Mm 13859, platey[5, A 5]
CGeneNane: Mus nuscul us ribosomal protein L41 nmRNA, conpl ete cds

i) Multiple HP-XY 'sets' p-value using median normalization for ratio (HP-X/HP-Y) datafor the "Pseudocolor (HP-X,HP-Y) 'sets
p-value display.

[ 1- A7,20] HP-XY: mm( X, Y)=(3.449,0.853) (X Y)(F1, F2, mean)=(4.09, 4.008, 4.041), (Norm: median
i ntensity)

Clonel D: 1382656, dbESTS5': 1775754, GenBank 5': Al 036495, Uni Gene: Mm 300, plate[12, A 8]
GeneNane: Carboni c anhydrase 3

Reporting for Cy3 and Cy5 channels for a single hybridized sample

k) If you have Cy3/Cy5 data, then you can look at the two channels for a single sample ( the current HP sample). For median
normalization and the display set to "Pseudocolor Red(Cy5)-Y ellow-Green(Cy3) Cy3/Cy5 data" display.

[ 1- A6, 11] Cyb5/ Cy3=0.3588, Cy5=67.324, Cy3=187.622, (Norm: median intensity)
Cl onel D: | MAGE: 1054189,
GeneNane: expressed sequence AW213287

Reporting HP-X (Cy3 or Cy5) vs HP-Y (Cy3 or Cy5) data for 2 samples

) If you want to compare Cy3 or Cy5 in the HP-X sample with a Cy3 or Cy5 valuein the HP-Y sample, you do it through the
special Cy3,Cy5 scatter plots. There are four types of plots:

1. HP-X Cy3vsHP-Y Cy3
2. HP-X Cy3vsHP-Y Cy5
3. HP-X Cy5vsHP-Y Cy3
4. HP-X Cy5vsHP-Y Cy5

After the plot is started, clicking on a scatter plot will report data from the point in that plot will print the following data as shown
in the following example where HP-X Cy3is plotted against HP-Y Cy3.

[1- A5, 16] intensX=4.695, intensY=5.923, (X-VY)=-1.2275, (Norm: |og nedian intensity)
Cl onel D: | MAGE: 963758,
CGeneNanme: RI KEN cDNA 2410114014 gene
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3.4 Selecting subsets of genes using the data Filter

Genes may be selected on a number of criteria specified by the data Filter (Section 2.4.3) that is a cascade of datatests. The first
might be the gene class (Section 2.4.1) to restrict the set of al genesto a particular subset. Various numeric and statistical data
tests might be applied on the remaining genes to exclude those not meeting these tests. For example, genes having a high
coefficient of variation between duplicate spots on the same sample or duplicate samples could be eliminated. Then one could
select genes that had a (HP-X/HP-Y) ratio greater than 4.0 but less than 8.0, etc. The latter could be done using either the ratio
scrollers or by clicking on that binin the ratio histogram plot. See the Filter menu options and look at one of the tutorials

(Appendix A) for ideas on adjusting the Filter to close in on a particular subset of genes.

3.5 Selecting subsets of hybridized sample conditions

Sets and lists of hybridized sample conditions (HP-X and HP-Y sets, HP-E list) may be selected using various commands from the
Samples Menu (Section 2.2) including pull-down menus, guessing by name or part of aname, or using a"Chooser" (see Figure
2.2.1) to design your settings for the current (HP-X and HP-Y sets, HP-E list). The Chooser is the easiest way to select these
entries. In addition, if you want to change the current HP-X or HP-Y individual sample, you can do this directly from the array
pseudoarray image by clicking on the [X] or [Y] part of the image and then selecting the particular sample to use. Note that if the
mouse-over checkbox is enabled, then moving the mouse over the sample names gives you the full sample name. Otherwise, the
sample hame may be truncated.

3.6 Setting threshold values using the state-scroller sliders

Y ou may filter genes using a variety of thresholding operations (see the Filter menu (Section 2.4.3) to select any of these). For
example, these include a spot intensity (per channel) range [SI1:S12], gene intensity range [11:12], ratio range [R1:R2], Zdiff range
[Z21:Z22], Coefficient Of Variation (CV) range [0:1.0], p-value range [0:1.0] for the t-test, etc. Additional threshold scrollers are
used with the clustering methods including the number of clusters (default 6), the maximum cluster distance from ageneto a
another gene for the latter to be considered in the same cluster, and the absolute difference between HP-X and HP-Y.

For the intensity and ratio threshold filters, the range interpretation may be inside, or outside the specified range. The ratio range
[R1:R2] is between 0.01 and 100.0. The Zdiff range [Z1:Z22] and [CZ1:CZ2] are between -4.0 and +4.0. The intensity threshold
range [11:12] is set to the dynamic range of the min and max intensity for the current normalization method.

A list of possible threshold sliders is shown in the following table. When a Filter is enabled that requires adlider, it pops up the
Sate Scrollers window that contains one or more slides. When you disable all filters that use these sliders, the popup window will
disappear. The corresponding Ratio R1[R2] or Zdiff Z1[Z2] sliders are used if you are using aratio or Zscore normalization - and
will change if the normalization changes while the filter is active.

Some of the sliders are implemented with a non-linear scale so that you have more resolution at the low end (eg. p-Value, Spot
CV, Diff HP-XY).

Depending on the set of data Filters selected, there may be multiple sliders present in the State Slider popup window (eg. see
Figure 2.4.3).

Table3.3.1. List of threshold sliders. Sliders are enabled in the State-Scroller popup window when the corresponding datafilters
are enabled.

Slider name Associated with operation
Spot Intensity SI1 |Filter by spot intensity range per channel
Spot Intensity SI2 |Filter by spot intensity range per channel

Filter by percent of spots whose spot intensity
isin threshold range criteriameetsthe AT LEAST or AT MOST criteria

Intensity 11 Filter by gene intensity range

Percent SI OK
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Intensity 12 Filter by gene intensity range

Ratio R1 Filter by gene X/Y ratio range

Ratio R2 Filter by gene X/Y ratio range

Zdiff Z1 Filter by gene X-Y Zdiff range

Zdiff 22 Filter by gene X-Y Zdiff range

Ratio CR1 Filter by Cy3/Cy5 gene X/Y ratio range
Ratio CR2 Filter by Cy3/Cy5 gene X/Y ratio range
Zdiff CZ1 Filter by gene (Cy3-Cy5) X-Y Zdiff range
Zdiff Cz2 Filter by gene (Cy3-Cy5) X-Y Zdiff range
p-Vaue Filter by t-Test

Spot CV Filter by Coefficient of Variation

Cluster Distance |Plot - cluster by expression similarity

# of Clusters Plot - K-means clustering

Diff HP-XY Filter by absolute difference (HP-X,HP-Y)
Spot Quality Filter by continuous spot quality (If data available)

3.7 Exporting report and plot data

Dataistypicaly reported in MAExplorer in report and plot windows. These may be saved using cut and pasteif your are using
MAEXxplorer as an Applet or with "SaveAs' buttons on the popup windows if you are running it as an stand-al one application .
Reports are then saved as text (.txt extension) files, and plots are saved as GIF (.gif extension) files.

If you are running on awindowing system supporting cut and paste, then you may cut and paste data from reports and plots into
applications on your system that allow you to save or print this data. Set the Report menu table-format to "Tab-delimited”. Then, in
Windows 95/98/NT/2000/X P, cut data from the popup tables (or other text reports) and paste it into Microsoft Excel. In Windows,
you can capture (i.e. "cut") the entire screen by pressing the "Prt Sc" or print screen button. To capture a specific window (e.g. a
scatter plot), hold the "Alt" key when pressing the "Prt Sc" key. Then go into a Windows imaging application (such as PhotoShop)
and paste it into the application. In PhotoShop, in the File menu, select New (or type Control/N). Then when the window is
opened, click on the window and paste the MAEXplorer screen you had cut into the image window by typing Control/V. In both
Excel and PhotoShop you may print the data or saveitin afile.

4. Status and Bugs of MAExplorer

This section discusses the status and known bugs in MAEXxplorer. It also discusses dealing with the reporting of fatal errors so we
can resolve them.

Section 4.1 discusses known bugs, Section 4.2 lists the revision notes for older versions known bugs. If you have experienced bugs

with an older version of MAEXxplorer, you might check the revision notes to seeif the bug was fixed and download a new version.
Section 4.3 discusses problems in using MAExplorer as an applet with Web browsers. Section 4.4 describes handling fatal

"DRYROT" errors.

.
@ 4.1 Known Bugs in MAExplorer

Disclaimer: none of our code ever has bugs... :-). So despite this, we are working on resolving these bugs and implementing
planned functionality. Here is a short non-inclusive list of known problems that we are resolving. We welcome and encourage you
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to E-mail us with any bugs that you find do exist as well as suggestions for capabilities you would like to see. Asthe new open-
source MAEPIugins facility evolves, most new (and some old) functionality will migrate to these plugins. Then the user
community can help maintain these analytic methods.

If you encounter afatal error that is detected by MAExplorer, it will popup an error reporting window. Please E-mail this data to us
SO we can try to resolve the problem.

In the mean time, partially implemented commands are disabled to keep you out of trouble :-) ...

You can help us and get MAExplorer to do more of the things you would like to see. Let us know of problems that you encounter
aswell as suggestions for changes or new methods you would like to see - send us E-mail.

4.1.1 Browser Applet Bugs

4.1.2 Downloading and Installer Bugs
4.1.3 Computation speed and display Bugs
4.1.4 User state and login Status

4.1.5 Datafile names Bug

4.1.6 Gene Sets Bugs

4.1.7 Clustering Bugs
4.1.9 Expression profile Bugs

4.1.9 Data conversion problems
4.1.10 Java Plugins Bugs

4.1.1 Browser Applet Bugs

1. When using MAEXxplorer as a Web browser applet (this does not apply if running as a stand-alone application - and we
recommend running it as a stand-al one application not as an applet), there are problems with running MAEXxplorer on some
of the Web browsers on some operating systems. It generally works with Netscape 4.7 or later, on Windows PCs
(95/98/NT/2000/XP), and on SUN Unix and with Microsoft Internet Explorer 5.0 on PCs. It may not work aswell as an
applet on Macintoshes - even with Internet Explorer (although it works fine as a stand-al one application on the Mac) and
problems have been reported on SGI systems because of browser problems.

If you are experiencing Web browser problems using the MAExplorer applet, you might check the discussion of possible
solutions.

2. When run as aWeb browser applet, you should only click once since multiple clicks may cause some browsers to hang.
Note that when you click the first time, it starts downloading the applet. Clicking a second time may cause a second request
for the applet to be launched. Thisinterferes with the first request and so neither is started correctly.

3. When the MAEXxplorer applet is being downloaded, some browsers do not indicate to the user that it is being downl oaded
and so it may appear that nothing is going on. Some browsers will not indicate that it is downloading an applet. So please
be patient. When it starts, the main window will popup and it continues to download data. Wait awhile for it to load the
applet before giving up. For a 28Kb Internet connection, this could take several minutes. When it is finished, the menu bar
will become active and it will display Ready - click on a gene to query database.

4.1.3 Downloading and Installer Bugs

1. We have had reports of problems with MAEXxplorer installations or running MAExplroer on MacOS 9 since we started
distributing MAEXxplorer with the new Install Anywhere version 5.0.2. We suggest you switch to MacOS-X or use a
Windows, Linux or Solaris system until this gets resolved.

2. Installer does not start or does not download the data. Normally, when you attempt to download MAExplorer to your
computer, the Install Anywhere software running in your Web browser will detect which OS you are running and suggest
the particular download to usein:
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"Reconmended version for your comnputer
Downl oad installer for ...your OS..."?

Occasionally, we have seen instances where you can not install MAExplorer from within the Web browser. The solution is
to explicitly download the particular Platform for your OS in the Available Installerslist. And then to follow the
instructions on running it.

3. If you have problems downloading this with Netscape 4.7x or later, then try Internet Explorer 5.0. It could be a Mime/type
problem with your particular browser not setup correctly.

4. On Solaris, and possibly other Unix systems, you may have problems with the stack limits. Do a"man limit" to read about
the command for your particular Unix shell. We have found that the following seems to work. For CSH, add the following
to your .cshrc startup file. With versions 96.25 and later of MAEXxplorer, you may adjust the memory size using the (Edit
menu | Preferences | Resize MAEXxplorer memory limits for the next time it is run) command. This edits the startup file
according to the new memory limits you specify.

l[imt stacksize unlimted
4.1.4 Computation speed and display Bugs

1. Becauseit doesalot of computation, MAExplorer runs best on afast computer with lots of memory. An optimal system
should have at least 128Mb of memory at least 500Mhz CPU speed. For doing hierarchical clustering we recommend
256Mb of memory which will allow you to cluster larger sets of genes without paging the operating system. So you may
run into problems with running out of memory on an under-powered computer. To increase the usable memory size to more
than 256Mb (assuming your computer has it), then you may need to edit the MAExplorer.lax file that resides where you

installed MAExplorer on your computer to increase the heap and stack maximum limit.

2. We have seen instances where the same system will run out of memory with particular Web browsers (again - not a problem
when running stand-alone) Netscape 4.7 on a system with alot of memory. This does not seem to happen with Internet
Explorer 5.0. Thisis because Netscape4.7 on the Windows PC seems to be able to use only about 5.5Mb before it runs out
of memory. Thisis not the case with Internet Explorer 5.0.

3. MAExplorer isdifficult to use with a system with a small screen because of the size and number of multiple graphic images
and plots. We recommend a screen size of at least 1024x768. As they say these days, more is better :-), generally.

4. For problems with MAExplorer and MacOS, you might also see our MacOS problems FAQ.

5. For problems with MAExplorer and Sun Solaris OS, you might also see our SUNOS problems FAQ.

6. We have on rare occasions seen a data-related problem on MacOS systems. If the data was edited in such away that the line
terminators were Return characters instead of Linefeeds or Return-Linefeeds, the data may become corrupted and
MAExplorer has difficulty reading it. The solution is to replace the Return characters with Linefeeds or Return-Linefeeds.
One (painful) way this might be done by exporting the data to a system such as a Windows PC; read the data into Excel;
saveit as an Excel worksheet file format; exit Excel; start Excel again on the new datafiles; save the data files back into the
original MAEXxplorer directories as tab-delimited text files. MAEXxplorer should recognize Return as the line terminator.
This bug will be resolved in afuture rel ease.

4.1.5 User state and login Status

1. User registration and the groupware access functionality are not available yet. However, login is available for collaborator
databases on the MGAP MAEXxIorer Web server.

2. The commands to save and restore user states for a particular user on the back-end server are not available yet. However, in
stand-alone mode you may save the state (including all gene and condition sets, parameter conditions, condition sets, etc) on
alocal computer by doing a (File menu | Databases | Save As DB). The specialized groupware commands that will allow
users to selectively share their saved states with particular other users on a public groupware server is not available yet.
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4.1.6 Data file names Bug

1. Thereisapotential problem with using long file names when using MAExplorer with MacOS-8 or MacOS-9. Both of these
operating systems limit file names to 32 characters. This could be a problem if importing data from another operating
system (Windows, Unix, Linux, etc) that does not have this restriction. The solution is to use short file names. This should
not be a problem with MacOS-X sinceit allows file names with up to 256 characters.

4.1.7 Gene Sets Bugs

1. Thefull range of GeneClass subsets (Section 2.4.1) is not available yet. However, you may use the gene name guesser to
find a set of genes by wildcard into the Edited Gene List (e.g. "*ONCO*" to find all oncogenes or proto-oncogenes, €tc).
These EGL sets may then be saved as named gene sets and used in the data filter as "Filter by 'User Gene Set™. See the
Gene Class ontologies using Gene Set operations (Section 2.4.1) that can achieve asimilar effect.

4.1.8 Clustering Bugs

1. The hierarchical clustering method is buggy. It currently clusters genes - but not samples. The latter is under construction.
Centroid averaging is implemented and the arithmetic averaging is under construction. Although it generates a clustergram
plot, the dendrogram drawing may not be drawn correctly using centroid averaging. Depending on the number of samples, it
you do acomplete hierarchical cluster for all genes and ESTs on a Netscape browser on a Windows PC, the browser may
run out of memory and nothing appears. [When done in the stand-alone application, thisis less of a problem since there are
no memory restrictions.] Y ou can do three things at this point: 1) switch to Internet Explorer, or 2) decrease the number of
genes being clustered (e.g. just "All named genes") or the CV filter. The third option isto disable the clustering cache. This
will be done automatically for you and it will continue doing the clustering. Y ou may turn off (or on) the Use cluster
distance matrix cachein the "Hierarchical Cluster Plots submenu. It will perform the clustering, but will take MUCH
longer without the cache.

2. If you are working with very large data sets then if you start afind similar genes or K-Means clustering with avery high
threshold, you can not change the threshold until it is done. In these situations, try pre-setting the threshold distance,
number of clusters using the (Edit | Preferences | Adjust all Filter threshold scrollers). Thiswill popup the state scroller
window with all of the thresholds. Y ou may also select the current gene prior to starting clustering.

4.1.9 Expression profile plots

1. The Expression Profile Overlay display is being improved to offer better graphics and interaction.

2. We have observed some instances of the popup EP plot where data does not seem to correspond to the data. This may be
related to the normalization method.

3. When viewing an ordered list of EP plots associated with a sorted list of genes (e.g. clustering genes similar to a seed gene),
if there are replicated genes in the clustered genes, they may not show up in the scrollable list of EP plots.

4.1.10 Data conversion problems
1. The Cvt2Mae datafile converter application is currently available for beta-testing on the arelated MAExplorer Cvt2Mae
Web page. It enables users to convert their data files (academic one-of-a-kind as well as commercial e.g. Affymetrix,

Incyte, GenePix, Scanalyze, etc) to the standard MAEXxplorer files as described in Appendix C and D.

2. If you are not able to convert your data using Cvt2Mae (which is currently in early Betatesting - see the Cvi2Mae Web
page for current status), you can always manually convert the data using the examplesin Appendix C.

3. We have seen some problems running the converter with some types of data on MacOS 8-9. The temporary solution isto
convert your data using another system such as Windows until we fix the problem.

4. If you are using the NCI-CIT mAdb system to package data for MAEXxplorer, you must select al samples from multiple
projects that you want to compare with MAEXxplorer while packing the datain mAdb. (See PDF document "How to
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download mAdb data For MAExplorer") Currently, you can not easily merge the data after you have downloaded the files
to your computer. The solution isto use mAdb to prepackage all data you want to analyze in asingle .zip file. You can not
currently merge data from separately unzipped files (without manually editing the SamplesDB.txt file). The way you
package datausing mAdb isto: 1) select ALL of the projects that contain samples that you want (on the mAdb "Top Level
Anaysis Selection” web page); 2) further select the exact subset of samples that you want in the "Array Selection” table on
the "mAdb: Database Retrieval" web page). NOTE: currently, you can only select arrays using the same GAL file so they
have compatible geometries. Thisis on our list of things to change so you can mix and match data from different chips.

4.1.11 Java Plugins bugs

1. JavaPlugins arein the process of being implemented and will be made available to the user community to enable them to
add their own analysis methods to MAExplorer.

4.2 Revision notes

This section lists the revision history and is useful for deciding whether to upgrade to the most recent release. Y ou may want to
check for the latest the current " Stable release” available on the MAEXxplorer Web site. That may be different than the Stable
release listed in this copy of the Reference Manual. The "Betarelease” listed below the Stable release in the previouslinksis

experimental and may generally be downloaded as it has more functionality. If you experience problems, you can just reinstall the
Stable version.

Note: An archive of some of the stable older releases is available on the NCI/LECB Web site for alimited period. I

. Version 0.96.34.01: (11-24-2003) Fixed problem introduced in the previous release where you could not increase the
memory size invoked by the (Edit | Preferences | Resize MAEXxplorer memory limits for the next timeit is run) command.
To fix this bug you must reinstall MAExplorer using the full download using the Javainstallers. Also added ability to
visualize the CV (coefficient of variation of a set of replicate samples) using the new (Analysis | Plots | Show microarray |
Pseudocolor HP-EP 'list' CV (Coefficient of Variation) [RB]) command. It computes the CV for the HP list. So use the
(Samples | Choose HP-X, HP-Y and HP-E samples) command to define the HP-EP list of samples you want to investigate.

. Version 0.96.33.07: (08-15-2003) The code implementing the R eval paragigm has been refactord so that it is clearer and
will be easier to use for other projects. See the RtestPlugin documentation Section 6 for details.

. Version 0.96.33.04: (07-31-2003) Fixed minor bugsin MAExplorer and Reval data export for RLO methods.

. Version 0.96.33.03: (07-23-2003) Fixed minor bugs in current OCL state as well as adding support for future
MAERIibr.zip updates from the Web.

. Version 0.96.33.01: (07-09-2003) Fixed bugs where the XY scatterplot and other functions may not work with some data
where there were empty genes in the database. Changed the underlying control mechanism to switch between the 4
clustering methods so it is more robust and easier to use.

. Version 0.96.32.10: (06-30-2003) added loessPlot() R method to MAERIibr R library. Thisis used by RtestPlugin for
generated code.

. Version 0.96.32.09: (06-26-2003) added new command (Plugin menu | Save RLO reports in time-stamped Report/ folder
[CB]). put files generated by R from successive executions of the same RLO into separate sub-foldersin the Report/ folder
with names "RLOname-YY MMDD-HHMM SS/" to peep the data separate. This is useful when you want to compare results
from the same RLO method but with different MAEXxplorer preprocessing. Also added new command (Analysis menu |
Filter | Filter by genes with non-zero intensity) which can be used to omit genes with zero intensity values in any samples of
the HP-EP set of samples. Thisis useful when exporting datato RLOs that may have problems by dividing by 0.0 etc.
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. Version 0.96.32.08: (06-17-2003) fixed bug in RtestPlugin for Version 0.96.32.07 where it did not always use the intput
file mode correctly. Simplied the "Add Template" usage to "Generate Template for 1st input file". Finished inplementing
the (Files | Update RLO methods from Web server) so that it updates the MAERIibr package library file
(libkMAERIibr/R/IMAERIibr) aswell asthe .R and .rlo files for the RLO methods.

. Version 0.96.32.07: (06-15-2003) fixed RtestPlugin editor bug that did not always setup parameters for New RLO
correctly. Thereis still abut that may require you to set the input files mode to the corresponding Demo BEFORE doing
"Add Template". Thiswill be corrected shortly.

. Version 0.96.32.06: (06-13-2003) fixed RtestPlugin editor bug that did not always save the Routput files types. Also fixed
bug in demo R script Test.R.

. Version 0.96.32.05: (06-12-2003) fixed code generators and changed all R methods in the MAExplorer MAERIibr to have
a"mae." prefix to minimize conflict with other packages. Added alpha-level support for XY overlay plotsin MJAplot class
of the API.

. Version 0.96.32.04: (06-11-2003) fixed code generators on Demos 1-15. Demos 16-17 now broken with VSTACK error.
Major code generators cleanup in RtestPlugin. Demo 15 (with use Filter Action) works but does not toggle the (Analysis |
Filter | Filter by user gene set) menu checkbox. Also added code to R2MAE actions to better support reimporting gene sets
back into MAEXxplorer.

. Version 0.96.32.03: (06-08-2003) Moved the MAEXxplorer-R interface R library code from the .R filesto an full R library
that now is downloaded when you do the full download/install of MAExplorer. We will be adding an update for this
MAERIibr library. The Web update is not available currently available.

. Version 0.96.32.01: (05-29-2003) Added (Files | Update RLO methods from maexpl orer.sourceforge.net) command to
update RL O methods from the server. RLO methods consist of pairs of R scripts and RLO files. Note: R must be installed
on your computer to use these methods. When MAEXxplorer is restarted these new RLO methods will be available in the
(Plugins | RLO methods) submenu.

. Version 0.96.31.23: (05-27-2003) Fixed bug in reading RLOs if they were manually edited with a Windows text editor that
replace line feeds with carriage returns.

. Version 0.96.31.22: (05-22-2003) Minor changesin RtestPlugin and R evaluation support code.

. Version 0.96.31.21: (05-18-2003) Reorganized RtestPlugin code and updated some of the code generators.

. Version 0.96.31.20: (05-14-2003) Fixed bug where MAEXxplorer could crash if R was not installed. Thiswas also in the
RtestPlugin. Now, it detects that it is not there if you cancel the prompt for specifying R iswhen it can't find it. Thisis noted
inaspecial . RbasePat h filewhich contains"**NO_R_INSTALLED**". Thisisthen used to prevent you trying to
access any R commands or menus (i.e. keep you out of trouble).

. Version 0.96.31.19: (05-14-2003) Fixed minor bugs in RtestPlugin and support for horizontal and vertical stacked data.

. Version 0.96.31.18: (05-08-2003) Fixed minor bugs in RtestPlugin and support.

. Version 0.96.31.17: (05-06-2003) Fixed prompt in "Update Plugins’.

. Version 0.96.31.16: (05-05-2003) Changed the "Update M AEPIugins from maexplorer.sourceforge.net” so that it will
download ALL of the pluginsif you answer Y ES rather than one at atime. More cleanup for RtestPlugin Template
paradigm.

. Version 0.96.31.15: (05-05-2003) In RtestPlugin, simplified R code to use new multi-line header datafile paradigm and
started to add data model Template generation code. OCL demo does not work with new paradigm.

. Version 0.96.31.14: (04-30-2003) Fixed problem with R script evaluation if the sample names had spaces in the name.
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Quoting these fixed the problem.

Version 0.96.31.12; (04-28-2003) Fixed fatal error problem introduced in 0.96.31.12 if start MAEXxplorer with no database.
This version fixes bugs in some of the RtestPlugin Demo R code generators and data files.

. Version 0.96.31.11: (04-25-2003) Fixed quote problem with with executing R in some cases for RtestPlugin. Fixed

Prev/Next problem.

. Version 0.96.31.10: (04-23-2003) Added "Save ALL Demo RLOs" to RtestPlugin to generated demo RLOs for (Plugins |

RL O methods) menu next time MAEXxplorer is restarted. The demo R Code generators are not validated yet.

. Version 0.96.31.9: (04-22-2003) Fixed RtestPlugin problem with sample set names when generate RLOs for XY sets and

OCL condition sample sets. Changed the export data formats so easier to use in R. The demo R Code generators are not
validated yet.

. Version 0.96.31.8: (04-21-2003) Fixed problem with RtestPlugin that sometimes showed up when installed in " C:/Program

Files/" on a Windows system (needed to quote the path). It now works on windows. Note: RtestPlugin Demos 10-13 and
Demo 16 are not working correctly. The demo R Code generators are not validated yet.

. Version 0.96.31.7: (04-18-2003) Gene Set actions now work for RLOs. The demo R Code generators are not validated yet.

. Version 0.96.31.5: (04-13-2003) Extended the RL O definition and support code. Extended RtestPlugin to access this. The

demo R Code generators are not validated yet.

. Version 0.96.31.4: (04-11-2003) Added "RL O methods to Plugins menu. This uses RLO files generated by the RtestPlugin.

Additional bug fixes and better error reporting of R evaluation errors. The demo R Code generators are not validated yet.

. Version 0.96.31.2: (04-07-2003) Extended RtestPlugin and corresponding changesin MJA API. The demo R Code

generators are not validated yet.

. Version 0.96.31.1: (04-03-2003) Cleaned up gene filter processing model.

. Version 0.96.30.10: (03-29-2003) Better support for RtestPlugin.

Version 0.96.30.8: (03-28-2003) Modified the MJAReval, MJAgeneList, MJAfilter API class methods to support the
RtestPlugin. RtestPlugin now supports "New RLO" at alphalevel.

Version 0.96.30.6: (03-25-2003) The RtestPlugin editor isworking (alphalevel) for demonstration purposes-only at this
time.

Version 0.96.30.5: (03-18-2003) The RtestPluginis alphalevel. Maodified the MJAReval class methods to support this.
Thisis ill alpha-level, and may change.

Version 0.96.30.4: (03-17-2003) Added new functionality to evaluate MAExplorer data using the R system. Thereisanew
MJAReval to access methods to do this. Using MJAReval, one can write MAEPlugins to process MAExplorer datain R
and to bring back the results into MAExplorer. Thisis still alpha-level, and may change.

Version 0.96.30.3:; (03-04-2003) Fixed radio-button usage of NormalizationPlugin so that only one normalization (either
built-in or plugin) is active at atime. The MJA APl was enhanced to add this functionality.

Version 0.96.30.2: (03-02-2003) Major ehnancements of the NormalizationPlugin paradigm in the MJA library to support a
wide variety of normalization methods - both global and local. This includes support code throughout MAExplorer to
support it and to make it easier to debug. Although it works, the NormalizationPlugin is still Alpha-level and will be
documented fully when it enters Beta-level code.

Version 0.96.29.3: (02-25-2003) Rebuilt installers (Windows, Linux, Solaris) with Java Virtual Machine (JDK) 1.4.1 01
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that has improved performance. Y ou must do adownload and reinstall -- not just an update from (File menu | Update
MAExplorer from maexplorer.sourceforge.net).

. Version 0.96.29.3: (02-23-2003) Added more support for FilterPlugins. The ExampleXY datakilterPlugin example now
works. It is meant to be amodel for more sophisticated plugins. [TODOQ] it needs parameters GUI popdown.

. Version 0.96.29.2: (02-21-2003) Fixed many problems with MJA classes where some methods which should have been
public were not so MAEPIugins could not access them. This has been corrected. The FtestNconditionsFilterPlugin is now
working.

. Version 0.96.29.1: (02-19-2003) Added popup aert message window for bettering informing users of conditions that
prevent them from doing the operation they requrested. They must press the Close button to pop-down the message,
although they can do a SaveAsto afile to save the message. For complex problems, some of the messages may suggest
what they need to do to correct the problem.

. Version 0.96.28.3: (02-18-2003) Added 2 new filters: "Filter by HP-X,HP-Y 'sets t-Test [p-Value] dider [RB]" and "Filter
by current Ordered Cond. List (OCL) F-Test [p-Vaug] slider [RB]". The p-Value related Filter tests were changed to radio
buttons [RB] so that only one would be operative at atime. If another p-Value dependent test is on, it will be shut off it you
select a different p-Value dependent test. Added new support methodsin the MJA API in classes MJAsampleList,
MJAstatistics, MJAfilter, and MJAmath. Implemented the "List OCL" and "List All"* OCLsin the OCL chooser. Improved
the GUI legends in the Condition Chooser and the Ordered Condition Chooser.

. Version 0.96.28.1: (02-15-2003) fixed default R2 and CR2. Modified State Scrollers paradigm so that it uses slider usage
counters (instead of flags) so that MAEPlugins may share sliders (e.g., p-Value, cluster distance, etc).

. Version 0.96.27.1: (02-12-2003) added named Ordered Condition List (OCL) editor as a builting method.

. Version 0.96.26.1: (02-08-2003) added methods to MJAsampleList to get either normalized Filtered data or normalized
complete set of genes data. Fixed bug in CompositeDatabase.

. Version 0.96.25.5: (01-28-2003) Fixed bug in "Remove Parameter" in the condition chooser. Added new methods
MJA condition, added method in MJAsampleList to get all raw sample data.

. Version 0.96.25.4: (01-13-2003) Fixed bug in "Remove Parameter" in the condition chooser.
. Version 0.96.25.3: (01-02-2003) Fixed bug in "Remove Condition" where it previously deleted the wrong condition list.

. Version 0.96.25.2: (12-14-2002) Added "Remove Condition" to (Sample menu | Choose named condition lists of samples)
aswell asfixed severa bugs related to the condition chooser. Also added the same command to the (Edit menu | Sets of
conditions | Choose named condition lists of samples) menu since it is a condition editing function.

. Version 0.96.25.1: (12-11-2002) Made some of the tests for names case-independent for smoother operation.

. Version 0.96.25: (12-06-2002) Added new anew command (Sample menu | Choose named condition lists of samples) lets
you define or edit new named lists of hybridized samples.

. Version 0.96.24.12: (12-04-2002) Added support for RefSeqlD and alternate spellings of other genomic identifiers.
Modified MAJcondition class to support ConditionChooser.

. Version 0.96.24.11: (12-02-2002) Added support for RefSeglD and alternate spellings of other genomic identifiers.
Modified MA Jcondition class to support ConditionChooser.

. Version 0.96.24.10: (11-30-2002) Updated the default URL s used for GenBank, UniGene, LocusLink, and added OMIM
ID support.

. Cvt2Mae Version 0.73 (11-26-2002) Added ability specify multiple chips/sample (e.g. Affy U133A and U133B) for the

file:///C|/tmp/MaeRefMan/hmaeFullRefMan.html (112 of 234) [11/24/2003 10:49:36 AM]



MAExplorer - cDNA Microarray Exploratory Data Analysis

MASS5.0 data. It will merge the data into one sample during the conversion.

. Version 0.96.24.8: (11-20-2002) The ConditionChooserPlugin is now working (alpha) and is included in the distribution.
Additional changes were made to MAEXxplorer to support it.

. Version 0.96.24.7: (11-18-2002) Fixed Scrollbar initialization problem for the non-linear scrollers (p-Values, CV value,
etc.)

. Version 0.96.24.6: (11-15-2002) Fixed Q&A error in the command "Resize MAExplorer memory limits for the next time it
isrun" isin the (Edit | Preferences) menu. Added or debugged methods to M JA property and extended M JAcondition MJA
API.

. Version 0.96.24.5: (11-07-2002) Add command to resize the memory limits of MAExplorer. The command "Resize
MAExplorer memory limits for the next timeit isrun" isin the (Edit | Preferences) menu. After the command is run, you
must exit and restart MAExplorer for the new memory limits to take affect. It changes the memory limitsin the
MAExplorer.lax startup file.

. Cvt2MaeVersion 0.72.4 (11-07-2002) Fixed bugsin "Define Gipo Fields' where it would be be available under certain
conditions. Also fixed another bug introduced with the addition of the MAS5.0 data.

. Cvt2MaeVersion 0.72.3 (11-05-2002) Increase buffer sizesto fix problem for very large input files with large gene
descriptions.

. Version 0.96.24.4: (11-03-2002) Fixed bug in non-linear slidersin State Scrollers. This had affected the values for the p-
value and CV value. Extended functionality of popup State Scrollers sliders window. Y ou can now toggle between all
dliders, even those not active, and only those that are active.

. Cvt2MaeVersion 0.72.2 (11-02-2002) Fixed bugsin Affymetrix MAS5.0 where the "Define Quant Fields" were not being
mapped automatically and separate files were not converting correctly.

. Version 0.96.24.2: (10-24-2002) Added (File | Update Plugins) operation. It will prompt you on whether you want to
update each default plugin one by one.

. Cvt2MaeVersion 0.71.2 (10-23-2002) Moved the name of the available Cvt2Mage.jar version number to the popup diaog
guery when doing the "Update Cvt2Mage" operation.

. Version 0.96.24: (10-22-2002) Extended the number of grid groups from 52 [A-Z,a-Z] to 152 [A-Z,a-z,1-100]. Moved the
name of the available MAEXxplorer.jar version number to the popup dialog query when doing a (File | Update MAExplorer)
operation.

. Version 0.96.23:; (10-21-2002) Extended the MJAgene.java API class so MJAPIugins can set gene annotations and
properties from the plugin using external data.

. Version 0.96.22: (10-18-2002) Extended the (File | Update MAExplorer) command so that it reads the version number of
the MAEXxplorer.jar file on the maexplorer.sourceforge.net server and displaysit prior to requesting the user to finish
requesting the update. This allows usersto seeif they want to do the update.

. Cvt2MaeVersion 0.71.1 (10-16-2002) Added a"Update Cvt2Mage" button. Thiswill (1) backup the current Cvt2Mae.jar
file as Cvt2Mae.jar.bkup; (2) copy the latest Cvt2Mae.jar file from the maexplorer.sourceforge.net Web site and replace
your Cvt2Maejar file in your installation directory. Then when you restart MAExplorer, it will use the new version of the
program. The much more time consuming alternative is to do an entire download and reinstallation from the Web site.

. Version 0.96.21: (10-15-2002) fixed comments for (File | Update MAExplorer) to give the actual server it will use. Fixed
default PseudoArray Image to use when have single Cy3/Cy5 sample to use (Red-Y ellow-Green) display. Cvt2M ae
Version 0.70.7 (10-15-2002) has a major re-indentation of the Java source code to make it easier to read using the
convention describe in the previous revision.
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. Version 0.96.20: (10-14-2002) We added a"Define GEO Platform ID" command for arrays that were submitted to NCBI's
GEO (Gene Expression Omnibus) for use with future MAEPIugins. Y ou can now use the new "Update MAExplorer"
command in the File menu. Thiswill (1) backup the current MAEXxplorer.jar file as MAEXxplorer.jar.bkup; (2) copy the
latest MAEXxplorer.jar file from the maexplorer.sourceforge.net Web site and replace your MAExplorer.jar file in your
installation directory. Then when you restart MAEXxplorer, it will use the new version of the program. The much moretime
consuming alternative is to do an entire download and reinstallation from the Web site. This version also has amajor re-
indentation of the Java source code to make it easier to read. It uses the automatic javaindentation engine in Fote 4.0 (2
spaces/tab, convert tabs/space, space before '{', no space before ().

. Cvt2MaeVersion 0.70.6 (10-11-2002) Fixed bug in Configuration file generator.

. Version 0.96.18: (10-09-2002) Changed popup HP chooser initial window sizing so it works more consistently across
platforms.

. Version 0.96.17: (10-04-2002) Fixed bug with DetValue dlider (the test was reversed). Also increased the dynamic range
and precision of value indicated. The default isto leave the Detection Value filter off. Changed the default PseudoArray
Image if there is one Cy3/Cy5 sample from the intensity display to the sum of cy5 (red) and Cy3(green) channels.

. Cvt2MaeVersion 0.70.5 (10-03-2002) Fixed bug in Affy MAS4 converter when selected "Generate genomic IDs from
Descriptiopn”. Also fixed bug in Quant Field assignments so it now shows the "DetVaue" field when it was selected by the
DetVaue checkbox in the Genomic Identifiers Wizard.

. Version 0.96.16: (9-30-2002) Fixed bug with positive data filter whereby it defaulted to being on. This was changed so that
you need to explicitly enableit in the Filter menu.

. Cvt2MaeVersion 0.70.4 (09-27-2002) Added GEO Platform ID support.

. Cvt2Mae Version 0.70.3 (09-23-2002) fixing the ArrayLayout Affy MASS5 tmp file converter. It now appears to generate
the temp file correctly and read it correctly. Need to verify the code generators for the GIPO.txt file. There was a problem
with embedded double quotes and the MAS5 ALO was not correct. Also had to add the additional fields to the FieldMap
when thetmp file is extended.

. Version 0.96.15: (9-19-2002) Added a new "Filter by Spot Detection Value" datafilter. This can be used with the new
Affymetrix MAS5.0 "Detection p-value' mapped through the "DetValue" or "CorrCoef" field in the .quant file. The next
version of Cvt2Mae after 0.70.2 will output the "DetValue' field.

. Cvt2MaeVersion 0.70.2: (09-18-2002) Added automatic delete of old default Affymetrix*.alo files when Cvt2Mae starts
up. Thiswas required since we changed the names to reflect the MAS-4.0 and MAS-5.0 versions of the analysis software.
Without this, you would have multiple names for the same filesin the Array Layout chip list.

. Cvt2MaeVersion 0.70.1: (09-17-2002) Fixed bugs introduced in 0.70. Added remap code to better handle MAS5.0 data.

. Cvt2MaeVersion 0.70: (09-15-2002) Added Affymetrix MASS array layout so it will map (Signal, Detection, Detection p-
value) to (Rawlntensity, Qual Check, CorrCoef) Quant data fields. Fixed bug in " SwissProtID" data parser.

. Version 0.96.14: (9-14-2002) Fixed incorrect base URL in "Help" pull-down menu. It had pointed to the old MAEXxplorer
Web site not the the new http://maexpl orer.sourceforge.net/MAExplorer/. The same documents were always visible from
the Web site, but this makes it more convenient.

. Cvt2Mae Version 0.68: (08-30-2002) Fixed bugs in Edit Layout where it was not aways saving the changes you make to
the state. Pressing Cancel in the Edit Layout restoresthe initial state before starting the edit. Pressing Back saves the state of
the current panel you are working - previously only Next or Finish did that.

. Version 0.96.12: Fixed bug introduced in version 0.96.11 such that it would pop up the dialog query when you did a"Open
Disk DB" command.

. Version 0.96.11: Extended MJAeval methods so can more easily invoke a new .mae startup file via a client-server
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MAEPIugin as well as the invokeCommand method. Modified internal methods and structures to support this.

. Cvt2MaeVersion 0.67: (08-15-2002) Fixed bug where the generated pseudoarray image was overiding the user specified
(grid,row,column) geometry.

. Version 0.96.10: Fixed bug in pseudoarray image whereby the current gene icon (yellow circle) sometimes was not reset
properly for adatabase with X,Y coordinate data if the current gene was selected and you switched the current sample.

. Version 0.96.08: Fixed bug in pseudoarray image whereby the current gene icon (yellow circle) sometimes was not reset
properly if you toggled the mouseover checkbox, selected a different sample using the sample list in the pseudoarray image,
or scrolled the pseudoarray.

. Version 0.96.07: Fixed bug in font size updates for the pseudoarray image and scatter plot. Added methods to MJAproperty
to get font size and font familiy.

. Version 0.96.06: Modified data filter property bits for Gene, MJAgene, and Filter to make them more consistent when
writing MAEPlugins.

. Version 0.96.05: Fixed bug in datafilter that caused problems with FilterPlugin's.

. Version 0.96.04: Fixed bug when run database with no startup database, it does not refresh spot listsin the PseudoArray
image.

. Version 0.96.02: Fixed bug when run database with no startup database and no default MGAP demo database. It now lets
you search the disk to find a.mae startup file instead of aborting with a Dryrot error. Fixed bug with chooser where it
sometimes failsto let you access the last element of alist. The NCI/LECB site and the SourceForge site now both have the
same full installers with JDK's (except for AlX and HPUX) and with the MGAP database.

A Cvt2Mae Version 0.66: bug has been fixed that makes it easier to automatically find the first row of spot data when
scanning the users data input data file. Previously, the user might have to manually enter that starting data arow number in
the Edit Layout wizard.

SourceForge
. Version 0.96.01: Initial release onlLodo Note: The NCI/LECB site will have the sameinstallers., but with VMs
if you want to download a version with the VM for your computer. The SourceForce does not have the JV M s because of

space limitations.

. Version 0.95.20: Inserted Open Source Licenseinto all code.

. Version 0.95.19: Changed default for (File | Save file DB) and (File | SaveAsfile DB) so that it saves all samplesin the
new .mae startup file - not just the samplesin HP-X 'set', HP-Y 'set or in HP-E 'list'. Made the three status lines in the main
window non-editable.

. Version 0.95.18: Maintenance release. The Open Java API has been changed in the mjaGeneList, mjaGene, mjaEval
classes.

. Version 0.95.17: Maintenance release. The Open Java API has been updated and now includes working updateCurGene(),
updateFilter(), updateSlider(), updatel abel (), and close() methods as well as new methodsin the MJAgeneList API class.
The stable release is now the version with the MaeJavaAPI active. The previous stable release 0.95.04 did not have the API.

. Version 0.95.16: Maintenance release.

. Version 0.95.15: Maintenance release to fixed FilterPlugins so the FilterTestPlugin example is working. Fixed bug recently
introduced that prevented selecting spot in pseudoarray image.
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Version 0.95.14: Fixed bug recently introduced that prevented menu commands from working correctly.

Version 0.95.12: Maintenance release. Changes to help support MAEPIugins and additional functionsin the Open Java
API. Fixed Quant input data parser bug so it now handles strictly lower-case letters for (Grid,Row,Column) data.

Version 0.95.11: Maintenance release. Changes to help support MAEPIugins and additional functions in the Open Java
API.

Version 0.95.10: Maintenance rel ease changes to help support MAEPIugins and additional functionsin the Open Java API.
Menu Plugin command is enabled to load MAEPIugins built using the Open Java API (under construction).

Version 0.95.08: Maintenance release to help support MAEPIugins and additional functions in the Open Java API. Menu
Plugin command is enabled to load MAEPIugins built using the Open Java APl (under construction). Added Pluging folder
to distribution that is installed where you install MAExplorer. It contains severa apha-level JAR file plugins that work
with the (Plugins | Load Plugin) command. We will be releasing the source code soon as the Open Java APl adphareleasein
put on the MAEPlugins Web site.

Version 0.95.05: Maintenance release. Changes to help support MAEPIugins and additional functions in the Open Java
API. Menu Plugin command is enabled to load MAEPIugins built using the Open Java APl (under construction). Added
(Plugins | Test Plugin Code) to invoke code for a plugin a debugging context (maintenance).

Version 0.95.04: Same as Version 0.95.03 optimized. It was compiled with the optimizing Java compile without debugging
symbol tables. All Plugin support codes was removed. Thisresultsin aMAEXxplorer.jar file of 449Kb vs 599K b for. Since
the MGAP Web site Applet version can not use Plugins, thisversion is optimized for Applets and isto preferred over the
Beta 0.95.03 version for now.

Version 0.95.03: Maintenance release. Changes to help support MAEPIugins. Menu Plugin command is enabled, but will
only load MAEPIugins built using the Open Java APl (under construction).

Version 0.95.01: Increased the number of spots/array that may be used from 16K to unlimited. Maintenance rel ease.
Changes to help support MAEPIugins.

. Version 0.94.15: Fixed bug where occasionally, it would not load additional samples from the (Samples | Set Samples from

Lists|...) commands.

. Version 0.94.14: Maintenance release. Changes to help support MAEPIugins. This rel ease fixes a menu-related bug that

occured if you used (File |Open File DB) to switch to a different database or to start the initial database rather than starting
directly from the .mae startup file. The problem was that some of the sub menus generated might not correspond to the type
of database. For example, if the previous database was an intensity database with duplicates F1 and F2, switching to a
Cy3/Cy5 database might have some of the menus still appear as (FL/F2).

. Version 0.94.12: Maintenance release. Changed placement of magenta circle marker so it is more visible in ClusterGram

when selecting genes in the dendrogram/ClusterGram for the EGL by clicking on a gene with the Control key pressed.

. Version 0.94.11: Fixed fatal error introduced ni 0.94.10 that occursif you start the database with no data. Version 0.94.10

did work if you started it with a particular .mae startup file.

. Version 0.94.10: Maintenance release. The "Filter by positive Quant data' toggle checkbox in the (Analysis | Filter menu)

is enabled for al databases - not just those requesting it. If the database has 2 channels (F1, F2) or (Cy3,Cy5) each channel
is checked. If the background correction is enabled, the background corrected values are tested to see if any of them are
negative. Changed the labelsin the scatter plot so that instead of displaying the current gene values as intensX= and
intensY= or intens X=and intens' Y=, it now displaysitas X=and Y=or X'=and Y'=. The' indicates that background
correction isactive. A new (Analysis | Plot | Show Microarray | " Scale pseudoarray image by 1/100 to zoom low-range
values) command has been added to rescale intensity and (Cy3+Cy5) and (HP-X + HY-Y) (Red-Y ellow-Green) plotsto so
low values are easier to visualize.

. Version 0.94.09: Maintenance and Reference Manual update. Added copy of "Show 'Edited Gene List™ to Edit EGL
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submenu so easier to find.

. Version 0.94.08: Changed button layouts on popup plots so it is easier to resize them to remove the right part of the plot if
you want to conserve screen space.

. Version 0.94.07: Fixed bug recently introduced in the histogram plots which prevent them from working. Fixed another
histogram plot bug where the frequency count for "><" thresholding was reported incorrectly.

. Version 0.94.06: Added the saving of the current values of all of the State Threshold scrollers when the (Edit menu |
Preferences | Adjust all Filter threshold scrollers) in the message logging area when the State Thresholds popup window
is closed. The Cvt2Mae (Version 0.60) has been extended to now handle Scanalyze data files as well as supporing a
separate GIPO input datafile.

. Version 0.94.05: Added logging of MAEXxplorer messages to buttons in popup plots and reports. Fixed bug where old fixed
gene sets for empty wells were not always restored correctly fro the previous state.

. Version 0.94.04: Added logging of MAExplorer messages and command history in popup windows in the View Menu as
"Show log messages' that occur during a session and " Show log of command history” respectively. The windows may be
saved in log files. Added additional error detection of bad (field,grid,row,column) data when reading the GIPO and Quant
files.

. Version 0.94.03: Maintenance release for improving MAEPIugin support.

. Version 0.94.02: Minor bug fixes related to the renaming of HybProbe to Samples menus. Also, extensive update of
reference manual in both text and figures to showing many of the renamed menus so it is synchronized with the program.

Version 0.94.01: Major version release.

Renamed all previous references in the program to "hybridization probe" or "hybridization sample probe" to the new term
"hybridized sample" for clarity. Changed many "HybProbe Menu" to "Samples Menu" and also many menu selections as
well as plot and report labels to reflect this change. We are in the process of updating the manual computer screen figures
and PDF dlide presentations so that "hybridization sample probe” is shown as "hybridized sample”. Also fixed other minor
problems including fixing the inverted color scale for the "Pseudocolor Red(Cy5)-Y ellow-Green(Cy3) Cy5+Cy3 ratio or
Zdiff" command.

. Version 0.93.03: Minor reorganization of (Plots | Clusters) submenus. Thisis the last release using the "HybProbe" menu.

. Version 0.93.02: Beta-test of JDK-1.3 MAEXxplorer.jar file and new InstallAnywhere 4.5 installer. This adds JDK-1.3
installers for MacOS-X, IBM AlX, HP-UX, Linux. However, MacOS 8.1-9.x use the MRJ-2.2.5 JDK1.1.8 library. It d'so
fixes a problem recently found running MAExplorer on some Windows-NT systems.

Version 0.93.01: Major version release.

Moved "Cluster Plots' submenu of the "Plots" submenu up one level inthe"Analysis' menu.

. Version 0.92.24: Maintenance and added more Plugins support. Top level Plugins menu appears, but is disabled in
production version.

. Version 0.92.23: Maintenance and changed names of some commands and some messages. Major edit of Reference Manual
including expanded table of contents.

Version 0.92.22: Last Stable Release.

Major version release. Optimized colorsin grayscale display for "Pseudocolor (HP-X,HP-Y) 'sets' p-value'. Fixed error and
optimized t-test computation.
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. Version 0.92.21: Changed grayscale display for "Pseudocolor (HP-X,HP-Y) 'sets' p-value" to display it as a color spectrum.
Changed data displayed so p-Vaue isin the front of the list when you click on a spot etc. Added tests to disallow this
display unless the data supportsiit.

. Version 0.92.20: Betatesting new pseudoarray image display "Pseudocolor (HP-X,HP-Y) 'sets' p-value" that displays agray
value proportional to the p-Vauein at-Test of the HP-X 'set' vs HP-Y 'set'.

. Version 0.92.18: Improved EP plot labels so it no longer printsthe "MID:" prefix. Improved spot features list so it no longer
prints the "plate[null,null,null]" if the plate coordinates are not present in the GIPO file.

. Version 0.92.17: Fixed a bug which incorrectly computed the max and minimum ratio Cy3/Cy5 ratio valuesiif the data
allows negative intensity on these channels after background subtraction. Thisis required to support the GenePix array data
format converter in the new version of Cvt2Mae (11-24-2001).

. Version 0.92.15: A new (Edit | Preferences) command Adjust all Filter threshold scrollers - popup the state scroller
window with all of the thresholds. Thisis useful when you want to adjust thresholds befor e you enable data Filtering or
clustering. A bug was fixed where the state of the previous clustering method was not always cleared if you aborted
clustering by clicking on the delete window button (eg. in Windows or the Mac). Click on arow with the Control (Shift)
key pressed in the ClusterGram for hierarchical clustering will add(remove) that gene to(from) the Edited Gene List. If the
(View | Show 'Edited Gene List") is enabled, then it will draw a magenta *' before the gene name to indicate that you have
selected it. Thislets you select a particular subset of the genes from the hierarchical cluster. The Cvt2M ae data converter

now has an apha-release to let you convert non-standard data using the <User -defined> data option.

. Version 0.92.14: The name of sample names and sample file names IDs has been made more flexible. If the
"Database File" islonger than 32 characters, there may be problems reading that file with MacOS-8/9. Therefore, you can
use the "DatabaseFilel D" to specify the "Database File" (in which case they would be the same). Then, the labels used for
the samples are the "Sample_ID" fields. Thisis upwards compatible with the previous method which used the
"Database File" for both the file name and the label name. The Reports of Highest (Lowest) Cy3/Cy5 datafor asingle
sample were not easily accessible and this has been fixed. Alternate names for automatic detection of ESTs, ESTs similar to
named genes were expanded and also includes the "EmptyWell" gene set (i.e. spots with no genes) (see Automatic Gene
Class naming based on Gene Name in Appendix C Table C.4.1). A clustering option was added, Use median instead of
mean for K-means clustering, of mean when computing K-means clustering (Bickel, 2001)).

. Version 0.92.13: Maintenance release. Changed per-sample Good Spot filter algorithm and the CV filter algorithm. Added
optionsto filter by either "HP-X 'set™ or "HP-Y 'set™. Algorithm now uses filters "HP-X or HP-Y" and "HP-X or HP-Y
'sets™ rather than the previous "HP-X and HP-Y" and "HP-X and HP-Y 'sets”. Adding some of the missing state that was
not being saved during a" SaveAs DB" operation when creating a checking .mae startup file.

. Version 0.92.12: Maintenance release for Plugins.

. Version 0.92.11: Maintainence release. Increased width of scrollable sample names selection windows so it is easier to see
the details on long sample names.

. Version 0.92.10: Maintenance release. Due to a problem that some users are experiencing with the Java Installer, we are
reverting to the previous version 4.01 (that does not support Mac-x). We will resolve these problems as soon as possible.
Also fixed a problem with the Pseudocolor Red(Cy5)-Y ellow-Green(Cy3) Cy3/Cy5 ratio or Zdiff which is now
resolved.

. Version 0.92.09: Maintenance release. Distribution of Java application with Install Anywhere 4.5 (previous was version
4.0.1). This now supports MacOS-X, other Unix systems and may fix some other installation problems.

. Version 0.92.08: Fixed bug in Edit use (Cy5/Cy3) else (Cy3/Cy5) for each HP command in HybProbe menu that changes
were not saved in the state. Fixed bug introduced in HP Cy3 vs Cy5 intensity scatter plot.

. Version 0.92.07: Added display of Cy3 and Cy5 channel intensity when click on gene in Pseudocolor Red-Y ellow-Green
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Cy3/Cy5ratio or Zdiff mode. Also added additional support for plugin installation from Configuration DB and .mae
startup files.

. Version 0.92.06: The Pseudocolor Red-Y ellow-Green Cy3/Cy5 ratio or Zdiff - display the Cy3 and Cy5 microarrays as a
pseudocolor image as the sum of Cy3 (Red) and Cy5 (Green).

. Version 0.92.04: Internal changes. Also fixed bug in reading Affymetrix data converted with Cvt2Mae in the case where
there is no genomic identifier and the "L ocation" is used as the genomic identifier.

. Version 0.91.03: Made configuration database "swapRowsColumns' default to FAL SE. This should probably never need to
be true except for the initial MGAP database. If this flag was not set to false in previous configuration DB files, it would
swap rows and columnsin the pseudoarray image display.

. Version 0.91.02: maintenance revision.

Version 0.91.01: Major version release.

This corrects afew minor bugs including crashing when starting up an empty database (that bug was introduced sometime
in the last month). It isthe first rel ease with some reorganized code.

. Version 0.90.08: Fixed bug in "Filter by 'Good Spot data" where the initial " Check spots for Good Spot mode" was not
properly initialized.

. Version 0.90.07: Additional fixes in Qual Check mapping now handles the three types: Alphabetic codes, MAExplorer
integer property codes, continuous floating point monotonic quality value. If the latter is used, then a" Spot Quality
threshold" slider will popup when it isinvoked. The MAExplorer Plugins Web page is also available at thei Web site and
will track progress with the development of the MAExplorer Plugins Open Java APl for investigators adding their own
analysis methods.

. Version 0.90.06: Fixed bugsin Genomic database popups. It was ignoring the request to popup aweb page for particular
genomic IDs.

. Version 0.90.05: Added Qual Check mappings of Affymetrix "Abs Call" of "P" (or "G" or "T") to Good Spot, "A" to Bad
Spot, and "M" (or "B" or "F") to Marginal Spot. This allows the "Filter by 'Good Spot data™” to handle thistype of data.

. Version 0.90.04: Added experimental GenomicMenu/URL configuation options for future use.

. Version 0.90.03: Added QualCheck datafilter for "Filter by 'Good Spot data™. Thiswill be active if the QualCheck datais
available in the .quant files.

. Version 0.90.02: Fix bug in some of the State scroller controls when adjusting a scroller latches into a fixed state that can
only be changed by restarting MAExplorer. Added LocusLink popup Web pages from LocusID (if it exists) or LocusLink
from GenBank identifiers.

Version 0.90.01: Major version release.

(very Beta) Changing convention so use "MasterI D" as the master gene index. This makes it more flexible than when used
the Clonel D as the master gene index. Added LocusLink.

. Version 0.89.41: Added new scatter plots for comparing Cy3/Cy5 ratio data to compare either Cy3 or Cy5 of HP-X against
Cy3 or Cy5 for HP-Y. Added additional change limit constraints "Compare channels meeting range" to "Filter by spot
intensity [SI1:S12] sliders™. This allows partial filtering by spot intensity.

. Version 0.89.40: Some of the State Scrollers were too sensitive at low values. Therefore, we set them to respond non-
linearly with a more precise vernier at the low end.

file://IC|tmp/MaeRefMan/hmaeFullRefMan.html (119 of 234) [11/24/2003 10:49:37 AM]


file:///C|/tmp/MAEPlugins/index.html

MAExplorer - cDNA Microarray Exploratory Data Analysis

. Version 0.89.39: Fixed bug t-Test if using multiple samples with arrays with 1 Field.

. Version 0.89.38: Fixed bug in Filter that allows the user to use either "positive only" or "positive or negative' intensity data
(used with Affymetrix data).

. Version 0.89.37: Increased the dynamic range of the scrollers for p-value, cluster distance, [21:22], |Diff XY|. Fixed labels
in the Cy3 vs Cy5 plot so they are updated when the current sample changes.

. Version 0.89.36: Fixed error in "Inside Range" for "Filter by Ratio ..." and "Filter by Cy3/Cy5 Ratio ...". Fixed HP-X,Y ,E
labels in the popup HybProbe menu "Choose HP-X,Y E ..." command. Also added a new button "<< that removes al
entries from the Selected list to the Remainder list. Changed the way the Cy3 vs Cy5 (for ratio data) or F1 vs F2 (if you are
using intensity data where all spots are replicated) scatter plots work - the HP-X vs HP-Y scatter plots are not changed. The
data Filter still worksfor al of the plots. Changed the name of the "NPN clustering” method in the menus and reports to "K-
means clustering” since that is essentially what it is.

. Version 0.89.35: Improved HP sample ID reporting in various lists, lists, etc. Added HybProbe menu command "Edit use
(Cy5/Cy3) else (Cy3/Cy5) for each HP" for use with ratio data. This selectively swaps (Cy3,Cy5) data entries so may use
(carefully!) dye-swap data for replicates. Added UP/DOWN buttons in the HP chooser to make it easier to adjust the order
of the HP-E list.

. Version 0.89.34: Changed the pseudoarray image generation paradigm so that it uses a fixed size spot and spacing and

makes the pseudoarray image size dependent on the number of grids, rows, columns and fields. This resultsin amore
consistent interface.

. Version 0.89.33: Added "Filter by Cy3/Cy5 HP-X ratio or Zdiff diders' to the Filter menu. Thisis useful for filtering data
from asingle sample.

. Version 0.89.31: Added Rename command for Gene Sets and Condition lists. Added "SaveAs GeneSets' to K-means
clustering. This saves all of the clusters as named Gene sets ("Cluster #1", "Cluster #2", etc.);

. Version 0.89.30: Fixed prablem with popup Web browser for Macintoshes.
. Version 0.89.29: Optimized sorting on startup so it starts much faster when working with large arrays.

. Version 0.89.28: Gene set and Condition set operations now let you select the sets by a pull-down choice menu as well as
by typing in names of sets. Additional error checking added for input datafiles.

. Version 0.89.26: Enhanced configuration file parser and sample name menu default; better error checking on input files to
help catch some errorsin manually edited user datafiles.

. Version 0.89.25: Fixed configuration parser errors when reading non-standard data.
. Version 0.89.24a: Fixed datafor MAExplorer MGAP demo.

. Version 0.89.24: Fixed bugs in popup browser to use GenBank ID (if it exists) with NCBI server, elseit uses the Clone-1D
(if it exists) with the nciarray clonel D-to-GenBank server.

. Version 0.89.22: Fixed bugs in ClusterGram, saving current Gene Class.

. Version 0.89.21: Fixed bugs in HP Chooser, Pseudocolor Red-Y ellow-Green HP-XY plot menu, HP vs. HP correlation
Report.

. Version 0.89.20: Added correct scale for (Plot | Show Microarray | Pseudocolor Red-Y ellow-Green HP-XY ratio or Zdiff).

. Version 0.89.19: Added (Plot | Show Microarray | Pseudocolor Red-Y ellow-Green HP-XY ratio or Zdiff) command to
display the X and Y data as an additive sum of red (HP-X) and green (HP-Y) data.
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. Version 0.89.18: New version of download Javainstaller program that improves portability on different platforms (eg.

MacOS, etc). Minor changes (spelling errors in parts of the program). Improved documentation.

. Version 0.89.17: Added commands and functionality to a) find al copies of a named gene in the guesser using the

SetE.G.L. button, b) added the "Replicate genes' GeneClass, ¢) added the "Filter by Genes with replicates’ data Filter.

. Version 0.89.16: Fixed several consistency checks when reading non-standard array data.

. Version 0.89.15: Ignore enclosing space characters in SamplesDB, Configuration and .mae startup files.

. Version 0.89.14: Fixed bug in Gene guesser when press the "Donge" button. It sets the gene, but did not update the

pseudoarray image. Disable genomic browser optionsin View menu if dbEST3/5' or GenBankAcc3/5' is not in the GIPO
file database. Since GenBank and dbEST may be accessed via the mAdb Clone report or UniGene report, this should not be
aproblem. In the Reference Manual a) figures were updated for Genes instead of the older notation of Clone (Version
0.88.*); b) the Short Tutorial (Appendix A) was updated and clarified.

. Version 0.89.12: Added "/Report" directory to hold SaveAs text (.txt) and plot window image (.gif) files. Improved fatal

error (called DRYROT errors) reporting. Additional parts of the state saved.

. Version 0.89.11: Added "Filter by positive quant. data" to filter out raw quantified data with negative values which may

occur with some types of arrays. Also improved some of the popup window updates when the data Filter, normalization,
EGL, or current clone changes.

. Version 0.89.10: Fixed bug in correlation coefficient computation so it works correctly with all Gene Classes and data

Filter.

. Version 0.89.09: Fixed bug in reading configuration file that occurs if SubMenus are omitted. Fixed bug recently introduced

when updating the finding clones similar to the current clone.

. Version 0.89.08: Fixed bug in auto-update of List of Gene Sets when used with adding(removing) genes using the

Control (Shift) clicking on agene in the array image, scatter plot, etc.
Version 0.89.07: Fixed bugsin state saving.

Version 0.89.06: Save the full State when do a (File | SaveAs DB). The full state is restore when you startup the database
you saved. Corrected bug in Gene Set Difference operator. Clarified some menu option names. Can now set # genes to
report or Filter in a highest/lowest ratio genesin (Filter | Set max # genes in highest/lowest report). Added Report for
(Report | Genesin ‘Normalization Gene List').

Version 0.89.05: Added information fields in HP chooser.

Version 0.89.04: Corrected bug in Ratio Median correction option if using ratio data (i.e. Cy3/Cy5). Improved scatter plot
labeling.

Version 0.89.03: Optimized the main screen area usage. Corrected data-dependent bug which sometimes occurs with the
Use Ratio Median correction option if using ratio data (i.e. Cy3/Cy5).

Version 0.89.02: Set the Use Ratio Median correction option if using ratio data (i.e. Cy3/Cy5).

Version 0.89.01: Major version release.

Because MAEXxplorer can be used with both spotted clone arrays and oligo arrays,we renamed clones as genes (except
where Clone ID is used) in both the MAExplorer program and in the Reference Manual.

Version 0.88.08: Enabled saving the name of the last project when you exit so it knows which file to use as a default when
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you do an "Open disk DB". Fixed the mnX/mnY datain XY -Statistics Report. Fixed title update in main window when
open anew database. Also has fix for Linux Javainstaller (tested on Red Hat Linux version 6.0).

. Version 0.88.07: Disabled the (File | Set Project) command as there is occasionally a problem with reading the
maeProject.txt database file which causes it to hang. This should not be a problem for users with multiple databases as you
still get the popup startup file browser when you invoke (File | Databases | Open file DB).

. Version 0.88.06: Edit submenu " Sets of Conditions" HP listsisworking and is saved/restore with the File menu " Save disk
DB"/"Open disk DB".

. Version 0.88.05: Added mouse-over to main window and moved gene locator button to left. Added "Use ratio median

correction" option to Normalization menu. This option can be used for rescaling Cy3, Cy5 intensity data if the medians are
unegual. Also, the manual has been updated and more discussion on data mining has been added.

. Version 0.88.04: Edit submenu " Sets of HybridProbes' Condition lists are partially working (not working with File menu
"Save disk DB"/"Open disk DB", set operations not enabled yet).

. Version 0.88.03 Edit submenu " Sets of clones" and File menu "Save disk DB"/"Open disk DB" Save/Restore clone sets as
.cbs clone bit set filesin stand-alone.

. Version 0.88.02: cleaned up SamplesDB.txt and MaExplorerConfig.txt specifications and sample filesin Appendix C.
. Version 0.87.08: Fixed some bugsin HP-X,-Y ,-E chooser. Added additional checking for missing field namesin datafiles.

If afield isincorrect, MAEXxplorer can't continue. It now gives a popup "Dryrot" error message to give us information about
which fields are incorrect.

. Version 0.87.06: May now use combined chooser for selecting the active HP-X, HP-Y and HP-E probes.

. Version 0.87.05: May now save all popup text windows as .txt filesin stand-alone mode.

. Version 0.87.01: May now save al plot windows as GIF images as .gif filesin stand-alone mode.

. Version 0.86.36: Fixed bug in "Filter by spot intensity [SI1:S12] sliders’. Allow simultaneous viewing of HP-X vs HP-Y
and Cy3 vs Cy5 (or F1 vs F2) scatter plots. Y ou may now also simultaneously view and HP-X/HP-Y and Cy3/CY5 ratio

histograms.

. Version 0.86.35: A new "Filter by spot intensity [SI1:SI2] sliders' mode has been added to the Filter menu. It is useful for
filtering individual changes when analyzing Cy3/Cy5 data.

. Version 0.86.34: The new stand-alone distribution is now generated with Install Anywhere 3.5 instead of 3.5 beta. This
corrects some of the problems we had seen with very large core images.

. Version 0.86.34: The handling of "Out of memory errors" seen when clustering large numbers of clones on a small
computer has been changed. Previously, it shut off the cache and continued the computation - although VERY slowly. Now,
it prints out the following message:

There is not enough nenory to cluster current filtered clones. Options:
1. reduce the nunber of filtered clones and try again, or,
2. disable cluster-cache (Clustering nenu) - will be VERY slow

. Version 0.86.33: A new "Set project” command has been added to the File menu. It selects the current project, if multiple
projects have been set up (using the future "New project” command).

. Version 0.86.29: A new "Show mouse-overinfo" mode has been added to the View menu (default is on). It reports HP probe
and spot/clone details in the array image, scatter plot, expression profile overlay plot, etc.
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. Version 0.86.27: In stand-alone mode, the "Open disk DB" now lets the user open a.mae startup file. The user browses the
local file system to select the startup file to use.

. Version 0.86.25: When using ratio (i.e. Cy3/Cy5) data, the menu entries, plot and report legends change the names from
(F1,F2) to (Cy3,Cy5) where appropriate.

. Version 0.86.24: Corrected bug in using the ratio and intensity thresholding of mean HP data was previously using the
single probe data.

4.3 Web Browser problems when running MAExplorer as an applet

Because MAEXxplorer is alarge system, and there may be occasional problems running it in some Web browsers on some operating
systems. We recommend you run MAEXxplorer as a stand-alone application asit is more robust.

. Normally, MAExplorer works well as an applet with Netscape 4.7 or Windows Internet Explorer 5.0 on Windows PCs and
on SUN Unix. It does not seem to work well as an applet on Macintoshs and problems have been reported on SGI systems.

. Onesolutionisinstall Sun's HotJava browser. The HotJava browser is available from Sun Microsystems _. You
can download HotJava for the Windows-95/-98/-NT/-2000/-X P and for Solaris (Unix).

. Reguardless of which browser is used, becauseit isis doing alot of computation, MAEXxplorer runs best on afast machine
with lots of memory. Thisis especially true when running a browser because of the additional browser overhead.

4.4 Handling fatal error reporting (i.e. DRYROT errors)

If you encounter afatal error that is detected by MAEXxplorer, it will popup an error reporting window. We call thisa"DRYROT"
error (thanksto "S.A.I.L." - Stanford Al Lab) because something iswrong in the program or in the user's data files and from which
it can not recover. Thistype of error should not have happened. Please save and e-mail the report to us so we can try to fix the bug
or diagnose the problem. The following figure shows an example of part of a DRY ROT error report.
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Figure 4.4 Example of afatal Dryrot Error window. This may occur for avariety of reasons. This window lists the main reason and also lists some of
the MAEXxplorer state information. If you wish, you may save thiswindow (press the "SaveAs' button) and mail it to us. We may try to correct the
problem in the next release if it is a problem with MAExplorer. Alternatively, it could be a user data error.

=4 Fatal MAExplorer emor - aborting

DRYROT Status Has Been Saved CiijwsblAExplore AmasiReportimaeDRYRO Tmessage. td

Please E:mail this saved file to mae@noiford.gow
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ﬂ A

Figure 4.4.1 Example of afatal Dryrot Error window after SaveAs. Thistells you where the saved error message file was saved and the email
addressto send it to if you wish.
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Release Archive for stand-alone MicroArray Explorer on
NCI/LECB

Thisisan archive of some of the older stable versions of the MAExplorer stand-alone application program. These are the full
installers which include the Java JDK s for al operating systems as well asthe MGAP database. The user reference manual
(available as azip file) specific for that version is aso included. After awhile, we will remove some of the older releases. To find
what the current and beta rel eases are, see the Install home page. The changes between releases are listed in Section 4.2 Revision
Notes.

Release |Release Date [Manual (.zip) for Release
0.96.02 (07-02-2002 |-

0.95.20 |05-31-2002 |MaeRefMan.zip (10Mb)
0.95.16 |05-24-2002 |(MaeRefMan.zip (10Mb)
0.95.04 |03-22-2002 |MaeRefMan.zip (10Mb)
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References to related exploratory data analysis methods and MAExplorer

This short list of referencesis limited to afew related to exploratory data analysis methods for microarrays as they relate to
MAExplorer. It is not meant to be inclusive. More extensive lists of references to many of the array preparation and data mining
methods can be found in some of these papers and on the Internet.
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Appendix A. Short tutorial for MAExplorer

Thistutorial isfor use with MAEXxplorer, an exploratory data analysis facility for microarray DNA databases. It may be used with
any MAExplorer database. Aswith all tutorials, they are only starting points for getting you started - in this case into
understanding the data mining analysis environment. Try out new options on your own, you can't break anything :-).

Thistutorial letsyou
1. Analyze expression of individual genes

2. Anayze expression of gene families and clusters
3. Compare expression patterns in multiple hybridized samples

NOTE: THISAPPENDIX ISBEING REVISED AND EXPANDED...

A.1 Demonstration data

Note that the downloadable MAExplorer stand-alone application includes a subset of 50 hybridized samples from the MGAP
database including a number of startup files for that data (see the the list of startup .mae files included in the download
installation).

Thereis also a pre-computed example of an Ordered Condition List using 4 conditions of replicates of C57B6 (pregnancy day 13,

lactation days 1 and 10, and stat5a(-,-) 15 samples. The database also includes 4 additional condition sets of this data and an
Ordered Condition List of the 4 conditions (in the State/ directory). This may be used to demo the OCL F-test filter.

If you have access to another MAEXxplorer database, you can use it instead since the tutorials are fairly generic.
Using the stand-alone application for thetutorial

These same subsets as well as other subsets of the MGAP data are available in the set of .mae startup files distributed with
MAExplorer. To access these files,

1. Start MAExplorer after you haveinstalled it. Eg. in Windows, go to the Windows "Start Menu" and click on MAEXxplorer.
If itisnot in your Start Menu, you can go to where you installed it (typically C. \ Pr ogr am Fi | es\ MAExpl or er) and
click on MAExpl or er . exe.

2. Then after it starts, go to the "Files' menu and select "Open disk DB" and select the startup file you want. Alternatively, you
can go directly to the list of startup filesin C: \ Pr ogr am Fi | es\ MAExpl or er \ MAE) and double-click on one of the

startup files.
A.2 General instructions:

Throughout this tutorial we refer to condition X and condition Y. These are different hybridized samplesin the particular database
you have loaded. For example, in the MGAP database X might be lactation and Y might be pregnancy. X and Y 'sets' are multiple
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samples of these two conditions.

& First, select one of the start up databases.
SmartTip

. Asastand-alone application, select the startup file entry (files ending with a".mag" file extension) from adirectory of
startup files on your local computer. Generally these are in a subdirectory called MAE in a project directory (see Appendix

C. Use of MAExplorer with other microarrays).

If the particular samples you want to analyze are not listed in that example, after it starts you will be able to add samples you do
want and remove samples you don't want - regardless of which example wasintially used if the database " Samples' database
contains additional hybridized samples.

When it starts, a main window will pop up. It then downloads a gene database tables and the particular hybridized samples you
specified. When it is ready for you to begin interaction, the menu bar will become active and it will display a green Ready - click
on a gene to query database message. Depending on your Internet connection speed, it may take afew minutesto set up. If you are
running MAExplorer as a stand-alone application and it is getting data from your local disk, startup will be much faster.

/i\_ Second, go to the A.3 instructions for self-guided tutorial below for instructions on what to do next.
SmartTip

HINT: print this tutorial page and then read the following instructions from the printout rather than trying to keep this window
visible. Y ou might also print the parts of the MAExplorer Reference Manual for the same reason.

HINT: You might want to keep arecord of the commands you have used or the messages and measurements you have made. To do
this you need to enable message and command history logging. Go to the View pull-down menu and then select the type of logging
you want using the Show log of messages or the Show 1og of command history commands.

NOTES:. On computers with low resolution (i.e. less than 1024 X 780) you may need to resize the windows and move them to
different parts of the screen to view them simultaneously.

A.3 Self-guided tutorial of MAExplorer - notation and examples

Thefollowing is a self-guided tutorial (you issue the commands) that illustrates some of the data analysis capabilities. In the
following examples, the notation " go to A:B:C" means go pull-down menu A, then submenu B and, then make selection C.
"Selecting agene" from the microarray image or scatter plot means clicking on a spot in the pseudoarray image or a point in the
any of the plots.

A.3.1 Review of types of gene data available in the database

step 1: go to Analysis: GeneClass: All genes
the array shows all genes with white circles.
step 2: go to Analysis: GeneClass: All named genes
the array shows named genes with white circles.
step 3: go to Analysis: GeneClass: ESTs similar to genes
the array shows ESTs similar to named genes with white circles.
step 4: go to Analysis: GeneClass: ESTs
the array shows unknown ESTs with white circles.
step 5: go to Analysis: GeneClass: All genesand ESTs
the array shows all named genes and all ESTs with white circles.
step 6: go to Analysis. GeneClass: Replicate genes
the array shows replicate genes having at least 2 copiesin the
array with white circles.
step 7: go to Analysis: GeneClass: Calibration DNA
the array shows calibration DNA (if present) with white circles.
step 8: go to Anaysis: GeneClass: Y our plates
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the array shows clones from user's plates (if present) with white circles.
A.3.1.1 Analysis of the expression of a single known gene

a. ratio between two conditions X and Y (HP-X, HP-Y)
b. expression profile of aset of conditions (HP-E) (see Example A.3.1.7)

step 1: click on the blue "Enter gene name" button to pop up a name entry window

step 2: start typing gene name into blue text entry window

step 3: once gene names appear, click on gene of choice

step 4: press "Done" button in pop up window
A yellow circlewill define the gene as the "current gene” in the microarray
pseudoarray image (info on geneis also provided in the status area above the array).
If there are replicate grids (left and right fields of repeated genes are denoted
by F1 and F2) in the array (HP). The mean(HP-X,HP-Y) values and the (HP-X/HP-Y)
values for the specified gene are reported are reported.

step 5: dternatively, click on an array spot of choice to define any gene
in the array as the new current gene

A.3.1.2 Find a subset of genes with a common substring (e.g. *ONCO¥*)

step 1: click on the blue "Enter gene name" button to pop up a name entry window
step 2: start typing "* ONCO*" (without the quotes) into blue text entry window
step 3: once gene names appear, press " Set E.G.L." button in pop up window
Magenta squares will indicate these genes in the pseudoarray image.
These include the ‘onco'genes and the proto-'‘onco'genes

A.3.1.3 Two conditions - scatter plots:
Create a scatter plot of two hybridized samples where condition X datais on the X axis and condition Y dataon the Y axis.

step 1: go to Analysis: Plot: Scatter plots: HP-X vs. HP-Y.

then click on yellow circle in scatter plot to get HP-X/HP-Y ratio for the gene
step 2: click on any point in the scatter plot

this also alternatively defines any genein the plot as the new current gene
step 3: zoom in on aregion of the plot using the vertical or horizontal scroll bars
step 4: click on another point in the scatter plot to get the HP-X/HP-Y ratio another gene
step 5: press "Close" button to remove pop up window

A.3.1.4 Scatter plot of Cy3 vs Cy5 or replicate spots (F1 vs F2) of one sample

Create a scatter plot of Cy3 vs Cy5 channels or replicate spot F1, F2 dataif your database is contains (Cy3,Cy5) ratio data or it
contains replicate spot fields (F1,F2).

step 1: go to Analysis: Plot: Scatter plots: Cy3 vs. Cy5
or go to Analysis: Plot: Scatter plots: F1 vs. F2
Then, click on green circle in scatter plot to get Cy3/CY 5 ratio for the gene
or F1/F2 ratio for replicate spots for that gene
step 2: click on any point in the scatter plot
this also alternatively defines any genein the plot as the new current gene
step 3: zoom in on aregion of the plot using the vertical or horizontal scroll bars
step 4: click on another point in the scatter plot to get the HP-X/HP-Y ratio another gene

If you are working with Cy3/Cy5 dye-swap data, you may swap the Cy3/Cy5 channel datato Cy5/Cy3 for any selected subset of
samples. This may make it easier to use the data in various ways when data mining. If you do not have this type of data, go to step
7.
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step 5': go to Samples: Edit (Cy5/Cy3) else use (Cy3/Cy5) menu

step 6': select the samples you wish to swap and press "Done". This
enables you to see the swapped results in the scatter plot

step 7: press "Close" button to remove pop up window

A.3.1.5 Filter by expression ratio between two conditions X and Y

step 1: go to Analysis: Plat: Histograms: HP-X/HP-Y
the histogram shows the ratios
step 2: move pop up plot so you can seeit and the array simultaneously
step 3: choose (click on) aratio bin
genes filtered by the ratio range of the bin will light up on the array ('+'s)
step 4: click on different bin in the histogram to select another bin
step 5: click onword "Freq" on left in histogram to remove the histogram bin filter

Note of caution: if the signal is close to background the X/Y ratio may be bogus.
Y ou can filter out low intensity genes by

A.3.1.6 Filter by spot intensity range

step 1: go to Analysis: Filter: Filter by spot intensity [SI1:S12] dliders: Use spot intensity [SI1:S12] dliders
step 2: adjust intensity lower bound (SI1) to remove low ratio genes
step 3: when done, remove the 'Filter by intensity sliders' by toggling it off (redo step 1 to toggle it off)
step 4: repeat steps 1-3, but thistime use Filter : Filter by [11:12] dliders:

Use spot intensity (or Cy3/Cy5) [11:12] sliders

A.3.1.7 Multiple conditions - expression profile plots of HP-E data:

step 1: go to Analysis: Plot: Expression profile: Display a gene's expression profile

step 2: after the expression profile window pops up, click on agenein array to seeits profile
step 3: click on alinein the profile plot to see itsintensity

step 4 click on adifferent gene in the array to see its profile

step 5: press "Show HPS' button to see the list of samples used

step 6: press "Close" button to remove pop up windows

A.3.2 Changing the normalization between hybridized samples
Y ou may change the normalization method used to scale data between hybridized samples so they may be compared.
A.3.2.1 Set normalization

step 1: go to Analysis: Normalization: Median intensity
step 2: go to Analysis: Plot: Scatter plots: HP-X vs. HP-Y
to see the effect of normalization on the scatter plot. Note how outliers appear.
step 3: go to Analysis: Normalization: Zscore of intensity
step 4: go to Analysis: Normalization: Zscore of log intensity, stdDev
step 5: go to Anaysis: Normalization: Unnormalized
this does not scal e data between samples.
step 6: go to Anaysis: Normalization: Median intensity
this leaves the normalization method in Median mode.

A.3.3 Analysis of the expression profiles of gene classes
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Y ou may restrict the set of genes by Gene Class. Several built in gene classes are defined. Y ou may also set up additional ones and
filter by those (not covered in this short tutorial).

A.3.3.1 Filter by gene class membership

step 1: go to Analysis: GeneClass: All known genes
the array only shows named genes (additional gene subclasses are being added)
step 2: go to Analysis: Plot: Scatter plots: HP-X vs. HP-Y
to see the two condition expression of just these genes
step 3: go to Analysis: Plot: Expression profiles: Display Filtered genes expression profiles
to see the multiple condition expression of just these genes. This may take a
whileif there are many genes
step 4: you can click on aline in any of the plots to see the samples' intensity value for that gene
step 5: when done, press "Close" button in al pop up plot windows

A.3.3.2 Gene Reports

step 1: go to Analysis: Report: Gene reports: Filtered genes: Genes passing Filter
Clicking on a blue entry will bring up I.M.A.G.E, dbEST, UniGene, or GenBank,
LocusLink, or mAdb Clone database in pop up Web page

step 2: press "Close" button in report, and close this pop up Web page

step 3: go to Analysis: Report: Table format: Tab-delimited
to enable creating Excel-compatible reports

A.3.3.3 Exporting Gene Reports to Excel

step 1: repeat step 1 of the Gene Report, but this time to make text-formated report
step 2: cut the text from this window and paste it into an Excel window.
Thisisuseful for exporting dataif you are on a Windows PC
step 3: go to Analysis: Filter: al genes
torestoreit to al of the genes from all named genes
step 4: go to Analysis: Report: Table format: Spreadsheet
step 5: press "Close" button in report

A.3.4 Analysis of the expression profile of multiple hand picked genes

Users can manually define a set of genes which are kept in the Edited Gene List (E.G.L.). Various operations can then use the EGL
to restrict the set of data being analyzed.

A.3.4.1 Define a list of edited genes, then plot all their expression profiles at one time

step 1: go to View: Show 'Edited Gene List'
this turns on the 'Edited Gene List' magenta square box overlays
step 2: hold CONTROL key and click on genesin array to add agene
step 2': hold SHIFT key and click on genesin array to delete a gene.
Thisletsyou edit alist of genes. It a'so works when clicking in a scatter plot
step 3: go to Analysis: Plot: Scatter plots: HP-X vs. HP-Y
to see the Edited Gene List in the scatter plot
step 4: try defining (or removing) E.G.L. genesin the scatter plot by holding the
CONTROL (or SHIFT) key when clicking on points in the scatter plot

A.3.4.2 Filtering by edited gene list

step 1: go to Analysis: Filter: Filter by 'Edited Gene List'
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step 2: go to Analysis: Plot: Expression profiles: Display Filtered genes expression profiles
scroll through the plots to see all of the profiles

step 3: go to Analysis: Filter: Filter by 'edited gene list'
this turns off the 'edited gene list' filter

step 4: press "Close" button in expression profiles window

A.3.4.3 Report of edited gene list

step 1: go to Analysis: Report: Gene report: genesin 'edited genelist'
reports edited genes

step 2: press "Close" button in report

step 3: go to Analysis: Filter: Filter by 'edited gene list'
this turns off the 'edited gene list' filter

step 4: go to View: Show 'edited genelist'
this turns off the 'edited gene list' squares overlay

A.3.5 Identify a cluster of genes with similar expression profile to the current selected
gene

step 1: go to GeneClasses: All named genes and ESTs
step 2: go to Analysis: Plot: Cluster plots: Cluster genes with expression profiles similar to current gene
thiswill pop up a cluster summary and cluster distance slider control window.
Move the summary and slider windows so you can see al 3 windows. The size of
the cyan boxes on similar genesin the pseudoarray is proportional to the similarity.
Adjust the cluster distance slider to smaller values and note how the number of genes clustered decreases.
It should be set for areasonable number considering the material you are analyzing.
step 3: select (click on) anew current gene
the genes which belong to that cluster are labeled in the array with cyan boxes
and are defined as the "current cluster". The current gene you click on has
agreen circle around it
step 4: press "Cluster Report" button in the cluster summary
this pops up a Gene Report for the clustered genes
step 5: press "Close" button in the report
step 6: press "EP plot" button in the cluster summary
this pops up ascrollable list of expression profile plots sorted by similarity
to the current selected gene.
step 7: press "Close" button in the report
step 8: press "Close" button in the cluster summary

A.3.6 Identify clusters of genes with similar expression under various conditions
using data mining filters

step 1: go to GeneClasses: ESTs similar to genes

step 2: go to Analysis: Plot: Cluster plots: K-means clustering of gene expression profiles
thiswill pop up a cluster summary and slider control window. Move the summary
and slider windows so you can see all 3 windows. The size of the
magenta circlesin the array is proportional to # genes/cluster

step 3: select (click on) anew current gene
the genes which belong to that cluster are labeled in the array with tiny green
numbers are defined as the "current cluster". The current gene you click
on has agreen circle around it

step 4: go to View: Show 'edited genelist'
genesin the current cluster were also copied to the edited gene list
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step 5: go to Analysis: Report: Gene report: genesin 'edited genellist'
reports genes in the current cluster

step 6: press "Close" button in report

step 7: go to View: Show 'edited gene list'
thisturns off the 'edited gene list' squares overlay

A.3.6.1 Varying the number of clusters

step 1: vary the "# of clusters" dider value from 6 to 10, then 20
note the number of clusters changes and the gene cluster composition also changes

A.3.6.2 Defining a new cluster "seed" to recluster the genes

step 1: select anew current genein array and press the "Recompute clusters' button
this recomputes the clusters using the current gene as the new seed gene

A.3.6.3 Cluster expression profile plots

step 1: press "EP plot" button and scroll down the list after they appear
the primary nodes for each cluster are indicated with red labels in the set of
profiles, and the other genes are labeled with their cluster number

step 2: press "Mean EP plot" button and scroll down the list after they appear
these are the mean expression plots of the primary nodes clusters.

A.3.6.4 Report of all clusters

step 1: pressthe "Cluster-Report” button to get a sorted cluster
list scroll the spreadsheet to the right to see the cluster statistics
step 2: press the "Mn-Cluster-Report™ button to get a sorted cluster list
scroll the spreadsheet to the right to see the mean expression profiles
step 3: press "Close" button in pop up windows

A.3.6.5 Current cluster in scatter plot

step 1: go to Analysis: Plot: Scatter plots: HP-X vs. HP-Y
step 2: move the plot so you can see both scatter plot and array
step 3: click on agenein the cluster or on spots in the scatter plot
note that the green cluster numbers are drawn in the scatter plot
step 4: go to Edit: Sets of genes: Save 'Edited gene list' as gene sets
thiswill pop up adialog box requesting "Enter new gene set name"
step 5: type "Genesin current cluster class'
thiswill save the current cluster in agene set. This gene set will
be used in the next example
step 6: press "Close" button in pop up windows
step 7: (optionally) investigate hierarchical cluster with clustergrams and
dendrograms by going to Plot : Cluster Plots : Hierarchical clustering plot for HP-E

A.3.7 User Gene Set operations

Y ou may manipulate sets of genes. Some of these are predefined for you by the database (eg. All named genes, ESTS, etc.). Others
are defined by particular operations (E.G.L., clustering, etc.), and lastly others may be defined by you using logical operations on
these sets (OR, AND, DIFFERENCE).

A.3.7.1 List of the current gene sets
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step 1: go to Edit: Sets of genes: List saved gene sets
thislists the current list of gene sets

step 2: Change the E.G.L. set of genes and note how the # of E.G.L. genes changesin the list.
Y ou can add (remove) genesto the E.G.L. by clicking on a spot in the array while the
CONTROL (SHIFT) key is held down.

A.3.7.2 Filter by user defined gene set

step 1: go to Edit: Sets of genes: Set 'User Filter Gene Set' (for Filter)
thiswill request a gene set to use with the Filter in a pop up dialog box.
Enter gene set # for the set for "Genesin current cluster class" which you saved
in the previous example.
then press "Ok" in the dialog box.
step 2: go to Analysis: GeneClass: All genesand ESTs
this resets the filter to look at all genes and ESTs
step 3: go to Analysis: Filter: Filter by 'User Gene Set' membership
this restricts the genes to the saved current cluster in the previous example

A.3.7.3 Gene set operations

step 1: go to Edit: Sets of genes: OR (Union) of 2 gene sets
thiswill request 3 gene set names in a pop up dialog box.
Enter set # for (All known genes) for the 1st gene set name,
Enter set # for (Genesin current cluster class) for the 2nd gene set name,
Enter "Union of known genes and genesin current cluster" for new gene set name.
then press "Ok" in the dialog box.
this computes the union of the two gene sets into a new gene set

step 2: go to Edit: Sets of genes: Set 'User Filter Gene Set'
thiswill reset the 'User Filter Gene Set' for the Filter in a pop up dialog box.
Enter the set number or the beginning of the set name 'Union’ that is the
set for "Union of known genes and genesin current cluster” just saved.

step 3: try saving other Filtered genes sets and doing other gene set operations.

A.4 Additional tutorials

If you wish to investigate MAExplorer in more detail, try some of the suggested examplesin the advanced tutorial (Appendix B) in
the reference manual.

———m
—_— I e ===

Appendix B. Advanced tutorial for MAExplorer

There are a number of things you may do in this facility. We wrote this advanced tutorial to help demonstrate some of its
capabilities. A short tutorial (Appendix A) is also available and we recommend doing it before attempting the advanced tutorial .
Sources of startup datato use with the tutorials are listed in the short tutorial. Aswith all tutorias, they are only starting points for
getting you into the analysis environment - try out new options on your own, you can't break anything :-).

1. Analyze expression of individual genes
2. Anayze expression of gene families and clusters
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3. Compare expression patterns in multiple hybridized samples

NOTE: THISAPPENDIX ISBEING REVISED...

Here are some things to try

1. You could click on the Reference manual in the Help menu. That is this reference manual, but it appearsin anew

Netscape Web browser window so you may read it while working on MAEXxplorer. Delete the window when you are
finished with it.

2. Click on the Glossary in the MAExplorer Help menu. This section describes terms used in MAEXxplorer. Delete the window
when you are finished with it.

3. Click on the Index. It may be useful in finding things that are not in the table of contents.

4. Note: ahybridized sample isamicroarray hybridized with cDNA derived from the mRNA from a particular experiment
sampl e (see notation defined in the Overview). Currently, you may start MAExplorer with prel oaded set of samples by
starting the stand-alone MAEXxplorer on a.maefile. Alternatively, you may start it with no samplesloaded. It the latter case,
you would load samples you are interested in from the Samples menu.

When first started, it loads someinitial data it needs as well as the particular hybridized samples you specified. After MAExplorer
starts, it displays "Ready - click on a gene to query database” and the menus becomes active. Here are some thingsto try.

1. Click on different genes (i.e. spots in the pseudoarray image). The pseudoarray image may or may nhot correspond to the
actual array - depending on how the data was derived. Notice the data that gets displayed in the three text lines above the
image. If the spot you click on isanamed gene (e.g. [1-A4,3] at row 4 column 3 in Field 1), it will also print out the
GeneName of the gene.

2. Look at the pull-down menus. They consist of sets of commands with similar functionality grouped together in sub-menus.
In particular, look at the Analysis menu. It contains an ordered list of submenus that may be thought of as the sequence one

might perform an analysis. In reality, an analysis is more complicated and involves iterating various steps (see Figure 3.1).

3. Go to the "Samples' menu. This menu allows selecting hybridized samples for the HP-X, HP-Y, HP-X and HP-Y 'sets, and
the HP-E list. Y ou have several waysto do this. The easiest way isto use the "Choose HP-X, HP-Y and HP-E" sample
selection wizard. The other aternative isto use one of the set of cascading menus that may be used to change the selected
hybridized samples. Note that the HP-X and HP-Y submenus assign samples for subsequent analysis such as X-Y scatter
plots. The HP-E submenu sets the list of samples for expression profiles. Note how you may assign a sample either by
going through the cascading menus or from an aphabetic list of all hybridized samples in the pseudoarray image. To
change the default HP-X (HP-Y) sample, click on the purple *[X]" ("[Y]") box on the |eft side of the image (above the list
of samples) soit is selected. Then click on the desired purple "*" adjacent to the samples listed on the left edge of the
pseudoarray image. Y ou may switch between using single and multiple samples (i.e. 'sets) with HP-X and HP-Y . Note the
"HP-X:" and "HP-Y:" labels at top left when you switch between single and multiple samples. Go to the HP-X/-Y 'set' and
HP-E submenus and list the contents of the respective sets to see what they contain. Note how one may add or remove
samples from these sets.

4. Go to the "Samples' menu. Then select "Choose named condition list of samples®. This lets you define new condition lists
of samples. Go to the "Edit" menu then "Sets of Conditions (samples)” to see additional ways to manipulate these condition
sets. For example, you might define a new condition and the assign it to the working HP-X 'set'.

5. Go to the "Samples' menu. Then select "Choose ordered list of conditions'. Thislets you define anew or edit an old
Ordered Condition List(OCL). In the included MGAP there, there is a pre-computed example of an Ordered Condition List
using 4 conditions of replicates of C57B6 (pregnancy day 13, lactation days 1 and 10, and stat5a(-,-) 15 samples. The
database also includes 4 additional condition sets of this data and an Ordered Condition List of the 4 conditions (in the
State/ directory). This may be used to demo the OCL F-test filter. Go to the " Filter" menu and select "Filter by current
Ordered Condition List (OCL) F-test [p-Value]". Thiswill popup a p-value slider where you can adjust the criteriafor
selecting genes passing the F-test.
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6. Go to the "GeneClass' submenu in the"Analysis' menu. Thisis set of cascading menus that may be used to change the
default Gene Class. Different genes belong to different gene classes and thisis away of sub-setting the data. Y ou may
currently set it to All Genes, All Named Genes, ESTs similar to genes, ESTs, Good genes, All named genes and ESTS,
Replicate genes (multiple copies on the array), Calibration DNA. Select "ESTs similar to genes'. Notice that the display
now only shows the red (white) circles on the ESTs similar to genesin the intensity (ratio) pseudoarray image. Look at the
circle overlays on the microarray image - note how they changed. Go back and set the gene classto "All genes' and then
"Calibration DNA". The "Calibration DNA" is the set of spots that may be used for normalizing data between microarrays.
Check out the "Set gene class subset” submenu. Leave the gene class set to All Genes.

7. If you are connected to the Internet, go to the "View" Menu. Then turn on the switch "Enable display current genein popup
XXXX Web Browser". Depending on your database, XXX X may be GenBank, LocuslD, UniGene, dbEST or mAdb Clone
DB. Then click on agenein the image. It pops up a Web browser showing the genomic database Web page for that gene (if
any). If you click on a different spot, it will reuse the popup Web browser with new data. If you don't want it to be active,
go back to the "View Menu" and click on "Enable display current gene ..." again to disableit.

8. Go to the "Normalization" submenu in the "Analysis' menu. Thisis used for normalizing data between microarrays so they
may be compared. The default isto scale the data to the median value for each array. Investigate the other normalization
methods. If your quantified data contains spot background data, you may also enable background correction that subtracts a
microarray specific overall background intensity value from each intensity value in each array.

9. Go to the "Report" submenu in the "Analysis' menu. Y ou may generate areport in several formats " Spreadsheet” or "tab-
delimited", the latter being cut and paste compatible with Excel. In the "Samples Report" sub-submenu in the "Report”
submenu, click on "Hybridized Samples’, then switch to the other Report format and do it again. Click on "Hybridized
Sample Web links". In the "Gene Reports" submenu, try "All named genes'. Then try the "Highest HP-X/HP-Y ratio" in the
"Filtered gene reports’ submenu. If you are using alist of HP-E or HP-X/-Y 'sets of samples, you might try looking at the
expression profile ratios or statistical data respectively though other Reports.

10. Review thedata" Filter" submenuinthe"Analysis' menu. Select the "Filter by expression sliders” [11:12]. Expression is

intensity in the case of 33P or biotin labeled, or (Cy3/Cy5) in the case of ratio data. This pops up a state sliders window. The
11 scroll bar (lower limit of the gray value intensity) to about 100. Look at the genes that were eliminated because they are
out of therange. If you select the "Filter by spot intensity sliders" [SI1:S12], it will filter genes by spot intensity in either F1
or F2 duplicate (if you have duplicate spots), or the Cy3 or Cy5 spots. Y ou can select which sets of HPs to use (current HP,
HP-X and HP-Y, HP-XY sets, or HP-E). Y ou might disable the [11:12] filter while you experiment with [Si1:SI2] filter. If
you have (F1,F2) or (Cy3,Cy5) data, put up the F1 vs F2 or Cy3 vs Cy5 scatter plot and you can visualize how the
thresholding works.

In the Filter menu, add the "Filter by ratio or Zdiff diders'. Then the [R1:R2] ratio range sliders are added to the state dlider
window and may be used for filtering genes. If the normalization method is one of the Zscore methods, it filters by the
difference of the Zscores otherwise by theratio and the [21:Z2] range is used. Note that the genes that pass the filter will
appear to have ared (white) circle in the pseudoarray intensity (ratio) grayscale (pseudocolor), or red "+" in the scatter plots
so you might try moving the controls while in those plot modes. Try some of the other filters. The spot CV test removes
genes where replicate spot values (F1 and F2 in the case of a single sample or replicate sasmplesin the case of HP-X and HY -
Y 'sets or the HP-E' list of genes) are not well correlated. The t-Test filter may be used with sets of X and Y samplesto find
genes with a p-value less than the specified threshold.

11. Gotothe"Plot" submenu inthe "Anaysis' menu. Then got to the "Show Microarray" submenu, try pseudocolor ratio (or
Zscore) modes and finally leave it in the pseudograyscale image intensity mode. Try using the " Scatter Plots" and
"Histograms" in the Plot menu. Vary the normalization methods and see how it affects the array image and scatter plots.
When you are in a scatter plot, click on apoint. It will display data similar to when clicking on animage. If UniGene datais
available in your database, Go to the Views menu and set "Enable display current gene in popup UniGene Web browser"
and click on apoint again. This pops up another Web browser window and lookup that gene in the Uni Gene database.
Change the threshold slider and notice how points appear and disappear. Click on abin in the ratio histogram, it will filter
the genes so that only the genes that have ratios in that bin are displayed.

12. Go to the"Plot" submenu in the "Analysis' Menu and then to the "Expression profile" submenu. Then select the "Display
gene expr. profile for HP-E". It pops up awindow with two buttons " Show HP names' and "Close". Then click on agenein
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the image. It will draw the expression profile for that gene. Move the mouse so it is over one of the vertical barsin the plot
to get the data for that particular HP. If you click on a different spot in the image it will display the new expression profile
in the same window. Click on the "Show HP names" button to popup awindow with the list of HPs matching the numbers
in the expression profile plot. Now create a scatter plot of two HPs and then click on ared "+" in the plot. It will update the
expression profile plot with this gene. If you want to compare several expression profile plots, repeated create the "Display
gene expression..." windows from the View menu. Move the windows close to each other so they are easier to compare.
Only the last one you created alows you to change the gene. If you don't want a popup window anymore, click on its
"Close" button. Y ou may save the scatter plot as a GIF file by pressing the "SaveAs" button which will save it in the Report
subdirectory associated with the startup data..

13. Next welook at gene clustering. Go to the "Plot" submenu in the "Analysis' menu, and then to the " Cluster plots’ submenu,
try "Cluster genes with expression profiles similar to current gene". This pops up a slider with the cluster threshold. Then
click on agenein theimage. It will then popup atext window with the genes whose cluster distance is less than the cluster
threshold. It is sorted by minimum cluster distance. Notice that some genes in the image have different size blue boxes
around them. The larger the box, the smaller the cluster distance and the more similar. Move the cluster threshold slider.
Thiswill change the clustering as seen in both the image and in the cluster popup window. Click on the "Report" button in
the text window. Thiswill popup areport on these genes sorted by minimum cluster distance. Then click on the "EP plot".
This pops up a scrollable list of expression profile plots for the genes you have filtered by this test on so you can review the
actual expression profiles. Close this window and set the Filter to a small number of genes such as with "ESTs similar to
genes'. Note that the genes passing thisfilter are saved in the E.C.L. and may be saved as a gene subset or part of the data
Filter.

Turn on one or more Filters to reduce the number of genes to say under 100 (e.g. t-test or spot CV filters). Then press the
"Go 'Cluster all genes™ button in the cluster window. Thisis equivalent to invoking the "Cluster counts of Filtered genes by
expression profiles’ command from the "Cluster plots" submenu. Notice the Filtered genes has blue circles of different
sizes. Thelarger the circle, the more genes there are that are similar to that gene. Move the cluster threshold slider and note
that the number of similar genes changes, the size of the blue circles will change. Aswith the other cluster mode, you may
generate a report of sorted cluster counts. Click on a gene with the largest green circle. Thiswill then switch you back to
single gene clustering mode where you can investigate that gene in more detail.

14. Next welook at K-means gene clustering. Go to the "Plot" menu and in the "Cluster plots" submenu, try 'Display K-means
gene expression profiles for Filtered HP-E' (similar to K-means clustering). This pops up ascroller for "N-clusters’, the
number of clusters desired, with a default of 6 clusters. It will then popup a K-means report window with various controls.
The centers of the N clusters are indicated with magenta circles where the size corresponds to the number of genesin the
cluster. If you click on agenein the array, it will draw all members of its cluster as green numbers (try this with the scatter
plot present as well). Press "EP plot" to scroll through alist of expression profiles of the genes sorted by cluster. Press
"Mean EP plot" to scroll through the summary expression profiles of the clusters. Press " Cluster-Report" and "Mn-Cluster-
Report" to generate reports for these clusters. Y ou may change the seed gene by changing the current gene (click on a
different genein either the array image or the EP plot. Then and press "Recompute” to recompute the clusters. Pressing the
"Show HP names" pops up alist of the samples used in the expression profile. Now add a HP-X vs HP-Y scatter plot. If you
select a particular gene, it puts all genes associated with the cluster for that gene in the "Current Cluster" and colors them
with agreen cluster number instead of a"+".

15. Next welook at hierarchical gene clustering. Go to the "Plot" menu and in the "Cluster plots' submenu, try "Hierarchical
clustering of expression profiles’. Then select "Display clustergram of gene expr profiles’. Thiswill compute the
clustergram for the Filtered genes with the data normalized by the assigned HP-X sample. It will then popup a clustergram
window with various controls. The clustergram is scrollable. Y ou may optionally add the dendrogram with the
"Dendrogram” checkbox. Clicking on arow will show datafor that gene. Clicking on a box in the clustergram will show
datafor the particular sample for that gene. Y ou may zoom the dendrogram by repeatedly clicking on the "xxxX DB" zoom
button. Press"EP plot" to scroll through alist of expression profiles of the genes sorted the same as the clustergram. Press
"ClusterGram Report" to generate a report of the expression profile data sorted the same as the clustergram. Pressing the
"Show HP names' pops up alist of the samples used in the expression profile. Y ou may save the entire clustergram -
dendrogram image in a GIF file as before by pressing the "SaveAs" button.

16. You may perform operations on sets of genes. For example, merge sets of genes found under two different experiments or

conditions. Go to the " Sets of genes' submenu in the Edit menu and pick the "List saved gene sets" selection. Thislists the
default gene sets. Then select "Assign 'User Filter Gene Set™. Thiswill request a gene set to use with the Filter in apop up
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dialog box. Select the set for "Genes in current cluster class' that you saved in the previous example. Then press "Ok" in the
dialog box. Then select "All genes’ in the GeneClass menu. This resets the filter to look at all genes. Select "Filter by 'User
Gene Set' membership" in the Filter menu. This restricts the genes to the saved current cluster in the previous example.

17. Gene set operations may be performed on pairs of gene sets. Select "Union of 2 gene sets" entry from the " Sets of genes’
submenu in the Edit menu. Thiswill request 3 gene set namesin a pop up dialog box. Select 'Similar ESTS for the 1st gene
set name, select "Genesin current cluster class’ for the 2nd gene set name, Enter "Union of similar ESTs and genesin
current cluster” for new gene set name. Then press "OK" in the dialog box. This computes the union of the two gene sets
into anew gene set. Then select "Filter by 'User Gene Set' membership" as before. Thiswill reset the 'Use Gene Set' for the
Filter in apop up dialog box. Select the set for "Union of similar ESTs and genesin current cluster” just saved. Try saving
other Filtered genes sets and doing other gene set operations.

18. Goto the "Help" menu. The MAExplorer documentation and glossary as well as other MGAP documents are available and
will appear in a new popup Web browser.

19. If you are running MAEXplorer as a stand-alone application, you may save the state of your analysis (but not the gene
subsets at thistime). Go to the "File" menu and then "Databases' submenu. Select "Save asfile DB". Enter afile name to
save your startup state. Then you can restart MAExplorer on this data set at alatter time by clicking on thisfile (in a
windows based system). Saving the database will also save the state of the data Filter, the gene sets and the condition lists.
Y ou can see this by listing them in the Edit menu sub-options after you have restarted a previously saved database.

Appendix C. Use of MAExplorer with user's microarray data

This section discusses the use of MAEXxplorer to convert microarray datafrom avariety of sources including various types of
labeling 33P-labeled, biotin-labeled, or Cy3/Cy5 ratio-labeled spotted membranes or glass slides or oligo-chips of different
geometries and numbers of duplicate spots/gene.

Note: This appendix contains a"computerese" description on how to use MAEXxplorer with your array data. The user-friendly "wizard" tool Es-iiB

Cvt2Mae makes it much easier for most molecular biologists to use. Cvt2Mae is available for download on the MAExplorer home page. This
appendix gives some examples below of some of the required file data for those of you who want to understand the data file formats or want to

manually convert your data or use your own conversion program on your data. Note that you do not need to read this chapter to use MAExplorer if
you use the Cvt2Mae converter, use some other conversion software (eg. the NCI/CIT mAdb array database server), etc.

MAExplorer requires a specification of array geometry and quantification information. These are defined in a configuration
startup file. The startup file contains the initial list of hybridized samples to be loaded, and other parameters such as the name of
the configuration file (if it is different from the default name). A stand-alone application causes the .mae startup file (or the
PARAM list in the case of an applet) to be read when it is started. The configuration file contains various defaults. If any of these
are specified in the configuration file, the override the built in default values. Vaues from the .mae startup or applet PARAMs will
override the configuration file values. These configuration parameters may be overwritten by arguments in the stand-alone .mae
startup files or PARAMSsin the Applet startup specifications.

A few additiona files are required and are defined in the configuration file. These include: a Gene-In-Plate-Order or GI PO file; a
samples database file listing names of the samples available for loading; and a gene class namesfile. An optional (but
deprecated) extra array information file may be specified to access additional data about samples. Quantified hybridized sample
array spot data (Quant files) from each array is put into a separate datafile. Note that all data files are tab-delimited files such as
may be generated with Excel, relational databases or directly from array spot quantification software.

Hybridized sample arrays must be scanned and then spots quantified using other software. MAEXxplorer does not do spot
guantification from scanned image files. However, MAEXxplorer can use spot data from a variety of array image quantification
programs that generate tab-delimited datafiles. The data needs to be converted to the MAExplorer schema described in this
Appendix.
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The derivation of quantified spot data files from hybridized sample arraysis discussed later in this section as are in the quant file
data format.

The configuration file is created once for each new array GIPO geometry and database of hybridized samples. It isindependent of
the number of samples. Configuration parametersinclude array geometry (# of grids, # of duplicate spots/gene, etc), whether the
dataisintensity or ratio data (e.g. Cy3/Cyb5), etc. The configuration file may a so include labeling, quantification dynamic range,
default analysis thresholds, mapping of used data file table-field names to expected MAExplorer names for the GIPO and
guantification files, additional database-specific pull-down menu plugins, names of gene sets and sample condition lists, etc.

The GIPO file isindependent of the number of array samples and describes the mapping between spot position in an array and its
gene identification as well as corresponding data such as original plate number, row and column; UniGene ID, GenBank D,
dbEST ID, etc. These fileswill be described in more detail including how one can create the necessary database files that
MAExplorer requires for use with various types of microarray data.

Directory (i.e. folder) structure of stand-alone databases

When running as a stand-al one application, MAExplorer assumes that data from alocal computer has a specific directory structure.
The required and optional directories (also called "folders' on some operating systems) and files they contain are diagramed here
from a database project directory in your file system. The notation "/folder-name" indicates that "folder-name" is afolder inside of
the project.

(specific database directories and files they contain)
| Cache
/ (copies of any data files saved from Wb DB access)
/ Config
/ MaExpl orer Confi g. t xt
[ Sanpl esDB. t xt
/ G PO db. t xt
! MAE
| (set of startup database files). e
/ 1 mages
/ (set of original or sanpled array .jpg inmages) (optional)
/ Pl ugins
/ (optional set of .jar or .class MAEPl ugin files)
/ Quant
| (set of spot quantified data files).quant
/ Report
[/ (set of .txt and .gif report files generated using SaveAs
/| State
| (set of gene set files).cbs and
/ (set of condition list files).hbl generated using Save DB

Figure C.1 Directory structur e of stand-alone databases required by MAExplorer. The"/Config", "/Quant", and "/MAE" directories are required.
The /MAE directory is only used with the stand-alone version with .maefiles, not for the applet. [When used with an applet, the main path is the path of
the download JAR file and .mae files are not used.] The "/Report", and "/State" directories are created by MAEXxplorer as needed and the user need not
create them prior to running MAEXplorer. The text reports and plot GIF images are saved in the /Report folder when you "Save" areport or plot. When
you "Save" the current database session (File | Databases | Save ...), the gene sets and sample lists are saved in the /State folder for use when you restart
MAEXxplorer on the .mae startup file. The optional "/Cache" directory isonly used (and then, only optionally) when downloading data from a Web
server. The optional "/Image" directory isonly used in there are JPEG images of the arrays provided and their resolution and alignment must correspond
to the (X,Y) spot datain the Quant files. The "/Plugins" directory is where the MAEP ugins packaged with MAExplorer are normally kept and where
MAExplorer looks when you attempt to load a plugin. Since you can browse your file system, they do not have to appear here.

Examples of some of the database files required by MAExplorer
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These could be used as examples that could be used in creating your own database files. When the MAExplorer converter tool,
Cvt2Mae, isreleased it will eliminate the need for manually editing your database files.

Sample MGAP database configuration, quantification data and startup files are available for use as examples with which to make
your own files or for inspection.

. http://www.lech.ncifcrf.gov/mage/M GA P-Array-database/ Config/
. http://www.lecb.ncifcrf.gov/mae/M GA P-Array-database/ Quant/
. http://www.lech.ncifcrf.gov/mag/M GAP-Array-database/ M AE/

In addition, examples of the (Config/, Quant/ and MAE/) files needed for various types of arrays are available at:

. Example-P33 F1F2
. ExampleeNAME GRC
. Example-Cy3Cy5

Additional directories used at run-time

When running MAEXplorer as a stand-alone application, you may save data on the disk Text reports and plot graphics windows are
saved as ".txt" text and ".gif" image files when the user uses the "SaveAs" button in the respective popup windows. These files are
saved in the "Report” subdirectory.

Similarly, when the entire database is saved (File | Databases | SaveAs ...DB) into a.mae startup file, the set of gene set filesare
saved as".cbs" files and the set of condition list files are saved as ".hbl" filesin the "State" subdirectory. These are automatically
reloaded into MAEXxplorer when the .mae startup file is used to restart MAExplorer.

If your array data has JPEG or similar images of the original arrays, the should be saved in the "Images’ directory. For example,
the NCI-CIT mAdb database server alows you to download sampled images for your datain an "Images' subdirectory at the same
time you download the other MAEXxplorer data files. The images can then be used by various MAEPIugin programs. If your
quantified data converted to .quant files has (X,Y) coordinates corresponding to spots in these images, then you may be able to use
the Montage MAEPIugin to show where the current spots are in sub-regions of all of the input images. This plugin will be
available on the MAEPIugin Web site when we release the MAEPIugin facility for Beta-testing.

Tools for automating the construction a local stand-alone database

Software tools for aiding the construction of local stand-alone databases from vendor supplied GIPOs and spot quantification files
are not available at this time, but will be made available in the future.

Manually constructing a local stand-alone database

Although the Cvt2Mae converter tool can convert many files, you could aternatively build these files manually. We suggest using
Excel or your favorite RDBMSS system to manipulate the data. At the end, save the data into files with tab-delimited fields with the
abovefile extensions (i.e. .txt, .quant, .mae). The layout of these files and what is optional and what is not is described in detail
(maybe too much!) below. Y ou could use an ASCI| file text editor instead of Excel (such as Wordpad, Emacs, etc.) - but be
careful not to add or delete tabs since thiswill destroy the integrity of the database tables. Be consistent in your file names;
avoid spaces; use ASCII charactersin file names that are system independent (i.e. A-Z, az,0-9, "-", "+"," "); Use either "-" or "_"
or bath.

For a specific database (db), make sure the names of the configuration filesin/ Conf i g directory are entered in the
MaExplorerConfig-db.txt file for that database. Y ou may have multiple databases in the same/ Confi g,/ Quant and/ MAE
directoriesif the file names do not conflict. Thetrick isto havethe. mae startup filein the/ MAE directory point to the specific
confi gFi | e to be used. Since MAEXxplorer reads the MaExplorerConfig-db.txt file when it first starts up, it discovers the names
of the other database files. If there is no name conflicts, then thereis no problem mixing data.

Each spot data (.quant) sample file has a name which must be entered in the Dat abase_Fi | e field of the Samples-db.txt row
entry for anew sample. The Sanpl e_| Dfield is adescriptive name of that sample.
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Often GIPO files supplied by array vendors have additional fields not currently used by MAEXxplorer. You can leave them in (they
will beignored) or take them out (loading a database is faster).

If the field headingsin the various user's tables are not the same as that required by MAExplorer, you can easily fix this by adding
(Table,Field) mapping entries to your version of the MaExplorerConfig-db.txt file (see mapTF for examples).

Note that the optional Menu_Sour ce_Nane entry in the Samples-db.txt file specifies the sub-menu, if any, that the sample will
appear in the Samples menu By Sour ce sub-menu.

If the optional extra sample information fileis used, then make sure the sample names and database file names are the same, and
that there are corresponding rows in each table.

C.1 Creating quantified spot data files from hybridized sample arrays

Quantified spot data from images scanned from hybridized sample arrays may be created using a variety of software programs.
Discussion of these is beyond the scope of this manual. However, several of these including Pathways 2.01, ImageQuant-NT, and
others generate tab-delimited text files. These files may be used directly as the quantified spot files required by MAExplorer, or
simplified first (by removing unused or redundant data fields). Typically, the files are named (or renamed) to that of the sample to
distinguish them from each other and a. quant file extension assigned instead of the . t xt file extension. Other programs
generate tab-delimited files that could be mapped to our .quant file formats. (For example, the NCI/CIT mAdb system generates

such amapping for GenePix(TM), and ScanArray formated data.)

C.1.1 Color and prefix notation for the following tables: (req), (opt), (future)

The following tables list parameter s and some typical values that might be included in the configuration and quantification files.
These examples illustrate the variety of parameters or fields with examples of values that might be used. Required parameters are
in black with "(req)" prefix. Optional parameters are indicated in blue with a"(opt)" prefix. Optional parameters are not normally
specified and are generated in the .mae file when you save the state of a data exploration. Parameters that might be used with
Cy3/Cy5 ratio data are indicated in magentawith a"(ratio)" prefix. Future options not currently used are indicated in green with a
"(future)" prefix. Alternative options are indicated in red with an " (alt)" prefix.

C.2 Table of samples that can be loaded into MAExplorer

The samples available to be analyzed in a database are listed in a samples database table. Thislists all samples that could be
loaded. The user will then select a subset of these to be analyzed. The selection is done either in preset Web startup pages, or with
the stand-alone application . mae startup files, or at run-time by selecting new entries from the Samples pull-down menus. Extra
information may be provided to MAEXxplorer for each sample through this table and will be available for the Sample Array report

in Section 2.4.6.1.

A typical sample database table might look like:

Sanpl e_I D Proj ect Dat abase_Fil e
control 1 breast Cancer control 1
control 2 breast Cancer control 2
control 3 breast Cancer control 3
tunor 1 breast Cancer tunorl

tunor 2 breast Cancer tunor2

tunmor 3 breast Cancer tunor3

Y ou may optionally include a Database |D field. For example:
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Sanpl e_I D Pr oj ect Dat abase_Fi | e Dat abase_| D
control 1 breast Cancer control 1 270314
control 2 breast Cancer control 2 270315
control 3 breast Cancer control 3 270316
tunmor 1 breast Cancer tunorl 270317
tunor 2 br east Cancer tunor2 270318
tunor 3 breast Cancer tunor3 270319

The Database_ID may be useful if there are file length problems on some systems (i.e. MacOS 8-9), we offer the option of using
the Database ID asthe file name for the .quant (Quant/ directory) and .jpg (Images/ directory) rather than the Database File name.
For example one could specify "Quant/270314.quant” and "/Images/270314.quant” rather than the default " Quant/control 1.quant"
and "/Images/control 1.quant” names.

The Samples database table includes some required as well as optional fields (see Table C.2.1.1):

Table C.2.1 List of Samples data file table fields. The Samples table lists hybridized samples that are accessible to the user and
may be loaded into a database session if they wish. (See Section C.1.1 for option notation.)

Field Description
(req) Sample_ID
(req) Project

descriptive name of the sample, free text. [Note: an older depricated name is "Membrane_1D"]
that the sample belongs. Used for login protection and grouping of samples
(req) Database_File |name of the. quant spot database file, no spaces. Thisisthe file name for the sample.

databasefile ID corresponding to Database File and Sample_ID. For use with RDBMS Web databases (e.g. experiment id #).
(opt) DatabaseFilelD INOTE: if you are encoding auxillary data files using thisidentifier, e.g. sampled array imagesin the | nages/ directory, then
thisfield isrequired if you want to access those images.

Table C.2.1.1 List of optional Samples data file table fields. These fields may be used for some additional operations. If they are
not in the Samples DB table, then the operations will not be available. (See Section C.1.1 for option notation.)

Sample SubMenu j that this sample belongs. Y ou could use the word "Default” or leave out this entry if you do not want

(opt) Menu_Source Name {0 USe SUb Menus.

(opt)Orig_File_ Name
(opt)Strain

(opt) Source

(opt) Probe

(opt) Stage

(opt) Login

(opt) GeneCard_URL
(opt) Histology_URL
(opt) Model_URL
(opt) BGLow

(opt) BGAvg

(opt) BGRms

if applicable. The original file name and sample name if the data was split out from a multiple hybridized samplefile.
if applicable

if applicable

if applicable

if applicable (eg, developmental stage, dose, time point, etc)

(optional) TRUE if login required with a Web server else blank. Thisis used primarily with the Applet when interacting
with a Web server

GeneCard ID if applicable

(e.g. MGAP) histology DB Web page if applicable

(e.9. MGAP) mouse model database Web page if applicable
global low value of array background intensity

global average value of array background intensity

global root-mean-square value of array background intensity

TableC.2.1.2 List of optional Samples data filetable fields. These fields are not currently used in any computations but are
returned in the Sample Array report in Section 2.4.6.1.
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(opt) Contributor name of researcher submitting the sample

(opt) Contrib_Institute researcher's organization

(opt) Submission_Date when submitted

(opt) Exposure minutes or hours of radiolabel or fluorescent exposure

(opt) Sample_Nbr internal sample number

(opt) FilterType name of the array layout

(opt) FilterType_Description |additional description of array layout

(opt) Comments details describing sample

(opt) Researcher researcher performing the hybridization

(opt) SampleGrid serial number of the array or grid or internal laboratory numbering. (Useful if reusing arrays etc)

C.3 Quantified spot data file formats

MAExplorer has been designed to be able to read quantified spot data from a variety of spot analysis software packages. So the
datafile format is very flexible. Essentially, a data file contains one or more spot intensity values per gene in each row of the data
file. A spot location is specified by a GIPO (field#, grid#, grid column#, grid row#) 4-tuple with the field value optional. Note: a
"grid" is sometimes called a"block" or a"patch". If the field specification is omitted and there are duplicate spots in multiple fields
of grids, then it is defined implicitly. In that case, the corresponding spot intensity data for each field for ageneis specified as
separate columns going from left to right. The (grid#, column#, row#) part of the specification may be encoded severa ways. a)
explicitly as (grid#, column#, row#) or b) NAME_GRC.

Alphanumeric mappings for Grid, Grid Row and Grid Column data

Most quantitative data formats use integers for (grid,row,col) values. However, some formats use letters [A:Z] for the first 26 (i.e.
[1:26]), and [a:Z] for the next 26 (i.e. [27:52]) values. Sometimes only lower case |etters are used - in which case we must map

[aZ] to [1:26]. When MAEXplorer first sees aletter in reading the data, it checks to seeif it isan upper or lowercase letter and
generates the offset needed to generate the mapping.

The Molecular Dynamics Name_GRC numbering mapping for Grid, Grid Row and Grid Column data
Alternatively, the Molecular Dynamics ImageQuant GI PO coordinates represented by NAME_GRC with entries of the form "Grid -
<grid#>R<row#>C<column#>" (e.g. "Grid -3R6C8") may be used with or without the replicated field entry to replace the entries
(grid, grid col, grid row) in the GIPO table and Quant spot datafiles. For [G grids, R rows and C columng], this would cover a set
of spotsin therange[1,1,1] through [G,R,C].

Some examples of typical quantified spot data files might look like:

1. Single spot/gene intensity data.

grid grid col grid row Rawntensity Background
1 1 1 2226. 8 32.6
1 1 2 1234.8 25.6
10 25 28 3333.8 23.6

2. Double spots/geneintensity data contained in two fields of duplicate spots.

grid grid col grid row Rawintensityl Backgroundl Rawl ntensity2 Background2

1 1 1 2226. 8 32.6 2345.9 39.4
1 1 2 1234.8 25.6 1245.9 39.4
10 25 28 3333.8 23.6 3345.9 25.4

3. Double spots/gene intensity data contained in two fields of duplicate spots.
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field grid grid col grid row Rawintensity Background

1 1 1 1 2226. 8 32.6
1 1 1 2 1234.8 25.6
1 10 25 28 3333.8 23.6
2 1 1 1 2226.8 39.4
2 1 1 2 1234.8 39.4
2 10 25 28 3333.8 25. 4

4. Double spots/gene intensity data using the Molecular Dynamics NAME_GRC notation.

NAVE_GRC Rawi ntensityl Rawl nt ensi ty2
GRID 1-R1C1 2126.500 3662. 350
GRID 1-R2Cl 2311.430 3306. 290
GRID 1-R3Cl 3696.470 5780. 310
GRID 1-R4C1 3167.450 5245. 440

5. Cy3/Cy5 spot/generatio data.

grid grid col grid row Cy3 Cy3Bkgd y5 Cy5Bkgd
1 1 1 2226.8 32.6 2345.9 39.4
1 1 2 1234.8 25.6 1245.9 39.4
10 25 28 3333.8 23.6 3345.9 25.4

The basic Quant spot data file table includes entries listed in Table C.3.1:

Table C.3.1 List of Quant data filetablefields. This specifies the spot quantification data. There may be one or more spots,
corresponding to the same gene, on each row. (See Section C.1.1 for option notation.)

Field Description

\(opt) field ffield for duplicate genesiif using single 'Rawlntensity' value/Row
](req) grid ’grid name (either A,B,C,...or 1,2,3,...)

\(req) grid col column with in agrid

\(req) grid row row within agrid

\(opt+alt) NAME_GRC |(alternative specification of "grid, grid col, grid row").

’(req) RawlIntensityl ’intensity valuefor field 1. Use thisform if there is more than 1 intensity value/row.
](req) Rawlntensity2 ’intensity value for field 2 (required if it exists and for Cy3, Cy5 data)
|(reqr+alt) RawlIntensity |intensity value for field 1, if only one field used

\(opt) Background1  |background intensity value for field 1
’(opt) Background2 ’background intensity value for field 2 (if it exists for F1,F2 data or Cy3, Cy5 data)
’(opt+alt) Background ’background intensity value for field 1, if only one field used

’(opt) Qual Check ’qua] ity check for dataindicating "bad" spots or genes. Current codes are listed in the Table C.4.2 of Qual Check semantics

spot data detection value quality. This could be the Affymetrix MAS5.0 "Detection p-value" or some other metric correlated with spot detection quality

’(Opt) Detvaue inthe range of [0.0 : 1.0]. metrix

Note: If NAME_GRC is specified (eg. for use with ImageQuant-NT data), then the explicit (grid, grow row, grid col) fields are not
required. Note: For [G grids, R rows and C columng], thiswould cover a set of spotsin the range[1,1,1] through [G,R,C].

Note: If Cy3/Cy5 double fluorescent labeling is used, then the Rawlntensityl and RawlIntensity2 fields may be replaced with
Cy3RI and Cy5RI names and the (RawIntensity1, Rawlntensity?2) fields mapped to (Cy3RI, Cy5RlI) in the configuration file
mapTF entries (table C.5.4 below). (See Section C.1.1 for option notation.)
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Field Description

(req) Cy3RI RawlIntensityl value for Cy3
(req) Cy5RI Rawlntensity2 value for Cy5
(opt) Cy3Bkgrd |Backgroundl value for Cy3
(opt) Cy5Bkgrd |Background2 value for Cy5
(opt) Cy3 Rawlntensity1 value for Cy3
(opt) Cy5 Rawlntensity2 value for Cy5

C.4 The GIPO table database file format

The gene-in-plate-order (GIPO) table used to make the connection between a spot on amicroarray and the plate well
corresponding to a gene. We are working on extending the format so that it will more easily handle GIPO tables from a variety of
sources.

Datais extracted from atable created from the gene-in-plate-order (GIPO) gene coordinate table. This links spotsin a microarray
to these Genomic "gene I D"s and gene names. This table may contain Clone ID, GenBank, dbEST, UniGene IDs, LocusiD
corresponding to these Master Gene IDs. An optional table of Clone IDs and Gene Classes the gene belongs to may also be
defined.

A typical GIPO database table might look like:

Location grid grid col grid row plate plate row plate col Cone ID GenBankAcc GeneNane

39 A 2 15 2 1 3 1247601 AA763423 "Mus nuscul us

A ki nase anchor protein (AKAP-KL) nRNA, alternatively spliced isoforml, conplete cds"

40 A 2 16 2 1 4 1247553  AA763380 Mius muscul us
bodeni n gene

41 A 2 17 2 1 5 1247865 Al 465019 "Muse beta-D

gal act osi dase fusion protein nRNA, conplete cds"

The basic GIPO table includes the following fields:

Table C.4 List of GIPO data file table fields.

These fields define the mapping between a spot's grid coordinates on the array and its genomic identifier, gene name, its plate, etc.
Field Description

(opt) field array field for duplicate genes

grid array grid name (either A,B,C,... or 1,2,3,...)

grid col array column within agrid (either A,B,C,... or 1,2,3,...)
grid row array row within agrid (either A,B,C,... or 1,2,3,...)

(opt+alt) NAME_GRC |alternative specification to "grid, grid col, grid row". It is generated by the Molecular Dynamics spot quantification software.

Thisisthe master geneidentifier used in MAExplorer. It must be one or more of the identifierslisted in Table C.4.3. One of
these will be selected as the Master Gene ID (MID)

Master Gene Name. The GeneName options are listed in Table C.4.1. These alternative GeneClasses are automatically
recognized from the Gene Name.

(opt) Master Gene D

(req) Gene Name

(opt) plate plate name for original gene. If thisis not specified, it uses the grid value.
(opt) plate row plate row name for original gene. If thisis not specified, it usesthe grid row value.
(opt) plate col plate column name for original gene. If thisis not specified, it usesthe grid col value.
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(opt) QualCheck quality check for dataindicating "bad" spots or genes. Current codes are listed in the Table C.4.2 below

Table C.4.1 List of possible Master Gene Name

The Master Gene Name must be define as one the following identifiers:
Field Description
(opt) GeneName Gene name

(opt) Unigene cluster Name |alternative for GeneNameif the latter is not specified.

Automatic Gene Class naming based on Gene Name
Some Gene Classes are automatically recognized from the Gene Name including:

Unknown ESTs - the Gene Name is"EST", "ESTS", "expressed sequence”, "unknown"

ESTs similar to known genes - the Gene Nameis "EST, ...", "EST ...", "expressed sequence ..."

Cadlibration DNA - the Gene Name is the 'calibDNAname' value defined in the Configuration database table.

User's Plates - the Gene Name is the 'your plate' value defined in the Configuration database table.

Empty Well - the Gene Name is the 'EmptyWell' value defined in the Configuration database table.

Known genes - if the non-null Gene Name does not fit into any of the above categories and it is not an empty well, itis
assumed to be a known gene.

7. Good genes - normally set by the QualCheck field in the GIPO file, but if the gene nameis"EmptyWell", itisflagged as a
bad gene.

o0 kswNE

Alternative Grid,Row,Column encoding scheme: NAME_GRC

Some quantification programs (e.g. Molecular Dynamics "ImageQuant-NT) specify “grid, grid_col, grid_row" by asingle symbol
we denote NAME_GRC coded as follows

GRID-  grid#- R ow#Ccol #
For example, if grid #, row# and column# are (8,12,11), then it codes it as

GRI D 8- R12C11

Table C.4.2 List of QualCheck codes and their semantics

The data filter "Filter by '‘Good Spot data” may be used in eliminating bad spot data on a per-gene set basis. This uses the
"QualCheck" field in the quantified data table is present. It maps either an 1) integer numeric code (see Appendix C of the
Reference Manual), 2) an aphabetic code (e.g. Affymetrix "Abs Call") of "P* (or "G" or "T") to Good Spot, "A" (or "B" or "F") to
Bad Spot, and "M" to Marginal Spot, or 3) a continuous quality value. In thislatter case, QualCheck may be a continuous
monotonically increasing floating point value (e.g. 0.0 to 100.0, or 0.0 to 1.0, -100.0 to +100.0, etc.) in which case a" Spot Quality"
State threshold slider will popup when the filter isinvoked. Additional property value codes may be added in the future.

Status QualCheck value |Semantics
Good gene 2 the spot datais "Good" (some systems report thisby a NULL quality measure). It has a good gene name.
9 Alternatively, letter codes may be used "P*, "G", "T".
Bad gene 4 the spot datais bad, a good gene name.
is anon-analyzable spot (eg. marker, or "Bad", "Not Found", "Empty". etc.) Alternatively, letter codes may be used
Bad spot 8 nAn MR MER
Duplicate spot |16 is duplicate of another gene on array
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Marginal spot (256

isamarginally quantified spot. Alternatively, letter codes may be used "M".

Table C.4.3 List of possible Master Gene Identifiers

Additional datais used to point to datain external genomic databases by specifying the identifier. This may be used to dynamically
link genesin the MAEXxplorer database to Web database servers to bring up Web pages from these databases. Note the Master 1D
needs to be specified and may be any one of the following identifiers. The appropriate genomic Web browser access will be
enabled depending on the genomic Master 1D specified. (See Section C.1.1 for option notation.) The fields include:

Field

(opt) Location
(opt) Clone ID
(opt) Unigene cluster 1D
(opt) dbEST3'
(opt) dbESTS'
(opt) GenBankld
(opt) GenBanklId3'
(opt) GenBankld5'
(opt) RefSeqID
(opt) LocuslD
(opt) OMIMID
(opt) SwissProtID

Description

aternate spot identifier. E.g., Affymetrix ‘probe_set', or Incyte 'Incytel D', etc. This may be numeric or alphanumeric
I.M.A.G.E. consortium database clone ID. It may have a"IMAGE:" or "ATCC:" prefix

NCBI UniGene database ID
NCBI dbEST database
NCBI dbEST database
NCBI GenBank database
NCBI GenBank database
NCBI GenBank database
NCBI RefSeq database
NCBI LocusLink database
NCBI OMIM database
Swiss-Prot database

Table C.4.4 Extending Genomic IDs and associated URLs

MAExplorer allows you to define your own gene identifiers that will map to external genomic databases. Y ou add the following
entires in sets of 4 to the Configuration database or to the .mae startup file. These entries will be added to the View menu where
you may select the external genomic database to visit when you activate MAEXxplorer to launch a brower on clicking on a gene.
The following table shows the 4 required fields for 2 entries. There may be any humber of external genomic IDs. (See Section

C.1.1 for option notation.)

Parameter

(opt) GenomicM enul

(opt) GenomicURL1
(opt) GenomicURL epiloguel

(opt) Genomicl Dregl

(opt) GenomicM enu2

(opt) GenomicURL 2
(opt) GenomicURL epilogue2

(opt) GenomiclDreg2

Value

GenBank

http://www.nchi.nlm.nih.gov/htbin-post/Entrez/query ?db=2& form=1& term=

GBID

UniGene

http://www.ncbi.nlm.nih.gov/Uni Gene/query.cgi?ORG=Mm& CID=

V]1]

DataType [Comments

String

String
String

String

String

String
String

String

Name of the database. Thiswill appear in the View
menu

URL to which one adds the ‘Genomicl Dreq’ value
epilogue of the URL if any

Name of the GenomiclD required and that is specified
inthe GIPO file as one of itsfields

Name of the database. Thiswill appear in the View
menu

URL to which one adds the ‘GenomiclDreq' value
epilogue of the URL if any

Name of the GenomiclD required and that is specified
inthe GIPO file as one of its fields

C.5 Configuring MAExplorer for use with various types of array data
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MAExplorer has been designed so that it may be reconfigured for different array dependencies including: geometries, number of
replicate fields, scanner dynamic ranges, labeling, etc. When first started, MAExplorer reads this configuration file and then uses
thisinformation to handle reading different types of array datafiles that are subsequently loaded. To make it easier to understand,
the entire table is presented as several sub-tables - however, MAExplorer reads it as a single table (the default being called
MaExpl or er Confi g. t xt ). Note that optional parameters are for the most part - optional. Many of these may be set from the
MAExplorer menus once the program is started. The reconfigured state may then be saved (File | Database | SaveAs ... DB) with
these and other state values retained for the next time the particular startup database is used.

We are devel oping tools for creating and editing the configuration file. In the mean time, edit the file with Excel and save the
finished table as a tab-delimited text file with the name MaExpl or er Conf i g. t xt inthe Conf i g sub-directory) in the
directory where your database is stored.

Table C.5List of Configuration data filetable fields.

Parameter subset Function of these parameters

1. Array content & geometry |Describes the content and geometry of the arrays (required)
2. Threshold defaults Describes the threshold defaults (optional)

3. Array databasefiles Describes the array specific database files (required)

Describes "mapTF" table,field mapping. This maps user defined names
4. Table field mapping to names required by MAExplorer and is only required if the user names
are different from the names MAEXxplorer expects.

Describes base addresses of genomic Web DBs (optional).

5. URL genomic detabases If you do not specify these, default values are supplied from the program.

6. User menus Describes user-specific menus (optional)

The following sub-tables list the configuration par ameter s and some typical values that might be included. These examples
illustrate the variety of parameter options with examples of values that might be used. Required entries are listed at the tops of the
tables.

A typical MAEXxplorer minimal configuration database table might look like:

Par anet er Val ue Dat aType Comment s

MAX_FI ELDS 1 int # replicate grids/array

MAX_GRI DS 2 i nt # grids/field

MAX_GRI D_COLS 38 int # columms/grid

MAX_GRI D_ROWS 27 int # rows/grid

usePseudoXYcoor ds true bool ean use pseudoarray XY coord inmage - no XY data
gi poFile G PO t xt File name of APOfile from

sanpl esDBfi | e Sanpl esDB. t xt File nane of Sanples DB file

dat aBase deno String default nanme of project database

dbSubset denpnl String defaul t database subset nane

useRat i oDat a true bool ean treat duplicate(F1, F2) data as ratio (F1/F2) -
i.e. Cy3/Cy5

Edi t Dat e Tue Aug 21 2000 String deno

Table C.5.1 List of array database-specific content and geometry configuration
(Parameter,Value) entries

Thistable lists most of the options that the use could define. If they define an option, it will override the default set by
MAEXxplorer. The values are shown for some typical databases. (See (A HREF="#optThlNotation">Section C.1.1 for option
notation.)
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A) Array geometry parameters

Parameter \Value |DataType Comments

(reg) MAX_FIELDS ’2 int ’z a?;?gffi Efisgzt(zg%c;&agzlﬁ:,ﬁz%‘) of spots for each genein the array (i.e. F1, F2, etc.). Note that Cy3 and Cy5
|(reg) MAX_GRID_COLS 24 lint |# cols/grid in the array

|(req) MAX_GRID_ROWS |9 lint [# rows/grid in the array

|(reg) MAX_GRIDS 8 lint [#gridsinthe array

(opt) ignoreExtraFields ’F ALSE  |boolean ’ |fT ;r;erﬁl g:::ettril?slt; ?)Tii nflizl ?]z to; grzit;aa: Ir;l t:;il PO or .quant files, then ignore them. Only use the first rawlntensity
|(opt) reuseX Y coords |FALSE boolean |Reuse XY coordinates from first sample for rest of the samples

|(opt) SpotRadius |7 lint |(2to 20 pixels) 50 microns, scroller. Note: this should be set to about 4 or 5 for 2 10000 gene DB.

’(opt) swapRowsColumns |FALSE ’boolean |set if swap rows and columnsin the array (used with our particular Research Genetics arrays)

(opt) usePseudoX Y coords ’F ALSE  |boolean :ze aﬂﬁcc;gzr;ago f>:\:v( ;gorm nates image if thereis no explicit no XY spot position data generated by the
|(future) FIELD_LAYOUT |Ltor |String [fields are Left to Right

|(future) FIELDS_ARE_NUMBERED |TRUE  |boolean |Datafiles contain field number. Otherwise field is extrapolated

|(future) GRID_LAYOUT |Horizontal |String |Grids are Left To Right in the array

’(future) GRID_PER_ROW |4 ’int |# grids per row in each field of the array

B) Ratio and background parameters

Parameter Value DataType Comments

|(ratio) fluorescentLbl1 |cy3  |stiing Iname of dye for fluorescent label 1

|(ratio) fluorescentL b2 |cys  |string Iname of dye for fluorescent label 2

’(raIio) useRatioData |TRUE |boo|ean ’set if datais Cy3/Cy5 ratio data otherwise it assumes intensity data for each spot
|(opt+ratio) useRatioMedianCorrection [FALSE  |boolean \when using ratio data mode (Cy3/Cys5), use ratio median correction asthe default
|(opt) useBackgroundCorrection |FALSE |boolean |use background correction as the default when startup

|(future) useCy5/Cy3 |FALSE |boolean \compute Cy5/Cy3 ratios instead of Cy3/Cy5 ratios

C) Names of database, etc.

We indicate example values by italics.

Parameter Value DataType Comments
name for calibration DNA if available - replacing clonel D in the case where the clones are not yet in

(opt) calibDNAname mouse genomic DNA String the|.M.A.G.E. database. The particular cloneislocated using the Plate(grid,row,col) reported when
selecting the current gene.

’(opt) classNameX |HP-X 'set’ |Stri ng |defau|t name of HP-X samples 'set'

|(opt) classNameY |HP-Y 'set |string |default name of HP-Y samples 'set

|(opt) dataBase |MGAP DB |string [name of the database project

|(opt) dbSubset |Preg 13 vsLact 1 |string [name of the subset of data from the database

’(opt) geoPlatformlD |GPL80 |Stri ng |name of the NCBI Gene Expression Omnibus (GEO) Platform Id

|(opt) maAnalysisProgram |Research Genetics Pathways 2.01 |String [name of spot quantification program

name of researcher's clones if available - used in the clonel D datafield in the case where the clones
(opt) yourPlateName your plate String arenot yet in the |.M.A.G.E. database. The particular cloneis located using the Plate(grid,row,col)
reported when selecting the current gene. (See Table 2.4.1)

’(opt) emptyWelIName Ierrpty wells |sm ng |what you called empty wells if there are any in the database. (See Table 2.4.1)

|(opt) EditDate |06-19-00, Lemkin |string |comment why changed

D) Display Views

Parameter \Value DataType Comments
|(opt) gangSpotFlag [TRUE |boolean |set gang spot display on startup for database with duplicate spots
’(opt) presentationViewFlag ’FALSE ’boolean ’start MAExplorer with larger fonts and graphics symbols suitable for live presentations

file:///IC|/tmp/MaeRefMan/hmaeFullRefMan.html (150 of 234) [11/24/2003 10:49:37 AM]


file:///C|/tmp/MaeRefMan/hmaeDoc2.4.1.html#GeneNameClassificationRules
file:///C|/tmp/MaeRefMan/hmaeDoc2.4.1.html#GeneNameClassificationRules

MAExplorer - cDNA Microarray Exploratory Data Analysis

(opt) showEGL flag FALSE |boolean show EGL genes on startup from previously saved database that had EGL genes selected.
(opt) showM ouseOver TRUE |boolean show mouse-over info when move mouse in windows
(opt) useDichromasy FALSE |boolean use orange-blue else use red-green color scheme

view Filtered spots the array pseudoimage. If it is off, it shows just the pseudoarray image without spots passing the filter or

(opt) viewFilteredSpotsFlag | TRUE  |boolean MAExplorer state information.

Note that there are many other parameters reflecting the state of MAEXxplorer that are saved in the .mae startup file when doing a
(File | Database | SaveAs...DB) operation. These are reviewed and set from the MAExplorer menus. These parameters are not
listed here - although they could be used in setting up an initial .mae startup file.

Table C.5.2 List of default threshold database-specific configuration
(Parameter,Value) entries

Some of the default thresholds and sizes may be defined here as it may be useful to vary them with different types of data.

Parameter Value |DataType |Comments

(opt) CanvasHorSize 1100 int pixels, horizontal size of microarray image ** DEPRICATED**

(opt) CanvasVertSize 1100 int pixels, vertical size of microarray image ** DEPRICATED**

(opt) fontFamily SansSerif |String default text font family. See Font Family for other fonts. Some fonts look better with some operating systems.
(opt) clusterDistThr 10 float default cluster similarity threshold in [0.0 : 100.0], scroller

(opt) maxGenesReported 50 int max # of genesin highest/lowest gene report

(opt) maxPreloadlmages 4 int max # HP samplesto initially load

(opt) nbrOfClustersThr 6 int default # clusters for K-means clustering

(opt) pvalueThr 0.2 float default p-value for statistical tests

(opt) spotCVthr 0.25 float default spot Coefficient of Variation value

(opt) allowNegQuantDataFlag |FALSE  |boolean set if .quant file data has negative intensity values otherwise it clips the negative values to 0.0

(opt) usePosQuantDataFlag  |TRUE  |boolean Filter out genes where .quant file data has negative intensity values otherwise it uses the negative data

Table C.5.3 List of array specific auxiliary database files (Parameter,Value) entries

Thislists the names of the database-specific auxiliary files. Note that the names of these files may change with the database but the
name of theinitial configuration file containing these names (i.e. MaExpl or er Conf i g. t xt does not change. Optional
Parameter s areindicated with a™*" prefix. (See Section C.1.1 for option notation.)

Parameter Value DataType Comments
Composite Gene-In-Plate-Order (GIPO) file containing the spot print order, Clone-IDs, gene names, GenBank IDs, plate

(veq) gipoFile GIPO-DB.txt | [File coordinates, etc. (See Appendix C.4)
(req) samplesDBfile |Samples-DB.txt |File list of hybridized samplesin the database. [Note: an older depricated name was "membranesDBfile"]. (See Appendix C.2)
(opt) quantFileExt  |.quant String alternate quantification spot file name extension to use instead of ".quant”. (Y ou might set it to ".txt") (See Appendix C.3)

Table C.5.4 List of optional (Table,Field) mappings to configure specific user's data

types

Sometimes user data tables contain the proper data required by MAEXxplorer, but the names of the columns (i.e. fields) are
different. MAExplorer can map user (tablefield) namesto the internal names it uses. This allows users to maintain their tablesin
the names they choose. The following mapTF entries are not required if the fields in the corresponding tables already have the
MAE field name. The entries use the mapping where

. [TableName] isthe name of the table (repeated twice in the following specification).
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. [MAE field name] isthe internal MAExplorer name of the field in the table.
. [User field name] isthe external name of thefield in table in the user's file that corresponds to the internal MAExplorer
field.

[ Tabl eNane] , [ MAE fi el d nane], [ Tabl eNane], [ User field nane]

The following table fields may be mapped. Note: mapping is required only when the table field names of your data files are
different than the internal MAExplorer table field names.

1. GipoTable- GIPO tablefor entire database
2. SamplesTable- list of all samplesin the database
3. QuantTable- each. quant spot datafile

The following is an example of some of the parameters that might be added to the Configuration file to perform field name
mappings. Note: these mappings are only required if the data field names are non-standard. This shows some typical field name
mappings. It will not be the same for your data. (See Section C.1.1 for option notation.)

Parameter (Value DataType Comments

(opt) mapTF GipoTable,grid,GipoTable,SA String GIPO table grid name (numbers or letters)

(opt) mapTF GipoTable,grid row,GipoTable,R String GIPO table row of grid name (numbers or letters)
(opt) mapTF  |GipoTable,grid col,GipoTable,C String GIPO table column of grid name (numbers or letters)
(opt) mapTF GipoTable,plate,GipoTable,RG Pi String GIPO table plate where clone came from

(opt) mapTF GipoTable,plate row,GipoTable,RG row String GIPO table row of plate where clone came from
(opt) mapTF GipoTable,plate col,GipoTable,RG col String GIPO table column of plate where clone came from
(opt) mapTF  |GipoTable,Clone ID,GipoTable,Cloneid String GIPO name of Clone ID

(opt) mapTF GipoTable,GeneName,GipoTable,Gene name String GIPO table map gene name

(opt) mapTF GipoTable,Unigene cluster ID,GipoTable,ucid String GIPO table UniGene cluster id (if available)

(opt) mapTF Unigene cluster name,GipoTable,ucn String GIPO table UniGene cluster name (if available)
(opt) mapTF  |GipoTable,GenBank 3',GipoTable,gh3' String GIPO table GenBank 3'id (if available)

(opt) mapTF GipoTable,GenBank 5',GipoTable,gh5' String GIPO table GenBank 5' id (if available)

(opt) mapTF GipoTable,dbEST 3',GipoTable,est3' String GIPO table dbEST 3'id (if available)

(opt) mapTF GipoTable,dbEST 5',GipoTable,est5' String GIPO table dbEST 5'id (if available)

(opt) mapTF QuantTable,grid,QuantTable,SA String Quant table array grid name (numbers or |etters)
(opt) mapTF QuantTable,grid row,QuantTable,R String Quant table row of grid name (numbers or |etters)
(opt) mapTF QuantTable,grid col,QuantTable,C String Quant table column of grid name (numbers or letters)
(opt) mapTF QuantTable,Rawl ntensity,QuantTable,Intensity String Quant table RawlIntensity data

(opt) mapTF  |QuantTable,Background,QuantTable,Bkgrdintens  |String Quant table background intensity

(opt) mapTF QuantTable,RawlIntensity1,QuantTable,Cy3RI String Quant table RawlIntensityl Cy3 data

(opt) mapTF QuantTable,Rawlntensity2,QuantTable,Cy5RI String Quant table RawlIntensity2 Cy5 data

(opt) mapTF QuantTable,Backgroundl,QuantTable,BkgrdCy3RI |String Quant table background intensity for Cy3

(opt) mapTF QuantTable,Background2,QuantTable,BkgrdCy5RI |String Quant table background intensity for Cy5

Table C.5.5 List of configuration genomic database URLs (Parameter,Value) entries

These entries are base addresses of genomic and other Web servers that are used for accessing gene or hybridized sample specific
datain external databases. Note that these entries are hardwired in MAExplorer and do not need to be specified in the
Configuration file unless you wish to override these defaullts.

Parameter Value DataType |Comments

NCBI dbEst server by dbEST ID. You
may use an alternative server.

NCBI GenBank server by GenBankAcc
ID. You may use an alternative server.

http://www.nchi.nim.nih.gov/irx/cgi-bin/birx_doc?

(opt) dbEstURL i,

String

(opt) GenBankAccURL http://www.ncbi.nlm.nih.gov/entrez/query.fcgi ?cmd=Search& db=Nucl eotide& term= | String
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http://www.nchi.nim.nih.gov/irx/cgi-bin/submit_form_query?
TITLE=dbEST+Retrieval +Output& INPUTS=1& . NCBI GenBank entry by Clone_ID server.
Er)EailEel Tzl BRACKETS=NONE&ADDFLAGS=-b& DB=dbest&. =il Y ou may use an aternative server.
NDOCS=10& Q1=
) . . Epilog added after Clone_ID. Y ou may
(opt) GenBankCloneURL epilogue |[clin] String g S G —
lookup GenBank from Clonel D server.
httpy/inciartay.ni.nih.govicgi-binfUG,_query.cgi? Y ou may use an alternative Image to
J/Inci .nci.nih.gov/cgi-bi _query.cgi? ) ., A
(opt) IMAGE2GenBankURL ORG=Mm&ACC=IMAGE: String GenBank server. The "ORG=Mm should
be changed to reflect the proper species,
eg. "ORG=Hs" for human, etc.
NCI/CIT lookup GenBank GID from
Clonel D server. You may use an
http://nciarray.nci.nih.gov/cgi-bin/UG_query.cgi? ) aternative Clonel D to GenBank GID
(opt) IMAGE2GIDURL ORG=Mm& GID=IMAGE: String server. The"ORG=Mm" shouid be
changed to reflect the proper species, eg.
"ORG=Hs" for human, etc.
NCI/CIT lookup UNIGENE from
Clonel D server. You may use an
. http://nciarray.nci.nih.gov/cgi-bin/lUG_query.cgi? ; dternative Clonel D to UniGene server.
opt) IMAGE2unigeneURL - Strin
G:2 g ORG=Mm&CLONE=IMAGE: J The "ORG=Mm" should be changed to
reflect the proper species, eg. "ORG=Hs"
for human, etc.
NCBI UNIGENE by Clone ID server.
et/ nebi.nim.nih.gov/UniGeneldlust. cai ? Y ou may use an aternative UniGene
(opt) unigeneURL b VW c m.n goviLnIGenerclust.cgr String server. The "ORG=HSs" should be changed
ORG=Hs&CID= i
to reflect the proper species, eg.
"ORG=Mm" for mouse, &tc.
] ' Lo ’ NCBI LocusLink by GenBank ID server.
) http://www.nchi.nim.nih.gov/LocusLink/list.cgi? . : A
(o) lesre ISt SITE=104& V=18 ORG=Hs& ORG=Mm& ORG=Rn& ORG=Dr& ORG=DmM&Q= | "9 IziuLS?B”SL'”k SRSzl
) . http://www.nchi.nim.nih.gov/LocusLink/list.cgi?SI TE=104 ) NCBI LocusLink by Locus|D server. The
e LALTEEL UL &V=18 ORG=Hs& ORG=Mm& ORG=Rn& ORG=Dr& ORG=Dm& Q= String LocusLink server is accessed by LocusiD
|(opt) swissProtURL |ttp://www.expasy.chicgi-bin/get-sprot-entry? |Stri ng |SwissProt by SwissProt ID
|(opt) omimURL |http:/www.ncbi.nlm.nih.gov:80/entrez/dispomim.cgi Ad= |string [NCBI OMIM database by OMIM 1D
’(opt) pirURL ’http://pir.georgetown.edu/cgi-bi n/iproclass/iproclass?choice=entry&id= |Stri ng ’PI R ProClass database by SwissProt 1D
(opt) GeneCardURL http://bioinfo.weizmann.ac.il/cards-bin/carddisp? String GeneCa}rd OIS EENER U Iz E2E 1
alternative server.
E.g NIDDK MGAP histology DB server.
(opt) histologyURL http://mammary.nih.gov/models/ String If you have an alternative histology model
server, put it here.
e.g. NIDDK MGAP mouse models DB
(opt) modelsURL http://mammary.nih.gov/models/ String server. You may use an alternative models
server.
NCI/LECB proxy server to access servers
outside of the Java "sandbox". | f you set
(opt) proxyServer http://www.lecb.ncifcrf.gov/cgi-bin/maeProxySvr? String up MAExplorer on your local server,
then] this should point to a proxy server
on your system.

Table C.5.6 List of configuration database-specific userHelp menu (Parameter,Value)

entries

When creating a specific MAEXxplorer database, the Help menu may be configured for specific links to related databases. Any
number of additional Help entries may be used (including none). The following shows the entries for MGAP.

Parameter |Value DataType Comments

’(opt) HelpMenul |List of hybridized samples ’Stri ng ’Help sub menu URL
’(opt) HelpMenu2 |MGAP animal models ’Stri ng ’Help sub menu URL
|(opt) HelpMenu3 [MGAP home page |string |Help sub menu URL
|(opt) HelpURL 1| http://www.lech.ncifcrf.gov/mae/maeHybridizations.html | String |Help sub menu URL
’(opt) HelpURL2 |http://mammary.nih.gov/mode|s/ ’Stri ng ’Help sub menu URL
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(opt) HElpURL3 | http://mammary.nih.gov/ String Help sub menu URL

Table C.5.7 List of configuration database-specific user Plugin menu
(Parameter,Value) entries [Future]

When creating a specific MAExplorer database, the Plugin menu entries may be added to different parts of the menu tree. Any
number of additional unique Plugin entries may be used (including none). The following table illustrates some possible plugin
specifications that can be loaded (or not) at startup time or loaded when invoked from a menu.

Parameter Value DataType Comments

(opt) PluginM enuNamel New Cluster plot String Plugin sub menu string

(opt) PluginMenuStubNamel |PlotMenu:cluster String name of Plugin menu stub to add menu entry

(opt) PluginClassFilel NewClusterPlot.jar String Name of classfile

(opt)sPluginCallAtStartupl  |InstallinMenu String handling plugins at startup: “InstallinMenu", "RunOnStartup”, "Nolnstall"
(opt) PluginM enuName2 New sample report String Plugin sub menu string

(opt) PluginMenuStubName2 |ReportMenu:sample  |String name of Plugin menu stub to add menu entry

(opt) PluginClassFile2 NewSampleReport.jar |String Name of classfile

(opt)sPluginCallAtStartup2  |InstallinMenu String handling plugins at startup: "InstallinMenu", "RunOnStartup”, "Nolnstall"
(opt) PluginM enuName3 Client-server String Plugin sub menu string

(opt) PluginMenuStubName2 |-none- String name of Plugin menu stub to add menu entry

(opt) PluginClassFile2 ClineServerMAE.class |String Name of classfile

(opt)sPluginCallAtStartup2  |InstallinMenu String handling plugins at startup: "InstallinMenu", "RunOnStartup”, "Nolnstall"

List of acceptable Menu stub names for: PluginMenuStubName

When MAEPIugin's are available, you will be able to insert them into various parts of the MAExplorer menu. If the menu stub is
not found, it will install them in the generic "Plugin” pull-down menu.

. "FileMenu"

. "FileMenu:Databases"
. "FileMenu:State"

. "FileMenu:Groupware"
. "HPmenu"

. "GeneClassMenu"

. "NormMenu"

. "EditMenu"

. "EditMenu:EGL"

. "EditMenu:GeneSet"

. "EditMenu:CondList"
. "EditMenu:Preferences’
. "FilterMenu"

. "PlotMenu"

. "PlotMenu:EPplots’

. "PlotMenu:Histogram"
. "PlotMenu:PseudoArray"
. "PlotMenu:ScatterPlots’
. "ReportMenu"

. "ReportMenu:Genes'

. "ReportMenu:Samples’
. "ClusterMenu"

. "ClusterMenu:ClusterFlags'
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. "ViewMenu"
. "PluginMenu"
. "HelpMenu"

C.6 Using the Cvt2Mae 'wizard' tool to convert your array data for use with
MAExplorer

In order to use MAEXxplorer on your data, you must convert your datafiles into the data formats described in Appendix C and
Appendix D. Although we and others have done this by editing user's data files into the required formats, it is a non-trivia process.

Therefore we have created a Java conversion tool called Cvt2Mae to automate these conversions. Y ou may

and install Cvt2Mae on your computer and use it to convert your array datato MAExplorer dataformat. Figure
C.6.1 shows Cvt2Mae array data converter.

Cvt2Meeisa"Wizard" driven process designed for use by molecular biologists. It handles commercial chips such as Incyte,
Affymetrix, GenePix, Scanalyze, etc. or one-of-a-kind academic chips. It asks you questions to describe your chip and your data.
We call the chip description the "Array Layout". After you have created or edited an array layout, you may save it for usein future
conversions. [The array layouts are kept in a subdirectory "ArrayLayout” in the directory where you installed Cvt2Mae.] Since an
ArrayLayout isafile, you could mail it to a collaborator. After you have answered the questions, you then run the converter and it
generates the proper set of converted datafiles. In the case of user defined array layouts, we denote the latter as <User-defined>
where the user assigns a name to that layout as part of the description. Essentially, the array layout contains a set of "rules” for
describing the user's array data so Cvt2Mae knows how to read it. At some point, we plan to add the MAGE-ML standard to
Cvt2Mae as one of the array layouts so it should be able to handle awider variety of data.

Handling grid geometries that don't fit our model

If your array geometry does not conform to one of those handled by MAEXxplorer (see Section 1.1 Gene coordinate numbering on
the microarray), then treat the data as an list of spots. In Cvt2Mae Wizard panel "[2] Grid geometry data", select the checkbox

"Use # spots (BELOW), else grid-geometry (ABOVE)" and then enter the total number of spotsin the line below. Thiswill
construct an arbitrary pseudoarray geometry to serve as a basis to display the microarray pseudoimage (see the Algorithm for
constructing the pseudo array from alist of spotsin Appendix C.6). For example, this might be used in the case where your arrays

used meta-grids.
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Figure C.6.1 The Cvt2Mae array data converter. Selecting a Chipset Array Layout. The built-in array layouts are shown for the various chip types.
User-defined layouts may be added by selecting the <User-defined> layout then editing the layout using the Edit Layout, Assign GIPO fields, and
Assign Quant fields. These options are described in more detail in the Cvt2Mae home page..

Converting data for known chip "Array Layouts" or lists of quantified spots

Assuming the desired array isin thelist of chip array layouts, follow the eight step process below with steps 3 and 5 omitted. If the
user must describe their own array data using the <User-defined> chip array layout, then they would do step 3. If your chip is one
of the chipslisted in the chip Array Layouts list, then you may be able to do an "Edit Layout" to modify the description without
having to define the chip layout from scratch - in which case do step 3.

Select the desired Array Layout.

Select the set of input files to be converted.

If the array layout needs to be edited, use the Edit Layout, Assign GIPO fields, and Assign Quant fields wizards
Select the project output folder (i.e. directory) to place the converted data

(Optionally) save the edited Array Layout in case you want to use it again in the future.

Press "Run" to convert the data.

Press "Done" when the conversion is finished.

Go to the project directory and then to the MAE sub-directory (listed after step 4).

Click on the "Start.mae" file to start MAExplorer on the next data. This assumes that you have previously installed
MAEXxplorer.

Nk wNE

The details on Cvt2Mae including more description, PDF examples of conversions for severa different types of arrays, the

download area, status of the converter, etc. are available on the B8 Cvt2M ae home page

Algorithm: Generation of a pseudoarray image geometry if no array geometry is
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specified

MAEXxplorer requires the data in the GIPO and Quant files be specified by a spot position. Thisisindicated by the array spot
geometry of (#fields, #grids, #rows/grid, #columng/grid). The #fields is the number of duplicated sets of gridsif available - itis1
otherwise. This 4-tuple must be specified in the Configuration file. However, some array data does not have a spot geometry
position data available. The alternative is to generate a pseudoarray geometry. Thisis possible since the pseudoarray imagein
MAEXxplorer is used simply to indicate success of the datafilter or relative differences depending on the "Plot | Show Microarray"
option. In Cvt2Mae we generate a visually appealing pseudoarray image geometry if no array geometry is specified with the data
(e.g. Affymetrix data, etc). The algorithm presented below will generate ageometry (nGri ds, nG i dRows, nGri dCol s) that
is compatible with the visual use of the pseudoarray. The only assumption is the nRows Expect ed, the number of spotsin the
microarray (rows in the database input file). The number of spotsin the array is computed automatically and the option to use the
pseudoarray instead of the actual array geometry is selected in the Edit Layout Wizard for Grid Geometry.

OPT_GRID_SI ZE = 1200; /* Optimal grid size for MAExpl orer view ng */
ROA5_TO COLS _ASPECT RATIO = 3.0/4.0; /* desired rows/cols aspect aspect for a grid */
extra = 0; /* # of extra grid cols required */

/* Estimate # of grids. Assune a square aspect ratio */
if(n <= OPT_GRI D_SI ZE)

nGids = 1;
el se

nGids = (n / OPT_GRID_SIZE) +1;

/* Estimate rows (r) and colums (c) froma rectangular grid
* where cols = (4/3) rows.
* Then, ¢ = (4/3)r and r*c= area.
* Then (4/3)*r*r = area or
*r = sqrt((3/4)*area).
*/
i f (nRowsExpected > 0)
whi [ e(true)
{ /* iterate to optimal size */
gridSize = n/nGids;
nGidRows = sqrt( ROA5_TO COLS ASPECT_RATIO * gridSize );
nGidCols = (nGidRows / ROAMS_TO COLS ASPECT_RATIO);
nGidCols += extra;
estTotSize = (nGids * nGidRows * nGidCols);
i f(estTotSize > nRowsExpect ed)
br eak;
el se
extra++; /* keep trying until neet criteria */
} /* iterate to optimal size */

Appendix D. Use of MAExplorer as a stand-alone application

The MAExplorer program is used primarily as a stand-alone Java Application. The same Java program may aso be used as a Java
Applet that runs within a Web browser. Both the applet version and the stand-al one version may be run on a stand-alone computer
without an Internet connection if the microarray database data files reside on that machine. The stand-alone Java version is more
robust and has some important advantages discussed in the Introduction and Appendix E.2.

This section discusses the installation of MAEXxplorer as a stand-alone application on a variety of computers. Since Javais portable
between Microsoft Windows (95/98/NT/2000/X P), Macintoshes, Linux, Solaris, etc., it is possible to freely download and install
MAExplorer and Cvt2Mae on your computer and run it as an application program.

Thereisadiscussion on using it with other arrays (Appendix C) that requires editing data files for use with MAEXxplorer. An array
data conversion tool is being constructed which will automate this processin the future.
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1. Stand-alone applications can utilize huge amounts of memory (for example, we were able to use >80Mb on a 128Mb

Windows NT system). This means that an analysis of large numbers of hybridizations and complex statistical computations
could be done locally.

. The stand-alone version can do local disk I/0. This means that data-mining sessions may be saved and restored locally to
continue a data-mining session at alatter time. Plots may be saved as GIF (.gif) files, and text windows as ASCI| text (.txt)
files. Hybridized sample quantification files slowly downloaded from amicroarray database Web server may be cached on
the local machine - saving time when the data session is resumed at alater time. Users could then add GIPO conforming
hybridized sample quantification files on their desktop and perform a data-mining analysis of hybridized data from multiple
sources - mixing datafrom public servers aswell as private data. This latter option would be most useful using commercial
arrays.

. Users may download a self-extracting Java application. Thisis available on the MAExplorer Web site for avariety of
computer systems and includes a Java Virtual Machine (JVM) for your operating system. [The VM isonly available on the
installers on the LECB/NCI web site, it is not available on the SourceForge Web site because of space considerations.
However, if by some chance your computer does not have a JV M, this should not be a problem since the JVMs (called
JDK's) are available at various Web sites.] This VM does not interfere with any other VMs you may already have
installed. However, it guarantees optimal operation of MAExplorer. This makes the stand-alone application more robust
than the Applet aswell as being smpleto install.

. Having more memory implies allows taking advantage of more sophisticated statistical, clustering and data-mining
methods, as well as working with large numbers of samples with larger numbers of spots. Some Web browsers will not give
you access to large amounts of memory - even if it is available on your computer.

5. Having the stand-alone version on the user's computer alows them to configure alocal database for their own data.

D.1 Installing MAExplorer as stand-alone application

It is possible to download MAExplorer for data-mining either stand-alone on an your personal computer or in setting up a Web site
for publishing your array data (like the MGAP site).

E i d¥eystos wel lwnabs - Hom g

MAExplorer stand-alone application for data mining microarray data

Fiasarmemaned burtallsten fer Yaur Platfarm:
ook Inztall e for Windows |

Awpllatie nitaliers

Platform Includes Java VM without.Jawa Vil bastrsstions
= g Windows C
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Figure D.1 Web page showing optionsfor installing MAExplorer as a stand-alone application. Installers are available for
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Windows95/98/NT/2000/XP, Mac OS, Solaris, Linux, Unix, and other Java enabled platforms.
D.2 Downloading MAExplorer for stand-alone use with other arrays

After MAExplorer isinstalled, you may start it by clicking on a startup icon for one of the saved databases (Windows) or running
the program (Unix, Macintosh). In Windows, you may also start it from the Window's " Start" menu. This stand-alone version
enables you to save data on your local machine and to run MAEXxplorer independent of an Internet connection as well as other
features that are discussed throughout this manual.

You first need to download MAExplorer for your particular type of operating system. These include Windows 95/98/NT/2000/XP,
MacOS for Power PC, Sun Solaris, HP-UX, other Unix versions (e.g. Linux, etc). The Windows, MacOS and Solaris versions
include a Java run-time (Java Virtual Machine) that works with MAExplorer. We recommend you download the full distribution
for your computer (which includes arecent Java virtual machine (JVM) if it exists). Thisinsures proper operation of MAEXxplorer
and does not interfere with other Java applications you might have installed or will install.

Thisinstallation process uses a commercia "Java Installer" (InstallAnywhere(T) by ZeroG Inc.) that requests you "Grant" it
permission to save the installation on your computer. It will suggest where to install it or you can install it wherever you want. For
example, in Windows it may suggest saving itin C: \ Pr ogr am Fi | es\ MAExpl or er\ - you can specify an aternative
directory if the default disk does not have much free space | eft.

1. Go to download MAEXxplorer to begin the installation.

2. With Netscape, Click on "Grant" to questions " Starting programs stored on your computer” and "Reading, modification, or
deletion of nay of your files'. With Internet Explorer, click on"Yes" in response to the popup window "Do you want to
install and run ...". [All datafiles are kept in the same directory tree where the MAEXxplorer program is kept. MAEXplorer
does not use any other directories on your computer and does not affect other Java programs on your computer.]

3. Either click on the default "Download ..." button that was automatically determined for your machine or scroll down and
click on a"download" hypertext link for the operating system you want to download. If it isthe latter, it pops up a"Save as"
window for you to select atemporary directory in which to put the "installMae.exe" (Windows), "installMae.bin" (MacOS
and Unix systems), etc. In Windows this could be "C:\Temp" or in Unix "/var/tmp", etc. After you have installed
MAEXxplorer, you can delete thisfile.

4. After the file was downloaded on your machine, go to that directory and start that file (e.g. click on it on a Windows or
MacOS system). [If you wish, you may exit your Web browser at this point sinceit is no longer needed)].

5. When the installer starts, it pops up awindow "Preparing to Install" and gives you the option of selection alanguage. Click
on the "OK" button.

6. It then pops up an "Introduction” window. Click on "Next".

7. It then pops up a"Choose Install Folder”. Y ou have the option of specifying a different directory. E.G. (on Windows) if it
says. C. \ Program Fi | es\ MAExpl or er and you don't have space on disk C: but do on disk E: and want to put it into
its own directory, you could specify it as E: \ MAExpl or er . Then click on the "Install" button.

8. It then pops up a new window with "Install Complete”. Click on the "Done" button. Y ou are now ready to run MAEXxplorer.

D.2.2.1 Subsequent updating of only the MAExplorer JAR file from the MAExplorer
server

Generaly, you can greatly shorten the subsequent download of new versions of MAExplorer. Thiswill work most of the time as
most often thisis the only change in the distribution (not including the documentation). If this causes problems, it may mean that
the other files have changed and you may have to reinstall the complete distribution asin Appendix D.2 above.

1. Download just the MAEXxplorer.jar file.
2. Usethisto replace the previous version of the MAEXxplorer.jar file on your system with thisfile.

Additional instructions for Installing MAExplorer on Sun Solaris

These instructions are valid for use with both TWM and CDE window managers. If you have problems with the Sun installer, you
may need to update your Solaris OS system patches using arecent patch set.
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It may involve more than a single patch. It is the latest Recommended Patch Cluster from Sun. We STRONGLY recommend
having your System Admininistrator do thisfor you if you have not done this before. Point your Web browser to:

http://sunsol ve. Sun. COM pub- cgi / show. pl ?t ar get =pat ches/ pat ch- access

and choose the appropriate patch set for the version of Solaris (2.6, 7, or 8, etc.) that you are running. Do not choose any of the x86 versions unless you
are running Solaris x86. Click on either the Download HTTP option or Download FTP option, and click the GO button to download the patch set.

Download Solaris version of MAExplorer by clicking on the correct link.

After downloading, open ashell or xt er mwindow then, cd to the directory where you downloaded the installer.

At the prompt type: "sh . /i nst al | MAExpl or er. bi n". thiswill run Install Anywhere.

The Install Anywhere program should now be running, follow the instructionsto install MAEXxplorer.

After MAExplorer isinstalled click on the Exit key to end the Install Anywhere program. Then cd to the directory where it
was installed and type "MAEXxplorer&" to run MAEXxplorer.

To uninstall MAExplorer: cd into/ Uni nst al | er Dat a subdirectory and at the Unix prompt type

Uni nst al | _MAExpl or er . Thiswill bring up awindow to prompt you to uninstall MAExplorer. Click on uninstall
button.

agrwdE

o

If you requested it, note that a Java virtual machine isincluded with this download. It will run automatically when you run the shell
script.

D.2.2 Enabling MAExplorer to fetch data from a microarray Web server

When run as a stand-alone application, MAEXxplorer can be set up to read data from a MAExplorer enabled Web database server
and to cache the datato your local computer. The following lists the three variables that should be set in the . mae startup database
file (see full table in discussion on setting up the configuration file). These variables may be set from the Edit menu Preferences

submenu Use Web DB and Web DB data caching toggle switches, and the URL of the database by the Set Web DB command.

Table D.2.2 Parameter s specifying Web database access. These optional parameters may be used for control accessto a
microarray Web database. The example values are shown for the MGAP database.

Parametery Value DataType |Comments

(opt) enableFlOcaching | TRUE boolean enable caching data files from Web server on local compute
(opt) saCodeBase http://www.lecb.ncifcrf.gov/mae/ |String Web database to use to get the data

(opt) useWebDB TRUE boolean set get data from a Web database

D.2.3 Enabling MAExplorer cache to save Web data on local computer

When run as a stand-al one application, MAExplorer can be set up to cache data from a MAExplorer enabled Web database server
to your local computer. Y ou can enable caching for future access using the Edit menu Preferences submenu Web DB data caching
toggle switch.

D.3 Starting MAExplorer by clicking on a .mae file

Once the MAEXxplorer stand-alone application has been installed and registered with the operating system, then for Windows (and
other operating systems when you can register files for startup) just click on theicon for any file with a.mae file extension to start
MAExplorer on that data. For Unix systems you can start MAExplorer on a.maefile by:

(installation path)/MAExpl orer MAE/ (sonme startup file). me
You can let your Unix system find MAExplorer by putting it in your pat h variablein your login or shell startup script.

set path = ($path <MAExpl orer installation path>)
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Then, you would start it by specifying the startup file residing in the MAE/ subdirectory as:

MAExpl orer MAE/ (sone startup file). me
Thereisaset of sample MGAP . mae filesin the MAE subdirectory in the downloaded installation.
D.4 The data file format for .mae startup files

When MAEXxplorer is used as a stand-alone application, it first reads a (tab-delimited) startup file. Thisfile contain the names of
the hybridized samples to be loaded as well as some of the additional parameters listed here. Note most of these parameters may be
specified in the configuration file as defaults and therefore do not need to be included in the .mae file unless you wish to override
the configuration values. (See Table C.5 tables for alist of these parameters).

The. mae startup files are smply tab-delimited ASCI| files with a.mae file extension. These could be created or edited either
manually (e.g. using Microsoft Excel and saving the file as atab-delimited file) or by various database programs (eg. the NCI/CIT
mAdb program, the MAEXxplorer Cvt2Mae program being developed). They may also be generated by MAEXxplorer
(File:Database: Save as file DB). The .mae file form consists of two tab-delimited columns containing fields Name and Value.
These field names appear in the first row. Thisisfollowed by instances of the various parameters. A simple .maefileisshownin
the following table Table D.4 using a4 sample Lactation database subset from the MGAP database. Although any of the
configuration file values can be specified in the .mae file, we list some of the more common optional parameters are indicated in
TableD.4.1.

Table D.4 The Minimum data required entriesfor .mae startup files. These entries are shown with exampl e values from some
of the datain the MGAP demonstration database. Each sampleis specified by an imagel name.

Name Value

imagel |C57B6-L1-30min
image2 |C57B6-L3-1hr
image3 |C57B6-L10-29hrs-1
image4 |Stat5a--.L1-30min

Table D.4.1 Some of the common optional entriesfor .mae startup files. These entries are shown with example values for the 4
samplesin Table D.4. See (Appendix C.5 for lists of many other options.

Name Value DataType Comments
(opt) maxPreloadimages |4 int overide the numberlof sampleﬁ (called images) to actually load. This may beless
than the number of image entries.
(opt) configFile MaExplorerConfig-M GAP.txt String name of Configuration file if not MaExplorerConfig.txt
(opt) dataBase MGAP DB String name of this specific database
(opt) dbSubset Pregnancy 13 days: C57BL/6 vs. statba (-,-), 8 samples |String title for this subset name of the database
hybridized samples for initial HP-X 'set'. Corresponding to imagel, image2, etc.
(opt) Xlist 123 String Empty if not defined - may be defined using the Choose HP-X(Y ,E) in the File
menu.
hybridized samples for initial HP-Y 'set’. Corresponding to imagel, image2, etc.
(opt) Ylist 4 String Empty if not defined - may be defined using the Choose HP-X(Y ,E) in the File
menu.
hybridized samplesfor initial HP-E 'list'. Corresponding to imagel, image2, etc.
(opt) Elist 1234 String Empty if not defined - may be defined using the Choose HP-X(Y ,E) in the File
menu.
(opt) classNameX C57B6 lactation (days 1,3,10) String Experimental class name for the HP-X 'set' of hybridized samples
(opt) classNameY Stat5a (-,-) lactation day 1 String Experimental class name for the HP-Y 'set’ of hybridized samples
(opt) noMsgReporting TRUE boolean If set TRUE, used with Applet only to not send loading status message.
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If set TRUE and the quantified data files have the (x,y) coordinates for each
(opt) reuseXY coords FALSE boolean spot, then use the same coordinates for all subsequent data files so that the
arrays can be superimposed (for Flickering two HPs).

If set TRUE, force MAEXxplorer to generate pseudoarray (X,Y) spot coordinates
(opt) usePseudoX Y coords |FALSE boolean and ignore (X,Y) datain the quantified spot filesif it exists. Thiswill be set to
TRUE automatically if there are no (X,Y) datafieldsin the quantified spot files.

D.5 Using MAExplorer as an Applet on your computer

It ispossible to create a Web site to publish users data using the MAExplorer.jar file to support your private microarray database
Web site. (Note that you can also get the MAEXxplorer.jar file from the directory where you installed MAExplorer on your
computer). Y ou might choose to mimic the way we did the http://www.lecb.ncifcrf.gov/mae MGAP Web site or organize it

differently. Y ou need to do the following:

Create aa sub-directory dir/ in your htdocs/ Web server tree (where dir/is what you called the directory).
Create dir/Config and dir/Quant sub-directories.

Copy the MAExplorer.jar fileinto dir/.

Edit configuration files and copy them to dir/Config sub-directory.

Copy quantification filesinto the dir/Quant sub-directory.

Add HTML Web pages containing <APPLET> code (see example below).

ok~ wdpE

Thefollowing is a simple example of HTML code containing an applet which will invoke MAEXxplorer. Y ou may add other
options with PARAMSs in the Applet (or for that matter in the the .mae startup file) that overide any options normally specifed in
the Configuration file (See Appendix C.5).

<HTM.>
<HEAD>
<TlI TLE>MAEXpl orer Startup: C57B6 Pregnancy vs Lactation</ Tl TLE>
</ HEAD>

<BODY>
<H2>MAExpl orer Startup: C57B6 Pregnancy vs Lactation</H2>

This startup database will start the MAExplorer. It contains a subset
of the database consisting of four C57B6 mammary devel oprent
hybri di zed sanples (HP): two each for pregnancy and | actation.

<APPLET CODE=MAExpl orer.class ARCH VE=MAExpl orer.jar
W DTH=10 HEI GHT=10 ALI GN=absmi ddl e>
<PARAM NAME=confi gFi | e VALUE=MaExpl or er Confi g- MGAP. t xt >
<PARAM NAME=dbSubset VALUE="C57B6 pregnhancy vs |actation">
<PARAM NAME=i magel VALUE=C57B6-p13. 1>
<PARAM NAME=i mage2 VALUE=C57B6- L1-30m n>
<PARAM NAME=i mage3 VALUE=C57B6- p13. 2pol y- A>
<PARAM NAME=i mage4 VALUE=C57B6-L1-total >
<PARAM NAME=XI i st VALUE=1, 3>
<PARAM NAME=YI i st VALUE=2, 4>
<PARAM NAME=El i st VALUE=1, 3, 2, 4>
<PARAM NAME=cl| assNameX VALUE=Pr egnancy>
<PARAM NAME=c| assNaneY VALUE=Lact ati on>
(Sorry, you need a Java-capable browser to viewthis.)
</ APPLET>
</ BODY>
</ HTM.>

D.6 List of startup .mae files included in the download installation

Thisisalist of the .mae startup files from the MAExplorer MGAP database. These are included with the distribution for use in the
tutorials, etc. They include data from 50 hybridized samples of mouse mammary breast tissue including normal and some knockout
samples. There are about 1700 duplicate clones on the arrays which are membranes printed by Research Genetics and hybridized
by the MGAP group. See the MGAP home page for more information on these samples. The .mae files are available as separate
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files http://www.lecb.ncifcrf.gov/mae/M GAP-Array-database/. The datais also packaged asazip file

http://www.lech.ncifcrf.gov/mag/M GA P-Array-database.zip, and a Unix tar file http://www.lecb.ncifcrf.gov/mae/M GAP-Array-

database.tar.

.maefile name

C57vsDevM odels-15probes.mae
C57vsDevM odel s-15probes-cache.mae
C57vsDevM odel s-38probes.mae
Lact1-C57vsStatba-38probes.mae
Lactlvs10-10probes.mae

L act1vs10-38probes.mae
Lact-C57vsStat5a-5probes.mae

Lact-C57vsStat5aCEBPnull-19probes.mae
MAEstartupDefault.mae

Preg13day-C57vsStat5a-19probes-cache.mae

Preg13day-C57vsStat5a-19probes.mae

Preg13day-C57vsStatba-38probes.mae
Preg-C57vsStatba-4probes.mae
Preg13VsL act1-18probes.mae
Preg13VsL act1-38probes.mae
Preg-C57vsStat5a-8probes.mae

Preg13day-Stat5aV sSCEBP-null-38probes.mae

reuseXY -Pregl13day-C57vsStatba-38probes.mae

reuseXY -Preg-C57vsStat5a-8probes.mae

MGAP-50samples.mae

OCL-P13L 1L 10Stat5a--15probes.mae

X vsY comparison

HP-XY is C57B6 vs developmental models

HP-XY is C57B6 vs developmental models (with cache)

HP-XY is C57B6 vs developmental models. HP-E is all samples

HP-XY is C57B6 Lactation day 1 vs Stat5a (-,-). HP-E is al samples
HP-XY is C57B6 Lactation day 1 vs Lactation day 10. HP-E is all samples
HP-XY is C57B6 Lactation day 1 vs Lactation day 10. HP-E is all samples
HP-XY is C57B6 Lactation day 1 vs Stat5a (-,-)

HP-XY is C57B6 Lactation day 1 vs Stat5a (-,-) and CEBP-null, HP-E has
samples of other tissues

none

HP-XY is C57B6 Pregnancy day 13 vs Stat5a (-,-). HP-E has samples of
other tissues (with cache)

HP-XY is C57B6 Pregnancy day 13 vs Stat5a (-,-). HP-E has samples of
other tissues

HP-XY is C57B6 Pregnancy day 13 vs Stat5a (-,-). HP-E is all samples
HP-XY is C57B6 Pregnancy day 13 vs Stat5a (-,-)

HP-XY is C57B6 Pregnancy day 13 vs Lactation day 1. HP-E is al samples
HP-XY is C57B6 Pregnancy day 13 vs Lactation day 1. HP-E is all samples
HP-XY is C57B6 Pregnancy day 13 vs Stat5a (-,-)

HP-XY is C57B6 Lactation day 1 vs Stat5a (-,-) and CEBP-null, HP-E is all
samples

HP-XY is C57B6 Pregnancy day 13 vs Stat5a (-,-). Use XY coords of first
probe for remainder for flickering. HP-E is all samples

HP-XY is C57B6 Pregnancy day 13 vs Statba (-,-). Use XY coords of first
sample for remainder for flickering

C57B6 day 13 preg. vsday 1 lact., 50 samples

replicates of C57B6 (pregnancy day 13, lactation days 1 and 10, and stat5a(-
,-) 15 samples. The database also includes 4 additional condition sets of this
data and an Ordered Condition List of the 4 conditions (in the State/
directory). This may be used to demo the OCL F-test filter.

# of hybridizations
15
15
33

38

18
38

38

38

50

15

Appendix E. Design issues

This appendix addresses a number of key design issues on the implementation of MAExplorer and the implications they have on
its efficiency. The ordinary user of MAExplorer need not be concerned with any of these issues. A PowerPoint presentation
describing the class structure of the " Software design of the MAEXxplorer data mining tool" is available as either an Adobe Acrobat

file (PDF) or a PowerPoint file (PPT).

E.1 Internal data structures design to facilitate direct manipulation

MAExplorer was constructed using a number of fundamental data objects including clones (genes), hybridized samples
(membranes or glass arrays), tables, etc. organized using an object-oriented methodology enforced by Java. Sets of genes are
implemented as bit sets for efficiency in both storage and set-theoretic operations. With a set being implemented as 64-bits/word, a
set intersection, union or difference can be performed on 64 genesin parallel in onelogical (i.e. AND, OR, XOR) computer
instruction. This makes the data filter quite efficient when computing the intersection of many gene sets. When ordered gene lists
are required, memory and compute intensive lists are used - but only when needed. Tab-delimited ASCII is used as the basic 1/0
filetype for al types of data. Thissimplifies 1/0 and alows data to be prepared with a variety of systemsincluding Excel, array
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guantification programs, relational database systems, etc.

Another major decision was to use multiple pop-up windows for 2D plots, histograms, expression profiles, clustergrams, reports,
dialog boxes, etc. rather than sharing a single window. These windows are maintained by a specia pop-up registry that handles
many of the bookkeeping chores involved with tracking and updating multiple windows viewing the same underlying data.
Whenever an event occurs which may change the set of data filtered genes, the current gene or the current cluster set of genes, the
registry is notified. Some of the events are the current clone changed, the Filter parameters changed, the sample labels changed, the
normalization method changed, etc. It in turn notifies al relevant active plots, tables and reports - requesting them to update
themselves if necessary. This object-oriented design greatly simplifies the process of synchronizing the various data presentations
with changes in the database.

E.2 Approaches to data mining: client-centric and server-centric models

There isarange of approaches for performing data mining of microarray data over the Internet. However, al assume rapid access
to underlying databases and the ability to transform data from one presentation mode to another where differences might be easily
observed. One extreme is the server-centric model using CGI or Appletsin Web browser. This assumes that al data search and
analysisis performed on a back-end server and graphic or tabular results from the server are sent back to the researcher over the
Internet. The server-centric model has the advantage of keeping all user data up-to-date, but the disadvantage of performing all
computations and graphics generation on the back-end server. Relying so much on the server for major computations and graphics
generation can result in significant delays if the networks or servers are heavily loaded. The other extreme is the client-centric
model. Here all of the data being analyzed is copied to a user's computer and computationally expensive analyses are done there.
This has the disadvantage for the user of possibly not having the most up-to-date data to analyze as well as setup time overhead.
However, it does distribute the computational load, allowing more effective data mining with many alternate views and avoiding
excessive delays during a data mining session. In both the Web browser applet and the stand-alone application, datais downloaded
to MAExplorer. The difference being access to the local file system with some additional capabilities in the case of the latter.

A good intersection of the server-centric and client-centric methods is to distribute the computation and data to the systems where
they can be handled most effectively. Because Java enables computation in a Web browser, PCs currently available have enormous
power and memory, and high-speed Internet connections are readily available, it is now possible to distribute some of the data and
computations to the desktop. If high-speed direct manipulation methodology is to be made available on the Internet for microarray
data mining, then it must be brought to the user's desktop browser or local computer rather than residing solely on the back-end
server. Thisis the approach taken in designing the MAExplorer.

Table E.2 Comparison of client-centric vs. server-centric data mining. The table shows a comparison of some of the features of client-
centric and server-centric (using CGI and/or Applet) data mining analysis methods. The client-centric approach presented here primarily uses Javawith
data downloaded to the client's computer. A server-centric approach might use amix of HTML, CGl, servlet and Java. However, even a client-centric
approach may take advantage of server support for additional functionality (e.g. accessing genomic serversto gain additional information about specific
genes or sets of genes).

Advantage (+)

Approach disadvantage (-) Feature

Client-centric a) |+ Java programs run (pretty much) on all operating system platforms as either stand-alone or applets (in browsers)
Client-centric b) |+ handles rapid response required for direct manipulation on the new generation of very fast desktop computers
Client-centric c) |+ stand-alone version may be restarted quickly from local data or data cached from the Web server

Client-centric d |+ size limitations are not a problem with stand-alone Java applications

Client-centric €) |+ Java plug-ins allows prototyping new local and Web DB analysis method functionality by any group of users

for the applet version, there is slow startup because the program and all data has to be downloaded each timeitis

Client-centric f) |- un

difficult to build large stable Web-applets handling very large data sets. However, stand-alone applications don't

GIELEEERNG @) - have this problem

for the stand-alone application version, it must be installed on client's computer where there nmight be some level
of incompatibility

Client-centric h)

Advantage (+)
Approach disadvantage (-) Feature
Server-centric a) |+ may have better resources for very large data sets but with dependence on server
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faster startup than downloaded applet since minimal GUI is required and data does not have to be loaded before

- i + .
SEREREEIIE 1) computation requests may be made to the server

may be easier to prototype and distribute new functionality using third party software such as RDBMS, S-plus,

- i + . : . .
SEREREEIE € etc. using centralized CGI or servlets where only one copy is required on the server

Server-centric d) |- susceptible to Internet traffic bandwidth problems for large numbers of users
Server-centric €) |- susceptible to server-load dependencies for large numbers of users
Server-centric f) |- difficult to get very rapid response for direct manipulation for data mining

E.3 Conversion of microarray data files to MAExplorer format using Cvt2Mae

A tool is being developed that converts microarray data files, both commercia and one-of-a-kind research data to a complete
MAExplorer data format. Input data will be tab-delimited, although it may be possible to use XML data at some point. When the
tool becomes available, it will be announced on the MAEXxplorer home page and in this manual .

Cvt2Mae data converter

Because it is difficult to manually edit user's microarray quantified data files, we constructed the Cvt2M ae data converter program
(also see Appendix C.6). Theideaisto create array layouts for known array chips and to let the user define their own for
specialized arrays. These user-defined layouts may then be saved and used in subsequent data conversions. The basic problem of
data conversion isthat of "field picking" to map user data fields to those required by MAEXxplorer, and of setting the appropriate
options in the MAExplorer configuration files. User-interactive wizards query the user and then does thisinformation to perform
the conversion generating the output data files that are ready to use with MAEXxplorer. Cvt2Mae then generates the directory tree of
required data files described in Appendix C.

r:@) E.4 Extending MAExplorer functionality using Java Plugins

We are adding the ability for usersto add their own Java Plug-in Extensions to MAExplorer. These will extend capabilities of the
core MAEXxplorer program to other analysis methods by users. The MAEPIugins Web site will be an Open Java API, open-source
Java code examples, our plugins and donated plugins, linksto plugins at other Web sites. Typical plug-insinclude: normalization,
Filters, PCA, clustering, client-server, Web-server functional analysis of cluster results, etc. We group these into three types of new
analytic functionality:

1. Using Java code to implement the complete plugin. This means it will be portable across al systems.

2. Accessing local programs written in any language ( eg. the R statistics package). This method may not be portable across all
systems.

3. Web-CGl or client-server to specialized genomic DBs Plug-ins. This method should be portable across al systems.

The MAExplorer Open Java APl (Applications Programming Interface) will allow usersto get at al data structures without
understanding the details of the system. The specialized application classes are derived from the GatherScatterAPI class which can
access all of the internal MAEXxplorer data structures. This allows us to improve and change the internal data structures without
causing problems with plugins using those data structures.

The following figures show the top level plugin design.
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MAEPgin Design
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Figure E.4.1 Overall MAEPIugin design for MAExplorer. Plugins are dynamically loaded into MAExplorer where they may be invoked from a menu
entry or by various other means such as startup, normalization, etc.
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Using Open Java API to Write a Plugin
MAExplorer

Plugin Loader -#———» FI‘DngI‘I‘I
I F Y

MaeJavaAPl +— MJAxxx classes to
gather [ scatter data

| MAEPIugn base class
4

User written Plugin

| AnalysisPlugin |‘—"‘_ | 1. Extend a xxxxPlugin class
[Connactionpiugin Je—»| 2. Alccess data via MJAxxx
classes
|FiherPlugin  l4—» 3. Add event handlers

NormalizationPlugin  +—

PopupPlugin |4—I-

Other specialized +
plugin base clvsses ...

L
Y

Figure E.4.2 Open Java API for MAEPIugins. Each type of application could be derived from specialized Java classes that contain most of the access
methods required for that type of analysis.

E.5 Web database server design

Although MAExplorer can be run stand-alone on a user's computer, additional capabilities may be made available with support
from the back-end Web database server. This server design, used with the MGAP database, includes several distinct functions
(Figure 1). The primary oneis the hosting of login-protected microarray quantitative data and auxiliary flat files required to
support basic MAEXxplorer operations. These "flat files" could be synthesized on the fly from searches on arelational database
server that is part of the microarray database Web server. The public database does not require alogin while the collaborator subset
of the database does.

In support of the MGAP server, additional software was written to automate the pre-processing of the microarray quantitetive data
from Research Genetics' Pathways array quantification analysis program and perform compression and Web server updates for this
data. The Web server also hosts severa common gateway interface (CGI) programs. These include user login support, a Web
proxy server (to access other genomic Web sites from the Java applet), support of login-protected user state file access, custom
database creation, user state files, and "groupware" user-access support.

—

—

Downloading the stand-alone MicroArray Explorer (current
release)
Y ou may freely download and install the current stable release of the stand-alone version of the MAEXxplorer program. Y ou are

free to use or redistribute MAEXxplorer (see disclaimer). We also include a subset of 50 Mammary Genome Anatomy Program
(MGAP) hybridized sample data to run stand-alone on your computer platform. These are may also be downloaded directly as:

. individua files http://www.lecb.ncifcrf.gov/mae/M GA P-Array-database/
. aZlPfile http://www.lecb.ncifcrf.gov/mae/M GA P-Array-database.zip
. aUnix Tar file http://www.lecb.ncifcrf.gov/mae/M GA P-Array-database.tar
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This data may be used for learning about MAEXxplorer with the tutorials and for investigating some of the stages of normal and
mouse-model mammary development. The MAExplorer reference manual may be viewed in your browser from the Web from this

Web site. Alternatively, you may download the full manual as a Acrobat MaeRefMan.pdf PDF file (> 5Mb).
If you have problems with the installation, then you might want to read the rest of this section and also the part of the manual
which discusses installation (Appendix D) and using it with your arrays (Appendix C). The latter requires editing your data files

for use with MAEXxplorer. The Cvt2maeis a"wizard" array data conversion tool automates this process.

. Anarchive of some of the stable older releases of MAEXxplorer is available for alimited period on the LECB/NCI server.

. For more details on specific releases, see the revision notes (Section 4.2).

If you have previously installed MAEXxplorer and you want to update just the MAEXxplorer.jar file (the actual program), you can do
this as described in Section 1.3. Alternatively, you can use the new "Update MAExplorer” command in the Files menu. Thiswill

(2) backup the current MAExplorer.jar file as MAEXxplorer.jar.bkup; (2) copy the latest MAExplorer.jar file from the
maexplorer.sourceforge.net Web site and replace your MAEXxplorer.jar file in your installation directory. Then when you restart

MAExplorer, it will use the new version of the program.

After initially, installing MAExplorer (or the Cvt2Mae for that matter), you can simply download the latest .jar file and overwrite
the previous version you had when you installed the program. The MGAP demo data can be downloaded separately.

Sour ceForge Download MAEXxplorer Installer

B E# lew o Comsness Hep
| Ra el o ek Hebwaw Pl Gerl Sk

T

MAExplorer stand-alone application for data mining microarray data
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Figure. Web page showing optionsfor installing M AExplorer as a stand-alone application. Installers are available for Windows95/98/NT/2000/X P,
MacOS-8/9, MacOS-X, Solaris, HP-UX, Linux, Unix, and other Java enabled platforms. [Click on the figure to see a high resolution version.] NOTE:
the MacOS installer is currently not available. If you have problems with the Sun installer, you may need to update your Solaris OS system patches (see

below).
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Distribution contents

1. Werecommend including the Java Virtual Machine (JVM) for a more robust installation.
Thiswill not affect any of your other Java applications or Web browsers asit is used only with MAExplorer.
2. Thedistribution includes:
o The MAExplorer Java stand-al one application,
o A set of 50 hybridized samples data from the http://mammary.nih.gov/mgap DB. These may be accessed after you
have installed MAExplorer by clicking ona".mae" filein the/MAE/ directory in the installation directory. These
date are not on the SourceForge Web site but are available at http://www.lecb.ncifcrf.gov/mae/M GAP-Array-

database.zip.
o Support files for your operating system - possibly including the VM which you may optionally download (JVMs
are only on the NCI/LECB site).

1. Procedure for downloading and installing MAExplorer on your computer

1. Click here to select the current installer for your operating system. This Web page allows you to select the operating system you

are using. If you have problems downloading the installer with Netscape 4.7x or later, then try Internet Explorer 5.0. It could be a
Mime/type problem with your browser setup.

2. You start the download process when you click on the installer for your computer platform. (Y ou may alternatively use the
default installer discussed below.) Follow the directions it provides as you download the installer. It also providesinstructionsin
the "View" hyperlink adjacent to the operating system you selected that tells you what to do after you finished the download. Part
of the installation consists of telling the installer where you want to 1) put the executable installer (atemporary directory where
you have lots of room is a good choice), and 2) the "installation” directory where you will typically leave the distribution after the
installer unpacksit.

We use the commercial Install Anywhere{TM) program to create the installers. It providesinstallers for:

. Windows 95/98/NT/2000/X P

. Mac OS (0S8 and 0OS9, OS-X)
. Solaris

. HP-UX

. Linux

. Unix

. Other Java enabled platforms

Other systems will be added as installers become available through Install Anywhere (www.ZeroG.com).

1.1 The Default Installer

Alternatively, you can use the default installer that is selected for your computer. If you want to control where the files are saved
on your computer, then use the explicit installer for your particular platform described above.

The default installer will put the installer executable in afixed directory and the installed MAExplorer filesin another fixed
directory.

. For Windows, theinstaller will gointo C: \ I nst al | Anywher e_I nst al | er s\ and the program filesinto
C.\ Program Fi | es\ MAExpl orer\.

. For Unix systems, it will put them at $HOVE/ | nst al | Anywher e_I nst al | er s and the program filesinto
$HOVE/ MAEXxpl or er/ .

. For MacOs, it will put them on the desktop.
1.2 Installation Notes
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Currently, the Windows and Linux installers are robust. We have had mixed success with Mac OS and Solaris.

Note that the installers (where possible) will include a copy of arecent Java Virtual Machine (JVM) from Install Anywhere(TM) to
make running MAExplorer on your computer more robust. Thisis used locally and only affects the running of MAExplorer. It will
not affect any other Java applications on your computer. In the case of Mac OS, if you have an older version of the MRJJVM, it
will ask you if you want to upgrade to the newer version (MRJ-2.4.5) - however you do not have to unless you want to.

The MAExplorer Reference Manual describes the details of MAExplorer as well as showing a number of screensillustrating
various data-mining operations. Several tutorials are available and are discussed in the Reference Manual.

1.3 Downloading just the MAExplorer.jar file after initial install

If you have previously done an installation. you may avoid a compl ete re-installation download by getting just the latest Java
MAExplorer.jar file. You should replace the old version of thisfile on your system with the one you are downloading. This will
work if the new MAEXxplorer.jar file does not depend on any new entriesin the configuration files (which generally the case - try it
and see what happens).

Update MAExplorer Program from maexplorer.sourceforge.net

Asof version 0.96.21 of MAExplorer, it is now possible to update the MAExplorer program from the program itself - rather than
having to download the complete installer and then running the installer. Press the "Update MAEXxplorer" button at the lower left of
the corner of MAExplorer when it isrunning. It asks if you want to update MAEXxplorer. Answer yes. Thiswill then (1) backup the
current MAExplorer.jar file as MAExplorer.jar.bkup in the directory where you had initially installed MAExplorer; (2) it then
copies the latest MAExplorer.jar file from the maexplorer.sourceforge.net Web site and replaces your working MAExplorer.jar file
in your installation directory. Y ou must restart MAEXxplorer for this to take effect. It will then use the new version of the program.
Thisisamuch less time consuming aternative than doing an entire download and reinstallation from the Web site.

2. Description of Sample MGAP Datasets in the Distribution

The MGAP datais supplied in three directories. The installer leaves other directories and filesin the "installation" directory needed
to run MAEXxplorer as a stand-al one application. These include MAExpl orer . j ar, MAExpl orer. exe (. bi nif UNIX or
Mac), Uni nst al | - MAExpl orer. exe (.bin),etc. Thel ax files,andj re, resour ce directoriesare used by
InstallAnywhere and you do not need to be concerned with their contents. The MGAP data directories are listed here and are
discussed in detail in Appendix D of the Reference Manual:

1. / Confi g - contains database configuration and samples tables for this database
2. [ Quant - contains 50 quantified hybridized sample spot lists
3. / MAE - contains MAExplorer ".mae" startup files

2.1 List of MGAP demo data MAExplorer ".mae" Startup Files in the /MAE Directory

The table lists the startup files provided for the MGAP database. Some good sets of datato try initialy are the Lact1vs10-
38probes.mae, Preg13V sl act1-38probes.mage, and Pregl3day-C57vsStatba-38probes.mae startup files.

.mae startup file Data set contents
L act-C57vsStat5a-5probes.mae 5 probes. (X,Y) islactation day 1 (C57B6, Stat5a(-,-))

19 probes. (X,Y) subset islactation day 1

L act-C57vsStat5aCEBPnull-19probes.mae (C57B6, Stat5a(--) + CEBP-null)

Lactl-C57vsStat5a-38probes.mae 38 probes. (X,Y) subset is lactation day 1 (C57B6, Stat5a(-,-))
L act1vs10-38probes.mae 38 prabes. (X,Y) subset is C57B6 lactation day (1,10)
MAEstartupDefault.mae Noinitial samplesloaded

Preg-C57vsStat5a-4probes.mae 4 samples. (X,Y) is pregnancy (C57B6, Stat5a(-,-))
Preg-C57vsStat5a-8probes.mae 8 samples. (X,Y) is pregnancy (C57B6, Stat5a(-,-))
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Preg13V sl act1-38probes.mae 38 samples. (X,Y) subset is pregnancy (C57B6, Stat5a(-,-))

19 samples from MGAP Web server. (X,Y) subset is

Pregl3day-C57vsStat5a-19probes-cache.mae pregnancy (C57B6, Stat5a(-.-))

Preg13day-C57vsStat5a-19probes.mae 19 samples. (X,Y) subset is pregnancy (C57B6, Stat5a(-,-))
Preg13day-C57vsStat5a-38probes.mae 38 samples. (X,Y) subset is pregnancy (C57B6, Stat5a(-,-))
Preg13day-Stat5aV sCEBP-null-38probes.mae |19 samples. (X,Y) subset is pregnancy (Stat5a(-,-),CEBP-null)
reuseX Y -Preg-C57vsStatba-8probes.mae Same as other startup, but uses XY coordinates of 1st sample

reuseXY -Pregl3day-C57vsStat5a-38probes.mae [Same as other startup, but uses XY coordinates of 1st sample

15 samples from MGAP cache. (X,Y) subset is

C57vsDevModel s-15probes-cache.mae (C57B6, knock-outs)

C57vsDevM odel s-15probes.mae 15 samples. (X,Y) subset is (C57B6, knock-outs)
C57vsDevM odel s-38probes.mae 38 samples. (X,Y) subset is (C57B6, knock-outs)
MGA P-50samples.mae 50 samples. All of the public samples sorted a phabetically

2.2 Starting MAExplorer Using a ".mae" Startup File

If you are on Windows 95/98/NT/2000/X P system, simply click on the .mae file you want to use. Hint: you might put a short-cut to
the installation-directoryA\ MAE\ directory on your desk-top to make it more convenient to find the files.

If you are on a Macintosh system, then start MAExplorer and then run the startup .mae file you want by going to the File menu and
then the Databases submenu. Use the "Open disk DB" option to browse your disk and then open up the startup file of interest.

If you are on a Unix system, then you supply the MAE file explicitly in the command line. Y ou might consider adding the
"installation” directory to your UNIX $PATH or $pat h variable to have UNIX automatically find the executable binary.

cd installation-directory/
MAEXpl orer. bi n MAE/ Pregl3VsLact 1- 38pr obes. nmae

2.3 The MAExplorer Error Log File

Each time you run MAEXxplorer, it creates or overides the previous error log file called MAEer r . | og in the installation-directory.
If you are experiencing major problems, thisfile is useful to usin helping figure out what iswrong. Otherwise, just ignore it.

2.4 Problems installing MAExplorer on some operating systems

1. The MacOS instaler isavailable, but may not work with older versions of MacOS. In addition, there may be problems if
your file names are longer than 32 characters. For now, the solution is to use short file names. There may a so be problems
if your data files have embedded carriage returnsin addition to line feeds. For now, the solution is to strip the CRs out of
the datafile.

2. On Solaris, and possibly ather Unix systems, you may have problems with the stack limits. Do a"man limit" to read about
the command for your particular Unix shell. We have found that the following seems to work. For the Unix C-shell (csh),
add the following to your .cshrc startup file.

limt stacksize unlinted

In addition, we have set the default stack size that MAExplorer uses to 256Mbytes. If your computer has less physical
memory, it will page. Y ou may also increase this number as well if you have more memory and want to use it. The solution
isto edit the MAExplorer.lax file found where you installed MAExplorer. Change the two instances of memory allocation
from 256000000 to a smaller number that is less than your actual memory size.

3. On Solaris, if you download the version with the VM, unless your Solaris system has been updated recently, it may not be
ableto find the libCrun.so.xxx version required by the VM. Try downloading the non-JVM version or update your Solaris
system.

4. If you have problems with the Sun installer, you may need to update your Solaris OS system patch set. It isnot asingle
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patch. It is the latest Recommended Patch Cluster from Sun. We STRONGL Y recommend having your SysAdmin do this
for you if you have not done this before. Point your Web browser to:

http://sunsol ve. Sun. COM pub- cgi / show. pl ?t ar get =pat ches/ pat ch- access
and choose the appropriate patch set for the version of Solaris (2.6, 7, or 8) that you are running. Do not choose any of the

x86 versions unless you are running Solaris x86. Click on either the Download HTTP option or Download FTP option, and
click the GO button to download the patch set.

2.5 FAQ of problems using MAExplorer on Mac OS for NCI/CIT mAdb users

Q: How many characters can | usein array names for data to be donwloaded to MAEXxplorer?

A: For Mac-X, with 256 character file names, thisis not a problem. For MacOS 8 and 9 with 32 character file namesit may be a
problem. Because MAEXxplorer uses file extensions (eg. ".quant"), you are currently limited to 25 characters or less. We will be
modifying the system to remove this limit.

Q: | tried unsuccessfully to open NCI/CIT mAdb data (nciarray.nih.gov) on aMac OS system. | generated a .zip file using mAdb
"BETA Formatted Array Data Retrieval Tool" , then decompressed this .zip file using " Stuffit Expander" on my Mac. The
Start.mae file could not be opened by MAEXxplorer, what can | do to fix this?

A: Stuffit Expander (default settings) removes aform feed character from decompressed text files, this prevents the Start.mae (and
other text files used by MAExplorer) to be read by MAEXxplorer. To fix this you need to set Stuffit Expander so that it will keep the
form feed characters when it decompress text files:

Open Stuffit Expander by double clicking its icon

Click on nenu File -> Preferences

Click on "Cross Platfornt

Click on "Never" button of 'Convert text file to Maci ntosh format:'

Your .zip will be decompressed properly and the text files from your mAdb data can now be open by MAExplorer.
Q: How do | start MAEXplorer on my data automatically by double-clicking a Start.mae file on my Mac.

A: Thereisno easy way to do this at this time. Use the File menu, Databases, Open Disk DB browser to specify the Start. maefile.

2.6 Sun Solaris (or other Unix system) Memory Problems

We have on occasion seen the following types of memory errors. This discusses how to handle them.
MAExplorer Stack size Memory Error on Sun Solaris

Running MAEXxplorer on a Solaris (or other Unix system) may produce this error:

% MAExpl or er

Stack size of 97664 Kb exceeds current [imt of 8192 Kb.
(Stack sizes are rounded up to a multiple of the system page size.)
See limt(1l) to increase the stack size limt.

If the Sun (under Solaris) is slow in loading MAExplorer or has memory errors (shown above) one should first see what the
memory limits are set to on your machine using the "limit" command. If they are too small they should be increased or set to
"unlimited” (seein 2.4 above

MAExplorer LAX file
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If the problems persist, one might have to edit the MAExplorer.lax file found in the MAEXxplorer directory (see example below).
The default memory settings in the MAExplorer.lax file (found in the installation directory) should be no larger than the total
memory of the machine or paging problems will occur. For instance, if you have 192Mb of memory in your Sun, edit the
"lax.nl.java.option.native.stack.size.max" and " lax.nl.java.option.java.heap.sizemax" optionsto be under 192Mb. Y ou can
use any text editor to do this. More memory may be needed to be installed on your Sun to run MAEXxplorer with very large
datasets.

Default Lax settings

The Lax fileis a startup file generated by Install Anywhere when we packaged MAExplorer. It is used when MAEXxplorer starts up
on your computer. We currently set the memory limits to 256M bytes. If you have more memory, you can edit the Lax file to have
it use more memory.

# LAX. NL. JAVA. OPTI ON. JAVA. HEAP. SI ZE. VAX

| ax. nl.java. option.java. heap. si ze. nax=256000000

# LAX. NL. JAVA. OPTI ON. NATI VE. STACK. SI ZE. MAX

| ax. nl.java. option. native. st ack. si ze. nax=256000000

The MicroArray Explorer MAEPIugins Home page

MAEXxplorer | MAEPIugin home | Design | Open Java API | MJA classes | MJA javadocs | Open Java API javadocs |
Plugin Tutorial Examples | List of Plugins | Developing a Plugin | Installing Plugins |
MAExplorer home | MAExplorer revision notes | Help desk

MAExplorer has a Java plugin extension facility. Plugins written for MAExplorer are called "MAEPIugins'. These MAEPIugins
alow investigators to extend the core capabilities of MAEXxplorer program themselves by writing special programs to implement
new analysis methods and access data from their MAEXxplorer database(s). The design of this plugin extension enables users to
write these new methods and have them added to the MAEXxplorer menus or for plugins to be invoked when MAEXxplorer starts up.
In addition, default MAExplorer functionality could be changed by replacing existing MAExplorer methods with user defined
methods. Writing a plugin to extend functionality using our Open Java API (Application Programming Interface) than to
understand and modify the full MAExplorer program. This section of the Web site describes the API, describes how to write a
MAEPIugin, and gives examples of various plugins. All source code is available on our CV S Repository.

The Open Java AP is available as the set of MJAxxxx classesin the MAExplorer.jar file.

new  Keep checking this Web page for the current status of the API as well as the MAEXxplorer Revision Notes which gives a
history of new features and changes to both MAEXxplorer and the API.

MAEXxplorer is open source with aMozilla 1.1 general public license. However, we have made the MAEPIugins public domain
(asecondary license that is even less restrictive) with no restrictions on their use. This enables the research community to modify
and help improve MAEXxplorer and the MAEPIugins as required. We are dividing the plugins into those that are donated and
those that require interaction with the supplier. We hope that most plugin developers will make them available as open source,
but that is not arequirement. If you are interested in writing a plugin or working with us on this open sour ce project please
contact us.

1. The MAEPIugins home page

This Web page includes documentation, an Open Java AP with javadoc documentation, open source Java source code and jar file
examples for lists of MAEPIugins. It contains donated MAEPIugins and links to MAEPIugins offered at other Web sites. Typica
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MAEPIugins could include: normalization, distance metrics, data Filters, PCA or other visualization tools, graphic plots,
clustering, classifiers, array sample I/O data conversion, client-server, Web-server functional analysis of cluster results, etc.

1.1 MAEPIlugins are grouped into three types of implementations
These allow various degrees of portability and server independence.

1. Using 100% Java code to implement the complete plugin. This means it will be portable across al systems.

2. Accessing local programs written in any language (eg. the R-statistics package). This method may not be portable across all
systems.

3. Web-CGl or client-server to specialized genomic database plugins. This method should be portable across all systems.

2. Open Java API (Applications Programming Interface)

The MAExplorer Open Java API (Applications Programming Interface) allows users to access all data structures without having to
understand the low level internal details of the MAExplorer system.

Aswe noted, the Open Java APl isincluded in the regular .jar file distributed when you download MAExplorer. The current
MAEXxplorer jar file may be downloaded from MAExplorer.jar. You also will also automatically download the jar file when
installing MAExplorer. If you have MAEXxplorer installed, then you can use the (File menu | Update MAEXxplorer from
maexpl orer.sourceforge.net) command when running MAEXxplorer to get the latest MAExplorer.jar file release.

3. Distribution of MAExplorer Plugins

The distribution system for MAEPIuginsis very flexible. There are several options for distributing Plugins on this Web site
including:

1. MAEPIugins with Java source files, ready-to-run Jar files, and documentation. These are devel oped by various groups and
contributed to the Open Source Web site. Y ou may maintain these yourself or contract the authors or contact the Open
Source development group for MAEXxplorer.

2. Linksto other Web sites where you may obtain the Jar files and (or) Java source and documentation for MAEPIugins from
that provider. No MAExplugins will be kept on the this server unless the source code is included.

4. Lists of MAEPIugins being made available

. List of MAEPIugins sorted alphabetically
. List of MAEPIugins by analysis method
. List of MAEPIugins by links to other Web sites to contact for the plugins

5. How to write a MAEPIugin

. The Java Plugin paradigm

. Open Java APl documentation

. How to writea MAEPIugin

. Java MAEPIugin code examples

Design of MAEPIugins

MAExplorer | MAEPIugin home | Design | Open Java API | MJA classes | MJA javadocs | Open Java API javadocs |
Plugin Tutorial Examples | List of Plugins | Developing a Plugin | Installing Plugins |
MAExplorer home | MAExplorer revision notes | Help desk

This document discusses the paradigm how MAEPIugins are used with MAEXxplorer and the design used to give them access to
MAExplorer data. The first part discuss the top level design and the second part gives an example of using a plugin. The details on
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the internals for MAEXxplorer itself are described in a Design doc (PDF) or (PPT). However, an understanding of the MAExplorer
internalsis not required to write a MAEP ugin.

1. Overview of MAEPIugin design

The MAExplorer Open Java APl (Applications Programming Interface) allows usersto access almost all data structures without
understanding the details of the system. Specialized interfacing classes (MJAXxxx), organized by function, are accessed from the
MaeJavaAPI class. The MJAXxxx classes map internal datato user datain a protected manner. Users do not have direct access to
internal MAEXxplorer data structures. However, MAEPIugins do have accessto relevant data. This allows us to improve and change
the internal data structures without causing problems with plugins using those data structures. The following figures show the top
level plugin design.

MAEPIugin Design

Local Array DB files

Load Save state, plots,
data and Reports
Plugin "jar" | MAExplorer |+=—
files — plore
Open
Java
Invoke AP

Plugins Plugin #n |- .

Get and Put
data as required

Cluster

Plugin #1

Figure 1. Overall MAEPIugin design for MAExplorer. Plugins are dynamically loaded into MAExplorer where they may be invoked from amenu
entry or by various other means such as startup, normalization, datafiltering, etc. Any number of plugins may be loaded simultaneously. They may be
loaded and unloaded dynamically, and saved for automatic |oading when the current database is saved.
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Using Open Java API to Write a Plugin
Plugin Loader C—o‘ E:::::':‘: rer

| HaeJ:waAPI — | MJAxxx classes to
I gather I scatter data

MAEPIugn base class T
' F :

User written Plugin
| AnalysisPlugin_[+— 1. Extend a xxxxPlugin class
o a—

[ ConnectionPlugin 14— 2. Alccess data via MJAxxx
classes
| FilerPlugin  4—, ' 3. Add event handlers

HormalizationPlugin  4—

| PopupPlugin -I—I-

[ other specialized -ll—h
plugin base clvsses ... v

Figure 2. Open Java API for MAEPIugins. Each type of application could be derived from specialized Java classes that contain most of the access
methods required for that type of analysis. The Gather - Scatter API is ameans of "gathering" datafrom MAExplorer interna data structures for the
plugin. When a plugin wants to store data back into MAExplorer, it is "scattered” back into the internal data structures. Thisisimplemented using the
MaeJavaAPl and MJAXxxx classes described in the Open Java API.

2. Example of using a Plugin

This shows a short demonstration of what isinvolved in using a MAEPIugin. The user first load the plugin from the disk.
Generally the plugins .jar or .classfiles are stored in the Pluging directory where you have installed MAExplorer. Then they load a
particular plugin which installs it in the Plugins pull-down menu. Then they revisit that menu to invoke the particular plugin. You
may load any number of plugins (until you run out of computer memory if that should occur).
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Figure 3. Loading a MAEPIugin from your file system using the L oad Plugins command in the Plugins pull down menu. If you have aplugin .jar
or .classfile, it may be specified using the "L oad plugin” command. This pops up afile browser to let you specify the plugin file.

may Explorer - Wil 2 H=E
Ed — .

[trangplante
wt_MG_at

8] TostChechE mfiugn ja
TesthleraFiugn ja

Figure 4. Executing the new command previously loaded in the Plugin menu. Selecting the new "Show List Active Filters' command that now
appears in the Plugins menu invokes the plugin. This pops up areport shown in the next figure.
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Figure D.5. Popup window from executing the MAEPIugin. This plugin gives afull report on the data Filter statusin a new pop up window.

MAEPIugins Open Java API
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This document describes the MAEPIugins Open Java APl (Applications Programming Interface) to enable researchers to write
their own MAEPIugins for use with MAExplorer. The Open Java API (or APl) is presented here as two javadoc trees.

The Open Java APl is automatically included in the MAExplorer.jar file. Although it wastes some space, we are exporting the
symbol tables with the filesin MAEXxplorer.jar so that you could use it with a debugger (such as Forte for Java Community
Edition) to develop a MAEPIugin. Forte 4.0 has been renamed "Sun One". We have prepared a document Configuring
SourceForge's CV S to work with Forte on Windows for MAExplorer that describes how to set up a software development

environment.

Notes:

1. The Open Java API is undergoing improvements with new methods being added to further reflect the underlying
MAEXxplorer capabilities and data structures.

2. The NormalizationPlugin and FilterPlugin base classes have been enhanced to handle both simple global plugins and data-
dependent local plugins. Some generic examples of plugins based on these are available in the list of plugins. These
handl e the various types of data access. If you use these as abasis for developing your own plugins, you might remove
the unused code to simplify your own code..

3. If thereisfunctionality needed but you can't find in the Open Java API, make a suggestion or better still - help
develop the API code by joing this Open Sour ce efforty.

. docsOJAPI/ isthe entire Open Java API javadoc tree
. docsMJA/ isthe data access MaeJavaAPl MJAXxxx classes subset javadoc tree

Thefirst, docsOJAPI/, is the entire API accessible to the plugin writer including the MAEPIugin classes required to extend your
plugins. However, many of the MJAxxxx methods are not normally called explicitly by the plugin writer. Instead, a subset of
classes, docsMJA/ constituting the MaeJavaA Pl set of classes, isthelibrary of access methods that the plugin writer normally uses.

1. List of MaeJavaAPI (MJA) classes

The MJA classes are organized by function. For example, if you want to access data and methods on samples, then go to the
MJAsample or MJAsampleList classes. See the javadocs for the Open Java APl for details. The detailed descriptions of these
classes are available in the docsMJA javadocs.

MIAxxxx C ass

Ml Abase

MIAcl ust er
MJAcondi ti on
Ml Aeval
MlAexprProfile

MIAfil ter

MIAgene
MIAgeneli st
MlAgenom cDB
MJAgeonet ry

Ml Ahel p
MJAhi st ogr am

oj ects and net hod access

base class and constants used by other MA cl asses
cluster data structures and mnet hodst

condition lists of sanples and ordered lists of condition lists
command interpreter to invoke MAExpl orer conmands
expression profiles data

data filters

singl e gene data

lists of genes and get sets

genom ¢ dat abases on the Internet

array geonetry, spot to gene naps, etc.

popup browser hel p net hods
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This document briefly describes how to write MAEPIugins using the MJA Open Java APl (Application Programming Interface). It
discusses key issues to be addressed when writing a MAEPIugin and describes in sufficient detail to enable researchersto write
their own MAEPIugins for use with MAExplorer. Note that there are basically two types of plugins. those which are one-shot
plugins (e.g., popup awindow with its own user interface or perform an operation one time), and pipeline operations. The latter
include FilterPlugins and NormalizationPlugins. These are inserted by MAExplorer into the gene filtering chained intersection
analysis and the normalization analysis. See examples of existing plugins to help understand the differences.

1. Using a Java development environment to develop and debug
a Plugin

We have designed the MAExplorer.jar file so that it contains both MAExplorer and the Open Java API. All MAExplorer classes
are compiled with the symbol table so that it may be used in a debugger. We use the Sun's Forte for Java (Community Edition)

which is afree development environment (IDE) available over the Internet. Forte (now known as " SUnONE" and most other IDES)
allowsyou "mount” ajar file. So to create a new plugin you would:

1. Create anew project directory (e.g., see the ExamplePlugin source code example and discussion).

2. Copy some example MAEXxplugin code into this project and rename the modules and classes to correspond to the names of
your new plugin.

3. Mount the MAExplorer.jar file (you can mount it from the directory where you installed MAExplorer (eg. typically
C:/Program FilesMAExplorer/MAExplorer.jar for Windows, etc.)

4. After you have compiled your plugin and want to test it, you create a new Jar file with the name of the plugin (e.g.
ExamplePlugin.jar) from the file browser. Forte lets you create jar files with with ajar packager tool.

5. Totestit, you first open the MAEXxplorer.jar file tree you have mounted. Then you select "MAExplorer”. At this point you
can execute MAExplorer or run the debugger.

6. After MAEXxplorer is running, you select "Load Plugin” from the MAExplorer Plugins pull-down menu, and then enter the

name of the plugin (e.g. ExamplePlugin.jar).

At this point you may run the plugin by going back to the Plugins menu and select the entry corresponding to your plugin.

8. If you want to make a change in your plugin and try again, you do not need to restart MAEXxplorer. Instead first unload your
plugin using the "Unload Plugin" command in the Plugins menu. Then rebuild your plugin, use "Load Plugin”, and try

again.

~

2. Installing your MAEPIugin in a working MAExplorer
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environment

1. After you are happy (or somewhat happy) with your plugin, copy the plugin jar file (e.g. ExamplePlugin.jar) to the
installation Pluging/ directory where you can access on any of your MAEXxplorer database(s) (e.g., C:/Program
FilessM AExplorer/Plugins for Windows, etc.)

2. To usethe plugin on any database, just start MAExplorer and then load and run the plugin as above.

—ee

Tutorial Examples of MAEPIugins

MAEXxplorer | MAEPIugin home | Design | Open Java API | MJA classes | MJA javadocs | Open Java API javadocs |
Plugin Tutorial Examples | List of Plugins | Developing a Plugin | Installing Plugins |
MAExplorer home | MAExplorer revisions notes | Help desk

This document gives asimple tutorial example of MAEPIugins source code. After you have read this you might look at some of
the source code from actual plugins. Note that there are several base class plugins (PopupPlugin, FilterPiugin,

NormalizationPlugin, etc.) that require different overide methods or have abstract methods you must implement. Look at the
examplesto clarify this.

1. Example of a simple PopupPlugin and how it uses the Open
Java API

The following code illustrated how to create a simple popup plugin ExamplePlugin.java using the Open Java APl by extending the
PopupPlugin. It passes the MaeJavaAPI mja instance to the actual workhorse, Example.java, that then retrieves and saves any

MAExplorer data it requires. We show very simple examples of this code to give the flavor of the procedures required and how it
interfaces with the API.

1.1 Example of plugin class that is loaded into MAExplorer

For convenience, we will name the class that is loaded into MAEXxplorer XxxxxPlugin.java and the subsequent primary body of the
plugin class Xxxxx.javawhere Xxxxx is some particular class. In our following example, Xxxxx is"Example", but it might be
"MyNewClusterMethod" etc. We first show ExamplePlugin.javathat serves as the interface between MAEXxplorer and the primary
body class Example.java.

1.1.1. You must import the two class definitions:

i mport MAEPI ugi n. popup. PopupPl ugi n;
i mport MAEPI ugi n. *;

If you are writting other types of plugins, you need to import those instead (eg. MAEPIugin.analysis.NormalizationPlugin,
MAEPIugin.analysis.FilterPlugin, etc).

1.1.2 The XxxxxPlugin.java class must have the following methods as a minimum:

XxxxxPlugin() - isthe constructor for the class (here it is ExamplePlugin).
pluginMain() - the method end-users must implement to use the API.
updateCurGene() - update any data since current gene has changed.

updateFilter() - update any dependent data since Filter has changed.

updateSlider() - update any dependent data since a threshold slider may have changed.
updatelabels() - update any dependent data since global |abels may have changed.
close() - close the plugin

NourwNE
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The XxxxxPlugin() method is called at the time the plugin isloaded. Any particular actions that may be required can be performed
at that time. In this example, we merely set the name of the plugin asit isto appear in the Plugins pull-down menu.

The pluginMain() method is called at the time the plugin isinvoked by selecting the menu entry.

The four specia event handling methods updateCurGene(), updateFilter(), updateSlider(), and updatelabels() are invoked by the
MAExplorer PopupRegistry when any of these events occurs. If you are doing nothing with the events, they may be no-ops.
However, if you want to take action on these events, you would normally implement the actual event handling code in your
XXxxX.java class.

/** File: ExanplePlugin.java */

i mport MAEPI ugi n. popup. PopupPl ugi n;
i mport MAEPI ugi n. *;
/**

* This class i nvokes the Exanpl ePl ugi n pl ugin.
*/

public class Exanpl ePl ugi n ext ends PopupPl ugi n i npl ements MAEUpdat eLi st ener
{

/** The current instance of a plugin called "Exanple".

* The instance may be non-null if run previously and is needed to kill
* a previous instance when new i nstances are created.
*/
private Exanple
ebj = nul | ;
/**

* Exanpl ePlugin() - this is the constructor end-users nust inplenment
* to use the API. It is called at the time the plugin is | oaded.
*/
publ i ¢ Exanpl ePl ugi n() throws Pl ugi nException
{ /'* Exanpl ePlugin */
/* Note: "Exanple plugin"” is a string that appears in the
* Pl ugi n nenu.
*/
set MenuLabel (" Exanpl e plugin");

M) ApopupRegi stry
pr= MAExpl or er. nj a. nj aPopupRegi stry;
i nt
propBits= (pr.PRPROP_CUR GENE | pr.PRPROP_FILTER | pr.PRPROP_LABEL |
pr. PRPROP_SLI DER | pr. PRPROP_UNI QUE);
pr. addUni quePopupW ndowToReg(t hi s, "ShowlistActiveFilters"”, propBits);
} /* Exanpl ePlugin */

/** pluginMain() - the nethod end-users nust inplenent to use the API.
* |t is invoked when the user selects the plugin in a nmenu.
*/
public void plugi nMvain()
{ /'* pluginMain */
MaeJavaAPI
nj a= MAExpl orer.nj a; /* Open Java APl library access */

i f(eoj==null)
ebj = new Exampl e(nj a);
el se
{ I'* re-rerun Exanple on new data */
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ebj . di spose();
ebj = nul | ;
System gc();
nja.njautil. meRepaint();
ebj = new Exampl e(nj a);
}
} /'* pluginMain */

/** updat eCur Gene() - update any data since current gene has changed.
* This is invoked by the MAExpl orer PopupRegistry.
* @arammd is the MD (Master Gene ID) that is the new current gene.

*/
public voi d updat eCur Gene(i nt m d)
{
i f(eCbj!=null)
ebj . updat eCur Gene(ni d;
}

/** updateFilter() - update any dependent data since the data Filter
* has changed. This is invoked by the MAExpl orer PopupRegistry.

*/

public void updateFilter()

i f(ej!=null)

eQbj . updateFilter();
}

/** updateSlider() - update any dependent data since a threshold slider
* has changed. This is invoked by the MAExpl orer PopupRegistry.

*/
public void updateSlider()
{
if(ej!=null)
ebj . updat eSli der();
}

/** updat eLabel s() - update any dependent data since gl obal |abels
* have changed. This is invoked by the MAExpl orer PopupRegistry.

*/
public voi d updat eLabel s()
{
i f(eCbj!=null)
ebj . updat eLabel s();
}
/**

* close() - close the plugin. This will be called if you
* had specified the plugin as PRPROP_UNI QUE si nce previous
* instances will be closed before the new instance is started.
* @aram preserveDataStructuresFlag to save data structures
*/
public void cl ose(bool ean preserveDat aStruct uresFl ag)
{
if(eObj!=null)
ebj . close();
}

} /'* end of class Exanpl ePl ugi n*/
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1.2 Example of the main body of plugin code

The main body of code the plugin writer generatesisillustrated here showing how one might access data and methods from the
Open Java APl. We illustrate this with a very simple example, Example.java, showing the entry point aretrieving afew data
structures from the Open Java API. In this example, we will popup a new Frame and add Action and Window listeners (code not
shown to support the Frame since that is not the point of this example). However, any Java code could be used.

/** File: Exanple.java */

public class ListActiveFilters extends Frane
i mpl enents ActionLi stener, W ndowLi stener, etc.

{

/** Exanpl e() - Constructor
*/
publ i ¢ Exanpl e( MaeJavaAPl nj a)
{ /'* Exanple */
/* [1] Access Open Java APl required through MaeJavaAPl instances
* of these MIA cl asses.
*/
MIAfilter
nmaFilter= nja.naFilter; /* Open Java APl library */
MJAgeneli st
n aGeneli st = nj a. nj aCGeneli st; /* Open Java APl library */
MJApr operty
n aProperty= nj a.nj aProperty; /* Open Java APl library */
MIAsanpl eLi st
n aSanpl eLi st= nja.nj aSanpl eList; /* Qpen Java APl library */

/* [2] Get the data */

String
sR= "Exanpl e of sone data accessed from MAExpl orer\n",
maePrj Pat h= nj aProperty. get MaeCur Pr oj ect Pat h(),
maeBrowser Titl e= nj aProperty. get MaeBrowserTitl e(),
maeDat abase= nj aProperty. get MaeDat abaseTitl e(),
maeDbSubset = nj aProperty. get MaeDbSubset Titl e();

String

sActive[]= nmjaFilter.getListFilterNanes();
i nt

nActi ve= sActive.length;
sR += " LIST OF ACTIVE FILTERS\ n";

for(int i=0;i<nActive;i++)
i f(sActive[i]!=null)

SR += " " + sActive[i] + "\n";
i nt
nSanpl es= nj aSanpl eLi st. get Nor HPsanpl es() ;
String
sanpl eNanmes[] = nj aSanpl eLi st. get HP_El i st _Sanpl eNanmes() ;
sR += " LIST OF SAMPLES\n";

for(int i=0;i<nSanples;i++)
SR += sanpl eNane[i] +"\n";

i nt
filteredM D ist[]= njaGenelList.getM Di ndi cesForFilterGenelList(),
nFilteredGenes= filteredM D ist. | ength;
String
filteredGeneNanes[]=
nj aGeneli st . get GeneFi el dDat aFr onteenelLi st ("wor ki ngCL", " GeneNane");
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sR += " LI ST OF FILTERED GENES\ n";
for(int i=0;i<nSanples;i++)
SR += "Gene ["+filteredMDist[i]+"] = "+filteredGeneNanes[i]+"\n";

System out. println(sR); /* print to java console */
} /* Exanple */

/* In this exanple, no actions are taken on popup registry events.
* However, the methods nmust exist in the code.

*/

public void updateCurGene(int md) { }

public void updateFilter() { }

public void updateSlider() { }

public void updateLabels() { }

public void close() {this.destroy(); }

} /* end of class Exanple.java */

——

List of All MAEPIugins By Origin and Analysis Method

MAExplorer | MAEPIugin home | Design | Open Java API | MJA classes | MJA javadocs | Open Java API javadocs |
Plugin Tutorial Examples | List of Plugins | Developing a Plugin | Installing Plugins |
MAExplorer home | MAExplorer revision notes | Help desk

This document lists all of the MAEPIugins aphabetically, by analysis method, and also links to MAEPIugins available on other
Web sites. The MAEPIugins include those donated to the MAExplorer Open source Web site. All plugins distributed from this
Web site will have the Java source code, JAR file and documentation. Some of these MAEPIugins were incorporated into
MAEXxplorer after they were written because of their key functionality. However, we are leaving them on the Web site to serve as
examples.

If you want to use the jar file plugins directly: (1) install MAExplorer from the list of Jar files on this Web site, (2) get the jar
file(s) from the plugins below and save them in the Pluging/ directory where you installed MAExplorer, (3) run MAExplorer and
use the (Plugins | Load Plugin) menu command to load the plugin. After it isloaded, just use it as you would any other menu
command. The Plugins-jar.tar fileis available with all of the MAEPIugin jar files. Simply unpack the directory using Unix tar or a
Windows unzip program into a directory you can access when running MAExplorer. To let MAEXxplorer go directly to these files
when you do a (Plugins | Load plugins) menu command, copy the .jar filesinto the Pluging directory where you previously
installed MAExplorer. We also periodically update the MAEPIugins-....-src.tar.gz file in the Files download area. Files from the
following list of MAEPIugins are archived as follows:. source files are from the CV S archive, jar files are from the Web server
archive of plugin .jar files, documentation is also from the CV S archive.

If you want to use these plugins as a basis for developing your own plugins, see developing a plugin and other resources available

on this Web site. The source code for each plugin is available beow. We encourage, but don't require, plugin writers to donate their
new plugin analytic methods to the MAExplorer Open Source Web site for othersto use.

1. List of all MAEPIugins sorted alphabetically

1.1 Alpha-level MAEPIugins (not fully developed)

1. RtestPluginisaR program - MAExplorer editor for creating and testing R scripts for extending MAExplorer. One
creates "R LayOuts" (RLOs) using RtestPlugin. These can then be evaluated by R using data exported from
MAExplorer and data computed by R imported back into the MAExplorer state. These use the new MJAReva API
to manage the RLO resources. It is available as source code and as jar file, with a documentation page. [NOTE: this
isvery apha-level code - read the documentation for details. We are interested in working with groups wishing to
integrate R code with MAEXxplorer. Please contact us for more information.]
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ExampleXY dataFilter Plugin is an example of an X/Y data Filter plugin to filter by X/Y ratios under various data
modes (Cy3 vs Cy5 for HP-X, single HP-X vs HP-Y, and HP-X 'set' vs HP-Y 'set' means). It can serve asan
example for those wishing to write other data filters using this type of data. Available as source code and as jar file,

with a documentation page.

Filter TestPlugin is an example Filter plugin to halve the number of genes accepted by the other filters. Available as
source code and as jar file, with a documentation page.

FtestNconditionsFilter Plugin is an example of an F-test data Filter plugin to filter by the current Ordered Condition
List (current OCL) by the F-test (fixed effects). It can serve as an example for those wishing to write other data
filters using this type of data. It has been merged into MAEXxplorer as the (Filter menu | Filter by current Ordered

Condition List (OCL) F-Test [p-Valug] slider [RB]) command. Available as source code and as jar file, with a
documentation page.

GenericNormalizationPlugin is an example of an generic normalization plugin. Rather than being used itself, it
was designed to ser ve as an example for those wishing to write other normalization methods. It contains code to
access global sample dataas well aslocal (i.e., per-spot data) that can be used for designing your own normalization
methods. Available as source code and as jar file, with a documentation page.

GeoCachePlugin downloads genomic ID from NCBI's GEO server by Geo Platform Identifier and installs the data
into MAExplorer. Available as source code and as jar file, with a documentation page. Written by Alan Li.

. Scatter PlotAllSamplesPlugin generates a scatter plot of filtered genesfor al samples (very primitive at this point).

Available as source code and as jar file, with a documentation page.

1.2 Stable MAEPIugins

1

ConditionChooser Plugin generates lets you define new or edit named condition lists of samples and assign
additional characteristics to those lists. A condition list may contain a set of replicates. It has been merged into
MAExplorer as the (Samples menu | Choose named condition lists of samples) command. Available as source code

and asjar file, with a documentation page.

ListActiveFiltersPlugin lists the state of the data filter options, modes and threshold values. Available as source
code and as jar file, with a documentation page.

. OrderedCondChooser generates lets you define new or edit named ordered lists of conditions (OCL) and assign

additional annotation to those lists. The OCL may be used for various analysis including the F-test on a set of
conditions with replicates. It has been merged into MAEXxplorer as the (Samples menu | Choose ordered condition

lists of conditions) command. Available as source code and as jar file, with a documentation page.

M ontagePlugin shows a montage composite image of subregions around current gene "cut" out of the original
images (if the datais available to MAExplorer supportsit. The NCI/CIT mAdb exported data does support this
feature). Available as source code and asjar file, with a documentation page.

. TestCheckBoxPlugin isavery simple plugin to toggle a checkbox in the menu. It is meant to be used asasimple

example of a checkbox plugin. Available as source code and asjar file, with a documentation page.

TestMenuPlugin isavery simple plugin to be invoked when selected from the menu. It is meant to be used as a
simple example of amenu plugin. Available as source code and as jar file, with a documentation page.

2. List of MAEPIugins by analysis method
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2.1 Access outside servers to acquire data

1. GeoCachePlugin downloads genomic ID from NCBI's GEO server by Geo Platform Identifier and installs the data
into MAExplorer. Available as source code and as jar file, with a documentation page. Written by Alan Li.

2.2 Connections to servers
2.3 Clustering methods

2.4 Data filtering methods

1. ExampleXYdataFilter Plugin isan example of an X/Y data Filter plugin to filter by X/Y ratios under various data
modes (Cy3 vs Cy5 for HP-X, single HP-X vs HP-Y, and HP-X 'set' vs HP-Y 'set' means). It can serve as an
example for those wishing to write other data filters using this type of data. Available as source code and as jar file,
with a documentation page.

2. FtestNconditionsFilter Plugin is an example of an F-test data Filter plugin to filter by the current Ordered Condition
List (current OCL) by the F-test (fixed effects). It can serve as an example for those wishing to write other data
filters using this type of data. It has been merged into MAEXxplorer as the (Filter menu | Filter by current Ordered

Condition List (OCL) F-Test [p-Value] slider [RB]) command. Available as source code and asjar file, with a
documentation page.

3. ListActiveFilter sPlugin lists the state of the data filter options, modes and threshold values. Available as source
code and as jar file, with a documentation page.

2.5 Normalization methods

. GenericNormalizationPlugin is an example of an generic normalization plugin. Rather than being used itself, it was
designed to serve as an example for those wishing to write other normalization methods. It contains code to access global
sample data as well aslocad (i.e., per-spot data) that can be used for designing your own normalization methods. Available
as source code and as jar file, with a documentation page.

2.6 Plot methods

1. Scatter PlotAllSamplesPlugin generates a scatter plot of filtered genesfor al samples (very primitive at this point).
Available as source code and as jar file, with a documentation page.

2.7 Report methods

2.8 Sample and condition list manipulation methods

1. ConditionChooser Plugin generates lets you define new or edit named condition lists of samples and assign
additional characteristics to those lists. A condition list may contain a set of replicates. It has been merged into
MAExplorer as the (Samples menu | Choose named condition lists of samples) command. Available as source code

and asjar file, with a documentation page.

2. OrderedCondChooser generates lets you define new or edit named ordered lists of conditions (OCL) and assign
additional annotation to those lists. The OCL may be used for various analysis including the F-test on a set of
conditions with replicates. It has been merged into MAEXxplorer as the (Samples menu | Choose ordered condition

lists of conditions) command. Available as source code and as jar file, with a documentation page.

2.9 Visualization methods
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1. MontagePlugin shows a montage composite image of subregions around current gene "cut” out of the origina
images (if the datais available to MAExplorer supportsit. The NCI/CIT mAdb exported data does support this
feature). Available as source code and as jar file, with a documentation page.

2.10 Other methods

1. TestCheckBoxPlugin isavery simple plugin to toggle a checkbox in the menu. It is meant to be used asasimple
example of a checkbox plugin. Available as source code and asjar file, with a documentation page.

2. TestMenuPlugin isavery simple plugin to be invoked when selected from the menu. It is meant to be used as a
simple example of amenu plugin. Available as source code and asjar file, with a documentation page.

3. List of MAEPIugins by links to other Web sites

Thislist contains links to other Web sites where you may obtain the Jar files and (or) Java source and documentation for
MAEPIugins from that provider. No MAExplugins will be kept on the this server unless the source code is included.

e

Cvt2Mae Data Converter

Cvt2Mae Home | Description | Download | FAQ | Appendix | Example | Revisions | Update | MAExplorer home | Help Desk

Cvt2Mae Basics

In order to use the MAExplorer data-mining tool on your cODNA or oligo tab-delimited array data, you must convert your datafiles
into the data formats described in Appendix C and Appendix D of the MAExplorer reference manual . Although this maybe done
by editing user's data files by hand into the required formats, it is a non-trivia process. Therefore we have developed a "wizard"
conversion tool called Cvt2Mae to automate these conversions.

Cvt2Mae is a Java program designed to make it easier for use by researchers to use MAExplorer by helping them convert their data
into the MAEXxplorer format. Cvt2Mae handles commercial chips such as Affymetrix, aswell as other standard formats such as
GenePix and Scanayze or one-of-a-kind custom academic chips (<User-defined>). In addition, you may specify the fields of
interest for the "Print file" or (GIPO or Gene-In-Plate-Order) file, and the fields containing the quantified data.

The Cvt2Mae converts specific chip information you entered into what we call an "Array Layout". This Array Layout file may be
edited and saved for use in future conversions and shared with collaborators. Essentially, the Array Layout contains a set of "rules’
for converting the user's data. After you have filled out the formsin Cvt2Mae, it will generate the set of converted data files and
directories to be used directly with MAEXxplorer.
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Cvt2Mae Data Conversion Steps and Tutorials

There is adetailed description on using the Cvt2Mae converter that provides the level of detail you need to use it effectively. In
addition, a step by step example is provided converting Affymetrix data.

There are several slide shows describing how to use the Cvt2Mae to convert various data sets. They consist of a series of screen
shots from Cvt2Mae that go through each of the steps on how to set up the parameters and convert your data. There are two for
Affymetrix data, one is a downloadable PDF and other an extensive online version.

Tutorials

Affymetrix Data with afull description (HTML)
Affymetrix Data (PDF) or (PPT)

GenePix Data (PDF) or (PPT)

Scanayze Data (PDF) or (PPT)

<User-defined> Data (PDF) or (PPT)

Incyte Data PDF

GRS .

Downloading latest Cvt2Mae Version

Y ou may freely download and install the current rel ease of the Cvt2Mae stand-alone application. Y ou are free to use or redistribute
Cvt2Mae. Y ou may want to review the revision history.

Download and Install Cvt2Mae.

Instructions on downloading and installing Cvt2M ae.

Update Cvt2Mae Program from maexplorer.sourceforge.net

Asof version 0.71.1 of Cvt2Mae, it is now possible to update the Cvt2Mae program from the program itself - rather than having to
download the complete installer and then running the installer. Press the "Update Cvt2Mage" button at the lower |eft of the corner of
Cvt2Mae when it is running. It asksif you want to update Cvt2Mae. Answer yes. Thiswill then (1) backup the current
Cvt2Maejar file as Cvt2Mae.jar.bkup in the directory where you had initially installed Cvt2Mae; (2) it then copies the latest
Cvt2Mae.jar file from the maexplorer.sourceforge.net Web site and replaces your working Cvt2Mae.jar filein your installation
directory. Y ou must restart Cvt2Mae for this to take effect. It will then use the new version of the program. Thisisamuch less
time consuming alternative than doing an entire download and reinstallation from the Web site.

Frequently Asked Questions (FAQ)

Here are some questions you might have about the Cvt2M ae data converter.
FAQ

If Additional Help is Needed

Before emailing us for help, please read these Cvt2Mae Web pages to ensure that you have set the parameters correctly and have
the raw data in the correct format. Y ou might also read the Appendix C of the MAEXxplorer manua. MAExplorer and Cvt2Mae

also create log files that might be of helpful in troubleshooting.

If you then are till having problems email the help desk. Please include:

. A detailed description of the problem including error messages
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. Information about the computer system (memory, operating system etc.)
. What array chip you are using, describein detail if it is not one of the default Array Layouts.

[ MAExplorer home | Cvt2Mae home | Help desk | LECB/NCI/FCRDC ]

Cvt2Mae Data Conversion Steps Description

Cvt2Mae Home | Description | Download | FAQ | Appendix | Example | Revisions | MAExplorer home | Help Desk

The Cvt2Mae "Wizard"

Y ou should use the Cvt2Mae program to convert your data to the MAEXxplorer format. Cvt2Mae has a multi-step process (wizard)
that allows you to create an Array Layout that describes your data. One could edit the raw data files by hand but this is tedious and
proneto errors. NOTE: The step titles below are links to in depth descriptions.

Step 1 Select Array Chip (Array Layout)

Cvt2Mae has severa predefined Array Layouts (Affymetrix, GenePix, Scanalyze and others) available from a pull down
menu. One can also create, edit and save their own custom Array Layouts using the <user-define> Array Layout.

Step 2 Select input file(s)
Some arrays may have several datafiles, such as a separate GIPO file or separate spot quantification files. Some files have
multiple samples within each file. Y ou can also pick multiple data files to convert. Cvt2Mae has the flexibility to handle
complex datafiles.

Step 3 Edit Array Layout
For <user-defined> arrays, you must first define some parameters such as array geometry, which row containsthe fields, if
it is Cy3/Cy5 data or intensity data etc. before converting data. Also, if you are using one of the predefined Array Layouts
and your datais dlightly different you will have to edit the Array Layout to correct these differences. These parameters are
described in detail in Appendix A. The Array Layout can then be saved and used many times for other data files with the
same data format.

Step 4 Choose output folder/directory
Thisisthe project directory where the converted data files will be saved and used with MAExplorer.

Step 5 Convert Data
Thelast step isto click the "Run" button which starts the data conversion. Several folders are created in the project
directory to hold the converted data. Once thisis completed, the "Run" button will turn into a"Done" button which you
pressto exit the program. Y ou can now go the newly created MAE sub directory and click on the Start.mae file (assuming
you have installed MAExplorer) to start MAEXxplorer on your converted data.

Status Window and Help

There are 3 message areas at the bottom of the Cvt2Mae window that are used for reporting error and status messages. If certain
parameters are not consistent, error messages will appear in the message area along with suggestions on how to correct the
problem.

The Edit Layout wizard also has its own information areathat is used for reporting. When you hold the mouse over the afield on
the left side of the wizard window, information about that parameter will appear in the lower message area.

Generation of a pseudoarray geometry if no array geometry is specified
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MAExplorer requires the datain the GIPO and Quant files be specified by a spot position. Thisisindicated by the array spot
geometry of (#fields, #grids, #rows/grid, #columns/grid). The #fieldsis the number ofof duplicated sets of gridsif available - itis1
otherwise. This 4-tuple must be specified in the Configuration file. However, some array data does not have a spot geometry
position data available. The alternative is to generate a pseudoarray geometry. Thisis possible since the pseudoarray image in
MAExplorer is used simply to indicate success of the datafilter or relative differences depending on the "Plot | Show Microarray"
option. The algorithm presented below will generate ageometry (nG i ds, nGri dRows, nGri dCol s) that is compatible with
the visual use of the pseudoarray. The only assumption isthe nRows Expect ed, the number of spotsin the microarray (rowsin
the database input file). The number of spotsin the array is computed automatically and the option to use the pseudoarray instead
of the actual array geometry is selected in the Edit Layout Wizard for Grid Geometry.

OPT_GRID_SIZE = 1200; /* Optimal grid size for MAExpl orer view ng */
ROA5_TO COLS _ASPECT _RATIO = 3.0/4.0; /* desired rows/cols aspect aspect for a grid */
extra = 0; /* # of extra grid cols required */

/* Estimate # of grids. Assune a square aspect ratio */
if(n <= OPT_GRI D_SI ZE)

nGids = 1;
el se

n&ids = (n / OPT_GRID S| ZE) +1;

/* Estimate rows (r) and colums (c) froma rectangular grid
* where cols = (4/3) rows.
* Then, ¢ = (4/3)r and r*c= area.
* Then (4/3)*r*r = area or
*r = sqgrt((3/4)*area).
*/
i f (nRowsExpected > 0)
whi | e(true)
{ /* iterate to optinmal size */
gridSize = n/nGids;
nG i dRows = sqrt( ROAS_TO COLS ASPECT_RATIO * gridSize );
nGidCols = (nGidRows / RONS_TO COLS ASPECT_RATI O ;
nGidCols += extra;
estTotSize = (nGids * nGidRows * nGidCols);
i f(estTotSize > nRowsExpect ed)
br eak;
el se
extra++; /* keep trying until meet criteria */
} /* iterate to optinmal size */

[ MAExplorer home | Cvt2Mae home | Help desk | LECB/NCI/FCRDC ]
Cvt2Mae Home | Description | Download | FAQ | Appendix | Example | Revisions | MAExplorer home | Help Desk

Example of Using Cvt2Mae to convert Some Affymetrix data for
MAEXplorer

This detailed example shows how one might convert Affymetrix data for use with MAEXxplorer. The example is presented as a
series of computer screen shots. Similar screen shots are available as PDF documents for other types of chip array layouts. The
exampleis divided into three parts. specifying the input datafiles, editing the array layout, and generating the output data files for
use with MAExplorer.

1. Specifying the input data files

Figure 1. shows the Affymetrix tab-delimited datain Excel. Figure 2. Initial state of the Cvt2Mae Program. Figure 3. Selecting a
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Chipset Array Layout. Figure 4. Selecting one or more user input data files by pressing the "Browse input file name" button. Then
select a user input data file using the file browser. Figure 5. Files selected by user and samples "discovered” in the datafile.

2. Editing the array layout

Figure 6. Edit Layout Wizard for name of the Array Layout with A) original and B) the new layout name. Figure 7. Edit Layout
Wizard for Grid Geometry. Figure 8. Edit Layout Wizard for Starting Data Rows. Figure 9. Edit Layout Wizard for Ratio or
Intensity data. Figure 10. Edit Layout Wizard for optional (X,Y) spot coordinates available in the input data. Figure 11. Edit
Layout Wizard for optional Genomic ID values available in the input data. Figure 12. Edit Layout Wizard for optional Gene
Names available in the data. Figure 13. Edit Layout Wizard for optional calibration DNA available in the data and UniGene
species prefix. Figure 14. Edit Layout Wizard for optional user names for Project, Database, Sub-database, etc. Figure 15. Edit
Layout Wizard for optional HP-X and HP-Y 'set' experimental class (i.e. condition) names. Figure 16. Edit Layout Wizard for
changing the default data filter threshold slider values.

2.1 Specifying the mapping between your data file fields and those required by MAExplorer

There are two specia wizards for specifying the mapping array layout GIPO and Quant input data field names. These mappings

allow the converter to take your data specified in some columns (i.e. Fields) of your datainput file and use it to generate standard
MAExplorer output files. Figure 17. shows the Edit Layout Wizard for "Assign GIPO fields" used to generate the MAExplorer

GIPO datafile. Figure 18. showsthe Edit Layout Wizard for "Assign Quant fields" used to generate the MAEXxplorer Quant files
(onefor each hybridized sample). Figure 19. shows saving modified Array Layout if you have made changes.

3. Generating the output data files for use with MAExplorer

Finally, the array layout has been defined and we can run the converter. Figure 20. Selecting the output folder in which to save the
converted files. Figure 21. Browse to select the output folder in which to save the converted files. Figure 22. shows the interface
after selection of the output file folder using afile browser. Figure 23. shows the conversion being performed after the user pressed
the RUN button. Figure 24. shows the conversion summary instructions after the conversion is finished. Figure 25. shows the files
that are generated by Cvt2Mae for use by MAExplorer. Figure 26. Starting MAExplorer on the converted data by clicking on

Start.mae file. Note that the location of the "MAExplorer startup file:" in Figure 8. Go to that file and click on it to start
MAEXxplorer. Alternatively, start MAExplorer and do "File | Open Disk DB" and open that file to start it up.
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Figure 1. showsthe Affymetrix tab-delimited data in Excel. (after missing fields have been edited as described above).
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Figure 3. Selecting a Chipset Array Layout. The built-in array layouts are shown for the Incyte and Affymetrix. User-defined layouts would be added
by selecting the <User-defined> layout.
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Figure 4. Select one or more user input data files by pressing the " Browse input file name" button and then pick afile. If the layout indicates that
it may contain more than one hybridization, it will attempt to find the data. Y ou can subsequently rename individual samples which may be necessary if
you are reading several files with the same sub-sample names. After the file browser pops up, select a user input datafile. If you are using afile that
contains al of your samples, then you only need to specify onefile. If you have several files, then repeat this step until you have added all of thefiles

you want.
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Figure 6. Edit Layout Wizard for name of the Array Layout. A) isthe original array layout frome the database. B) Since we may want to edit it, we
will rename the vendor and Array layout name. Thiswill enable us to save the changed layout if we wish. Y ou may not overide system defined layouts,
but you may overide your own layouts or save a system layout under a new name (as is shown here).
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Figure 7. Edit Layout Wizard for Grid Geometry.
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Figure 8. Edit Layout Wizard for Starting Data Rows.
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Figure9. Edit Layout Wizard for Ratio or Intensity data.
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Figure 10. Edit Layout Wizard for optional (X,Y) spot coordinates availablein theinput data.
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Figure 11. Edit Layout Wizard for optional Genomic ID values availablein the input data.
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Figure 12. Edit Layout Wizard for optional Gene Names available in the data.
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Figure 13. Edit Layout Wizard for optional calibration DNA availablein the data and UniGene species pr efix.
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Figure 14. Edit Layout Wizard for optional user namesfor Project, Database, Subdatabase, etc.
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Figure 15. Edit Layout Wizard for optional HP-X and HP-Y 'set' experimental class (i.e. condition) names.
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Figure 16. Edit Layout Wizard for changing the default data filter threshold slider values.

Mapping Array Layout GIPO and Quant input data field names

In addition to the above global defintions, additonal Array Layout parameters need to be define. These are mapping of input file
datafield names for GIPO and Quant data to the names required by MAExplorer. There are two wizards for helping define these
mappings. For the predefined Array Layouts these are already setup but may need to be defined or edited for user-defined data.
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.............................................
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Dnnel Cancell Hell™
Diff Call

Fold Change
Avg Diff

Figure 17. Edit Layout Wizard for Assign GI PO fields. These Gene-In-Plate-Order data field mappings should only be changed if required for
additional data fields you may have added to your input file. All fields should be defined. (it is required for <User-defined> data). In general, it may be
ok to have some non-critical genomic ID fields undefined.
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Figure 18. Edit Layout Wizard for Assign Quant fields. These Quantification data field mappings should only be changed if required to define all
fields (it isrequired for <User-defined> data).

file://IC|tmp/MaeRefMan/hmaeFullRefMan.html (201 of 234) [11/24/2003 10:49:38 AM]


file:///C|/tmp/MaeRefMan/hmaeDocC.html#quantFileFmt

MAExplorer - cDNA Microarray Exploratory Data Analysis

convesl ey dala bo MAE sploam Fles - Vemson: 00 -23-3002 'V 0LED [Dets)
Eralor dabi for sPaps T, 2, aod 3 Fian 4, press R o convar! your deke b A cpdarar Sormal

1. Sainct Chiprok [Amrrratis - Hmim =] Remove Layon
2 Sedoct inpul Daks Fikes: mwﬁmlr Separale GPD  Drowse GO I

‘mmmnmm

Eaittayort Assige GO ekis | Assigr Guand Seids |

& E i array ay ol srvd map Faids;

[ Expert ascigrmose
22 SRl fe i << SR RAT T Revnove sanple | Revsene campls |
ol T arrard oDy i OB P Ayt e [ Soumiple- TA- 1-LASA] =
e Famp ey LA T ARy befss [Sampke. 8. LSAT
TS e LM T AT b | Soimple- - 1-LII5A]
F AL E il Dt e ey bl mris AV E ASRmrimbees brlaiy A evenis B 8 FABLAT d
Wandar | Admyemvatrzemy-spacial
L ayen | Atyrvatre: - Fran gy speci)
£ pOtS BT TRy T
¥, Safoct Profect Cupul Foider | - Sifnct Gudprt Fokder— |
Project utput folder
FANERDoTar S Pk

+samanaron e oot

Sl JS-WH adiad oy kit [ARyrelrt - Human guy s peckal

o WFe [Ty ke i i

Figure 19. Saving modified Array Layout if you have made changes. Thisis useful if you have changed the array layout with "Edit Layout", "Assign
GIPO fields", or "Assign Quant fields' so that you can use it another time.
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Figure 20. Selecting the output folder in which to save the converted files. The Magenta " Save Layout" button means that you may save the edited
array layout if you wish. Y ou now need to create an output folder to put the converted data. Y ou may create a New Folder, use an Existing Folder or use
the Same Folder that contained the input files. We selected the "New Folder" option.
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Figure 21. Browseto select the output folder in which to save the converted files. Y ou may create anew folder here. Select the "name" of the folder -
don't go into the folder.

al 2 ald wn: (0 -23-2002 VOILUED [lets]
Eralor dabi for sPaps T, 2, aed 3 Fiean 4, press R o convar! yeur dele b A pdarar Sormal
1. Sefoct Chipseb [.'tr.\ur.-.-.h. b freer & pecrall 3 H._Il:q-tl

2. Sedoch inpul Dok Fikes: s i el e e I [ |Sepmrate R0 | Brove GIFO e I

T Assign GIFO Balds | Assigr Quat Seidy |
&1 E T srray layoul srd map Paids
[~ Expert ascigrmose
22 SAihes i uen <R Sarye I ﬁr.-.-.l:-.zr-.i.h-.-l_r-.l.r-l .l'rr.-.-.m.ms.'-.-.lm.lﬂl
ol P ey g -8 P - Affredc et [ Samipke- TA- LR SA] -
e Fampizemaricl ki ganric L3 T Aol bets [Sample. 18- 9L5A]

S P RO i e MO T ATl bt [ R aake- 20 1L 5A]

LF AL Farmnil _rmari D belsanards (A F AFenaies el (Vamnia 20 8 FAMLAT d
Wider | Amyemvatrzemy s pecial
L ayen | Atyrvatre: - Fran gy speci)
£ pOtS BT oTEY |T2ﬂ'5

¥ Safoct Profect Cutpul Foider | Crisate Mew prajuct foldar |

Profect output folder: |G Tampiami
AAEXpRorer siwip Fihe: | G FampimibAR 1 S trtman

+Eamanaron oo comersion | Lt osor

Siplue: [ Now prass Fun’ b comvert your daf fo MAEXpioner format

file:///IC|/tmp/MaeRefMan/hmaeFullRefMan.html (203 of 234) [11/24/2003 10:49:38 AM]


file:///C|/tmp/MaeRefMan/GifsDocH/fig-Cvt2Mae-AffyEx-BrowseNewProjectOutputFolderOptionLarge.gif
file:///C|/tmp/MaeRefMan/GifsDocH/fig-Cvt2Mae-AffyEx-NamesOfOutputFolderLarge.gif

MAExplorer - cDNA Microarray Exploratory Data Analysis

Figure 22. showsthe interface after selection of the output file folder using a file browser. Notice that the current project directory is now displayed
in the interface as well as the location of the MAExplorer Start.mae file that will be generated. The datawill be created when the Run button is pressed.
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Figure 23. shows the conversion being performed after the user pressed the RUN button. This process takes a minute or so depending on the speed
of the computer and the complexity of the data.
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Figure 24. shows the conversion summary instructions after the conversion isfinished. At this point press the DONE button to exit the converter.
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Figure 25. showsthefilesthat are generated by Cvt2M ae for use by MAExplorer. The generated data consists of several directoriesthat are
described in the Reference Manual Appendix C.
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Figure 26. Starting MAExplorer on the converted data by clicking on Start.maefile. Alternatively, Note that the location of the "MAExplorer
startup file:" is specified. Go to that file and click on it to start MAExplorer. Alternatively, start MAExplorer and do "File | Open Disk DB" and open that
fileto start it.

MAEXxplorer [ MAExplorer home | Cvt2Mae home | Help desk | LECB/NCI/FCRDC ]

Downloads for The MicroArray Explorer Project

List of program downloads | Update programs | Download MGAP data | Download PDF documents |

Table 1. below lists the various types of downloads: program installers, source codefiles, jar files, and information on installing
the programs. The Java APl documentation is also available. Table 2. lists various ways to download the Mammary Genome
Anatomy Program (MGAP) public data set that can be used with MAEXxplorer.

Types of download files available

Y ou may download program installers for your particular computer for both MAEXxplorer and Cvt2Mae. Y ou may aso download
executable JAR files for the MAEPIugins. Thereis a discussion of the program installer process for MAExplorer. The same

procedure is used for installing Cvt2Mae. If you are interested in the source code, that is also available. Individual files are
available in the CV S directories listed in the table below (see instructions on using CV Sto access these files directly with CV'S).

Gzipped tar archived packages of the source code are also available on the SourceForge.net site.

Click on the entries to download the files.

Table 1. Access of MAExplorer, MAEPIugins, Cvt2Mae from either Web server
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Installer |Update Program |Program I nformation on .
Program yersion  Version ingtallers  |ingtalling seliize IEFIIEE
MAExplorer |0.96.34.01 |0.96.34.01 MAExplorer |installing MAExplorer |source code | MAEXxplorer.jar
MAEPlugins - - (not required) |Using MAEPIugins  |source code |List of MAEPIugins
Cvi2Mae  |0.73 0.73 Cvt2Mae installing Cvt2Mae  |source code |Cvi2Mae.jar

Mammary Genome Anatomy Program (MGAP) public data set

Y ou may also download the Mammary Genome Anatomy Program (M GAP) public data set that can be used with MAEXxplorer.
Thereisalist of of PDF documents describing MAExplorer and the Cvt2Mae data conversion wizard that may be downloaded.

Table 2. Download the Mammary Genome Anatomy Program (MGAP) public data set

The Mammary Genome Anatomy Program (MGAP) using mouse models has available a of public data set of 50 samples that may

be downloaded and used with MAEXxplorer or other types of analysis. The hybridized samples data consists of tab-delimited files
(no images) for about 1700 duplicate spots/membrane. Thereisalist of startup .mae files included in the download. Y ou may

download it several different ways.

Download method Web address

A single gzip file from SourceForge |SourceForge.net: MGAP-Array-database.tar.gz

As separate files http://www.lecb.ncifcrf.gov/mae/M GA P-Array-database/

A singlezipfile http://www.lecb.ncifcrf.gov/mae/M GA P-Array-database.zip
A singletar file http://www.lecb.ncifcrf.gov/mae/M GAP-Array-database.tar

Upgrading the MAExplorer or Cvt2Mae JAR program files after the initial installation

If you want to upgrade your installation to the latest JAR files, smply download the JAR files and save them wherever you have
installed the programs replacing the previous jar files. For example, in atypical Windows OS installation, the MAEXpl orer . j ar
(or Cvt 2Mae. j ar)isinstalledin C: \ Progr am Fi | es\ MAExpl or er\ (or C:\ Program Fi | es\ Cvt 2MVae\ ) folder.
Alternatively, you can update the Jar file when running MAExplorer or Cvt2Mae as described in the next paragraph.

Updating the MAExplorer or Cvt2Mae JAR files from the running programs

Y ou can use the new "Update MAExplorer" command in the Files menu to quickly download and install just the JAR file. This
first prompt you to verify that you want to update your program. Then it will (1) backup the current MAEXxplorer.jar file as
MAExplorer.jar.bkup; (2) copy the latest MAEXxplorer.jar file from the maexplorer.sourceforge.net Web site and replace your
MAExplorer.jar file in your installation directory. Then when you restart MAEXxplorer, it will use the new version of the program.

Similarly, in the Cvt2Mae program, pressing the "Update Cvt2Mae" button will repeat the same process except that it does it for
the Cvt2Mae.jar file and creates a backup file called Cvt2Mae.jar.bkup.

MAEPIugin JAR program files
A Plugins-jar.tar fileis available with al of the released MAEPIugin jar files. Simply unpack the directory using Unix tar or a
Windows unzip program and copy the .jar filesinto adirectory you can access when running MAExplorer. To let MAEXxplorer go

directly to these files when you do a (Plugins | Load plugins) menu command, copy the .jar filesinto the Pluging/ directory where
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you previously installed MAExplorer. For example, in atypical Windows OS installation, thiswould be the C. \ Pr ogr am
Fi | es\ MAExpl or er\ Pl ugi ns\ folder.

Revision history of MAExplorer and Cvt2Mae

See the Revision notes for more information on what changes have been made to MAExplorer and Cvt2Mae and what new features
are available or bugs have been corrected.

Javadocs documentation views of the MAExplorer Project

Java documentation is useful for writing MAEPIugins as well as understanding the MAExplorer code. Because of size restrictions
the docsFull and docsAllPublic directories are currently available on the NCI/LECB web server.

However, you can generate your own javadocs for the code using the Unix script CreateM A ExplorerJavaDocs.do for MAEXxplorer
and CreateCvt2MaeJavaDoc.do .

View Javadoc folder
Full javadocs (public+private) for MAExplorer |docsFull

Full javadocs (public only) for MAExplorer  |docsAllPublic
Open Java API javadocs for MAExplorer docsOJAPI
MaelavaAPl (MJA) javadocs for MAExplorer (docsMJA

Full (public+private) javadocs for Cvt2Mae  |javadocs

opensource.org

Mozilla Public License 1.1 (MPL (e

accompanies the MPL
1 . 1) 1.1 document.

1. Definitions.

opensource.org home
page

1.0.1. "Commercial Use" neans distribution or
ot herwi se maki ng the Covered Code available to a
third party.

1.1. '"Contributor'' neans each entity that
creates or contributes to the creation of
Modi fi cati ons.

1.2. ''Contributor Version'' neans the

conbi nati on of the Original Code, prior

Modi fi cati ons used by a Contributor, and the
Modi fi cati ons made by that particul ar

Contri but or.

1.3. ''Covered Code'' neans the Oiginal Code or
Modi fi cati ons or the conbination of the Oiginal
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Code and Modifications, in each case including
portions thereof.

1.4. '""Electronic Distribution Mechanism' nmeans
a mechani sm generally accepted in the software
devel opnent comunity for the el ectronic transfer
of dat a.

1.5. ''Executable'' neans Covered Code in any
form ot her than Source Code

1.6. '""Initial Developer'' neans the individua
or entity identified as the Initial Devel oper in
t he Source Code notice required by Exhibit A

1.7. ''Larger Work'' neans a work whi ch conbi nes
Covered Code or portions thereof with code not
governed by the ternms of this License.

1.8. ''License'’ neans this docunent.

1.8.1. "Licensable" neans having the right to
grant, to the maxi num extent possible, whether at
the tine of the initial grant or subsequently
acquired, any and all of the rights conveyed
her ei n.

1.9. '"Modifications'' nmeans any addition to or
del etion fromthe substance or structure of
either the Oiginal Code or any previous

Modi fi cati ons. When Covered Code is rel eased as a
series of files, a Modification is:

A. Any addition to or deletion fromthe
contents of a file containing Oiginal Code
or previous Mdifications.

B. Any new file that contains any part of
the Oiginal Code or previous Mdifications.

1.10. '"Oiginal Code'' neans Source Code of
conput er software code which is described in the
Source Code notice required by Exhibit A as
Oiginal Code, and which, at the time of its

rel ease under this License is not al ready Covered
Code governed by this License.

1.10.1. "Patent C ains" neans any patent

claim's), now owned or hereafter acquired
including without limtation, nethod, process,
and apparatus clainms, in any patent Licensable by
grantor.

1.11. ''Source Code'' neans the preferred form of

the Covered Code for making nodifications to it,
i ncluding all nodules it contains, plus any
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associ ated interface definition files, scripts
used to control conpilation and installation of
an Executabl e, or source code differential

conpari sons agai nst either the Oigi nal Code or
anot her well known, avail abl e Covered Code of the
Contributor's choice. The Source Code can be in a
conpressed or archival form provided the
appropri ate deconpressi on or de-archiving
software is widely avail able for no charge

1.12. "You'' (or "Your") means an individual or
a legal entity exercising rights under, and
conmplying with all of the terms of, this License
or a future version of this License issued under
Section 6.1. For legal entities, "You'' includes
any entity which controls, is controlled by, or

i s under common control with You. For purposes of
this definition, "control'' means (a) the power,
direct or indirect, to cause the direction or
managenent of such entity, whether by contract or
ot herwi se, or (b) ownership of nore than fifty
percent (50% of the outstanding shares or
beneficial ownership of such entity.

2. Source Code License.

2.1. The Initial Devel oper Grant.
The Initial Devel oper hereby grants You a worl d-
wi de, royalty-free, non-exclusive |license,
subject to third party intellectual property
cl ai ns:
(a) wunder intellectual property rights
(other than patent or trademark) Licensable
by Initial Devel oper to use, reproduce
nmodi fy, display, perform sublicense and
distribute the Oiginal Code (or portions
thereof) with or w thout Modifications,
and/ or as part of a Larger Wrk; and

(b) under Patents C ains infringed by the
maki ng, using or selling of Oiginal Code,
to make, have made, use, practice, sell, and
of fer for sale, and/or otherw se di spose of
the Original Code (or portions thereof).

(c) the licenses granted in this Section
2.1(a) and (b) are effective on the date
Initial Devel oper first distributes Oiginal
Code under the ternms of this License.

(d) Notwi thstandi ng Section 2.1(b) above, no
patent license is granted: 1) for code that
You delete fromthe Oiginal Code; 2)
separate fromthe Oiginal Code; or 3) for

i nfri ngements caused by: i) the nodification
of the Original Code or ii) the conbination
of the Original Code with other software or
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devi ces.

2.2. Contributor G ant.

Subject to third party intellectual property

cl ai ms, each Contributor hereby grants You a
wor | d-wi de, royalty-free, non-exclusive |icense

(a) wunder intellectual property rights

(ot her than patent or trademark) Licensable
by Contributor, to use, reproduce, nodify,
di spl ay, perform sublicense and distribute
the Modifications created by such
Contributor (or portions thereof) either on
an unnodi fied basis, with other

Modi fi cati ons, as Covered Code and/or as
part of a Larger Work; and

(b) under Patent Cains infringed by the
maki ng, using, or selling of Modifications
made by that Contributor either al one and/or
in combination with its Contributor Version
(or portions of such conbination), to nmake,
use, sell, offer for sale, have nade, and/or
ot herwi se di spose of: 1) Mdifications nade
by that Contributor (or portions thereof);
and 2) the conbination of Modifications
made by that Contributor with its

Contri butor Version (or portions of such
conbi nati on).

(c) the licenses granted in Sections 2.2(a)
and 2.2(b) are effective on the date
Contributor first makes Conmercial Use of

t he Covered Code.

(d) Not wi t hst andi ng Secti on 2.2(b) above,
no patent license is granted: 1) for any
code that Contributor has deleted fromthe
Contri butor Version; 2) separate fromthe
Contributor Version; 3) for infringenents
caused by: i) third party nodifications of
Contributor Version or ii) the conbination
of Modifications nade by that Contri butor
with other software (except as part of the
Contri butor Version) or other devices; or 4)
under Patent d ains infringed by Covered
Code in the absence of Modifications nmade by
that Contri but or.

3. Distribution Ooligations.

3.1. Application of License.

The Modifications which You create or to which
You contribute are governed by the terms of this
Li cense, including without [imtation Section
2.2. The Source Code version of Covered Code may
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be distributed only under the terns of this

Li cense or a future version of this License

rel eased under Section 6.1, and You nust include
a copy of this License with every copy of the
Source Code You distribute. You may not offer or
i npose any ternms on any Source Code version that
alters or restricts the applicable version of
this License or the recipients' rights hereunder
However, You may include an additional docunent
of fering the additional rights described in
Section 3.5.

3.2. Availability of Source Code.

Any Modi fication which You create or to which You
contribute nust be nade avail able in Source Code
formunder the terns of this License either on
the sane nedia as an Executabl e version or via an
accepted Electronic Distribution Mechanismto
anyone to whom you nmade an Execut abl e version
avai l able; and if made available via El ectronic
Di stri bution Mechani sm must remain avail able for
at least twelve (12) nonths after the date it
initially becane available, or at |east six (6)
mont hs after a subsequent version of that
particul ar Modification has been nmade avail abl e
to such recipients. You are responsible for
ensuring that the Source Code version remains
avai |l abl e even if the Electronic Distribution
Mechani smis maintained by a third party.

3.3. Description of Mdifications.

You nust cause all Covered Code to which You
contribute to contain a file docunenting the
changes You made to create that Covered Code and
the date of any change. You nust include a

prom nent statenent that the Mdification is
derived, directly or indirectly, from Ori gi nal
Code provided by the Initial Devel oper and

i ncluding the nanme of the Initial Devel oper in
(a) the Source Code, and (b) in any notice in an
Execut abl e version or rel ated docunentation in
whi ch You describe the origin or ownership of the
Cover ed Code.

3.4. Intellectual Property Matters

(a) Third Party d ai ns.

If Contributor has knowl edge that a |icense
under a third party's intellectual property
rights is required to exercise the rights
granted by such Contri butor under Sections
2.1 or 2.2, Contributor must include a text
file with the Source Code distribution
titled "LEGAL'' whi ch describes the claim
and the party making the claimin sufficient
detail that a recipient will know whomto
contact. If Contributor obtains such

know edge after the Mdification is made

file:///C|/tmp/MaeRefMan/hmaeFullRefMan.html (212 of 234) [11/24/2003 10:49:38 AM]



MAExplorer - cDNA Microarray Exploratory Data Analysis

avai |l abl e as described in Section 3.2,

Contri butor shall pronptly nodify the LEGAL
file in all copies Contributor makes
avai |l abl e thereafter and shall take other
steps (such as notifying appropriate nailing
lists or newsgroups) reasonably cal cul ated
to informthose who received the Covered
Code that new know edge has been obt ai ned.

(b) Contributor APIs.

If Contributor's Mdifications include an
application progranm ng interface and

Contri butor has know edge of patent |icenses
whi ch are reasonably necessary to inpl enment
that APlI, Contributor nust also include this
information in the LEGAL file.

(c) Repr esent at i ons.
Contri butor represents that, except as
di scl osed pursuant to Section 3.4(a) above,
Contributor believes that Contributor's
Modi fications are Contributor's original
creation(s) and/or Contributor has
sufficient rights to grant the rights
conveyed by this License.

3.5. Required Notices.

You nust duplicate the notice in Exhibit Ain
each file of the Source Code. |If it is not
possi bl e to put such notice in a particul ar
Source Code file due to its structure, then You
must include such notice in a location (such as a
rel evant directory) where a user would be likely
to | ook for such a notice. |f You created one or
nore Modification(s) You may add your nane as a
Contributor to the notice described in Exhibit

A.  You nust also duplicate this License in any
document ati on for the Source Code where You
describe recipients' rights or ownership rights
relating to Covered Code. You may choose to
offer, and to charge a fee for, warranty,

support, indemity or liability obligations to
one or nore recipients of Covered Code. However
You may do so only on Your own behal f, and not on
behal f of the Initial Devel oper or any
Contributor. You nust nmake it absolutely clear
than any such warranty, support, indemity or
liability obligation is offered by You al one, and
You hereby agree to indemify the Initial

Devel oper and every Contributor for any liability
incurred by the Initial Devel oper or such
Contributor as a result of warranty, support,
indermity or liability terns You offer

3.6. Distribution of Executable Versions.
You may distribute Covered Code in Executable
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formonly if the requirenments of Section 3.1-3.5
have been net for that Covered Code, and if You

i nclude a notice stating that the Source Code
versi on of the Covered Code is avail abl e under
the terms of this License, including a
description of how and where You have fulfilled
the obligations of Section 3.2. The notice nust
be conspi cuously included in any notice in an
Execut abl e version, related docunentation or
collateral in which You describe recipients'
rights relating to the Covered Code. You may

di stribute the Executabl e version of Covered Code
or ownership rights under a |icense of Your

choi ce, which may contain ternms different from
this License, provided that You are in conpliance
with the terns of this License and that the
|icense for the Executabl e version does not
attenpt to limt or alter the recipient's rights
in the Source Code version fromthe rights set
forth in this License. If You distribute the
Execut abl e version under a different |icense You
must make it absolutely clear that any terms
which differ fromthis License are offered by You
al one, not by the Initial Devel oper or any

Contri butor. You hereby agree to i ndemify the
Initial Devel oper and every Contributor for any
liability incurred by the Initial Devel oper or
such Contributor as a result of any such terns
You offer.

3.7. Larger Wbrks.

You may create a Larger Work by conbi ni ng Covered
Code with other code not governed by the terms of
this License and distribute the Larger Wirk as a
singl e product. In such a case, You nust make
sure the requirements of this License are
fulfilled for the Covered Code

4. lnability to Conply Due to Statute or Regul ati on

If it is inpossible for You to conply with any of
the ternms of this License with respect to sone or
all of the Covered Code due to statute, judicial
order, or regulation then You nust: (a) conply
with the terms of this License to the maxi mum
extent possible; and (b) describe the limtations
and the code they affect. Such description nust
be included in the LEGAL fil e described in
Section 3.4 and nmust be included with al

di stributions of the Source Code. Except to the
extent prohibited by statute or regul ation, such
description nust be sufficiently detailed for a
reci pient of ordinary skill to be able to
understand it.

5. Application of this License.

This License applies to code to which the Initial
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Devel oper has attached the notice in Exhibit A
and to rel ated Covered Code

6. Versions of the License.

6.1. New Versions.

Net scape Communi cati ons Cor porati on

('" Netscape'') may publish revised and/ or new
versions of the License fromtinme to time. Each
version will be given a distinguishing version
numnber .

6.2. Effect of New Versions.

Once Covered Code has been published under a
particul ar version of the License, You may al ways
continue to use it under the terms of that
version. You may al so choose to use such Covered
Code under the terms of any subsequent version of
the Li cense published by Netscape. No one ot her
than Netscape has the right to nmodify the termns
applicable to Covered Code created under this

Li cense.

6.3. Derivative Wrks.

If You create or use a nodified version of this
Li cense (which you may only do in order to apply
it to code which is not already Covered Code
governed by this License), You nust (a) renane
Your |license so that the phrases ''Mzilla'"',

"' MXZI LLAPL" ", "' MOZPL'', '' Netscape'', "MPL",
"'"NPL'" or any confusingly simlar phrase do not
appear in your |icense (except to note that your
license differs fromthis License) and (b)

ot herwi se nmake it clear that Your version of the
|icense contains terms which differ fromthe
Mozilla Public License and Netscape Public
License. (Filling in the nane of the Initial
Devel oper, Original Code or Contributor in the
noti ce described in Exhibit A shall not of

t hensel ves be deened to be nodifications of this
Li cense.)

7. DI SCLAI MER OF WARRANTY.

COVERED CODE |'S PROVI DED UNDER THI S LI CENSE ON AN
"AS IS'' BASIS, WTHOUT WARRANTY OF ANY KI ND

El THER EXPRESSED OR | MPLI ED, | NCLUDI NG W THOUT

LI M TATI ON, WARRANTI ES THAT THE COVERED CODE | S
FREE OF DEFECTS, MERCHANTABLE, FIT FOR A

PARTI CULAR PURPCSE OR NON-|I NFRI NG NG THE ENTI RE
RI SK AS TO THE QUALI TY AND PERFCRMANCE OF THE
COVERED CODE IS WTH YOU. SHOULD ANY COVERED CCDE
PROVE DEFECTI VE | N ANY RESPECT, YOU (NOT THE

I NI TI AL DEVELOPER OR ANY OTHER CONTRI BUTCR)
ASSUME THE COST OF ANY NECESSARY SERVI Cl NG
REPAI R OR CORRECTI ON. THI S DI SCLAI MER OF WARRANTY
CONSTI TUTES AN ESSENTI AL PART OF THI S LI CENSE. NO
USE OF ANY COVERED CODE | S AUTHORI ZED HEREUNDER
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EXCEPT UNDER THI S DI SCLAI MER
8. TERM NATI ON.

8.1. This License and the rights granted
hereunder will termnate automatically if You
fail to conply with ternms herein and fail to cure
such breach within 30 days of becom ng aware of
the breach. Al sublicenses to the Covered Code
whi ch are properly granted shall survive any
term nation of this License. Provisions which, by
their nature, nust remain in effect beyond the
term nation of this License shall survive

8.2. If You initiate litigation by asserting a
pat ent infringenment claim (excluding declatory

j udgnment actions) against Initial Devel oper or a
Contributor (the Initial Devel oper or Contri butor
agai nst whom You file such action is referred to
as "Participant”) alleging that:

(a) such Participant's Contributor Version
directly or indirectly infringes any patent, then
any and all rights granted by such Participant to
You under Sections 2.1 and/or 2.2 of this License
shal |, upon 60 days notice from Parti ci pant

term nate prospectively, unless if within 60 days
after receipt of notice You either: (i) agree in
witing to pay Participant a nmutually agreeable
reasonabl e royalty for Your past and future use
of Modifications made by such Participant, or
(ii) withdraw Your litigation claimw th respect
to the Contributor Version agai nst such
Participant. |If within 60 days of notice, a
reasonabl e royalty and paynent arrangenment are
not rmutually agreed upon in witing by the
parties or the litigation claimis not wthdrawn,
the rights granted by Partici pant to You under
Sections 2.1 and/or 2.2 automatically term nate
at the expiration of the 60 day notice period
speci fi ed above.

(b) any software, hardware, or device, other
than such Participant's Contributor Version
directly or indirectly infringes any patent, then
any rights granted to You by such Parti ci pant
under Sections 2.1(b) and 2.2(b) are revoked
effective as of the date You first nmade, used,
sold, distributed, or had nade, Modifications
made by that Partici pant.

8.3. If You assert a patent infringement claim
agai nst Participant alleging that such
Participant's Contributor Version directly or
indirectly infringes any patent where such claim
is resolved (such as by license or settl enent)
prior to the initiation of patent infringenment
litigation, then the reasonabl e val ue of the
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|icenses granted by such Partici pant under
Sections 2.1 or 2.2 shall be taken into account
in determ ning the anount or val ue of any paynent
or |icense.

8.4. In the event of term nation under Sections
8.1 or 8.2 above, all end user license
agreenents (excluding distributors and resellers)
whi ch have been validly granted by You or any

di stributor hereunder prior to term nation shal
survive termnation.

9. LIMTATION CF LIABILITY.

UNDER NO Cl RCUMSTANCES AND UNDER NO LEGAL THECRY
VHETHER TORT (I NCLUDI NG NEGLI GENCE), CONTRACT, OR
OTHERW SE, SHALL YOU, THE I N TI AL DEVELOPER, ANY
OTHER CONTRI BUTOR, OR ANY DI STRI BUTOR CF COVERED
CODE, OR ANY SUPPLI ER OF ANY OF SUCH PARTI ES, BE
LI ABLE TO ANY PERSON FOR ANY | NDI RECT, SPECI AL,

| NCI DENTAL, OR CONSEQUENTI AL DAMAGES OF ANY
CHARACTER | NCLUDI NG, W THOUT LI M TATI ON, DAVAGES
FOR LOSS OF GOODW LL, WORK STOPPAGE, COVPUTER
FAI LURE OR MALFUNCTI ON, OR ANY AND ALL OTHER
COMVERCI AL DAMAGES OR LGOSSES, EVEN | F SUCH PARTY
SHALL HAVE BEEN | NFORMED OF THE POSSI Bl LI TY OF
SUCH DAMAGES. THI'S LI M TATION OF LI ABILITY SHALL
NOT APPLY TO LI ABI LI TY FOR DEATH OR PERSONAL

I NJURY RESULTI NG FROM SUCH PARTY' S NEGLI GENCE TO
THE EXTENT APPLI CABLE LAW PROHI BI TS SUCH

LI M TATI ON. SQOVE JURI SDI CTI ONS DO NOT ALLOW THE
EXCLUSI ON OR LI M TATI ON OF | NCI DENTAL OR
CONSEQUENTI AL DAMAGES, SO THI S EXCLUSI ON AND

LI M TATI ON MAY NOT APPLY TO YQU

10. U.S. GOVERNMENT END USERS

The Covered Code is a ''commercial item'' as
that termis defined in 48 CF. R 2.101 (Cct.
1995), consisting of ''commercial conputer
software'' and ''commerci al conputer software
docunentation,'' as such terns are used in 48
CF.R 12.212 (Sept. 1995). Consistent with 48
CF.R 12.212 and 48 C.F. R 227.7202-1 through
227.7202-4 (June 1995), all U S. Governnent End
Users acquire Covered Code with only those rights
set forth herein.

11. M SCELLANEQUS

Thi s License represents the conpl ete agreenent
concerni ng subject matter hereof. If any
provision of this License is held to be
unenf or ceabl e, such provision shall be refornmed
only to the extent necessary to make it
enforceabl e. This License shall be governed by
California | aw provisions (except to the extent
applicable law, if any, provides otherw se),

file:///C|/tmp/MaeRefMan/hmaeFullRefMan.html (217 of 234) [11/24/2003 10:49:38 AM]



MAExplorer - cDNA Microarray Exploratory Data Analysis

excluding its conflict-of-Ilaw provisions. Wth
respect to disputes in which at | east one party
is acitizen of, or an entity chartered or

regi stered to do business in the United States of
Anerica, any litigation relating to this License
shall be subject to the jurisdiction of the
Federal Courts of the Northern District of
California, with venue lying in Santa O ara
County, California, with the |osing party
responsi ble for costs, including wthout
limtation, court costs and reasonabl e attorneys
fees and expenses. The application of the United
Nati ons Convention on Contracts for the
International Sale of Goods is expressly
excluded. Any |aw or regul ati on which provides
that the | anguage of a contract shall be
construed against the drafter shall not apply to
this License.

12. RESPONSI BI LI TY FOR CLAI M5

As between Initial Devel oper and the
Contributors, each party is responsible for

cl ai ns and damages arising, directly or
indirectly, out of its utilization of rights
under this License and You agree to work with
Initial Devel oper and Contributors to distribute
such responsibility on an equitabl e basis.
Not hi ng herein is intended or shall be deened to
constitute any adm ssion of liability.

13. MJLTI PLE- LI CENSED CCDE

Initial Devel oper may desi gnate portions of the
Covered Code as “Miltiple-Licensed”. “Miltiple-
Li censed” nmeans that the Initial Devel oper
permts you to utilize portions of the Covered
Code under Your choice of the NPL or the
alternative |licenses, if any, specified by the
Initial Developer in the file described in

Exhi bit A

EXH BIT A -Mzilla Public License.

"“The contents of this file are subject to the
Mozilla Public License Version 1.1 (the
"License"); you may not use this file except in
conpliance with the License. You may obtain a
copy of the License at
http://ww. nmozil | a. org/ MPL/

Software distributed under the License is
distributed on an "AS | S" basis, WTHOUT WARRANTY
O

ANY KIND, either express or inplied. See the

Li cense for the specific | anguage governi ng
rights and
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limtati ons under the License.

The Oiginal Code is

The Initial Devel oper of the Oiginal Code is
Portions created by

are Copyright (O

Al Rights

Reserved.

Contri butor(s):

Al ternatively, the contents of this file may be
used under the terns of the __ license (the
“[__] License”), in which case the provisions of
[ ] License are applicable instead of those
above. If you wish to allow use of your version
of this file only under the ternms of the [ ]

Li cense and not to allow others to use your
version of this file under the MPL, indicate your
deci sion by deleting the provisions above and
replace themw th the notice and ot her
provisions required by the [___ ] License. If you
do not del ete the provisions above, a recipient
may use your version of this file under either
the MPL or the [__ ] License."

[ NOTE: The text of this Exhibit A may differ
slightly fromthe text of the notices in the
Source Code files of the Original Code. You
shoul d use the text of this Exhibit A rather than
the text found in the Oiginal Code Source Code
for Your Mdifications.]

LEGAL file - MAExplorer Software under the Mozilla Public

License (V 1.1)

MAExplorer Software under the Mozilla Public License (version 1.1)
Date: 5-31-2002

This document comprises the LEGAL File pursuant to Articles 3.4 and 4 of the Mozilla Public License (version 1.1) stating the

intellectual property and other limitations associated with the use of MAEXxplorer under this License. Dr. Peter Lemkin asan
employee of The National Cancer Institute (NCI), an agency of the United States Government, is the Initial Developer of

MAExplorer (the Original Code). As such, the following limitations apply to this License:

1. Thisisawork of the United States Government and as such there is no copyright associated with it. Notwithstanding

herein, the Government does not provide or grant any automatic license to any copyright or patent.

2. Neither the NClI, the National Institutes of Health or the United States Government endorse MAEXxplorer or any product.

Express or implied endorsement by these entitiesis prohibited.
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3. The NCl, as an agency of the United States Government, is forbidden by statute to indemnify athird party. Thus, no
indemnification for any loss, claim, damage or liability isintended or provided by NCI under this License. The NCI, asan
agency of the United States Government, assumes liability only to the extent provided under the federal Tort Claims Act, 28
U.S.C. 2671 et seq.

4. This License shall be construed and governed in accordance with Federal law as applied by the Federal courts in the District
of Columbia. In case of conflict in law between Federal law and the laws of any other jurisdiction, Federal law as applied
by the Federal courtsin the District of Columbia shall prevail.
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Glossary of terms used in MAExplorer

. Abbreviations:
o E.C.L.isEdited Genelist
o G.C.isGeneClass
o H.P.ishybridized sample
o HP-E islist of expression profile hybridized samples
o HP-Xislist of X-axis hybridized samples
o HP-Y islist of Y-axis hybridized samples

. Applet - ajavaprogram that runsin a Web browser and is downloaded from the Web server each time it isrun. Applets do
not require installing any software on your computer. However, they may not read or write any files on your computer.
MAExplorer was initially used used as an applet when accessing microarray data on the originad MGAP
http://www.lecb.ncifcrf.gov/maemicroarray Web server.

. Background - the background intensity measured near a spot in amicroarray image. Spot intensity measurements from
images with high background or where background varies over the image because of non-specific hybridization in parts of
the array need to be corrected. Some data sets have this background available as a single average value for the entire array
and others may have it on a per-spot bases. MAEXxplorer can optionally subtract this background if it is available.

. CDNA - complementary DNA immobilized as spots on the target microarray are hybridized with mRNA of the hybridized
sample. Alternative methods of constructing arrays attach synthetic oligonuclectides to the arrays rather than cDNA from
clones.

. Clone - consisting of many copies of a particular cONA. Each spot in the microarray target represents cDNA from a
different clone. In MAExplorer we use the term gene to refer to both clone spotted arrays and oligonucliotide arrays.

. ClonelD - The uniqueidentifier assigned to the clone by the |.M.A.G.E. consortium. This may be used to lookup the clone
and related datain the NCBI dbEST, GenBank, UniGene, NCI/CIT mAdb clone databases. The Clone ID is reported in all
results from MAExplorer searches.

. Cluster - aset of geneswith similar hybridized samples expression profiles. It may also be a set of HPs with similar
expression profiles for a specific set of genes. Different clustering methods define "similarity" in different ways. See Cluster

Plots in the Reference Manual.

. Condition - isanamed set of samples defined or edited using one of the condition choosers. One is the (Samples menu |
Choose HP-X, HP-Y and HP-E samples) to define the current working sets. The other defines a named condition set using
the (Samples menu | Choose named condition lists of samples). Condition sets are used in various operations including
clustering and statistical tests. For example the t-Test compares the HP-X and HP-Y condition sets of replicates.

. Current gene - the particular gene being analyzed in MAExplorer. Thisis set by the user by clicking on agenein the array,
scatter plot or Clone ID instancein areport or typing the name or Clone ID in the popup text window. It isindicated with a
green circlein the array and scatter plots, and by a darkened background in the Reports.

. Current cluster - the particular subset of genes belonging to a cluster of genes found using the K-means clustering method.
These genes belong to the cluster to which the current gene belongs. Therefore, to change the current cluster - change the
current gene. If K-means clustering is active and the current cluster is defined, the genes which belong to it will be indicated
with atiny green cluster number in the array image and in the scatter plot (if oneis present). When the current cluster is
defined, the genesin the current cluster are copied to the 'edited gene list'.
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. Current condition - the last named condition set edited with the condition chooser using the (Samples menu | Choose
named condition lists of samples). It is available for any analysis method that may want to use a particular condition.

. dbEST - Expressed Sequence Tag (EST) data from the NCBI dbEST database. The database may be indexed by clone Id
and may have entries for the 3' and/or 5' sequenced genes.

. DRYROT error - isafatal error that is detected by MAEXxplorer, it will popup an error reporting window. We call thisa
"DRYROT" error (thanksto "S.A.l.L.") because something is wrong in the program or datafiles and from which it can not
recover. Thistype of error should not have happened.

. Duplicate genes - (notation) genes that are spotted multiple times (i.e. F1, F2) for all of the genes on the same array. Thisis
different than replicated genes that may not have copies for al genes.

. Edited GeneList - (E.G.L) isasubset of genes in the MAEXxplorer database. It may be defined and edited manually or may
be set from various MAEXxplorer operations (e.g. set to the current cluster when doing similarity clustering, K-means
clustering, etc).

. EST - Expressed Sequence Tag of a particular gene fragment which is expressed in a particular tissue.

. Expression Profile - (or EP) is the vector of the spot intensity values or expression profile for the same gene for the list of
hybridized samples being analyzed. Thisis used in computing similarity between genes. Alternatively, it may be a vector of
geneintensities for a hybridized sample. Thisis used in computing similarity between samples.

. F1,F2- aretheleft (F1) and right (F1) replicate fields of the microarray (if the array supportsit). Some arrays duplicate the
genein corresponding grids of spotsin the microarray (Research Genetics, NIA neuroarrays, etc.). Thislets us compute a
coefficient of variation (CV) for the gene. If the CV islow, then the measurement is more reliable.

. Filter - (datafilter) is a sequence of restrictions on the set of al genes used to determine a subset list of genes. These
restrictions include gene membership in a"Gene Class' (eg. oncogenes); quantitative tests including: gene class
membership, spot-CV-value, ratio or intensity range or membership in histogram bins, statistical and clustering tests, etc.
These are then used to pre-filter the set of all genesto aworking subset which may then be used for viewing, reporting, or
saving in agene subset. The subset may then be used in subsequent MAEXplorer operations or saved for later use.

. Gene- in MAEXxplorer we use the generic term gene to refer to data for both gene spotted arrays and oligonucliotide arrays.
. GeneClass- (G.C.) the sets of particular genes with similar properties, e.g. oncogenes, heat shock, milk proteins, etc.

These can be used to help partition the set of al genes as part of the data filtering process. The MAEXxplorer Gene Name
Guesser (Section 2.3.1)

. Geneexpression profile - (or EP) the vector of normalized quantitative values for the corresponding gene in the set of
hybridized sample (HP-E). This vector represents the expression of the gene across a set of experimental conditions such as
developmental stages, dose-response, time-series, etc.

. Genesubset - aset of genes defined by the current filter may be saved and used at a later time as part of the Filter. In
addition, there are anumber of set operations (union, intersection and difference) which may be used to derive new sets of
genes.

. Grid - arectangular matrix of spots on the microarray. Generally the spots are laid out in a series of grids (also called
"blocks' or a"patches'). They areindexed within the grid asa"grid row" and a"grid column" If the grids are replicated,
they are indicated by multiple fields of duplicated spots.

. Grid coordinates - The genes are layed down in amicroarray in rows and columns of agrid. There are multiple grids
which may have a space between them. For example, in the MGAP microarray database there are 8 grids (named A through
H) to afield with a space between grids. Finally, there may be two fields (Ieft and right named 1 and 2 or F1 and F2) which
are duplicates of the grids so asto allow us to get an estimate of the hybridized sample variance by spotting the same gene
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multiple timesin the array.

. Hierarchical clustering is a clustering method that constructs a binary tree where the leaf objects are the set of genes (or
conditions) being clustered. The algorithm is described in Section 3.2.2.3 describing the K-means clustering. It isinvoked

by the Hierarchical clustering menu entry in Section 2.4.5.4.

. Hybridized Sample - (or HP) a particular hybridized sample's quantified data. It may be a hybridized microarray of cDNA
clones (or alternatively oligonucleotides) are hybridized with 33P radio-labled or Cy3 and Cy5 flourescent-labeled mRNA
total sample probe. We abbreviate this hybrized sample in MAExplorer as H.P. or HP.

« HP-X - theindividua H.P. sample assigned to the Y -axis when doing an analysis. The H.P-Y 'set' is a set of samples used
to compute mean intensity for each gene.

« HP-Y - theindividua H.P. sample assigned to the Y -axis when doing an analysis. The H.P-Y 'set' is a set of samples used
to compute mean intensity for each gene.

. HP-E - an ordered list of hybridized samplesthat is used in computing the gene expression profile.

. Image - the microarray image associated with a hybridized sample with a microarray obtained by scanning the radioactive
or flourescent labeled array on a phosphoimager or densitometer (if 33P labeling was used to expose film) at about 50 or
100 microng/pixel. [see particular brands and models for details.] Theimage is then quantified to obtain individual spot
intensity values using an image analysis program (the image analysis step is not part of MAEXxplorer).

. .M. A.G.E. - .M.A.G.E. clone consortium is a public collection of sequenced clones which offers the ability to locate and
acquire specific cDNA clones by assigned ID numbers. MAExplorer uses the Clone ID as the primary gene identifier.

. Intensity - refersto the integrated density over a spot and corresponds to the level of that hybridized sample's labeled
MRNA to the genes cDNA immobilized on the array. Also see background density.

. K-meansisa clustering method that assigns data Filtered genes to a fixed number of orthogonal clusters. The algorithm is
described in Section 3.2.2.2 describing the K-means clustering. It isinvoked by the K-means clustering menu entry in

Section 2.4.5.3.

. Microarray - anylon membrane, glass slide, or other subtrate with thousands of cDNA clones or oligonucleotides
"spotted” in unique positions on the array. The cDNA are typically PCR products of approximately 0.6-2.4kb representing
specific genes and typically 100-500 microgram/ml (Duggan, Nature Genetics Supplement, 21, Jan, 1999, pg 11). For
example, the initial MGAP database array created by Research Geneticsis a nylon membrane (3x7 cm) with 3500 spots
(1500 duplicated clonesin cDNA and EST inserts). The array may be "hybridized" with labeled samples to quantify how
much of each cDNA is present in the sample. See (Schulze, 2001) for a nice summary of the current technology.

. mAdb - the NCI/CIT MicroArray Database Program [http://nciarray.nci.nih.gov/] is arepository of microarray datafrom
the NCI ATC (Advanced Technology Center) microarray spotting facility.

. mAdb Clone DB - a clone database integrating hypertext links to various genomic databases for a clone. Thisis part of the
mAdb.

. MGAP - Mammary Genome Anatomy Program. MAEXxplorer was initially developed for this Program. Thisis part of the
Biology of the Mammary Gland [http://mammary.nih.gov/] Web site.

. Normalization - the method for scaling all spot quantitation measurements on a set of hybridized samples to the same
relative range so as that data from the differerent samples may be compared.

. Ordered Condition List (OCL) of condition lists- isanamed list of conditions defined or edited using the (Samples

menu | Choose ordered lists of conditions).Thisis an list of multiple conditions that you have previoudly defined. The OCL
may be sorted if you want and the data lends itself to sorting. E.g., atime series of conditions lendsitself to sorting -
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different types of diagnoses may not. Ordered Condition Lists are used in various operations such as statistical tests that
require conditions sets of replicate samples.

. Probe- (MAExplorer convention) total sample labled mMRNASs used to test hybridization with target cONA immobilized on
the array. Synonymous with hybridized samplein MAExplorer.

. Pseudoarray image - a MAExplorer image representing the quantified spot data in the database. It may or may not
correspond to the actual layout of grids, grid-rows and grid-columns in the original array. It is useful for getting the gestalt
of the overall changes in the data. There are many representations of the data (see Section 2.4.4.1 Show Microarray for

discussion and examples of these representations.

. Quantification - the analysis of a scanned microarray image for the purpose of quantifying each spot on the array. This
process typically consists of first finding the extent of a spot and then integrating the intensity. If multiple dyes are used
(e.g. Cy3, Cyb5) then the processis performed for each color-filtered image.

. Ratio - in the context of microarrays and MAEXxplorer, consists of computing the ratio of Cy3/Cy5 or HP-X/HP-Y sets of
samples. Y ou need to see the particular context of its use to determine which meaning isimplied.

. Replicate genes - (notation) genes that are spotted multiple times for some of the genes on the array. Thisis different than
duplicated genes that do have copiesfor all genes.

. Reports - are popup window reports of ordered sets of genes meeting various search criteria may be generated. These
consist of the quantitative measure, Clone Id, dbEST id, GenBank Id, Unigene link, etc. These are created in popup
windowsin MAExplorer as either scrollable dynamic spreadsheets or tab-delimited text windows which can be exported by
cutting and pasting into Excel. The default dynamic spreadsheet option, contains active hyperlink fields which point to other
web databases (such as GeneCard, dbEST, GenBank, Unigene, mAdb clones, etc.).

. Sample - same as hybridized sample in the context of MAExplorer.

. SaveAs- isthe command or button used in many of the plot windows to save the current plot as afull resolution GIF file
specified by the user in a popup file browser window. It is available only in stand-alone mode and not in the applet version.
These files could then be used for documenting a data-mining experiment or for publication.

. Silhouette plot - isway to graphically display a sorted list of similar objects. In the way it isused in MAEXxplorer, each
object in the descending sorted list (e.g. of genes) hasaline (or set of "******") proportional to the similarity to the object
at the top of thelist. It has the largest number of stars sinceits similarity is 1.0. See (Kaufman and Rousseeuw, 1990) for

discussion on silhouette plots. It may be visualized in the following example as:
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. Similarity measure - is a scalar measure computed from two vectors of normalized measurements for two objects
indicating how similar these two objects are. In MAEXxplorer, the vector is the expression profile (see Section 3.2.1) of the
same gene for the list of hybridized samples being analyzed. It may alternatively be the expression profile of alist of genes
for agiven hybridized sample. So similarity measures indicate how similar two different expression profilesare. In
MAExplorer, you may use either an Euclidian distance or correlation-coefficient as the scalar metric.

. Similarity cluster isa clustering method that finds the subset of objects (eg. genes or conditions) that is most similar to the
selected object. The list of genesis reduced to those whose "distance” between the selected object and the candidate genes
isless than some threshold. The algorithm is described in Section 3.2.2.1 describing the similarity clustering. It isinvoked

by the similarity cluster menu entry in Section 2.4.5.1.
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. Spot - the spot in amicroarray image corresponds to a clone or oligonucleotide attached to the array substrate. The intensity
of the spot corresponds to the level of hybridized sample for that gene to the DNA in the spot which correlates to mRNA
transcription expression.

. Startup file - when using MAExplorer as a stand-alone application, thisis the file (with the file name ending with a".mae"
extension) that invokes MAEXxplorer. On systems where you launch applications by double clicking on them, you would
double click on thisfile. On systems such as UNIX where you specify arguments to a command line interface, you would
type "MAEXxplorer startup .mae file name".

. Target - (MAExplorer convention) cDNA or oligonucleoctide of a gene immobilized as spot on a microarray. The array
contains thousands of these hybridized sample spots.

. UniGene - the NCBI UniGene database "is an experimenta system group for automatically partitioning GenBank
sequences into a non-redundant set of gene-oriented clusters. Each UniGene cluster contains sequences that represent a
unique gene, as well as related information such as the tissue types in which the gene has been expressed and map location."

. Zdiff - statistical measure of difference between two samples (eg. HP-X and HP-Y) when using the Zscore or Zscore of
logs of the data normalizations. If samples x,y have Zscore values for gene ¢ in samples HP-X and HP-Y, or HP-X 'sets' and
HP-Y 'sets, then the Zdiff is computed as:

Zdiff(x,y,c) = Zscore(x,c) - Zscore(y,Cc)

. Zscore - HP data normalization scaling method to set the mean value to 0.0 and the maximum and minimum values of the
scaled values to about +3.0 to -3.0 (standard deviations). It only makes sense if the data is roughly a gaussian distribution. If
itisnot, you could use the Zscore of the logs of the datato make it more gaussian. If cisagenein hybridized sample p with
mean,, and stdDev,, then it is computed as:

Zscore(p,c) = (c - meanp)/stdDev,
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Index

Thisindex is designed to be used with a Web browser. Since the page numbersin a"paper" copy of the document depends on the
font and browser window sizes we do not include page numbers. Click on a hyperlink in an index entry to jump to that entry in the
reference manual. Unfortunately, the lack of page numbers makes it difficult to use the index with a paper copy of the reference
manual.
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